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Introduction 
 

Target Audience and Purpose 
The "Reference Guide" is targeted to system administrators who operate DeploymentManager (hereafter, DPM) 
and explains DPM operations on the screen, tools, maintenance-related information, and troubleshooting. 
 

Document Structure 
1 Web Console: Explains the names and the outline of the DeploymentManager Web Console. 
2 Management: Explains users, licenses, and the configuration of DPM Server in the Management view. 
3 Operations: Explains the operations of DeploymentManager. 
4 Monitor: Explains viewing the status for managed machines and logs on the DPM. 
5 Image Builder: Explains Image Builder, which is a tool for registering images. 
6 PackageDescriber: Explains PackageDescriber, which is a tool for creating packages and registering 

them on the Package Web Server. 
7 Other Tools: Explains tools used by DPM. 
8 DPM Command Line: Explains command lines which control the DPM. 
9 Maintenance: Explains the maintenance information of DPM. 
10 Precautions: Explains precautions about DPM. 
11 Troubleshooting: Explains the method to handle error information of DPM. 
 
Appendices 
Appendix A Service List 
Appendix B Event Log 
Appendix C Error Information 
Appendix D Network Port and Protocol List 
Appendix E Log Files Output by DPM 
Appendix F Procedure to Check the Version of Each Component 
Appendix G Glossary 
Appendix H Revision History 
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DeploymentManager Manual Organization  
 
See "DeploymentManager Manual Organization" in First Step Guide. 
 
 

Documentation Guidelines 
 
See "Documentation Guidelines" in First Step Guide.
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1. Web Console 
This chapter explains each name and the overview of DPM Web Console. 
 

1.1. Web Console Overview 
You can perform various operations on the Web Console, such as machine operations and group management 
and so on. 
The Web Console is comprised of the following 9 components. 
 
 
 
 
 
 

 

 

Tree View 

Main menu Main Window Title Bar Configuration 
menu 

Action Menu 

Operation 
menu 

Action Link 

Group Box 
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(1) Title Bar 

The title bar is displayed at the top of the Web Console. 
The title bar is organized from the account management function and the main menu. 

 
・ Account Management Function 

You can configure log in users and manage them. 
 

Item Description 
User Name 
(Authority) 

Displays the user name and authority for login user. 

Account You can change the password for the user who is logged in, display a notification 
dialog or set the number of items to display in the group box. 
See Section 1.1.2, "Account" for details. 

Logout Logs out from the DPM. 
 

・ Main Menu 
You can switch the contents of tree view and main window by clicking each menu. 

 
Item Description 
Management The Management view is the view that you use for the DPM initial setting or 

the environment setting such as managing DPM users and authority, user 
lists, license management , and the setting for DPM Server. 

Operations The Operations view is the view that you use for normal operations such as 
adding a new group or machine and executing a scenario. 

Monitor The Monitor view is the view that you use for monitoring information 
necessary to operate the DPM such as scenario execution status, automatic 
update execution status, file distribution status, and file deletion status. 

 
(2) Tree View 

When you click the main menu, it will switch the tree view. 
When you click a tree view icon, detailed information about that icon will be displayed in the main window 
and the configuration and operations for that icon will be displayed in the Configuration menu and the 
Operation menu. 

 
(3) Main Window 

This is the DPM main window. Detailed information is displayed about the icon selected in the tree view. 
 

・ Group Box 
The group box indicates the box that displays the detailed information and the lists displayed in the main 
window. You can click the name of the column in the group box to display " " (ascending 
order/descending order) and sort the items. 
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・ The items that are displayed in the group box are shown in the table below. 

Display Count Select the number of items to be displayed in the list. 
"Action" Link Indicates the links in each group box where you can perform 

operations on the selected resource in the group box. 
You do this by selecting the checkbox in the left column of the group 
box to select the resource target for the operation and then clicking 
on the Action link. 

"Action" Menu Indicates the menu where you can select from the Machine 
Individual Operations in each group box, and you can perform 
operations on the selected resource in the group box. 
You do this by selecting the checkbox in the left column of the group 
box to select the resource target for the operation and selecting the 
Action menu. 

Checkbox Select the item that is the operation target from the Action link/Action 
menu. 
If you select the check in the top checkbox, you can select all of the 
users or managed machines and so on in the corresponding page. 

The following will be shown if the number of the items exceeds the specified Display Count. 
 < Moves to the previous page. 

> Moves to the next page. 
<< Moves to the initial page. 
>> Moves to the last page. 
(Text box) Enter the number of the page. 
Go Moves to the page set in the text box. 

 
(4) Configuration Menu, Operation Menu 

These are the menus for configuration/operation for the target resource. The menu content will differ 
depending on the authority (Administrator, Operator, or Observer) of the user. See Section 2.2, "User Icon" 
regarding the user authority. 
The operations performed with this menu can be performed for the resource selected from the icons in the 
tree view. 
A notification dialog box will be displayed if the operation cannot be performed. 

 
  When you use a short cut key peculiar to the browser as F1 key and so on, it 

may affect the action of Web Console. 
 There is a case that you operate to obtain a list and create a folder for all folders 

and files on the Management Server. When there is a folder or a file that a 
problem occurs by such an operation, it is recommended that you change from 
"Local System Account" which is default logon account, to other account which 
has administrative authority, about the following service and configure the 
account restriction for the account. 
・ DeploymentManager API Service 

 Refresh in the Operation menu refreshes the same as pressing the F5 key. 
However, if the F5 key is pressed while you are operating the screen, it will 
move to the first screen of the Operations/Management/Monitor view. If you 
click Refresh in the Operation menu, the current screen will be refreshed. 

 
 When you operate on the screen, a password can be requested and a 

confirmation message can be displayed by the guard parameter setting. 
See Section 2.7.2, "Guard Parameter Setting" regarding the settings screen. 
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1.1.1. DeploymentManager Login 
When the DPM Web Console is launched, DeploymentManager Login screen appears. Start the DPM Web 
Console in the following procedure. 
 

 When you log in Web Console by using the user account of LDAP server, configure 
in advance by seeing Appendix G, "Logging in to Web Console Using LDAP Server 
" in Installation Guide. 

 
(1) Select All Programs from the Start menu and select Internet Explorer. 
 
(2) By entering either of the following URL in the address field of the browser, start Web Console. (The same 

page appears by any URL.) 
 

http://HOST/DPM/ 
http://HOST/DPM/Login.aspx 
http://HOST/DPM/Default.aspx 
 
In Host, enter DNS name or IP address of the Management Server connected by the Web Console. 
Upper case and lower case are not distinguished. 
 

  When a character, which is not recommended in Windows (except alphanumeric 
characters and "-"(hyphen)), is included, specify IP address in the address filed 
of Web browser. 
If you specify DNS name, it may fail to start the Web Console. 

 When the port used by Web Service (IIS) is changed from the default value (80), 
specify URL including changed port number as the following. 
http://HOST:Port Number/DPM/ 

 
 When you access from the same machine with DPM Server, "localhost" can be 

specified in HOST. 
http://localhost/DPM/ 
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(3) The DPM Web Console is launched and DeploymentManager Login screen appears. 
 

 
 

DeploymentManager Login 
 User Name 

(Required) 
Enter the user name. 

Password 
(Required) 

Enter the password. 

Remember User Name If you select the checkbox, you can omit entering the user 
name from the next time you log in. 
If you delete the cookies using Internet Explorer's Internet 
Options, the check will be removed and it will be 
necessary to re-enter the user name. 

Login You can log into the DPM by clicking Login after the user 
name and password are entered. 

 

1.1.2. Account 
In the Account Setting screen, you can change the password of the user being logged in and configure whether 
to display the notice dialog. 
 
(1) On the Web Console, click Account in the title bar. 
 
(2) The Account Setting screen appears in the main window. 
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Account Setting 

 Change Password If you select the Change Password checkbox, you can 
change the password. By default, the checkbox is not 
selected. 

 Old Password 
(Required) Enter the currently used password. 

New Password  
(Required) 

Enter the new password. 128 characters or less can be 
entered. Alphanumeric characters and the following 
symbols can be entered: 
! " # $ % & ' ( ) * + , - . / : ; < = > ? @ [ \ ] ^ _ ` { | } ~ 

Confirm New Password 
(Required) 

Re-enter the same password for confirmation. 

Show Notice Dialog When you select the Show Notice Dialog checkbox, you 
can configure the Notice Dialog display. 
If this is selected, the Notice Dialog will be displayed the 
next time the Web Console is launched. Also, this screen 
will be displayed if you press the F5 key in an arbitrary 
window. 
By default, the checkbox is selected. 

The Count Of Lines 
Displayed Per Page 
(Required) 

This is for setting the number of items that will be 
displayed on one page for pages such as Machine List 
where the list is displayed on two or more pages. 
999 items or less can be displayed on one page. 
The number of items can be set by entering two or more 
numbers. 
Separate numeric characters by commas to set two or 
more numbers. 
The default value is "20, 50, 100". 
If it is configured with two or more numbers, it will be 
displayed using the selection of the number configured in 
the Display Count of the group box. 
Furthermore, the first number that is entered into the 
textbox will be the default value. 
Example) If "50, 20, 100" is entered, "50" will be the 
default value. 

OK Saves the setting on the Account Setting screen and 
returns to the previous window. 

Cancel Returns to the previous window without saving the setting 
from the Account Setting screen. 
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2. Management 
This chapter explains the configuration of uses, licenses, and DPM Server, managed by Management view. 
 

2.1. Management View 
You can configure the information necessary to use DPM, such as DPM user and authority management, user 
lists, license management and DPM Server configuration and so on in the Management view. 
 
When you click Management in the title bar, it will switch to the Management view. The Management Function 
List group box appears in the main window. 
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2.2. "User" Icon 
You can manage the accounts of the users who are using DPM with the User icon. 
You can access the User icon from the User icon at the tree view of the Management view or from User in the 
Management Function List group box displayed in the Management view. 
Click the User icon to display the User List group box in the main window. See Section 2.3, "User List" regarding 
the screen. 
 
It is necessary to configure the authority for each user account. The usable range of DPM is limited by the type of 
the authority. 
The three types of authority are listed below. 
 

Administrator You can perform all of the operations such as DPM configuration, changes, 
machine operation or group management and so on from the Management, 
Operations and Monitor views. 
The Administrator can change any user's password. 

Operator You can perform management and so on for machines, machine groups and 
scenario groups from the Operations and Monitor views. 
You cannot perform DPM Server management, user or authority management 
or license management in the Management view. 

Observer You can only see the machine operating status and so on in the Operations or 
Monitor views. 
You cannot perform operations in the Management, Operations or Monitor 
views. 

 
User Account Management View Operations View Monitor view 
Administrator You can operate and see You can operate and 

see 
You can operate 
and see 

Operator You can only see some of 
the screens(*1) 

You can operate and 
see 

You can operate 
and see 

Observer You can only see some of 
the screens(*1) 

You can only see You can only see 

*1 
You can only see the following screen. 
・ Base Information of the Management Server (See Section 2.7, "Base Information about the Management 

Server" for details.) 
・ Detail Setting of the Management Server (See Section 2.7.1, "Detail Setting" for details.) 

 
  See Section 2.3.2, "Edit User" regarding changing the authority or password. 

 The user(deployment_user) is already created at the time of the installation 
to execute the processing from SSC and use DPM Command Line. Also, 
there are the following restrictions for this user. 
•Login from the Web Console by the user is not available. 
•This user cannot be deleted. 

The initial password for this user is "dpmmgr". When executing DPM 
Command Line, specify the password of "deployment_user". 
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2.3. User List 
You see a list of the users registered with DPM in the User List group box. The User List group box appears in 
the main window when you click the User icon. 
 

 
 

User List 
 Display Count Select the number of items to be displayed in the list. 

"Action" Link When you click Delete User, the user with a check in the 
checkbox on the left side will be removed. 
Two or more users can be deleted collectively by two or 
more checks. 

(Checkbox) If you select the top checkbox, all users in the list will be 
selected. 

User Name Displays the user name. This cannot be edited. 
Confirm the login status with the icon. 

     :Logged in 
(grey):Logged off 

Authority Displays the user's authority. 
See Section 2.2, "User Icon" regarding the authority. 

Description Displays the user description. 
Edit You can edit the user information. Click the " " icon to 

display the Edit User screen in the main window. See 
Section 2.3.2, "Edit User" regarding the Edit User screen. 
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2.3.1. Add User 
Add the users who will use DPM. 
 
(1) When you click Management on the title bar on the Web Console, it will switch to the Management view. 
 
(2) Click the User icon in the tree view. Or, you can click User in the Management Function List group box 

displayed in the main window. 
 
(3) The Configuration menu for the User icon will be displayed. Then click Add User. 
 
(4) The Add User screen appears in the main window. Set each item. 
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Add User 
 User Name 

(Required) 
Enter the new user name to be added. 
32 characters or less can be entered. Alphanumeric 
characters and symbols can be entered. 
The following symbols cannot be used. 
\ / < > * : ; , + = ? " 
The alphabet characters are case sensitive. 

Authority 
(Selection required) 

Select the authority for the user. The three types of 
authority for the users are listed below. 
•Administrator 
•Operator 
•Observer 

Password 
(Required) 

Enter the password for the user. 
128 characters or less can be entered. Alphanumeric 
characters and following symbols can be entered. 
! " # $ % & ' ( ) * + , - . / : ; < = > ? @ [ \ ] ^ _ ` { | } ~ 
The alphabet characters are case sensitive. 

Confirm Password 
(Required) 

Re-enter the same password as confirmation. 

Description You can enter the user's description. 
128 characters or less can be entered. 
Alphanumeric characters and symbols can be entered. 
This entry is optional. 

OK The user is added and it returns to the previous window. 
Cancel Returns to the previous window without adding the user. 

 
 There is no limit on the maximum number of users you can add. 

 

2.3.2. Edit User 
Edit the users registered in the DPM. 
 
(1) When you click Management on the title bar on the Web Console, it will switch to the Management view. 
 
(2) Click the User icon in the tree view. Or, you can click User in the Management Function List group box 

displayed in the main window. 
 
(3) When the User List group box appears, click the Edit User Icon ( ) for the user to be edited. 
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(4) The Edit User screen appears in the main window. Edit each item. 

 

 
 

Edit User 
 User Name Display the user name. This cannot be edited. 

Authority Displays the user's authority. The authority can be 
changed from the list box. 
The authority will become effective from the next login. 

Change Password If you select the Change Password checkbox, you can 
change the password. By default, the checkbox is not 
selected. 
The changed password will be reflected immediately. 

Password 
Enter the password. 
128 characters or less can be entered. Alphanumeric 
characters and following symbols can be entered. 
! " # $ % & ' ( ) * + , - . / : ; < = > ? @ [ \ ] ^ _ ` { | } ~ 
The alphabet characters are case sensitive. 

Confirm Password 
(Required) 

Enter the same password as you entered in Password. 

Description The user description is displayed and can be edited. 
128 characters or less can be entered. 
Alphanumeric characters and symbols can be entered. 

OK Saves the setting on the Edit User screen and returns to 
the previous window. 

Cancel Returns to the previous window without saving the setting 
from the Edit User screen. 
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2.3.3. Delete User 
Delete a user registered to DPM. 
 
(1) When you click Management on the title bar on the Web Console, it will switch to the Management view. 
 
(2) Click the User icon in the tree view. Or in the Management Function List group box in the main window, 

click User. 
 
(3) Select the checkbox in the left column of the User to be Deleted on the User List group box that is 

displayed in the main window. 
 
(4) When you click the Action link for Delete User, a confirmation dialog will be displayed. 
 
(5) Click OK. 
 

 A deleted user that is already logged in or one who deletes yourself will stay 
active until you log off or the Web Console times out. 

 

2.4. "License" Icon 
You can manage licenses registered with DPM with the License icon. 
You can access the License icon from the License icon at the top of the Management view tree view or from 
License in the Management Function List group box displayed in the Management view main window. Click 
the License icon to display the License Information group box and the Registration License List group box in 
the main window. See Section 2.5, "Detailed Information of Registration License" regarding the screen. 
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2.5. Detailed Information of Registration License 
Click the License icon to display the License Information group box and the Registration License List group 
box in the main window. 
In the License Information group box, the status of license use is displayed. 
In the Registration License List group box, a list of the licenses, which are registered in DPM, is displayed. 
 

 
 

License Information 
Total Number of License Displays the number of registered licenses. 
Number of Used Licenses Displays the number of licenses which are already used.(the 

number of registered managed machines) 
Number of Remained 
Licenses 

Displays the number of remaining licenses. 

Registration License List 
 Display Count Select the number of items to be displayed in the list. 

"Action" Link When you click Delete License Key, the selected license 
will be deleted. 

(Option Button) Select the license to delete. 
License Name Displays the license key name. 
License Key Displays the license key. 
Registration day Displays the date the license key was registered. 

 
 If using SSC bundled product, it is not necessary to register the DPM license so the 

License icon will not be shown on the Management view. 
See the SigmaSystemCenter Installation Guide about registering licenses for SSC 
bundled product. 
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2.5.1. Add License Key 
Add the DPM license key. 
 
(1) When you click Management on the title bar on the Web Console, it will switch to the Management view. 
 
(2) Click the License icon in the tree view. Or, you can click License in the Management Function List group 

box displayed in the main window. 
 
(3) The Configuration menu for the License icon will be displayed. Then click Add License Key. 
 
(4) The Add License Key screen will appear in the main window. Then enter the license key and click OK. 

 

 
 

Add License Key 
 License key 

(Required) 
Enter the license key. Enter upper and lower case letters 
correctly. 
•A license is required for each of the machines which are 
introduced, operated and managed by DPM. 
See Section 2.3, "DeploymentManager Product Line and 
Licenses" in First Step Guide for information regarding 
the license. 
•If you do not register the license key, you can only 
register 10 machines or less, and the trial period will be 
up to 30 days. You cannot use DPM if you exceed the 30 
day period. 

OK The license is added and it returns to the previous 
window. 

Cancel Returns to the previous window without adding the 
license. 

 

2.5.2. Delete License Key 
Delete the DPM license key. 
 
(1) When you click Management on the title bar on the Web Console, it will switch to the Management view. 
 
(2) Click the License icon in the tree view. Or, you can click License in the Management Function List group 

box displayed in the main window. 
 
(3) Select License to Delete from the Registration License List group box that is displayed in the main 

window. 
 
(4) When you click the Action link for Delete License Key, a confirmation dialog will be displayed. 
 
(5) Click OK. 
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2.6. "DPM Server" Icon 
You can configure the DPM environment such as behavior of DPM Server and Folder for Image and so on using 
the DPM Server icon. You can access the DPM Server icon from the DPM Server node at the top of the 
Management view tree view or from DPM Server in the Management Function List group box displayed in the 
Management view main window. 
Click the DPM Server icon to display the Base Information group box in the main window. See Section 2.7, 
"Base Information about the Management Server" regarding the screen. 
 

2.7. Base Information about the Management 
Server 

Base information about DPM Server is displayed in the Base Information group box. The Base Information 
group box appears in the main window when you click the DPM Server icon. 
 

 
 

Base Information 
 Product Name Displayed as Deployment Manager. 

Product Version Displays the DPM version. 
IP Configuration 
 IP Address The Management Server IP address is displayed. If there 

are two or more IP addresses, then all will be displayed. 
Web Site 
 Comment Displays a description of the Web site information. 

Protocol Displays the communication protocol for connecting to 
the Web site. 

IP Address:TCP Port Displays the Web site's IP address and port number. 
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2.7.1. Detail Setting 
The configuration of the Management Server can be confirmed or changed. 
 
(1) When you click Management on the title bar on the Web Console, it will switch to the Management view. 
 
(2) In the tree view, click the DPM Server icon. Or, you can click DPM Server in the Management Function 

List group box displayed in the main window. 
 
(3) The Configuration menu for the DPM Server icon will be displayed, then click Detail Settings. 
 
(4) Each item can be configured using each of the General, Scenario, Network and DHCP Server tabs on the 

Detail Setting screen which is displayed in the main window. 
See from Section 2.7.1.1, "General Tab" to Section 2.7.1.4, "DHCP Server Tab" about each screen. 
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2.7.1.1. "General" Tab 
In the General tab, you can view and configure license information, server information, server configuration, 
Folder for Backup Image, and Folder for Image. 
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Overview 
 License Information 

 License Count Displays the number of licenses that are registered in 
DPM Server. This cannot be edited. The "License" will not 
be displayed for SSC bundles product. 
(The DPM license is included with SSC) 

Server Information 
 Computer Name The Management Server machine name is displayed. This 

cannot be edited. 
IP Address Set IP address to connect with managed machines. 

If you want to specify IP address explicitly, specify IP 
address in the list box. (IP addresses, which are set in all 
LAN boards on the Management Server, are displayed in 
the list box.)  
Select ANY when IP address to use for connections is 
arbitrary. 
The default is ANY.(*1) 

Server Setting 
 Check the completion of 

a scenario by the 
communication with 
DPM Client 

You can monitor the scenario completion in real time by 
selecting the Check the completion of a scenario by 
the communication with DPM Client checkbox. You can 
confirm scenario completion by communication between 
DPM Server and DPM Client. 
If you do not install DPM Client, do not select this. 
By default, this is selected. 
For SSC product, select this surely. 

Upgrade DPM Client 
automatically 

If the Upgrade DPM Client automatically checkbox is 
selected, when DPM Client is started, it will communicate 
with DPM Server and if DPM Client version is different 
from that on the server, it will be automatically upgraded to 
the same version as that on the server. 
If you do not install DPM Client, do not select this. 
By default, this is selected. (For SSC product, this is not 
selected by default.) 
For SSC product, do not select this surely. 

Image Setting 

 Folder for Backup Image Set the Folder for Backup Image. 
Select the folder using the Browse button or the path can 
be specified by direct input. 
80 characters or less can be entered. 
The alphanumeric characters, symbols, and space can be 
entered. 
The following symbols cannot be entered. 
/ * ? < > " | : ; , 
The default is "C: \DeployBackup". 
Set the Folder for Backup Image as a folder that is 
confirmed to have sufficient free space. 
This is optional.(*2)(*3) 
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 Default Value of Deploy-OS  

  Default Value of 
Deploy-OS(IA32) 

Set the default value of Deploy-OS. 
Deploy-OSs, which are installed in DPM Server, are 
displayed in the list box. 
The default is "ia32_110331_26".  
This configuration is also applied to the managed machine 
that "Use Default Value" is specified. 
For details about the configuration of the managed 
machine, see Section 3.5.5, "Register Managed 
Machine." 

OK Saves the setting on the Detail Setting screen and 
returns to the previous window. 

Cancel Returns to the previous window without saving the setting 
from the Detail Setting screen. 

*1 
 When you changed IP address, change IP address configured in Image Builder (Remote Console). 

The configuration can be run by selecting Start menu -> All Programs -> DeploymentManager -> 
Image Builder. 

 Be careful of the following if an IP Address except ANY is selected. 
If two or more IP addresses are assigned to one LAN board, configure the first IP address visible in 
the OS. DPM Server may not operate properly if another IP address is configured. 

 The LAN board of the all target managed machines needs to be connected to one LAN board of the 
Management Server when the IP Address is set to ANY and it is transmitted using multicast with a 
remote update scenario. 

 Set the IP Address to except ANY (the IP address configured by the used LAN board) when a 
restore scenario is executed with multicast option. 

*2 
 If you change the Folder for Backup Image, change the image file location of already created 

backup and restore scenarios and the following scenarios created by default: 
・ System_Backup 
・ System_Restore_Unicast 

 You cannot specify the following folders as the location for the Folder for Backup Image or the 
Folder for Image. 
・ Using the same folder for the Folder for Backup Image and the Folder for Image 
・ The subfolder of the Folder for Image 
・ The Windows system folder 
・ A folder used by another application 
・ Directly under the drive 

Example) "D: \" 
・ Network drives(You can specify an image file in the network directly for one scenario.) 

And if you change the Folder for Backup Image or the Folder for Image, do not do any steps except 
those described in the User's Guide (directly editing or removing and so on using Explorer). 

  Folder for Image 
(Required) 

Set a folder where OS, applications and service packs 
and so on can be saved for remote install using DPM. 
Select the folder from Browse button or the path can be 
specified by direct input. 
254 characters or less can be entered. 
Alphanumeric characters and symbols can be entered. 
The following symbols cannot be used. 
/ * ? < > " | : ; , 
The default is "C: \Deploy". 
Set the Folder for Image as a folder that is confirmed to 
have sufficient free space.(*2)(*4) 
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*3 

If you change the Folder for Backup Image, the backup image files will not be automatically moved to 
the changed location. You will need to move the files manually. 

*4 
 Grant access that will allow access with full control on the Folder for Image by the user that performs 

the DPM operations or the account (the default is local system account (SYSTEM)) used by each 
service with the name that start with "DeploymentManager" on the Management Server. 

 If the exports folder that is under the Folder for Image is configured as an NFS shared folder, take 
the following steps when changing the Folder for Image. 
1) Remove the NFS shared folder configuration from the exports folder. 
2) Change the Folder for Image from the Detail Setting screen. 
3) Configure the exports folder under the Folder for Image as an NFS shared folder. 

 Specify an empty folder if you are setting up an existing folder as the new Folder for Image. 
 When the large size images as OS image are registered in Folder for Image, it takes time to change 

Folder for Image and the timeout may occur on the Web Console. Before changing Folder for 
Image, check the size of the folder and change the following timeout value of DPM Server and IIS as 
necessary. 
If the timeout occurred, wait until the processing of changing folder is completed. After the completion 
of the processing, you need to log in on the Web Console again. 
(1) The timeout value of DPM Server 

Change the timeout value in the following file. 
<DPM Server installation folder>\WebServer\App_Data\Config\MgrServerList.xml 
Item:TimeOut 
The default is 1200(seconds). 
If you change the timeout value, you need to restart IIS. 

(2) The timeout value of IIS 
Change the timeout value in the following procedure. 
(Explains the procedure of IIS7.0 (Windows Server 2008) as an example.) 
Configure the timeout value at 4 places in the Step 6), 9), and 11) of the procedure. The smallest 
value of them will be valid as the timeout. Therefore, it is recommended that values of four places 
are the same. 
The timeout occurs in 20 minutes in the default configuration. 
The configuration will be valid promptly. 
1) Select Administrative Tools -> Internet Information Services (IIS) Manager from Start 

menu. 
2) Internet Information Services (IIS) Manager is displayed. 

Select Application Pools on the left side of the screen. 
3) Select DeploymentManagerPool in Application Pools on the center of the screen and click 

Stop in Application Pool Tasks on the right of the screen. 
4) Click Default Web Site on the left of the screen and click Stop in Manage Web Site on the 

right side of the screen. 
5) Click DPM directly under Default Web Site on the left side of the screen, select Session 

State in ASP.NET on the center of the screen, and click Open Feature in Actions on the 
right of the screen. 

6) Specify the timeout value in Cookie Settings -> Time-out (in minutes) (Default: 20 minutes) 
in the Session State screen on the center of the screen and click Apply in Actions on the 
right of the screen 

7) .Click DPM directly under Default Web Site on the left side of the screen and select 
Authentication in IIS on the center of the screen and click Open Feature in Actions on the 
right of the screen. 

8) Select Forms Authentication in the Authentication screen on the center of the screen and 
click Edit... in Actions on the right of the screen. 

9) Edit Forms Authentication Settings screen appears. Specify timeout value in 
Authentication cookie time-out (in minutes) (Default: 30minutes) and click OK. 
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10) Click Application Pools on the left side of the screen and select DeploymentManagerPool 
in Application Pools on the center of the screen. Click Advanced Settings in Edit 
Application Pool on the right side of the screen. 

11) Advanced Settings screen appears. Specify the timeout value in the following two places 
and click OK. 
・ Process Model - Timeout in idle status(minute) (The default is 20 minutes) 
・ Recycle - Periodic Interval (minute) (The default is 1740 minutes) 

12) Click Start in Application Pool Task on the right side of the screen. 
13) Click Default Web Site on the left of the screen and click Start in Manage Web Site on the 

right side of the screen. 
 End Image Builder temporarily before changing the Folder for Image and then start it again after 

changing the folder. 
 

 If you change IP Address or Folder for Image, each service of DPM is restarted. 
When you set MasterScope Network Manager's TFTP service to cooperate with 
DPM's TFTP service, an error(Error code:7585) is displayed at the timing that you 
change IP Address. In this case, there is no problem in the operation. 

 

2.7.1.2. "Scenario" Tab 
You can configure the scenario timeout time in the Scenario tab. 
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Scenario 
 Timeout Setting (*1) 

 Hardware Setting 
(Required) 

Set the default value for the timeout for distributing floppy 
disk image of BIOS/Firmware update (Scenario HW 
Setting tab). 
This can be configured in one minute increments from "1" 
to "9999" minutes. 
The default value is "10" minutes. 

Linux Installation 
(Required) 

Set the timeout for installing the Linux OS (Scenario OS 
tab). 
This can be configured in one minute increments from "1" 
to "9999" minutes. 
The default value is "120" minutes. 

OK Saves the setting on the Detail Setting screen and 
returns to the previous window. 

Cancel Returns to the previous window without saving the setting 
from the Detail Setting screen. 

*1 
 The scenario timeout is the time from the start of the scenario to the timeout. A scenario execution 

error will occur when the scenario has not completed after the time specified for each item has been 
exceeded. 

 If you set both the HW Setting tab and the OS tab on the Add Scenario screen, each timeout will be 
valid for the execution times for Hardware Setting and Linux Installation. 
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2.7.1.3. "Network" Tab 
You can configure the remote power operation and configure the number of machines for simultaneous 
execution of a scenario in the Network tab. 
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Network 
 Remote Power Control Setting 

 Remote Power On 
Interval 
(Required) 

Set the execution interval for remote power ON for each 
machine by batch execution of remote power ON. 
This can be configured in one second increments from "1" to 
"99" seconds. 
The default value is "2" seconds. 

Remote Power On 
Timeout 
(Required) 

Set the wait time for a response from the machine for a remote 
power ON or scenario execution time. This can be configured in 
one minute increments from "0" to "99" minutes. 
The default value is "10" minutes. 
If this is set to 0, then it will continue waiting for a response from 
the managed machine (The timeout of the remote power ON 
will not occur).(*1) 

Scenario Execution Setting 
 Machines For 

Simultaneous 
Execution 
(Required) 

Set the maximum number of machines on which scenarios are 
executed simultaneously. This can be set from "1" to "1000" 
machines. The default value is "5" machines. (*2) 

OK Saves the setting on the Detail Setting screen and returns to 
the previous window. 

Cancel Returns to the previous window without saving the setting from 
the Detail Setting screen. 

*1 
If you perform remote power ON or a scenario on two or more managed machines, the default value of 
the Remote Power On Timeout may cause a timeout error. 
In principle, set the Remote Power On Timeout to be greater than the following value. 
(Remote power on interval) * (the number of scenario executing machines) + (the managed machines 
startup time). 
Furthermore, a remote power ON error will occur if there is no response within the time. Increase this 
value if it can be powered ON but a power ON error occurs. 

*2 
 The following action will be done if simultaneous execution was done for machines more than the 

value that was set for the Machines For Simultaneous Execution. 

The type of the scenario The action for machines over Machines For 
Simultaneous Execution 

Backup or restore(unicast 
distribution) 

Scenarios will be executed on the number of machines 
set as Machines For Simultaneous Execution and 
other managed machines will wait. Then, when running 
scenarios have completed, the scenario will be 
executed sequentially on the waiting managed 
machines. 
If you power on the managed machines that are waiting 
for execution of the scenario manually, the scenario will 
be executed on those machines although the number 
of machines on which scenarios are executed exceeds 
Machines For Simultaneous Execution. 

Remote update(unicast 
distribution) 

Scenarios will be executed on the number of machines 
set as Machines For Simultaneous Execution and 
other managed machines will wait. Then, when running 
scenarios have completed, the scenario will be 
executed sequentially on the waiting managed 
machines. 
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Restore(multicast 
distribution) 

Scenarios will be executed on the number of machines 
set as Machines For Simultaneous Execution and 
other managed machines will wait. Then, when all 
running scenarios have completed, scenarios will be 
executed on the number of machines set as Machines 
For Simultaneous Execution newly out of waiting 
managed machines. After that, the same action will be 
done repeatedly until scenarios on all managed 
machines are executed.  

Remote update 
(multicast distribution) 

Scenarios will be executed up to the specified number 
of Machines For Simultaneous Execution. Errors will 
occur on the other machines. In such a case, remove 
the scenario execution error and execute the scenario 
again. 
See Section 3.8.8, "Error Cancellation" about removing 
the error. 

 A maximum value of Machines For Simultaneous Execution is 1000 machines, but the load on the 
network will increase as the number of scenarios concurrently running increases. 

 The number of machines on which scenarios and automatic updates can be executed simultaneously 
is 1000 machines or less. Therefore, even if both of the number of machines set here and the number 
of machines for automatic update simultaneous execution (Management view –> DPM Server icon 
–> Automatic Update Setting in the Configuration menu –> Maximum Number Of Machines For 
Automatic Update (1-1000)) are set to 1000 machines, the number of machines on which scenarios 
are executed simultaneously may be less than 1000. 
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2.7.1.4. "DHCP Server" Tab 
You can specify whether to use a DHCP server and where a DHCP server is installed. 
 

 
 

DHCP Server 
 Use A DHCP Server Select this to use a DHCP Server. 

 DHCP Server is installed 
on the machine 

Select this if the DHCP Server is running on the same 
machine as DPM Server. 

DHCP Server is installed 
on an another machine 

Select this if the DHCP Server is running on a different 
machine than DPM Server. 

Do Not Use A DHCP Server Select this not to use a DHCP server. 
OK Saves the setting on the Detail Setting screen and 

returns to the previous window. 
Cancel Returns to the previous window without saving the setting 

from the Detail Setting screen. 
 

 See Appendix B, "For Customers Who Do Not Install a DHCP Server" in First Step 
Guide about operating without a DHCP server. 
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2.7.2. Guard Parameter Setting 
You can set the guard parameters. By setting the guard parameters, you enter the password of the login user or 
warning messages are displayed when operating, and you can prevent operation misses. 
 
(1) When you click Management on the title bar on the Web Console, it will switch to the Management view. 
 
(2) In the tree view, click the DPM Server icon. Also, the Management Function List group box appears in the 

main window. Then click DPM Server. 
 
(3) The Configuration menu for the DPM Server icon appears. Then click Guard Parameter Setting. 
 
(4) A screen appears that requires entry of the password. Enter the password. 
 

 Enter the password that is the password for the login user. 
 
(5) The Guard Parameter Setting screen appears. Then select Password, Warning or None and click OK. 

These become effective immediately after setting. The DPM services do not need to be restarted. 
 

The operation of the Password, Warning or None selected from the Guard Parameter Setting screen is 
shown in the table below. 

 
Setting Description 
Password A password entry screen will be displayed at the time of each operation, and 

you cannot operate it if the correct password is not entered. 
Warning A confirmation message will be displayed as a warning at the time of each 

operation. 
None Nothing will be displayed at the time of each operation. 
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 The default guard parameter settings are those in the above figure. 

 
Guard Parameter Setting 
 Add Machine Set the Add Machine guard parameters. 

Delete Machine Set the Delete Machine guard parameters. 
Add Group Set the Add Group guard parameters. 
Delete Group Set the Delete Group guard parameters. 
Add Scenario Set the Add Scenario guard parameters. 
Edit Scenario Set the Edit Scenario guard parameters. 
Delete Scenario Set the Delete Scenario guard parameters. 

Assign scenario Set the Assign Scenario guard parameters 

Remove Scenario 
Assignment 

Set the Remove Scenario Assignment guard 
parameters 

Execute Scenario Set the Execute Scenario guard parameters. 

Scenario Execution Stop Set the Scenario Execution Stop guard parameters. 

Power ON/Shutdown Set the Power ON/Shutdown guard parameters 

Package Download Setting Set the Package Download Setting guard parameters. 

Automatic Update Setting Set the Automatic Update Setting guard parameters. 

Set Automatic Update Time 
by the Batch 

Set the Set Automatic Update Time by the Batch 
guard parameters. 

OK Saves the setting on the Guard Parameter Setting 
screen and returns to the previous window. 

Cancel Returns to the previous window without saving the 
setting from the Guard Parameter Setting screen. 

 

2.7.3. Package Download Setting 
You can add, edit, or delete the Package Web Server or package automatic downloads. 
 
(1) When you click Management on the title bar on the Web Console, it will switch to the Management view. 
 
(2) In the tree view, click the DPM Server icon. Also, the Management Function List group box appears in the 

main window. Then click DPM Server. 
 
(3) The Configuration menu for the DPM Server icon appears. Click Package Download Setting. 
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(4) The Package Download Setting screen appears in the main window. Set each item. 

 

 
 

Package Download Setting 
 Proxy 

 Address Set the IP address or the host name of the proxy if accessing 
the Package Web Server using a proxy. 
127 characters or less can be entered. 
Alphanumeric characters and symbols can be entered. 
The following symbols cannot be used. 
\ * ? 
The default is blank. 

Port 
(Required) 

Set the proxy port number if accessing the Package Web 
Server using a proxy. 
This can be set in the range of "1 - 65535". 
The default value is "80." 

 Download Automatically 
  Left List Box When you select the Download Automatically checkbox, 

you can set the timing for package automatic downloads. By 
default, the checkbox is not selected. (*1) 

   Set the cycle and day of the week for the automatic 
download. You can select from the following. 
・ Every Hour 
・ •Everyday 
・ Sun - Sat (Sunday - Saturday) 

  Right List Box Set the time for the automatic download. You can select from 
the following. 
・ If you select Every Hour  

10 minute increments from "0" to "50" minutes  
・ If you select Everyday  

Hourly increments from "0:00" to "23:00"  
・ If you select either of Sun - Sat (Sunday - Saturday)  

Hourly increments from "0:00" to "23:00" 
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 Package Web Server 

 Display Count Select the number of items to be displayed in the list. 
"Action" Link When you click Add, Add Package Web Server screen 

appears and you can add a Package Web Server. About 
the method to add, see Section 2.7.3.1, "Add a Package 
Web Server." 
When you click Delete, you can delete the Package Web 
Server which is selected in the left check box. When you 
select two or more Package Web Servers, you can delete 
them collectively. 

(Checkbox) All Package Web Servers will be selected if you select in 
the top checkbox. 

Server Address Displays the address of the Package Web Server. 
If two or more Package Web Servers are registered, they 
will be displayed in ascending order. 
When you click the displayed address, the base 
information for the Package Web Server will be displayed 
in the main window. 

Server ID Displays the Package Web server identifier. 
When a package is downloaded to the Management 
Server, the server ID will be attached in front of each 
package's ID number. 

Download Displays whether the Package Web Server is the target of 
automatic downloads. 

Proxy Displays whether a proxy is used when downloading a 
package from the Package Web Server. 

  Latest Download 
Information 

Displays success/fail of the download or the time of the 
latest download. 

Edit Edit the Package Web Server. Click the " " icon to 
display the Edit Package Web Server screen in the main 
window. For the edit screen, see Section 2.7.3.2, "Edit the 
Package Web Server." 

OK Saves the setting on the Package Download Setting 
screen and returns to the previous window. 

Cancel Returns to the previous window without saving the setting 
of the Package Download Setting screen. 

 
*1 

DPM Server does not obtain the latest system time until the next download, so if you change the 
Windows system time after you set the automatic download, the download may not be performed as 
scheduled. 

 
  You can temporarily delete the package that was automatically downloaded 

to the Management Server using the function to delete the registered data of 
Image Builder. 
However, if you do not delete the corresponding package from the Package 
Web Server, it will be downloaded again at the set time of the automatic 
download. 

 If a package is deleted from the Package Web Server using 
PackageDescriber, the package on the Management Server will be deleted 
at the time the next automatic download is performed. 

 
 You cannot change the package download setting during automatic download. 
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2.7.3.1. Add a Package Web Server 
Add a Package Web Server. 
 
(1) When you click Management on the title bar on the Web Console, it will switch to the Management view. 
 
(2) In the tree view, click the DPM Server icon. Also, the Management Function List group box appears in the 

main window. Then click DPM Server. 
 
(3) The Configuration menu for the DPM Server icon appears. Click Package Download Setting. 
 
(4) The Package Web Server group box appears in the main window. Click Add in the Action link. 
 
(5) The Add Package Web Server screen appears in the main window. Set each item. 
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Add Package Web Server 
 Server ID 

(Required) Set the Package Web Server ID. 
7 characters or less can be entered. Alphanumeric 
characters and the following symbols can be entered. 
_ - 
"local" (case insensitive) is already reserved and cannot 
be used. 

Address 
(Required) Set the URL of the Package Web Server. 

255 characters or less can be entered. 
Alphanumeric characters and symbols can be entered. 
The following symbols cannot be used. 
\ * ? 
The default is blank. 

Port 
(Required) 

Set the Package Web Server port number. This can be set 
in the range of "1 - 65535." The default value is "80." 

Use Proxy A proxy will be used when accessing the Package Web 
Server if the Use Proxy checkbox is selected. 
Do not set user authentication to the proxy server when 
using a proxy server. By default, the checkbox is not 
selected. 

Select Automatic 
Download Target 

The package will be regularly downloaded from the 
Package Web Server when the Select Automatic 
Download Target checkbox is selected. 
By default, the checkbox is not selected.(*1) 

User Authentication If the User Authentication checkbox is selected, user 
authentication will be performed when the Package Web 
Server is accessed. 
Select this when user confirmation is required to access 
the Package Web Server. When you select the User 
Authentication, the User Name and Password entry is 
enabled and User Name is a required entry item. 
By default, the checkbox is not selected. 

 User Name 
(Required) 

Enter the basic authentication user name set in the IIS. 
63 characters or less can be entered. Alphanumeric 
characters and symbols can be entered. 

Password Enter the basic authentication password set in the IIS. 
63 characters or less can be entered. 
Alphanumeric characters and symbols can be entered. 
This entry is optional. 

OK Saves the setting on the Add Package Web Server 
screen and returns to the previous window. 

Cancel Returns to the previous window without saving the setting 
from the Add Package Web Server screen. 

*1 
The Management Server does not obtain the latest system time until the next download, so if you 
change the Windows system time after you set the automatic download, the download may not be 
performed as scheduled. 
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2.7.3.2. Edit the Package Web Server 
Edit a Package Web Server. 
 
(1) When you click Management on the title bar on the Web Console, it will switch to the Management view. 
 
(2) In the tree view, click the DPM Server icon. Also, the Management Function List group box appears in the 

main window. Then click DPM Server. 
 
(3) The Configuration menu for the DPM Server icon appears. Click Package Download Setting. 
 
(4) Once the Package Web Server group box appears in the main window, click the Edit icon( ) for the 

Package Web Server to be edited. 
 
(5) The Edit Package Web Server screen appears in the main window. Edit each item. 
 
You can also display the Package Web Server screen by the following steps. 
 
(1) When you click Management on the title bar on the Web Console, it will switch to the Management view. 
 
(2) In the tree view, click the DPM Server icon. Or, the Management Function List group box appears in the 

main window. Then click DPM Server. 
 
(3) The Configuration menu for the DPM Server icon appears. Click Package Download Setting. 
 
(4) The Package Web Server group box appears in the main window. Click the Server Address. 
 
(5) The Configuration menu for the Package Web Server appears. Click Edit Package Web Server. 
 
(6) The Edit Package Web Server screen appears in the main window. Edit each item. 
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Edit Package Web Server 
 Server ID The Package Web Server ID is displayed. This cannot be 

edited. 
Address 
(Required) The URL of the Package Web Server can be edited. 

255 characters or less can be entered. 
Alphanumeric characters and symbols can be entered. 
The following symbols cannot be used. 
\ * ? 

Port The Package Web Server port number can be edited. This 
can be set in the range of "1 – 65535". The default value is 
"80." 

Use Proxy A proxy will be used when accessing the Package Web 
Server if the Use Proxy checkbox is selected. Do not set 
user authentication to the proxy server when using a proxy 
server. 

Select Automatic 
Download Target 

The package will be regularly downloaded from the 
Package Web Server when the Select Automatic 
Download Target checkbox is selected. 

Change User Authorize When the Change User Authorize checkbox is selected, 
the User Authentication checkbox is enabled.  

User Authentication Select the User Authentication checkbox when user 
authentication is required to access the Package Web 
Server. 
When you select this, entry of User Name and Password 
is enabled. 

 User Name 
(Required) 

Edit the basic authentication user name set in the IIS. 
63 characters or less can be entered. 
Alphanumeric characters and symbols can be entered. 

Password Edit the basic authentication password set in the IIS. 
63 characters or less can be entered. 
Alphanumeric characters and symbols can be entered. 
This entry is optional. 

OK Saves the setting on the Edit Package Web Server 
screen and returns to the previous window. 

Cancel Returns to the previous window without saving the setting 
from the Edit Package Web Server screen. 

 

2.7.3.3. Delete the Package Web Server 
Delete a Package Web Server. 
 
(1) When you click Management on the title bar on the Web Console, it will switch to the Management view. 
 
(2) In the tree view, click the DPM Server icon. Or, the Management Function List group box appears in the 

main window. Then click DPM Server. 
 

(3) The Configuration menu for the DPM Server icon appears. Click Package Download Setting. 
 
(4) The Package Web Server group box appears in the main window. Then select the left column of the 

Package Web Server to Delete and click the Action link for Delete. 
 
(5) The confirmation dialog box appears. Click OK. 
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You can also delete the Package Web Server by the following steps. 
 
(1) When you click Management on the title bar on the Web Console, it will switch to the Management view. 
 
(2) In the tree view, click the DPM Server icon. Also, the Management Function List group box appears in the 

main window. Then click DPM Server. 
 
(3) The Configuration menu for the DPM Server icon appears. Click Package Download Setting. 
 
(4) The Package Web Server group box appears in the main window. Click the Server Address. 

 
(5) The Configuration menu for the Package Web Server appears. Click Delete Package Web Server. 
 

 
 

(6) The confirmation dialog box appears. Click OK. 
 

2.7.3.4. Base Information about the Package Web Server 
Displays the base information about the Package Web Server. 
  
(1) When you click Management on the title bar on the Web Console, it will switch to the Management view. 
 
(2) In the tree view, click the DPM Server icon. Also, the Management Function List group box appears in the 

main window. Then click DPM Server. 
 
(3) The Configuration menu for the DPM Server icon appears. Click Package Download Setting. 
 
(4) The Package Web Server group box appears in the main window. Then click the Server Address link. 
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(5) The Base Information group box for the Package Web Server appears in the main window. 

 

 
 

Base Information 
 Server ID Displays the ID of the Package Web Server. 

Address Displays the address of the Package Web Server. 
Port Displays the port number used by the Package Web 

Server. 
Use Proxy Displays "Yes" if a proxy server is used and "No" if a proxy 

server is not used. 
Target of Auto Download Displays "Yes" if it is target of auto download and "No" if it 

is not target of auto download. 
User Authorize Displays "Used" if user authentication is set and "Unused" 

if user authentication is not set. 
User Name Displays the user name. 
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2.7.4. Automatic Update Setting 
Set the automatic update. 
 
(1) When you click Management on the title bar on the Web Console, it will switch to the Management view. 
 
(2) In the tree view, click the DPM Server icon. Also, the Management Function List group box appears in the 

main window. Then click DPM Server. 
 
(3) The Configuration menu for the DPM Server icon appears. Click Automatic Update Setting. 

 
(4) The Automatic Update Setting screen appears in the main window. Set each item. 
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Automatic Update Setting 
 Maximum Number Of 

Machines For Automatic 
Update(1-1000) 
(Required) 

Set the upper limit on the number of machines that can do 
automatic updates at the same time.  
The Maximum Number Of Machines For Automatic 
Update is not a group unit; this is for all of the machines 
that are registered to the Management Server. 
This can be set in the range of "1-1000" units. The default 
value is "5" machines.(*1) 

The Maximum Transfer Rate 
(1-500MB/min) 

When you select The Maximum Transfer Rate 
checkbox, you can control the transfer rate when 
transferring the automatic update files. 
The maximum transfer rate is set as the maximum data 
volume in MByte that will transfer in 1 minute. This can be 
set in the range of "1 - 500." The default value is "500" 
MByte/minute. 
By default, the checkbox is not checked. 

Automatic Update During The New Group's Registration 
 Automatic Update Set the default value for the automatic update function for 

the new group. 
・ Constantly Off 
・ ON At Startup 
・ OFF At Startup 
The default is OFF At Startup. 
The following setting values will be disabled if the setting 
is Constantly Off. 
・ Automatic Update Time 
・ Application Timing 
・ Retry Count 
・ Retry Interval(Min.) 
When you set the automatic update function to 
Constantly Off, the managed machine will not request 
not applied packages to the Management Server. (*2) 

Automatic Update Time Set the default value for the automatic update time for the 
new group. 

 Left List Box Set the day for executing the automatic update. You can 
select from the following. 
・ Everyday 
・ Sunday - Saturday(Sun. - Sat) 
The default is blank. 

Right List Box Select hourly increments from "0:00" to "23:00." If you 
select blank in the left list box, the setting time will be 
disabled. 
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  Application Timing Set the default value for the automatic update 

application timing for the new group. 
・ Immediately 
・ At Next Startup 
・ Show Confirmation 
The default is At Next Startup. 
If the application Timing setting is Immediately or At 
Next Startup, the screen will not be displayed on the 
managed machines.(*3) 

Retry Count Set the default value of retry count which is set when a 
new group is added. 
The connection is retried up to the number which is set 
here. 
This can be set in the range of "0 – 5" times. The default 
value is "1" time. 

Retry Interval(Min.) Set the default value for the Retry Interval (Min.) for the 
new group. 
This can be configured in five minute increments from 
"5" to "30" minutes. The default value is"5" minutes. 

OK Saves the setting on the Automatic Update Setting 
screen and returns to the previous window. 

Cancel Returns to the previous window without saving the 
setting from the Automatic Update Setting screen. 

*1 
The number of machines on which automatic updates and scenarios can be executed simultaneously is 
1000 machines or less. Therefore, even if both of the number of machines set here and the number of 
machines for scenario simultaneous execution (Management view –> DPM Server icon –> Detail 
Setting in the Configuration menu –> Network tab -> Machines For Simultaneous Execution in 
Scenario Execution Setting group box) are set to 1000 machines, the number of machines on which 
automatic updates are executed simultaneously may be less than 1000. 

*2 
The example of the automatic update setting and action 
•If the automatic update is ON At Startup and the automatic update time is set to Everyday 12:00, an 
automatic update will be executed when the managed machine starts up and at 12:00 every day. 
•If the automatic update is Off At Startup and the automatic update time is set to Wednesday 12:00, 
an automatic update will be executed each week on Wednesday at 12:00. An automatic update will not 
be run on the managed machine at start up. 
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*3 

Selection and action of the Application Timing are shown in the table below. 
Selection Action 
Immediately Applies the package immediately. 

The status of the managed machine will change to Applying 
A Package(Automatic Update). 

At Next Startup Applies the package at the next start up. 
The status of the managed machine will change to Waiting 
For Restart(Automatic Update). 

Show Confirmation The following screen will be displayed on the managed 
machine. 
Click to Execute Immediately or Run at Next startup. 

 
 

 
 Automatic updates will not be executed for machines registered on  a new 

machine group. It must be added to a group to execute automatic update. 
 

 A package that has the priority Highest or High at the time of creation is sent 
with automatic update. See Section 5.5, "Package Registration/Modification" or 
Section 6.2, "Create Package" for details. 

 

3. Operations 
This chapter explains the operation of DPM in the Operations view. 
 

3.1. "Operations" View 
Functions such as information settings, information display and information management (add, edit or delete) for 
the various resources (machine, scenario, or image and so on) are provided in the Operations view. 
When you click Operations in the title bar, it will switch to the Operations view. The Summary Information 
group box appears in the main window. 
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3.2. "Resource" Icon 
You can manage resources used by the DPM with the Resource icon. 
 

 
 

Summary Information 
 Resource Type 

 Machines When you click Machines, the Group List screen 
appears. 

 Scenario Executing When you click Scenario Executing, the machines with 
normal status will be displayed on the Monitor view - 
Scenario Execution List screen. See Section 4.3, 
"Scenario Execution List" regarding the screen. 

Scenario Execution 
Error 

When you click Scenario Execution Error, the machines 
with error status will be displayed on the Monitor view - 
Scenario Execution List screen. See Section 4.3, 
"Scenario Execution List" regarding the screen. 

Scenario Execution 
Stop 

When you click Scenario Execution Stop, the machines 
with error status will be displayed on the Monitor view - 
Scenario Execution List screen. See Section 4.3, 
"Scenario Execution List" regarding the screen. 

Scenarios When you click Scenarios, the Group List group box 
appears. See Section 3.10, "Scenario Icon" regarding the 
screen. 

Images When you click Images, the Image List screen appears. 
See Section 3.16, "Images Icon" regarding the screen. 

 HW Images When you click HW Images, the HW Image list is 
displayed in the Image List group box. See Section 3.17, 
"Image Detailed Information" regarding the screen. 

OS Images When you click OS Images, the OS Image list is displayed 
in the Image List group box. See Section 3.17, "Image 
Detailed Information" regarding the screen. 

Packages When you click Packages, the Package list is displayed in 
the Image List group box. See Section 3.17.1, "Package 
Image Detailed Information" regarding the screen. 

Backup Images When you click Backup Images, the Backup Image is 
displayed in the Image List group box. See Section 
3.17.3, "Backup Image Detailed Information" regarding the 
screen. 
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3.3. "Machines" Icon 
You can manage machine groups and managed machines in the Machines icon. 
You can access the Machines icon from the Machines icon at the top of the Operations view - tree view or from 
Machines in the Summary Information group box displayed in the Operations view – the main window. 
Click the Machines icon to display the Group List group box in the main window. 
 

 
 

Group List 
 Display Count Select the number of items to be displayed in the list. 

"Action" Link When you click Delete Group, the group which is checked 
in the left checkbox will be deleted. 

(Checkbox) If you select the top checkbox, all groups in the list will be 
selected. 

Name Displays the name of the groups that are registered for 
DPM Server. When you click the name, the detailed 
information for the concerned group will be displayed. 

Subgroup Number 
(Directly/Subordinates) 

Displays the number of groups directly under/subordinate 
of the concerned group. 

Machine Number 
(Directly/Subordinates) 

Displays the number of machines (managed machines) 
directly under/subordinate of the concerned group. 

Edit You can edit the group information. Click the " " icon to 
display the Edit Group screen in the main window. See 
Section 3.5.1, "Edit Machine Group." 



 

51 

 

3.3.1. Add Machine Group 
Add a machine group. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click the Machines icon. The Summary Information group box appears in the main 

window. Click Machines. 
 
(3) The Configuration menu for the Machines icon will be displayed. Then click Add Group. 

 
(4) The Add Group screen appears in the main window. Set each item. 
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Add Group 
 Name 

(Required) Enter the group name. 64 characters or less can be 
entered. You cannot set the same name in the same layer. 
Alphanumeric characters and symbols can be entered. 
The following symbols cannot be used. 
; / 

Network Setting  Set the group network. 
This will be the default for newly added machines. 
The default will be Subnetwork is same with DPM 
Server. 

 Subnetwork is same with 
DPM Server 

Select this when the managed machines of the group are 
on the same Subnetwork as DPM Server. 

Subnetwork is not same 
with DPM Server 

Select this when the managed machines of the group are 
on a different Subnetwork than DPM Server. 
Select this when the group goes through a router and 
belongs to a different network than the Management 
Server. 
The following items will be enabled if Subnetwork is not 
same with DPM Server is selected. 
・ Default Gateway 
・ Subnet Mask 
You must set these items if you select this. 

 
 

Default Gateway 
(Required) 

Set the default gateway when the managed machines of 
the group are on a different Subnetwork from DPM Server. 
The top order of the IP address (first octet) is set in the 
range of "1-223". 

Subnet Mask 
(Required) 

Set the subnet mask when the managed machines of the 
group are on a different Subnetwork than DPM Server. 

Automatic Update Setting This setting will be default values for newly added 
machines. 
The values set on the Management view -> Automatic 
Update Setting screen are displayed as default. 
See Section 2.7.4, "Automatic Update Setting" regarding 
the Automatic Update Setting screen. 

  Automatic Update Set the automatic update function. You can select the 
following operations. 
・ Constantly OFF 
・ ON At Startup 
・ OFF At Startup 
The default is OFF At Startup. 
The following setting values will be disabled if the setting is 
Constantly OFF. 
・ Automatic Update Time 
・ Application Timing 
・ Retry Count 
・ Retry Interval(Min.) 
When you set the automatic update function to Constantly 
OFF, the managed machine will not request not applied 
packages to the Management Server. (*See Section 2.7.4, 
"Automatic Update Setting" regarding "The example of the 
automatic update setting and action.") 
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  Automatic Update Time Set the automatic update time. 

 Left List Box Select the date. You can select from the following. 
・ Everyday 
・ Sun - Sat 
The default is blank. 

Right List Box Select hourly increments from "0:00" to "23:00." If you 
select blank in the left list box, the setting time will be 
disabled. 

Application Timing Set the package application timing. You can select from 
the following. 
・ Immediately 
・ At Next Startup 
・ Show Confirmation 
The default is At Next Startup. 
If the application timing setting is Immediately or At Next 
Startup, the confirmation screen will not be displayed on 
the managed machines. (* See Section 2.7.4, "Automatic 
Update Setting" about selection and action of the 
Application Timing.) 

Retry Count If the connection to the Management Server failed, the 
connection will be re-tried the set number of times. This 
can be set in the range of "1 – 5" times. 
The default value is "1" time. 

Retry Interval(Min.) If the connection to the Management Server failed, the 
connection will be re-tried at the set time interval. This can 
be configured in five minute increments from "5" to "30" 
minutes. 
The default value is "5" minutes. 

OK The machine group is created with the setting from the 
Add Group screen and it returns to the previous window. 

Cancel Returns to the previous window without saving the setting 
from the Add Group screen. 

 
Note that the upper limit to machine groups and managed machines is as follows. 
Item Upper Limit 
Total number of machine groups(total number of machine groups including 
sub-machine groups) 1000 

Number of machine group layers 20 
Total number of managed machines(total number of managed machines 
affiliated with all machine groups, including sub-machine groups) 40000 
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3.3.2. Delete Machine Group 
Delete a machine group. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 
 
(2) In the tree view, click the Resource icon, then click the Machines icon. 
 
(3) The Group List group box appears. Then select the checkbox on the left side of Machine Group to Delete. 
 
(4) When you click the Action link for Delete Group, a confirmation dialog will be displayed. 
 
(5) Click OK and run. 
 
You can also do the following steps to delete a machine group. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click the Resource icon, then click the Machines icon -> Machine Group to Delete icon 

 
(3) The Configuration menu for the machine group icon will be displayed, and then click Delete Group. 
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(4) The confirmation dialog box appears. Click OK. 
 

  When you delete a group, the sub-groups and managed machines directly 
under the corresponding group will also be deleted. 

 If the Status column of any of the managed machines belonging to the group 
has one of the following status, the group cannot be deleted.  
・ Scenario Executing  
・ Scenario Execution Error 
・ Scenario Execution Stop 
・ Remote Power ON Error 
・ Automatic Update Progress 
・ Transferring Files (Automatic Update) 
・ Setting Automatic Update Time 
Also, if the following functions are being executed for either of managed 
machines belonging to the group, the group cannot be deleted. These 
statuses are not displayed in the Status column. 
・ File distribution 
・ File deletion 
・ Obtaining the information in File/Folder List screen 

 

3.3.3. Import Machine Data 
Execute the batch registration of the machine data. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 
 
(2) In the tree view, click the Machines icon. The Summary Information group box appears in the main 

window. Click Machines. 
 
(3) The Configuration menu for the Machines icon will be displayed. Then click Import Machine Data. 
 
(4) The Import Machine Data screen appears in the main window. Then select the CSV file from the Browse 

button in the CSV File Settings group box. 
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CSV File Setting 
 CSV File 

(Required) Displays the CSV file path. 

Browse Click Browse and select the CSV file to import the machine data. 
You cannot import the file if the CSV File Path is blank, if it is not a 
CSV format, or if the CSV file format is invalid. 
After importing the file, click Operations menu -> Refresh, and 
confirm that the file is imported correctly.(*1) 

Encoding 
 UTF-8 Select this if the encoding is UTF-8. 

Shift-JIS Select this if the encoding is Shift-JIS. 
ISO-8859-1 Select this if the encoding is ISO-8859-1. 

*1 
 When importing the CSV file which was exported on the Web Console of DPM Ver6.0 or later, select 

UTF-8 in Encoding. When you created the CSV file manually, select the same encoding with the file. 
 Note the following when importing the machine data (CSV file) created in earlier DPM version. 

1) When using the machine data (CSV file) created in the version earlier than DPM Ver5.0 
The CSV file can be imported without editing it. 
However, Identification Name, IP Address, Kernel ID, Kernel Display Name, and UUID, which 
were added in the version later than DPM Ver5.0, are set as blank (Not specified) when importing it. 
 

2) When using the machine data (CSV file) created in the version earlier than DPM Ver6.0. 
・ Select "ISO-8859-1" in Encoding. 
・ There were group types (General Computer/BladeServer) in the version earlier than DPM Ver6.0, 

but the group type was abolished from DPM Ver6.0 and they were unified to a General 
Computer group (It is called Group from DPM Ver6.0). 
The Unit ID/Slot ID/Scenario assignment permission and Slot width created by the BladeServer 
group are disregarded. The scenario assignment is always permitted from DPM Ver6.0. 

3) When using the machine data (CSV file) created in the version earlier than DPM Ver6.02. 
In DPM Ver6.02 or later, the way to specify a group was changed from the machine group name, to 
which the machine belongs directly, to the path name of the group, to which the machine is 
registered. Therefore, when using the machine data (CSV file) created in the version earlier than 
DPM Ver6.02, modify the file as to describe the path name of the group. 
(When using the file created in the version earlier than DPM Ver6.02 without editing it, a machine 
group is created directly under Machines icon.) 
Also, the Identification Name added by the functional enhancement is set as blank (Not specified) 
when importing it. 
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 The format and the description rule of the machine data file (CSV file). 

The first and second lines are fixed (the strings described as follows). Describe the information of the 
managed machine since third line. 

 
CSV File Format 
Version1.0 
Machine Name,Identification Name,Group Path,MAC Address,IP Address,Kernel ID,Kernel 
Display Name,UUID 
"Machine Name(the first machine)","Identification Name(the first machine)","Group Path","MAC 
Address","IP Address","Kernel ID","Kernel Display Name","UUID" 
"Machine Name(the second machine)","Identification Name(the second machine)","Group 
Path","MAC Address","IP Address","Kernel ID","Kernel Display Name","UUID" 

 
・ How to describe each item since the third line 
Item Specifying is 

Required/ 
Optional 

Description 

Machine Name Required Enter the name of the managed machine. 63 characters or less 
can be entered. Alphanumeric characters and symbols can be 
entered. 
The following symbols and space cannot be used. 
. , ; ` ~ ! @ # $ ^ & * = + { } % \ | : ' " < > / ? [ ] 
Also, you cannot register a machine name with only numbers. 

Identification 
Name 

Optional Enter the identification name of the managed machine. 
63 characters or less can be entered. Alphanumeric characters 
and symbols can be entered. 
The following symbols and space cannot be used. Also, you 
cannot enter the Identification Name containing only numerals. 
. , ; ` ~ ! @ # $ ^ & * = + { } % \ | : ' " < > / ? [ ] 

Group Path Required Enter the full path of the machine group to which the machine is 
registered. 
The number of the layer of the group path is 20 or less. 
Enter "/"(slash) to separate the layer of the machine group. 
64 characters or less can be entered as a group name for each 
layer. 
Alphanumeric characters and symbols can be entered. 
The following symbols cannot be used. 
; 
When there is not a group corresponding to the specified path, a 
machine group is automatically created. 

MAC Address Optional Enter the MAC address. 
A hexadecimal number can be entered (0 - 9/a - f/A - F). 
Enter it in the form "xx-xx-xx-xx-xx-xx". 
If there are two or more MAC addresses, describe the MAC 
addresses separating by "|". 
Example) "00-15-87-1e-c2-11|00-12-75-1e-d2-32" 
Enter "--" (two hyphens) when omitting the MAC address. 
Furthermore, when importing the machine data, all of the MAC 
addresses described in the CSV are imported. 
Enter either or both of the MAC address/UUID. 
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IP Address Optional Enter the IP address. 

The type of characters that can be used are "0 - 9." Enter them in the 
form "xxx.xxx.xxx.xxx". 
If there are two or moremultiple IP addresses, describe the IP 
addresses separating by ",". However, only first IP address is 
imported. 
Enter "-- (two hyphens) when omitting the IP address. 

Kernel ID Optional Enter the kernel ID. 
Enter "--" (two hyphens) when omitting the kernel ID. 

Kernel Display 
Name 

Optional Enter the kernel display name. 
Enter "--" (two hyphens) when omitting the kernel display name. 

UUID Optional Enter the UUID. 
A hexadecimal number can be entered. (0 - 9/a - f/A - F). 
Enter them in the form 
"xxxxxxxx-xxxx-xxxx-xxxx-xxxxxxxxxxxx". 
Enter "--" (two hyphens) when omitting the UUID. 
Enter either or both of the MAC address/UUID. 

 
  When specifying character strings including ", describe "" and enclose the item with ". 

Example) 
When the group name is /grou"p/, describe as "/grou""p/". 

 You can also register by the CSV file, which is output using Export Machine Data.See 
Section 3.3.4, "Export Machine Data" about exported CSV files. 

 
Example) When creating a CSV file to register the machine data by the contents of the following table, describe 

the file as sample01.csv. 
Machine 
Name 

Identifi
cation 
Name 

Group 
Path 

MAC Address IP Address Kernel 
ID 

Kernel 
Display 
Name 

UUID 

COMP1 IDEN1 /GROUP1/
GROUP2/
GROUP3 

00-11-22-33-44-55 None None None None 

COMP2 IDEN2 00-11-22-33-44-66 192.168.0.1 None None b4e8f2e4-a2ff-
4464-a97c-7e
93fef0542a 

COMP3 None 00-11-22-33-44-77 192.168.0.2 kernel1 NEC 
Express58
00 001 

None 

COMP4 IDEN4 /GROUP4 00-11-22-33-44-88 
00-11-22-33-44-99 

192.168.0.3 
192.168.0.4 

kernel2 NEC 
Express58
00 002 

8dda9b94-691
8-42ed-bd4c-1
aa3cfec750c 

 
sample01.csv 
Version1.0 
Machine Name,Identification Name,Group Path,MAC Address,IP Address,Kernel ID,Kernel Display 
Name,UUID 
"COMP1","IDEN1","/GROUP1/GROUP2/GROUP3","00-11-22-33-44-55","--","--","--","--" 
"COMP2","IDEN2","/GROUP1/GROUP2/GROUP3","00-11-22-33-44-66","192.168.0.1","--","--","b4e8f2e4
-a2ff-4464-a97c-7e93fef0542a" 
"COMP3","","/GROUP1/GROUP2/GROUP3","00-11-22-33-44-77","192.168.0.2","kernel1","NEC 
Express5800 001","--" 
"COMP4","IDEN4","/GROUP4","00-11-22-33-44-88|00-11-22-33-44-99","192.168.0.3,192.168.0.4","kern
el2","NEC Express5800 002","8dda9b94-6918-42ed-bd4c-1aa3cfec750c" 
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3.3.4. Export Machine Data 
The machine data is exported as a CSV format file. Once the machine data export is performed, you can simply 
make a format. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 
 
(2) In the tree view, click the Machines icon. Or in the Summary Information group box in the main window, 

click Machines. 
 
(3) The Configuration menu for the Machines icon will be displayed. Then click Export Machine Data. 
 
(4) The File Download dialog box appears and then click Save. 
 

  All of the machines included under the sub-group are exported. 
 When exported, the data is encoded to UTF-8. 
 Only the group on which the machine is registered is exported. 
 It will not export the Network Setting and Automatic Update Time Setting 

information. The default when importing will be the same settings as the 
registered group. 

 If the managed machine has two or more MAC addresses, all MAC addresses 
will be exported. 

 

3.4. "Group" Icon 
The machines are classified by group and managed in the Group icon. 
You can access the Group icon from the Machines icon -> Group icon at the top of the Operations view -> tree 
view or from Machines -> Group icon in the Summary Information group box displayed in the Operations view 
-> main window. 
Click the Group icon to display the Group Detail, the Machine List, and the Subgroup List group box in the 
main window. 
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3.5. Machine Group Details 
Displays the group detailed information. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 
 
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group to Display Group Detail icon. 
 
(3) Displays the Group Detail, Machine List and Subgroup List group box in the main window. 
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Group Detail Displays the group detail. 

This group box is not displayed by default. 
Expand it by clicking on the arrow ( ) in the right. 

 Parent Group Name The parent group name is displayed only when it is a 
submachine group (The group level is the second level or 
is lower than the second level). The parent group name will 
not be displayed for groups directly under the Machines 
(first level groups). 

Name Displays the group name. 
Network Setting Displays the group network setting. 
 Network Displays whether the managed machines of the group are 

on the same Subnetwork as DPM Server. 
Default Gateway Displays the default gateway when the managed machines 

of the group are on a different Subnetwork than DPM 
Server. 

Subnet Mask Displays the subnet mask when the managed machines of 
the group are on a different Subnetwork than DPM Server. 
This cannot be edited. 

Automatic Update Setting Displays the automatic update setting for the group. 
 Automatic Update Displays the automatic update function. 

Automatic Update Time Displays the automatic update time. 
Application Timing Displays the operation for the automatic update application 

timing. 
Retry Count Displays the number of retries. 
Retry Interval(Min.) Displays the retry interval. 

Machine List 
 Display Count Select the number of items to be displayed in the list. 

"Action" Link ・ When you click Move Machine, the managed 
machine, which is selected in the left checkbox, is 
moved between groups. You can move two or more 
managed machines between groups collectively by 
selecting two or more checkboxes. 

・ When you click Delete Machine, the managed 
machine, which is selected in the left checkbox, is 
deleted. You can delete two or more managed 
machines collectively by selecting two or more 
checkboxes.  

(Checkbox) You can select all of the managed machines in the list if 
you select the top checkbox. 

"Action" Menu Performs the operation on the selected managed machine. 
You can select the following from the action menu. 
・ Power ON 
・ Shutdown 
・ Set Power Management Schedule 
・ Assign Scenario 
・ Remove Scenario Assignment 
・ Execute Scenario 
・ Scenario Execution Stop 
・ Remove Error 
・ Remove Interruption 
・ File/Folder List 
・ File Operation 

If you select Set Power Management Schedule, the 
Power Management Schedule screen will be displayed. 
See Section 3.8.5, "Power Management Schedule" 
regarding the screen. 
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Name Displays the identification name of the managed machine 
registered to the group. (Displays the machine name when 
the identification name is not specified.) This cannot be 
edited. 

IP Address Displays the IP address of the managed machine. This 
cannot be edited. 

MAC Address Displays the MAC address of the managed machine. This 
cannot be edited. 

Status The status of the managed machine is displayed. See 
Section 3.7.1, "Machine Status" regarding status types and 
explanations. 

Power Displays the machine power status. 
Scenario Name Displays the name of the scenario assigned to the 

machine. 
Click Scenario Name to display the Scenario Detail 
screen in the main window. 
See Section 3.15, "Scenario Detail Information" regarding 
the screen. 

Edit Edit the managed machine. Click the " " icon to display 
the Edit Machine screen in the main window. See Section 
3.7.2, "Edit Managed Machine" regarding the edit screen. 

Subgroup List 
 Display Count Select the number of items to be displayed in the list. 

"Action" Link When you click Delete Group, the sub-group, which is 
selected in the left checkbox, will be deleted 
You can delete two or more sub-groups collectively by 
selecting two or more checkboxes. 

(Checkbox) You can select all of the sub-groups in the list if you select 
the top checkbox. 

Name Displays the name of the sub-group registered with the 
group. This cannot be edited. 

Subgroup Number 
(Directly/Subordinates) 

Displays the number of sub-groups directly 
under/subordinate to the concerned group. 

Machine Number 
(Directly/Subordinates) 

Displays the number of machines (managed machines) 
directly under/subordinate to the concerned group. 

Edit Edit a sub- group. Click the " " icon to display the Edit 
Group screen in the main window. See Section 3.5.1, "Edit 
Machine Group" regarding the edit screen. 
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3.5.1. Edit Machine Group 
Edit a machine group. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 
 
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group to Edit icon. 
 
(3) The Configuration menu for the Machine Group icon will be displayed, and then click Edit Group. 
 
(4) Click OK to display the Edit Group screen in the main window and edit each item. 

 



 

64 

 
Edit Group 
 Parent Group Name The parent group name is displayed only when it is a 

sub-machine group (The group level is the second level or 
is lower than the second level). 
The parent group name will not be displayed for groups 
(first level groups) directly under the Machines. 

Name 
(Required) 

Enter the group name. 64 characters or less can be 
entered. You cannot set the same name in the same 
layer. Alphanumeric characters and symbols can be 
entered. The following symbols cannot be used. 
; / 

Network Setting Edit the group network setting. 
The default is the value set on the Add Group screen. 
See Section 3.3.1, "Add Machine Group" regarding the 
Add Group screen. 
If you edit the group network setting this will become the 
default value for the newly added machine. 

 Subnetwork is same with 
DPM Server 

Select this when the managed machines of the group are 
on the same Subnetwork as DPM Server. 

Subnetwork is not same 
with DPM Server 

Select this when the managed machines of the group are 
on a different Subnetwork than DPM Server.  
Select this when the group goes through a router and 
belongs to a different network than DPM Server. 
The following items will be enabled if the setting is 
Subnetwork is not same with DPM Server. 
・ Default Gateway 
・ Sub-net Mask 
Set up is required if the items are enabled. 

 
 

Default Gateway 
(Required) 

Set the default gateway when the managed machines of 
the group on a different Subnetwork than DPM Server. 
The top order of the IP address (first octet) is set in the 
range of "1-223." 

Subnet Mask 
(Required) 

Set the subnet mask when the managed machines of the 
group on a different Subnetwork than DPM Server. 

Reflect setting to the 
machines that has been 
already registered to this 
group as well 

You can also apply the network settings to the managed 
machines belonging to this group If you select the Reflect 
setting to the machines that has been already 
registered to this group as well checkbox. By default, 
the checkbox is not selected. 

 Reflect setting to the 
direct machine 

Select this to apply the setting to the machines directly 
under the group. 
Reflect setting to the direct machine is selected by 
default. 

Reflect setting to the 
subordinate machine 
and group 

Select this to apply the setting to groups and machines 
under the group. 
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 Automatic Update Setting Edit the automatic update settings for the group. 

The default is the value set on the Add Group screen. 
See Section 3.3.1, "Add Machine Group" regarding the 
Add Group screen. 
If you edit the automatic update settings, this will become 
the default value for the newly added machine. 

 Automatic Update Set the automatic update function. You can select from 
the following. 
・ Constantly Off 
・ ON At Startup 
・ OFF At Startup 
The default is the value set on the Add Machine Group 
screen. See Section 3.3.1, "Add Machine Group" 
regarding the setting values. 
The following setting values will be disabled it the setting 
is Constantly Off. 
・ Automatic Update Time 
・ Application Timing 
・ Retry Count 
・ Retry Interval (Min.) 
When you set the automatic update function to 
Constantly OFF, the managed machine will not request 
not applied packages to the Management Server. (*See 
Section 2.7.4, "Automatic Update Setting" regarding "The 
example of the automatic update setting and action.") 

Automatic Update Time Set the automatic update time. 
 Left List Box Select the day for executing the automatic update. You 

can select from the following. 
・ Everyday 
・ Sun. – Sat. 
The default is the value set on the Add Machine Group 
screen. See Section 3.3.1, "Add Machine Group" 
regarding the setting values. 

Right List Box  You can select hourly increments from "0:00" to "23:00." If 
you select blank in the left list box, the setting time will be 
disabled. 
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  Application Timing Set the package Application Timing. You can select 

from the following. 
・ Immediately 
・ At Next Startup 
・ Show Confirmation 
The default is the value set in the Add Machine Group. 
See Section 3.3.1, "Add Machine Group" regarding the 
setting values. At Next Startup 
If the Application Timing setting is Immediately or At 
Next Startup, the user confirmation screen will not be 
displayed on the managed machines. (*See Section 2.7.4, 
"Automatic Update Setting" about selection and action of 
the Application Timing.") 

Retry Count If the connection to DPM Server failed, the connection will 
be re-tried the specified number of times for re-try. This 
can be set in the range of "1 – 5" times. 
The default is the value set in the Add Machine Group. 
See Section 3.3.1, "Add Machine Group" regarding the 
setting values. 

Retry Interval(Min.) If the connection to DPM Server failed, the connection will 
be re-tried at the set time interval. This can be configured 
in five minute increments from "5" to "30" minutes. 
The default is the value set in the Add Machine Group. 
See Section 3.3.1, "Add Machine Group" regarding the 
setting values. 

 Reflect setting to the 
machines that has been 
already registered to this 
group as well 

You can also apply the automatic update settings to the 
managed machines belonging to this group If you select 
the Reflect setting to the machines that has been 
already registered to this group as well checkbox. By 
default, the checkbox is not checked. 

 Reflect setting to the 
direct machine 

Select this to apply the setting to the machines directly 
under the group. 
Reflect setting to the direct machine is selected by 
default. 

Reflect setting to the 
subordinate machine 
and group 

Select this to apply the setting to groups and machines 
under the group. 

OK Saves the setting on the Edit Group screen and returns to 
the previous window. 

Cancel Returns to the previous window without saving the setting 
from the Edit Group screen. 

 
 If the Status column of any of the managed machines has one of the following status, 

the group cannot be deleted.  
・ Scenario Executing 
・ Scenario Execution Error 
・ Scenario Execution Stop 
・ Remote Power ON Error 
・ Automatic Update Progress 
・ Transferring Files(Automatic Update) 
・ Setting Automatic Update Time 

 

3.5.2. Delete Machine Group 
Delete a machine group. 
See Section 3.3.2, "Delete Machine Group" regarding the details. 
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3.5.3. Add Sub Group 
Add a sub-machine group. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 
 
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group to Add subgroup icon. 
 
(3) The Configuration menu for the Machine Group icon will be displayed, then click Add Subgroup. 
 
(4) The Add Group screen appears in the main window. Enter the subgroup information and set each item. 
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Add Group  
 Parent Group Name Display the parent group name. This cannot be edited. 

Name 
(Required) 

Enter the subgroup name. 64 characters or less can be 
entered. You cannot set the same name in the same layer. 
Alphanumeric characters and symbols can be entered. 
The following symbols cannot be used. 
; / 

Network Setting Edit the network settings for a subgroup. 
By default, the new group will inherit the values set in the 
parent group.  
If network settings are performed on the subgroup, these 
will become the default for machines under the 
corresponding group. 

 Subnetwork is same 
with DPM Server 

Select this when the managed machines of the group are 
on the same Subnetwork as DPM Server. 

Subnetwork is not 
same with DPM Server 

Select this when the managed machines of the group are 
on a different Subnetwork than DPM Server. 
Select this when the group goes through a router and 
belongs to a different network than DPM Server. 
The following items will be enabled if the setting is 
Subnetwork is not same with DPM Server. 
・ Default Gateway 
・ Subnet Mask 
Set up is required if the items are enabled. 

 
 

Default Gateway 
(Required) 

Set the default gateway when the managed machines of 
the group are on a different Subnetwork than DPM Server. 
The top order of the IP address (first octet) is set in the 
range of "1-223." 

Subnet Mask 
(Required) 

Set the subnet mask when the managed machines of the 
group are on a different Subnetwork than DPM Server. 

Automatic Update Setting Execute automatic updates setting for a sub group. 
By default, the new group will inherit the values set in the 
parent group.  
If automatic update setting is performed on the subgroup, 
these will become the default for machines under the 
corresponding group. 
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  Automatic Update Set the automatic update function. You can select from the 

following. 
・ Constantly OFF 
・ ON At Startup 
・ OFF At Startup 
The default is OFF At Startup. 
The following setting will be disabled it the setting is 
Constantly OFF. 
・ Automatic Update Time 
・ Application Timing 
・ Retry Count 
・ Retry Interval (Min.) 
When you set the automatic update function to 
Constantly OFF, the managed machine will not request 
not applied packages to the Management Server. (*See 
Section 2.7.4, "Automatic Update Setting" regarding "The 
example of the automatic update setting and action.") 

Automatic Update Time Set the automatic update time. 
 Left List Box Select the date. You can select from the following. 

・ Everyday 
・ Sun - Sat 
The default is blank. 

Right List Box Select hourly increments from "0:00" to "23:00". If you 
select blank in the left list box, the setting time will be 
disabled. 

Application Timing Set the package application timing. You can select from 
the following. 
・ Immediately 
・ At Next Startup 
・ Show Confirmation 
The default is At Next Startup 
If the application timing is Immediately or At Next 
Startup, the confirmation screen will not be displayed on 
the managed machines. (*See Section 2.7.4, "Automatic 
Update Setting" about selection and action of the 
Application Timing.) 

Retry Count If the connection to the Management Server failed, the 
connection will be re-tried by the set number. This can be 
set in the range of "0 – 5" times. 
The default value is "1" time. 

Retry Interval(.Min) 
 

If the connection to the Management Server failed, the 
connection will be re-tried by the set time interval. This can 
be configured in five minute increments from "5" to "30" 
minutes. 
The default value is "5" minutes. 

OK The sub-machine group is created with the setting on the 
Add Group screen and it returns to the previous window. 

Cancel Returns to the previous window without saving the setting 
from the Add Group screen. 

 
Note that the upper limit to machine groups and managed machines is as follows. 
Item Upper Limit 
Total number of machine groups (total number of machine groups including 
subgroups) 1000 

Number of machine group layers 20 
Total number of managed machines (total number of managed machines 
affiliated with all machine groups, including sub-machine groups) 40000 
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3.5.4. Delete Subgroup 
Delete a sub-machine group. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 
 
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group to Delete Sub Machine Group 

icon. 
 

(3) Subgroup List group box appears in the main window. Select the left checkbox of Machine Group to 
Delete. 

 
(4) Click Delete Group in Action link. The confirmation dialog box appears. 

 
(5) Click OK. 
 
Also, you can delete a sub-machine group in the following procedure. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 
 
(2) In the tree view, click Resource icon -> Machines icon -> Sub Machine Group to Delete icon. 
 
(3) The Configuration menu for the Sub Machine Group icon appears. Click Delete Group. 
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(4) The confirmation dialog box appears. Click OK. 
 

 If the Status column of any of the managed machines belonging to the group has one of 
the following status, the group cannot be deleted.  

・ Scenario Executing 
・ Scenario Execution Error 
・ Scenario Execution Stop 
・ Remote Power ON Error 
・ Automatic Update Progress 
・ Transferring Files(Automatic Update) 
・ Setting Automatic Update Time 

Also, if the following functions are being executed for either of managed machines 
belonging to the group, the group cannot be deleted. These statuses are not displayed in 
the Status column. 

・ File distribution 
・ File deletion 
・ Obtaining the information in File/Folder List screen 

 

3.5.5. Register Managed Machine 
Add a managed machine. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 
 
(2) In the tree view, click the Resource icon, click the Machines icon, and then click the Machine Group to 

Add Managed Machine icon. 
 
(3) The Configuration menu for the Group icon will be displayed, and then click Add Machine. 
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(4) The Add Machine screen appears in the main window. Set each item. 
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Add Machine 
 Group Name Displays the name of the group to which the managed machine will be 

added. This cannot be edited. 
Machine Name 
(Required) 

Enter the managed machine name. 
63 characters or less can be entered. 
Alphanumeric characters and symbols can be entered. 
The following symbols and space cannot be entered. Also, you cannot 
register a machine name with only numbers. 
. , ; ` ~ ! @ # $ ^ & * = + { } % \ | : ' " < > / ? [ ] 
If the OS is already installed on the machine to be added, you must 
enter the same name as the machine (OS) has. 
When DPM Client is installed, even if the machine name specified in 
this option and the actual machine name are different, the name will 
be automatically changed to the actual machine name when the 
machine is powered ON. 

Identification Name Enter the identification name of the managed machine. 
63 characters or less can be entered. Alphanumeric characters and 
symbols can be entered. 
The following symbols and space cannot be used. Also, you cannot 
use a name with only numbers. 
. , ; ` ~ ! @ # $ ^ & * = + { } % \ | : ' " < > / ? [ ] 
You cannot specify the same identification name under the same 
DPM Server. 

MAC Address 
(You must enter either or 
both of the MAC 
address/UUID) 

Enter the MAC address of the managed machine. 
A hexadecimal number can be entered.(0 - 9/a - f/A - F). 
Enter it in the form "xx-xx-xx-xx-xx-xx". 

UUID 
(You must enter either or 
both of the MAC 
address/UUID) 

Enter the UUID of the managed machine. 
A hexadecimal number can be entered.(0 - 9/a - f/A - F). Enter them in 
the form 
"xxxxxxxx-xxxx-xxxx-xxxx-xxxxxxxxxxxx". 
If you enter all "0" or all "F", the value is handled "nothing" by the 
DPM. 
If the UUID is unknown, register the machine without UUID. Please 
make the corresponding machine be booted from network, or please 
install DPM Client. The UUID will be complete through the network 
boot or DPM Client installation.(*1) 

IP Address Enter the IP address of the managed machine. 
Numeric characters can be entered. Enter them in the form 
"xxx.xxx.xxx.xxx". 
You cannot specify the same IP address under the same DPM 
Server. 
If there are two or more IP addresses on the managed machine, enter 
the IP address communicating with DPM Server. 
If you do not install DPM Client on the managed machine, enter IP 
address necessarily. 
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 Deploy-OS Select Deploy-OS to be used by the managed machine when you execute 

backup/restore/disk configuration check. 
Please contact your sales or support representative about the value, which 
is set for each machine model. 
Deploy-OS installed in DPM Server is displayed in the list box. 
If Deploy-OS for the machine model that is being used is not displayed in 
the list box, obtain the module for the machine model from your sales or 
support representative and install it on DPM Server. Deploy-OS will be 
displayed in the list box. 

Scenario Setting 
 Assign Scenario Select to assign a scenario to a managed machine. Browse in the 

Scenario Name text box is enabled. 
Scenario Name Set the scenario, which will be assigned to the managed machines. 

When you click Browse, the Select Scenario screen appears. Select the 
scenario and click OK. 

  Remove Scenario 
Assignment Select to remove the scenario assignment 

Scenario Applying 
Schedule If you select the Scenario Applying Schedule checkbox, you can set the 

scenario applying schedule. If you do not set the scenario, you cannot 
select the checkbox. 

Only 
Once 

The schedule is executed only once. 
Date 
(Required) 

Set the date. 
You can enter the date (year/month/day) or select the date from the 
displayed calendar by clicking the " " icon on the side of the textbox. 
When you enter a date, use YYYY/MM/DD format. 

Time 
(Required)  

Set the time. 
You can enter the following range in the textbox. 
・ "Hr" 0 - 23 
・ "Min" 0 - 59 
Numeric characters can be entered. 

Daily The schedule is executed on the set "Day" and "Time" from "Start Date." 
Start Date  
(Required) 

Set the start date. 
You can enter the date (year/month/day) or select the date from the 
displayed calendar by clicking the " " icon on the side of the textbox. 
When you enter a date, use YYYY/MM/DD format. 

End Date Set the end date. 
You can enter the date (year/month/day) or select the date from the 
displayed calendar by clicking the " " icon on the side of the textbox. 
When you enter a date, use YYYY/MM/DD format. 
If the end date is not set, the schedule will repeatedly run the set content. 
This is optional. 

Time 
(Required) 

Set the time. 
You can enter the following range in the textbox. 
・ "Hr" 0 - 23 
・ "Min" 0 - 59 

  Interval  
(Required) 

Edit the interval in day units. This can be set in the range of "1 - 99" 
days.The default value is "1" (once per day). 
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 Weekly The schedule is executed weekly on the set "Day of the Week" and "Time." 

Start Date  
(Required) 

Set the start date. 
You can enter the date (year/month/day) or select the date from the 
displayed calendar by clicking the " " icon on the side of the textbox. 
When you enter a date, use YYYY/MM/DD format. 

End Date Set the end date. 
You can enter the date (year/month/day) or select the date from the 
displayed calendar by clicking the " " icon on the side of the textbox. 
When you enter a date, use YYYY/MM/DD format. 
If the end date is not set, the schedule will be repeatedly run by the set 
content. This is optional. 

Time 
(Required) 

Set the time. 
You can enter the following range in the textbox. 
・ "Hr" 0 - 23 
・ "Min" 0 - 59 

Day of the 
Week Setting  
(Required) 

Set one or more of Sunday - Saturday. 

Monthly The schedule is executed monthly on the set "Date" and "Time." 
Start Month 
(Required) 

Set the start month. 
You can enter the date (year/month) or select the date from the displayed 
calendar by clicking the " " icon on the side of the textbox. 
When you enter a month, use YYYY/MM format. 

End Month Set the end month. 
You can enter the date (year/month) or select the date from the displayed 
calendar by clicking the " " icon on the side of the textbox. 
When you enter a month, use YYYY/MM format. 
If the end month is not set, the schedule will repeatedly run the set 
content. This is optional. 

Time 
(Required) 

Set the time. 
You can enter the following range in the textbox. 
・ "Hr" 0 - 23 
・ "Min" 0 - 59 

Day 
(You Must Set 
Either Day/ 
Week 

If you select Day, set the day from the list box. 
Example) "End of Month" day 

Week 
(You Must Set 
Either Day/ 
Week 

If you select Week, set the day of the week from the list box. 
Example) "1(First)" - "Monday" 
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 Power 

Management Schedule 
If you select the Power Management Schedule checkbox, you can 
manage the machine's power status. 
If a check is entered, select either or both Power ON Time /Shutdown 
Time. 

 Only 
Once 

The schedule is executed only once. 
Power ON Time 
(You must set 
either or both 
of Power ON 
Time/Shutdow
n Time.) 

If you select the Power ON Time checkbox, you can set the power ON 
time. 
You can enter the date (year/month/day) or select the date from the 
displayed calendar by clicking the " " icon on the side of the textbox. 
When you enter a date, use YYYY/MM/DD format. 
You can enter the following range in the textbox. 
・ "Hr" 0 - 23 
・ "Min" 0 - 59 
Set the time from after 5 minutes from the current time. 

Shutdown 
Time 
(You must set 
either or both 
of Power ON 
Time/Shutdow
n Time.) 

If you select the Shutdown Time checkbox, you can set the shutdown 
time. 
You can enter the date (year/month/day) or select the date from the 
displayed calendar by clicking the " " icon on the side of the textbox. 
When you enter a date, use YYYY/MM/DD format. 
You can enter the following range in the textbox. 
・ "Hr" 0 - 23 
・ "Min" 0 - 59 
Set the time from after 5 minutes from the current time. If you set this at 
the same time as the Power ON Time, set the interval more than 10 
minutes. 

Do not show 
countdown 
dialog 

If you select the Do not show countdown dialog checkbox, the 
countdown dialog is not displayed at the time of shutdown. 

Specify 
Day 

The schedule is executed on the set "Day of the Week" and "Time." 
Power On Time 
(You must set 
either or both 
of Power ON 
Time/Shutdow
n Time.) 

If you select the Power ON Time checkbox, you can set the power ON 
time. 
You can enter the following range in the textbox. 
・ "Hr" 0 - 23 
・ "Min" 0 - 59 

Shutdown 
Time 
(You must set 
either or both 
of Power ON 
Time/Shutdow
n Time.) 

If you select the Shutdown Time checkbox, you can set the shutdown 
time. 
You can enter the following range in the textbox. 
・ "Hr" 0 - 23 
・ "Min" 0 - 59 
If you set this at the same time as the Power ON Time, set the interval 
more than 10 minutes. 

Do not show 
countdown 
dialog 

If you select the Do not show countdown dialog checkbox, you cannot 
display the countdown timer dialog at the time of shutdown or not. 

Day of the 
Week Setting  
(Required) 

Set one or more of Sunday - Saturday. 
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 Network Setting 

 Subnetwork is same with 
DPM Server 

Select this when the managed machine is on the same Subnetwork as 
DPM Server. 

  Subnetwork is not same 
with DPM Server 

Select this when the managed machines is on a different Subnetwork 
than DPM Server. 
Select this when the managed machine goes through a router and 
belongs to a different network than DPM Server. 
The following items will be enabled if the setting is Subnetwork is not 
same with DPM Server. 
・ Default Gateway 
・ Subnet Mask 
Set up is required if the items are enabled. 

 

Default Gateway  
(Required) 

Set the default gateway when the managed machine is on a different 
Subnetwork than DPM Server. The top order of the IP address (first 
octet) is set in the range of "1-223." 

Subnet Mask 
(Required) 

Set the subnet mask when the managed machine is on a different 
Subnetwork than DPM Server. 

Automatic Update Setting 
 Automatic Update Set the automatic update function. You can select from the following. 

・ Constantly OFF 
・ ON At Startup 
・ OFF At Startup 
The default is OFF At Startup. 
The following setting will be disabled it the setting is Constantly OFF. 
・ Automatic Update Time 
・ Application Timing 
・ Retry Count 
・ Retry Interval (Min.) 
When you set the automatic update function to Constantly OFF, the 
managed machine will not request not applied packages to the 
Management Server. (*See Section 2.7.4, "Automatic Update Setting" 
regarding "The example of the automatic update setting and action.") 

Automatic Update Time Set the automatic update time. 
 Left List Box Select the day for executing the automatic update. You can select from 

the following. 
・ Everyday 
・ Sun - Sat 
The default is blank. 

Right List Box Select hourly increments from "0:00" to "23:00". If you select blank in the 
left list box, the setting time will be disabled. 

Application Timing Set the package application timing. You can select from the following. 
・ Immediately 
・ At Next Startup 
・ Show Confirmation 
The default is At Next Startup 
If the application timing is Immediately or At Next Startup, the 
confirmation screen will not be displayed on the managed machines. 
(*See Section 2.7.4, "Automatic Update Setting" about selection and 
action of the Application Timing.) 
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  Retry Count If the connection to the Management Server failed, the connection will be 

re-tried the set number of re-try times. This can be set in the range of "1 – 
5" times. 
The default value is "1" time. 

Retry Interval (Min.) If the connection to the Management Server failed, the connection will be 
re-tried at the set time interval. This can be configured in five minute 
increments from "5" to "30" minutes. 
The default value is "5" minutes. 

OK The machine is added with the setting on the Add Machine screen and it 
returns to the previous window. 

Cancel Returns to the previous window without adding the machine with the 
setting from the Add Machine screen. 

*1 
The DPM will distinguish the registered machine by UUID, so SSC coordination may not be performed 
properly if the UUID is not registered. In that case, register the UUID. 

 

3.5.6. Move Machine 
Move a managed machine between groups. You can move the managed machine regardless of its status 
(automatic update status/scenario status/power status). 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 
 
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group icon. 
 
(3) Select the checkbox in the left column of the Machine to Move on the Machine List group box in the main 

window. 
 
(4) Click Move Machine of Action link. 
 
(5) The Move Machine dialog box appears and then set Move Target Group. 
 

 
 
(6) Click OK. 
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You can also display the Move Machine screen by the following steps. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click Resource icon - Machines icon - Machine Group icon. 

 
(3) The Machine List group box appears in the main window. Then click the name of the Machine to Move. 

 
(4) The Configuration menu for the machine will be displayed, and then click Move Machine. 

 
(5) The Move Machine dialog box appears and then set Move Target Group. 

 
(6) Click OK. 
 

3.5.7. Delete Machine 
Delete a managed machine. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 
 
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group icon. 
 
(3) Select the checkbox in the left column of the Machine to Delete on the Machine List group box in the main 

window. 
 
(4) When you click the Action link for Delete Machine, a confirmation dialog will be displayed. 
 
(5) Click OK. 
 
You can also execute Delete Machine by the following steps. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 
 
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group icon. 
 
(3) The Machine List group box appears in the main window. Click the name of the Machine to Delete. 
 
(4) The Configuration menu for the machine will be displayed, and then click Delete Machine. 
 
(5) Click OK. 
 

 If the Status column of the managed machine has one of the following status, the 
machine cannot be deleted.  

・ Scenario Executing 
・ Scenario Execution Stop 
・ Scenario Execution Error 
・ Remote Power ON Error 
・ Automatic Update Progress 
・ Transferring Files(Automatic Update) 
・ Setting Automatic Update Time 

Also, if the following functions are being executed for the managed machine, the machine 
cannot be deleted. These statuses are not displayed in the Status column. 

・ File distribution 
・ File deletion 
・ Obtaining the information in File/Folder List screen 
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3.5.8. Batch Network Setting 
Set the network settings as a batch. Batch Network Setting can be applied to the machines directly under the 
group or the groups and machines under the group that is the target for the application. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group for Batch Network Setting 

icon. 
 

(3) The Configuration menu for the Machine Group icon will be displayed, and then click Network Setting 
from Batch Setting. 
 

(4) The Batch Network Setting screen appears in the main window. Set each item. 
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Batch Network Setting 

 Group Name Displays the group name. This cannot be edited. 

Network Setting Configure the network settings. 
The default is Subnetwork is same with DPM Server. 

 Subnetwork is same 
with DPM Server 

Select this when the managed machines of the group are on the 
same Subnetwork as DPM Server. 

Subnetwork is not 
same with DPM Server 

Select this when the managed machines of the group are on a 
different Subnetwork than DPM Server. 
Select this when the group or the managed machines which are 
specified by Scope To Apply goes through a router and belongs to a 
different network than DPM Server. 
The following items will be enabled if the setting is Subnetwork is 
not same with DPM Server. 
•Default Gateway  
•Subnet Mask  

Set up is required if the items are enabled. 

 
 

Default Gateway  
(Required)  

Set the default gateway when Subnetwork is not same with DPM 
Server is selected. The top order of the IP address (first octet) is set 
in the range of "1-223." 

Subnet Mask 
(Required)  

Set the subnet mask when Subnetwork is not same with DPM 
Server is selected. 

Scope To Apply Set the target for the network batch. 
  Reflect setting to the 

direct machine 
Select this to apply the setting to the machines directly under the 
group. 

Reflect setting to the 
subordinate machine 
and group 

Select this to apply the setting to all groups and machines under the 
group. 

OK Saves the batch settings details of the Batch Network Setting 
screen and returns to the previous window. 

Cancel Returns to the previous window without saving the setting from the 
Batch Network Setting screen. 
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3.5.9. Batch Set Automatic Update Time 
The automatic update time for the managed machine registered with the group is set by batch. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group for Set Automatic Update 

Time icon. 
 

(3) The Configuration menu for the Machine group icon will be displayed, and then click Set Automatic 
Update Time from Batch Setting. 
 

(4) The Batch Set Automatic Update Time screen appears in the main window. Set each item. 
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 Batch Set Automatic Update Time 

 Group Name Displays the group name. This cannot be edited. 

Automatic Update Time Setting 

 Automatic Update Set the automatic update function for the group. You can select 
from the following. 
・ Constantly Off  
・ ON At Startup 
・ OFF At Startup 
The default is OFF At Startup. 

The following setting values will be disabled it the setting is 
Constantly Off. 
・ Automatic Update Time 
・ Application Timing  
・ Retry Count 
・ Retry Interval (Min.) 
When you set the automatic update function to Constantly Off, the 
managed machine will not request not applied packages to the 
Management Server. (*See Section 2.7.4, "Automatic Update Setting" 
regarding "The example of the automatic update setting and action.") 

 Automatic Update Time Set the automatic update time for the group. 

 Left List Box  Select the day for executing the automatic update. You can select 
from the following. 
・ Everyday 
・ Sunday - Saturday(Sun. – Sat) 
The default is blank. 

Right List Box  Select hourly increments from "0:00" to "23:00". If you select blank 
in the left list box, the setting time will be disabled. 

Application Timing Set the action of application timing of the package. You can 
select from the following. 
・ Immediately 
・ At Next Startup 
・ Show Confirmation 

The default is At Next Startup. 
If the application timing is Immediately or At Next Startup, the 
screen will not be displayed on the managed machines. (*See 
Section 2.7.4, "Automatic Update Setting" about selection and 
action of the Application Timing.)  

Retry Count  If the connection to the Management Server failed, the connection 
will be re-tried by the set number. This can be set in the range of  
"0 - 5" times. 
The default value is "1" time. 

Retry Interval(Min.) If the connection to the Management Server failed, the connection 
will be re-tried at the set time interval. This can be configured in 
five minute increments from "5" to "30" minutes. 
The default value is "5" minutes. 
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3.6. Menu Operations for a Group 
Explains the menus related to the operations used by the group. 
 

3.6.1. Batch Execution 
These are batch operations such as Assign Scenario, Remove Scenario Assignment, Power ON, Shutdown, 
Execute Scenario, and Scenario Execution Stop for all of the managed machines in the corresponding group. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group for Batch Execution icon. 

 
(3) The Machine List group box appears. Then perform the various operations from Batch Execution on the 

Operation menu. The configuration and the notes about the Operation menu is the same with that about 
the Operation menu for the managed machine. See Section 3.8, "Menu Operations to a Machine." 
 

 

 Scope To Apply Set the target for Batch Set Automatic Update Time. 

 Reflect setting to the 
direct machine 

Select this to apply the setting to the machines directly under the 
group. 

Reflect setting to the 
subordinate machine 
and group 

Select this to apply the setting to all groups and machines under 
the group. 

OK Saves the batch settings details of the Batch Set Automatic 
Update Time screen and returns to the previous window. 

Cancel Returns to the previous window without saving the batch settings 
details from the Batch Set Automatic Update Time screen. 
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Batch Execution  

 Assign Scenario  Assigns the scenario to all managed machines in the corresponding 
group. 
Select the target from the Scope To Apply group box using the option 
button for the target machines as shown in the following example. 

Remove Scenario 
Assignment  

Deletes the scenario assignment for all managed machines in the 
corresponding group. 
Select the target from the Scope To Apply group box using the option 
button for the target machines as shown in the following example. 

Power ON  Executes the Power ON for all managed machines in the 
corresponding group. 
Select the target from the Scope To Apply group box using the option 
button for the target machines as shown in the following example. 

Shutdown  Executes the shutdown for all managed machines in the 
corresponding group. 
Select the target from the Scope To Apply group box using the option 
button for the target machines as shown in the following example. 

Execute Scenario  Executes the scenario for all managed machines in the corresponding 
group. 
Select the target from the Scope To Apply group box using the option 
button for the target machines as shown in the following example. 

Scenario Execution Stop 
 

Stops the scenario execution for all managed machines in the 
corresponding group. 
Select the target from the Scope To Apply group box using the option 
button for the target machines as shown in the following example. 

 
  The managed machine, for which you stopped the scenario execution, is powered off 

at the timing of PXE boot after running scenario is stopped. 
 When a scenario is executed on the managed machine over Machines For 

Simultaneous Execution, the processing of the scenario execution stop may be 
executed after the processing of the execution is started on the machine, depending 
on the timing. 
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Example) 

If you click Assign Scenario from Batch Execution on the Operation menu, the Batch Assign 
Scenario screen will be displayed. 

 

 
 

Application Target  

 Group Name Displays the group name. This cannot be edited. 

Scope To Apply  Set the target of the batch operation. 

 Reflect setting to the 
direct machine  

Select this to assign the scenario to the machines directly under 
the group. 

Reflect setting to the 
subordinate machine  

Select this to assign the scenario to all groups and machines under 
the group. 

Run Now  
(only for Assign Scenario) 

The scenario will run immediately on the target machine. An error 
message will be displayed if there is no scenario assigned to the 
target machine. 

OK Batch execution will be done by the configuration on the screen 
and returns to the previous window. 

Cancel Returns to the previous window without doing batch execution by 
the configuration on the screen. 
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3.7. Managed Machine Details 
Displays the machine detailed information. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group icon. 

 
(3) The Machine List group box appears. Click the name of the Machine to Display Information. 

 
(4) The Machine Detail group box appears in the main window. 
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Machine Detail 

 

Machine Name Displays the name of the managed machine. This cannot be edited. 

Identification Name Displays the identification name of the managed machine. This 
cannot be edited. 

Group  Displays the corresponding group to which the managed machine 
belongs. This cannot be edited. 

UUID Displays the UUID of the managed machine. 

IP Address  Displays the IP address of the managed machine. 
If there are two or more IP addresses for the managed machine, all IP 
addresses will be displayed. This will be displayed as blank if there is 
no IP address information. 

IPv6 Address Displays the IPv6 address of the managed machine. 
If there are two or more IPv6 addresses for the managed machine, all 
IPv6 addresses will be displayed. This will be displayed as blank if 
there is no IPv6 address information. 

MAC Address Displays the MAC address of the managed machine. 

Deploy-OS Displays Deploy-OS to be used by the managed machine when you 
execute backup/restore/disk configuration check. 

Status Displays the status of the managed machine. See Section 3.7.1, 
"Machine Status" regarding the status. 
Click Status to display the Scenario Execution List screen in the 
main window. See Section 4.3, "Scenario Execution List" regarding 
the screen. 

Power  Displays the power status of the managed machine. See Section 
3.8.1, "Power On" to Section 3.8.2, "Shutdown" regarding the power 
status. 

Operating System  Displays the name of the OS on the managed machine.(*1) 

Service Pack  Displays the service pack information for the managed machine. 

OS Language Displays the OS language of the managed machine. 

HotFix/Application  Displays the Detail if there is a hotfix or an application. 
Click Detail to display the HotFix/Application List screen in the 
main window. 
See Section 3.7.1.1, "HotFix/Application List" for details. 

Package Applying Status  Displays the Detail link. 
Click Detail to display the Package Applying Status (Package List) 
screen in the main window. 
See Section 3.7.1.2, "Package Applying Status (Package List)" 
regarding the screen. 

Disk Information Displays the Detail link. 
Click Detail to display the Disk Information(Disk Viewer) screen in 
the main window. 
See Section 3.7.1.3, "Disk Information" regarding the screen. 
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 Scenario Assignment 

 Scenario Name  Displays the name of the scenario assigned to the managed machine. 
Click the Scenario Name to display the Scenario Detail screen in 
the main window. 
See Section 3.15, "Scenario Detail Information" regarding the screen. 

Scenario Applying 
Schedule  

Displays the scenario applying schedule. 

Schedule  Displays the scenario applying schedule time. 

Power Management Schedule Information 

 Schedule  Displays the power management schedule. 

Power ON Time Displays the power ON time. 

Shutdown Time  Displays the shutdown time. 

Do not show countdown 
dialog  

Displays whether or not the countdown dialog will be displayed at 
shutdown. 

Network Settings 

 Network  Displays whether the managed machine is on the same Subnetwork 
as DPM Server. 

Default Gateway  Displays the default gateway when the managed machine is not on 
the same Subnetwork as DPM Server. 

Subnet Mask Displays the subnet mask when the managed machine is on a 
different Subnetwork than DPM Server. 

Automatic Update Settings  

 

Automatic Update  Displays the automatic update function. 

Automatic Update Time Displays the automatic update time. 

Application Timing  Displays the application timing. 

Retry Count  Displays the number of retry count. 

Retry Interval(Min.)  Displays the retry interval. 
*1  

Also, when you perform Server Core installation or the setting is Minimal Server Interface in Windows Server 
2012 or Windows Server 2012 R2, only OS name and edition name are displayed. 

 
 The following value will be displayed if the machine's OS is Windows Server 2003 R2. 

・ Operating System: Microsoft Windows Server 2003 Standard Edition,  
or Microsoft Windows Server 2003 Enterprise Edition  

・ Service Pack    : Service Pack 1 
 

 The machine name displayed on the Web Console will be only the host name in the 
FQDN. The domain suffix will not be shown. 
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3.7.1. Machine Status 
The DPM displays status information of the machine. 
The status information displayed in Status and Power on the Machine Detail screen shows the scenario 
execution status, the automatic update status and the power status. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group icon. 

 
(3) The Machine List group box appears in the main window. Click the name of the Machine to Confirm 

Status. 
 

(4) The Machine Detail group box appears. Confirm the Status column and the Power column. 
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 Status 

Displays the scenario execution status and the automatic update status for the machine. 

Status Description 

(Blank)  The status will be blank if it is not in the middle of running a scenario or 
automatic update. 

Scenario Executing  Displays when running a scenario. 

Scenario Execution Stop  Displays if scenario execution for a machine is interrupted. 
If you click Scenario Execution Stop displayed in the Status column, a 
scenario execution list will be displayed. See Section 4.3, "Scenario 
Execution List" regarding the scenario execution list. 

Scenario Execution Error  Displays when there is a scenario execution error. 
If you click Scenario Execution Error displayed in the Status column, a 
scenario execution list will be displayed. See Section 4.3, "Scenario 
Execution List" regarding the scenario execution list. 
Furthermore, if the status of the managed machine is both a scenario 
execution error and an automatic update execution error, Scenario 
Execution Error is displayed. 
See Section 4.7, "Automatic Update Result List Details" regarding the 
error status. 

Remote Power ON Error Displays when there is a Power On error. 
If you click Remote Power ON Error displayed in the Status column, a 
scenario execution list will be displayed. See Section 4.3, "Scenario 
Execution List" regarding the scenario execution list. 

Applying A 
Package(Automatic 
Update) 

Displays when applying an automatic update package. 

Transferring 
Files(Automatic Update) 

Displays when transferring an automatic update file to a managed 
machine. 

Confirming With 
User(Automatic Update) 

Displays when confirming the user of executing an automatic update. 

Waiting For 
Restart(Automatic 
Update) 

Displays when waiting for a machine restart. 

Automatic Update In 
Progress 

Displays when confirming the package after the automatic update starts. 

Automatic Update 
Execution Error 

Displays when there is an error with the automatic update. 

Setting Automatic Update 
Time 

Displays when setting the automatic update time for the managed 
machine. 

Automatic Update Setting 
Error  

Displays when there is an error when setting automatic update. 
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 The method is different for handling errors related to scenarios and errors related to automatic 

update. 
・ Errors related to scenarios  

Remove the error. See Section 3.8.8, "Error Cancellation" about the removing the error.  
Furthermore, a scenario execution error will occur when the scenario does not complete until 
the timeout expires, which was set in Section 2.7.1.2, "Scenario Tab." 

・ Errors related to automatic update 
Handle this by execute it again or restarting DPM Client. 

 
 Power 

Displays the power status of the machine. 

Power status Description 

On The power status of the machine is "On". 

Off The power status of the machine is "Off". 

Unknown The power status of the machine is "Unknown". 
This is displayed when the IP address is not set on the managed machine. 
You cannot use some functions as the shutdown. 

 

3.7.1.1. HotFix/Application List 
The list of hotfix/applications applied to the machine is displayed. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group icon. 

 
(3) The Machine List group box appears in the main window. Click the name of the Machine with the 

Applied HotFix/Application. 
 

(4) Click HotFix/Application -> Detail in the Machine Detail group box. 
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(5) The Applied HotFix and Installed Application group box appears in the main window. 

 

 
 

Applied HotFix 

 HotFix Name Displays the applied hotfix list. 

Installed Applications 

 Application Name Displays the installed applications list. 
 

3.7.1.2. Package Applying Status (Package List) 
The package applying status of the managed machine (package list) is displayed. 
The package application status is only displayed for Windows OS packages. Linux OS packages will not be 
displayed. 

 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group icon. 

 
(3) The Machine List group box appears in the main window, so click the name of the Machine to Which the 

Package Was Applied. 
 

(4) Click Package Applying Status -> Detail. 
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(5) The Package Applying Status (Package List) group box appears in the main window. Confirm the 

Applied Status column corresponding to the package ID. 
 

 
 

Package Applying Status (Package List) 

 Display Count Select the number of items to be displayed in the list. 

Package ID  Displays the package ID. 

Summary Displays the package summary. 

Applied Date  Displays the package applied date. 

Applied Status  Displays the package applied status. (*1) 
 

 Packages that cannot be applied to the managed machine will not be displayed in the 
list. 

 
*1 

Explains the display of the package applying status. 
The display of the 
package applied 
status 

Description 

Applied This is the status when the package has been applied to the managed 
machine. 
This is displayed if the prerequisites (conditions specified in the Dependency 
Information tab at the time of package creation) for applying the package 
have been met and the package application completion conditions (MS 
number, ID Information and conditions specified for application information) 
have been met. 
The absorbing service pack will determine to meet the package application 
complete conditions if the version of the service pack on the managed 
machine is the same as the Absorbing Service Pack or if it is newer in 
automatic update process. 

Not Applied The package is unapplied. 
This will be displayed if the conditions specified in the Dependency 
Information tab are met and if the MS Number, ID Information and 
conditions specified for application information are not met. 

Unnecessary Application of the package is unnecessary. 
This is displayed if the conditions specified in the Dependency Information 
are not met. 

Unrecognized The application status cannot be identified. 
This is displayed when nothing is specified in the MS number and ID 
Information tabs. 

 
A package will not be displayed on the list in the following case because it is not a package application 
target. 
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If the OS, language and service pack of the managed machine does not meet the OS, Lang, Base 
Service Pack or Absorbing Service Pack specified in Applicable OS/Language at the time of 
package creation by Image Builder or PackageDescriber, it is not a package application target and the 
package will not be displayed on the list. 
See Section 5, "Image Builder" or Section 6, "PackageDescriber" regarding the details of the methods for 
setting these. 

 
The conditions for the display of the package application status are below. 

 
OS/Language/Service Pack/Group Information 
Conditions met Conditions 

not met 
Managed Machine Information Inquiry (Not 

displayed 
on the list) 

Inquiry completed Inquiry not 
completed 

MS Number/Dependent Information/Service Pack Not Applied 
(*2) Conditions 

met 
Conditions not met There is no MS 

number and 
Dependency 
Information for 
the package 

Applied  
(*1) 

Dependency Unrecognized 
Conditions met  Conditions 

not met 
Not Applied 
 

Unnecessary  

*1 
This is not displayed on the Package Applying Status (Machine List). 

*2 
"Not Applied" is displayed if the inquiry is incomplete in automatic update processing or information 
sending from a managed machine to the Management Server. 

 

3.7.1.3. Disk Information 
The disk information of the managed machine is displayed. 
By executing disk configuration check, this screen can be displayed. See Section 7.2, "Disk Configuration Check 
Tool" for details. 
 

(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 
 

(2) In the tree view, click Resource icon -> Machines icon -> Machine Group icon. 
 
(3) The Machine List group box appears in the main window, so click the name of the Machine whose disk 

information is displayed. 
 
(4) Click Disk Information -> Detail in the Machine Detail group box. 



 

96 

 
(5) The Disk Detail group box and the List of Disks group box appears in the main window. 

 

 
 

Machine Name Displays the name of the managed machine. 

Disk Detail  

 Display Count Select the number of items to be displayed in the list. 

Disk Displays the disk information. 

Partition Displays the partition information. 
By default, hidden partitions are not displayed. (*1) 

*1 
The partition number is assigned in the order of primary partitions and then logical drives in extended 
partitions. (There may be difference between the order which is managed by DPM and the order which is 
displayed in Disk Management of Windows OS.) 

Example) 
When the disk configuration is as the following, partition (A) is "1," logical drive (B) of the extended 
partition is "3," logical drive (C) of the extended partition is "4" and partition (D) is "2." 
 

Primary Partition 
(A) 

Extended Partition 
Logical Drive (B) Logical Drive (C) 

 

Primary Partition 
(D) 

 
  There may be difference between the disk size or the partition size which is 

displayed in this screen and the disk size or the partition size which is displayed on 
the managed machine. 

 In executing disk configuration check scenario, the hidden partition is counted even 
if the Hidden Partition Is Disregarded is selected in the Partition Setting group 
box of the Backup/Restore tab. 
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 List of Disks 

Displays the list of disks 
By default, the List of Disks group box appears in the main window. 

 
List of Disks 
 Display Count Select the number of items to be displayed in the list. 

Disk Displays the disk number. 

Type Displays the disk type. 

Capacity Displays the capacity of the disk. 
 
 List of Partitions 

Displays the list of partitions. 
By selecting Operation menu -> List of Partitions, you can switch the display from the List of Disks group 
box to the List of Partitions group box in the main window. 
 

 
 
List of Partitions 
 Display Count Select the number of items to be displayed in the list. 

Partition Displays the partition number. 
The display format is "Partition Disk number-Partition number". 
By default, hidden partitions are not displayed. 

Type Displays the partition type. 

Capacity Displays the capacity of the partition. 

Attributes Displays the attribute of the partition. 
 
 A hidden partition is regarded 

Hidden partitions are displayed. 
If you select Operation menu -> A hidden partition is regarded, hidden partitions are displayed. 
 

 A hidden partition is disregarded 
Hidden partitions are not displayed. 
If you select Operation menu -> A hidden partition is disregarded, hidden partitions are not displayed. 
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3.7.2. Edit Managed Machine 
Edit the setting information for a managed machine. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group icon. 

 
(3) The Machine List group box appears in the main window. Then click the name of the Machine to Edit. 

 
(4) The Configuration menu for the machine will be displayed, and then click Edit Machine. 

 
(5) The Edit Machine screen appears in the main window. Edit each item. 

 
You can also display the Edit Machine screen by the following steps. 

 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group icon. 

 
(3) The Machine List group box appears in the main window, click the Edit icon ( ) for the Machine to Edit. 
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(4) The Edit Machine screen appears in the main window. Edit each item. 
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Edit Machine  

 Group Name Displays the corresponding group name to which the managed machine 
belongs. This cannot be edited. 

Machine Name 
(Required) 

Edit the managed machine name. 63 characters or less can be entered. 
Alphanumeric characters and symbols can be entered. 
The following symbols and space cannot be entered. Also, you cannot 
change to a machine name with only numbers. 
. , ; ` ~ ! @ # $ ^ & * = + { } % \ | : ' " < > / ? [ ] 
If DPM Client is installed, even if the machine name registered on the 
Web Console and the actual machine are different, the name will be 
automatically changed to the actual machine name on the Web Console 
when the machine is powered ON. 

Identification Name Edit the identification name of the managed machine. 
63 characters or less can be entered. Alphanumeric characters and 
symbols can be entered. 
The following symbols and space cannot be entered. Also, you cannot 
use a name with only numbers. 
. , ; ` ~ ! @ # $ ^ & * = + { } % \ | : ' " < > / ? [ ] 
The same name cannot be set under the same DPM Server. 

MAC Address Displays the MAC address of the managed machine. This cannot be 
edited. 

UUID Displays UUID of the managed machine are displayed. This cannot be 
edited. 

IP Address Edit the IP address of the managed machine. 
Numeric characters can be entered.  
Enter them in the form "xxx.xxx.xxx.xxx". 
The same IP address cannot be set under the same DPM Server. 
If there are two or more IP addresses on the managed machine, enter the 
IP address communicating with DPM Server. 
If you do not install DPM Client on the managed machine, enter IP 
address necessarily. 

Deploy-OS Select Deploy-OS used by the managed machine when you execute 
backup/restore/disk configuration check. 
Contact your sales or support representative about the setting values for 
each machine type. 
Deploy-OS installed in DPM Server is displayed in the list box. 
If Deploy-OS for the machine that is being used is not displayed in the list 
box, obtain the module for the machine from your sales or support 
representative and install it on DPM Server. Deploy-OS will be displayed 
in the list box. 
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 Scenario Setting  

 Assign scenario  Select to assign a scenario to a managed machine. Browse in the 
Scenario Name text box is enabled. 

Scenario Name  Set the scenario which will be assigned to the managed machines. 
When you click Browse, the Select Scenario screen appears. Select the 
scenario and click OK. 

  Remove Scenario 
Assignment  

Select to remove the scenario assignment. 

Scenario Applying 
Schedule  

If you put a check in the Scenario Applying Schedule checkbox, you 
can set the scenario applying schedule. If you have not set the scenario, 
you cannot select the checkbox. 

Only 
Once 

The schedule is executed Only Once. 

Date 
(Required)  

Edit the date. 
You can enter the date (year/month/day) or select the date from the 
displayed calendar by clicking the " " icon on the side of the textbox. 
When you enter a date, use YYYY/MM/DD format. 

Time 
(Required) 

Edit the time. 
You can enter the following range in the textbox. 
・ "Hr" 0 - 23 
・ "Min" 0 - 59 

Daily The schedule is executed on the set "Day" and "Time" from "Start Date."  

Start Date  
(Required)  

Edit the start date. 
You can enter the date (year/month/day) or select the date from the 
displayed calendar by clicking the " " icon on the side of the textbox. 
When you enter a date, use YYYY/MM/DD format. 

End Date  Edit the end date. 
You can enter the date (year/month/day) or select the date from the 
displayed calendar by clicking the " " icon on the side of the textbox. 
When you enter a date, use YYYY/MM/DD format. 
If the end date is not set, the schedule will repeatedly run the set content. 
This is optional. 

Time 
(Required) 

Edit the time. 
You can enter the following range in the textbox. 
・ "Hr" 0 - 23 
・ "Min" 0 - 59 

Interval  
(Required)  

Edit the interval in day units. This can be set in the range of "1 - 99" days. 
The default value is "1" (once per day). 
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 Weekly  The schedule is executed weekly on the set "Day of the Week" and "Time."  

 Start Date  
(Required)  

Edit the start date. 
You can enter the date (year/month/day) or select the date from the 
displayed calendar by clicking the " " icon on the side of the textbox. 
When you enter a date, use YYYY/MM/DD format. 

End Date  Edit the end date. 
You can enter the date (year/month/day) or select the date from the 
displayed calendar by clicking the " " icon on the side of the textbox. 
When you enter a date, use YYYY/MM/DD format. 
If the end date is not set, the schedule will repeatedly run the set 
content. This is optional. 

  Time 
(Required)  

Edit the time. 
You can enter the following range in the textbox. 
・ "Hr" 0 - 23 
・ "Min" 0 - 59  

Day of the Week 
Setting  
(Required)  

Set one or more of Sunday - Saturday. 

Monthly The schedule is executed monthly on the set "Date" and "Time."  

Start Month 
(Required)  

Edit the start month. 
You can enter the date (year/month) or select the date from the 
displayed calendar by clicking the " " icon on the side of the textbox. 
When you enter a month, use YYYY/MM format. 

End Month  Edit the end month. 
You can enter the date (year/month) or select the date from the 
displayed calendar by clicking the " " icon on the side of the textbox. 
When you enter a month, use YYYY/MM format. 
If the end month is not set, the schedule will repeatedly run the set 
content. This is optional. 

Time 
(Required) 

Edit the time. 
You can enter the following range in the textbox. 
・ "Hr" 0 - 23 
・ "Min" 0 - 59 

Day  
(You Must Set 
Either Day/ Week 

If you select Day, set the day from the list box. 
Example) "End of Month" 

Week  
(You Must Set 
Either Day / 
Week 

If you select Week, set the day of the week from the list box. 
Example) "1" - "Mon." 
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 Power Management 

Schedule  
If you select the Power Management Schedule checkbox, you can 
manage the managed machine's power status. 
If a check is entered, select either or both Power ON Time / Shutdown 
Time. 

 Only 
Once 
 

The schedule is executed Only Once. 

Power ON Time 
(You must set 
either or both of 
Power ON 
Time/Shutdown 
Time.) 

If you select the Power ON Time checkbox, you can edit the power ON 
time. 
You can enter the date (year/month/day) or select the date from the 
displayed calendar by clicking the " " icon on the side of the textbox. 
When you enter a date, use YYYY/MM/DD format. 
You can enter the following range in the textbox. 
・ "Hr" 0 - 23 
・ "Min" 0 - 59  
Set the time from after 5 minutes from the current time. 

Shutdown Time 
(You must set 
either or both of 
Power ON 
Time/Shutdown 
Time.) 

If you select the Shutdown Time checkbox, you can edit the shutdown 
time. 
You can enter the date (year/month/day) or select the date from the 
displayed calendar by clicking the " " icon on the side of the textbox. 
When you enter a date, use YYYY/MM/DD format. 
You can enter the following range in the textbox. 
・ "Hr" 0 - 23 
・ "Min" 0 - 59  
Set the time from after 5 minutes from the current time. If you set this at 
the same time as the Power ON Time, set the interval more than 10 
minutes. 

Do not show 
countdown 
dialog 

If you select the Do not show countdown dialog checkbox, the 
countdown dialog is not displayed at the time of shutdown. 

Specify 
Day 

The schedule is executed on the set "Day of the Week" and "Time."  

Power On Time 
(You must set 
either or both of 
Power ON 
Time/Shutdown 
Time.) 

If you select the Power ON Time checkbox, you can edit the power ON 
time. 
You can enter the following range in the textbox. 
・ "Hr" 0 - 23 
・ "Min" 0 - 59  

Shutdown Time 
(You must set 
either or both of 
Power ON 
Time/Shutdown 
Time.) 

If you select the Shutdown Time checkbox, you can edit the shutdown 
time. 
You can enter the following range in the textbox. 
・ "Hr" 0 - 23 
・ "Min" 0 - 59  
If you set this at the same time as the Power ON Time, set the interval 
more than 10 minutes. 

Do not show 
countdown 
dialog  

If you select the Do not show countdown dialog checkbox, the 
countdown dialog is not displayed at the time of shutdown. 

Day of the Week 
Setting  
(Required)  

Set one or more of Sunday - Saturday. 
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 Network Setting 

 Subnetwork is same 
with DPM Server 

Select this when the managed machine is on the same Subnetwork as 
DPM Server. 

Subnetwork is not 
same with DPM Server 

Select this when the managed machine is on a different Subnetwork than 
DPM Server. 
Select this when the managed machine goes through a router and 
belongs to a different network than DPM Server. 
The following items will be enabled if the setting is Subnetwork is not 
same with DPM Server. 
・ Default Gateway  
・ Subnet Mask  
Set up is required if the items are enabled. 

 
 

Default Gateway  
(Required) 

Set the default gateway when the managed machine is on a different 
Subnetwork than DPM Server. The top order of the IP address (first 
octet) is set in the range of "1-223." 

Subnet Mask 
(Required) 

Edit the subnet mask when the managed machine is on a different 
Subnetwork than DPM Server. 

Automatic Update Setting(*1) 

 Automatic Update Set the automatic update function. You can select the following 
operations. 
・ Constantly OFF 
・ ON At Startup  
・ OFF At Startup  
The following setting will be disabled if the setting is Constantly OFF. 
・ Automatic Update Time  
・ Application Timing  
・ Retry Count 
・ Retry Interval (Min.)  
When you set the automatic update function to Constantly OFF, the 
managed machine will not request not applied packages to the 
Management Server. (*See Section 2.7.4, "Automatic Update Setting" 
regarding "The example of the automatic update setting and action".) 

Automatic Update Time Set the automatic update time. 

 Left List Box  Select the day for executing the automatic update. You can select from 
the following. 
・ Everyday  
・ Sun - Sat  

Right List Box Select hourly increments from "0:00" to "23:00". If you select blank in the 
left list box, the setting time will be disabled. 

 



 

105 

 
  Application Timing Set the package application timing. You can select from the following. 

・ Immediately  
・ At Next Startup 

・ Show Confirmation  
If the application timing is Immediately or At Next Startup, the 
confirmation screen will not be displayed on the managed machines. 
(*See Section 2.7.4, "Automatic Update Setting" about selection and 
action of the Application Timing.) 

Retry Count If the connection to the Management Server failed, the connection will be 
re-tried the set number of re-try times. This can be set in the range of  
"1 - 5" times. 

Retry Interval(Min.) If the connection to the Management Server failed, the connection will be 
re-tried at the set time interval. This can be configured in five minute 
increments from "5" to "30" minutes. 

OK Saves the settings details on the Edit Machine screen and returns to the 
previous window. 

Cancel Returns to the previous window without saving the settings details from 
the Edit Machine screen. 

*1 
When the status of the managed machine is either of the following, Automatic Update Setting is set at the 
timing that the machine is started at next time. For details about the status, see Section 3.7.1, "Machine 
Status." 
・ Status 

- Scenario Executing 
- Scenario Execution Stop 
- Applying A Package(Automatic Update) 
- Transferring Files(Automatic Update) 
- Confirming With User(Automatic Update) 
- Waiting For Restart(Automatic Update) 
- Automatic Update In Progress 

・ Power 
- Off 

Also, if the following functions are being executed for the managed machine, Automatic Update Setting is set 
at the timing that the machine is started at next time. These statuses are not displayed in the Status column. 
・ File distribution 
・ File deletion 
・ Obtaining the information in File/Folder List screen 

 
 If the Status column of the managed machine has one of the following status, the 

machine cannot be edited (except automatic update setting). 
・ Scenario Executing 
・ Scenario Execution Error 
・ Scenario Execution Stop 
・ Remote Power ON Error 
・ Automatic Update Progress 
・ Transferring Files(Automatic Update) 
・ Setting Automatic Update Time 

Also, if the following functions are being executed for the managed machine, the 
machine cannot be edited. These statuses are not displayed in the Status column. 

・ File distribution 
・ File deletion 
・ Obtaining the information in File/Folder List screen 
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3.7.3. Move Machine 
Move a machine. 
See Section 3.5.6, "Move Machine" regarding moving a machine. 
 

3.7.4. Delete Machine 
Delete a machine. 
See Section 3.5.7, "Delete Machine" regarding deleting a machine. 
 

3.8. Menu Operations to a Machine 
Explains the Action menu and Operation menu for the machine. 
 

3.8.1. Power On 
Turn ON the power of the managed machine. 
You can operate Power ON for only one managed machine or two or more selected managed machines by 
Machine Individual Operations. 
 
・ To operate for only one managed machine 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group icon. 

 
(3) The Machine List group box appears in the main window. Click the name of the Managed Machine to 

Power ON. 
 

(4) The Operation menu for the managed machine is displayed, so click the Operation -> Power ON. 
 
・ To operate selected two or more managed machines 

 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group icon. 

 
(3) Select the checkbox in the left column of the Machine to Power ON in the Machine List group box in the 

main window. 
 

(4) Click Power ON of Machine Individual Operations... from the Action menu. 
 

The Power icon will become "  (green) On" after Power ON. 
If Power ON fails, Remote Power ON Error is displayed. Also, an error message is displayed. 
 

  If the Machine List group box status still shows power OFF after execute Power 
ON, click Refresh from the Operation menu to refresh to the latest information. 

 See Section 3.6.1, "Batch Execution" regarding Batch Execution - Power ON for 
batch operations for all managed machines. 
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3.8.2. Shutdown 
Shut down a managed machine. 
You can operate Shutdown for only one managed machine or two or more selected machines by Machine 
Individual Operations. 
 
・ To operate for only one managed machine 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group icon. 
 
(3) The Machine List group box appears in the main window. Click the name of the Machine to Shut down. 
 
(4) The Operation menu for the managed machine will be displayed, and then click Shutdown. 
 
・ To operate selected two or more managed machines 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 
 
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group icon. 
 
(3) Select the checkbox in the left column of the Machine to Shut down on the Machine List group box in the 

main window. 
 
(4) Click Shutdown of Machine Individual Operations... from the Action menu. 

The Power column icon will become "  (black) Off" after Shutdown. 
If Shutdown fails, nothing will be displayed. 

 
  Install DPM Client on the machine to perform shutdown. See Section 2.2, "Installing  

DPM Client" in Installation Guide for details. 
 You cannot shut down if the Windows managed machine status is as follows. 

・ The machine is locked by a workstation lock. 
・ The machine is locked with a screen saver with a password. 
・ The machine is connected to Remote Desktop, Terminal Service or remote 

connection software. 
・ There is data that is being edited or there is an application that does not respond to 

a shutdown request. 
If password lock function is enabled by default in the OS, shut down after canceling the 
password lock. 

 
 If a Linux machine is operating on X Window system, when Console is not running, you 

cannot confirm that shutdown was executed. 
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  If the status on the Machine List group box is still power ON after executing 

Shutdown, click Refresh from the Operation menu to refresh to the latest 
information. 

 You can stop shutdown by the following operation on the managed machine. 
・ Windows OS 

A countdown dialog box appears on the managed machine. Click Cancel. 
・ Linux OS 

- In the case of earlier than Red Hat Enterprise Linux 7 or SUSE Linux Enterprise 
9/10/11 a countdown message appears on the console of the managed machine. 
Execute  /usr/local/bin/depcancel on the console. 
In the environment that X-Window is not running (Run Level 3) in SUSE Linux 
Enterprise, two line messages may appear. These messages do not affect the 
action. 

- In the case of Red Hat Enterprise Linux 7 
When the console is already started on the managed machine, a countdown 
message appears. Execute /usr/local/bin/depcancel on the console.  
When the console is not started, a countdown message does not appear. Start the 
console manually and execute /usr/local/bin/depcancel. 

 See Section 3.6.1, "Batch Execution" regarding Batch Execution - Shutdown of 
batch operations for all managed machines. 

 

3.8.3. Assign Scenario 
Assign the scenario to managed machines. 

 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group icon. 

 
(3) The Machine List group box appears in the main window. Then click the name of the Managed Machine 

to Assign Scenario. 
 

(4) The Operation menu for the managed machine will be displayed, and then click Assign Scenario. 
 

(5) The Assign Scenario screen appears. Set each item. 
 

You can also display the Assign Scenario screen by the following steps. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group icon. 

 
(3) The Machine List group box appears in the main window. Check the check box on the left of the Managed 

Machine to Assign Scenario. 
 

(4) Click Assign Scenario from Machine Individual Operations... from the Action menu. 
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(5) The Assign Scenario screen appears in the main window. Set each item. 
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Assign Scenario 

 Scenario Setting 

 Assign Scenario Select to assign a scenario. 
If this is selected, Browse in the Scenario Name text box is 
enabled. 

Scenario Name Set the scenario which will be assigned to the machines. If you click 
Browse, Select Scenario screen appears. Select a scenario and 
click OK. 

Remove Scenario 
Assignment 

You cannot select Remove Scenario Assignment in this screen. 
To Remove Scenario Assignment, operate from Machine List 
group box -> Action menu -> Remove Scenario Assignment. See 
Section 3.5, "Machine Group Details" for details. (*1) 

Scenario Applying Schedule  If you select the Scenario Applying Schedule checkbox, you can 
set the scenario applying schedule. If you do not set the scenario, 
you cannot select the checkbox. 

Only 
Once 

The schedule is executed Only Once. 

Date 
(Required)  

Set the date. 
You can enter the date (year/month/day) or select the date from the 
displayed calendar by clicking the " " icon on the side of the 
textbox. 
When you enter a date, use YYYY/MM/DD format. 

Time 
(Required)  

Set the time. 
You can enter the following range in the textbox. 
・ "Hr" 0 - 23 
・ "Min" 0 - 59  
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 Daily The schedule is executed on the set "Day" and "Time" from Start Date. 

Start Date  
(Required)  

Set the start date. 
You can enter the date (year/month/day) or select the date from the 
displayed calendar by clicking the " " icon on the side of the 
textbox. 
When you enter a date, use YYYY/MM/DD format. 

End Date  Set the end date. 
You can enter the date (year/month/day) or select the date from the 
displayed calendar by clicking the " " icon on the side of the 
textbox. 
When you enter a date, use YYYY/MM/DD format. 
If the end date is not set, the schedule will repeatedly run following 
the set content. This is optional. 

Time 
(Required)  

Set the time. 
You can enter the following range in the textbox. 
・ "Hr" 0 - 23 
・ "Min" 0 - 59  

  Interval  
(Required)  

Edit the interval in day units. This can be set in the range of "1 - 99" 
days. 
The default value is "1" (once per day). 

Weekly  The schedule is executed weekly on the set "Day of the Week" and "Time." 

Start Date  
(Required)  

Set the start date. 
You can enter the date (year/month/day) or select the date from the 
displayed calendar by clicking the " " icon on the side of the 
textbox. 
When you enter a date, use YYYY/MM/DD format. 

End Date  Set the end date. 
You can enter the date (year/month/day) or select the date from the 
displayed calendar by clicking the " " icon on the side of the 
textbox. 
When you enter a date, use YYYY/MM/DD format. 
If the End Date is not set, the schedule will repeatedly run the set 
content. This is optional. 

Time 
(Required)  

Set the time. 
You can enter the following range in the textbox. 
・ "Hr" 0 - 23 
・ "Min" 0 - 59  

Day of the Week 
Setting  
(Required)  

Set one or more of Sunday - Saturday. 
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 Monthly The schedule is executed monthly on the set "Date" and "Time." 

Start Month 
(Required)  

Set the start month. 
You can enter the date (year/month) or select the date from the 
displayed calendar by clicking the " " icon on the side of the 
textbox. 
When you enter a month, use YYYY/MM format. 

End Month  Set the end month. 
You can enter the date (year/month) or select the date from the 
displayed calendar by clicking the " " icon on the side of the 
textbox. 
When you enter a month, use YYYY/MM format. 
If the End Month is not set, the schedule will repeatedly run the set 
content. This is optional. 

Time 
(Required)  

Set the time. 
You can enter the following range in the textbox. 
・ "Hr" 0 - 23 
・ "Min" 0 - 59  

Day  
(You must set 
either 
Day/Week.) 

If you select Day, select the day from the list box. 
example) "Last of the Month" day 

  Week  
(You must set 
either 
Day/Week.) 

If you select Week, select the day of the week from the list box. 
example) "1" "Monday" 

Run Now Assigns the scenario and execute it immediately. 

OK Assigns the scenario with the setting on the Assign Scenario 
screen and returns to the previous window. 

Cancel Returns to the previous window without assigning the scenario with 
the setting from the Assign Scenario screen. 

*1 
Also, the option button of Remove Scenario Assignment cannot be selected on the Operation menu -> 
Batch Execution -> Assign Scenario. 
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  A scenario execution may not be executed properly in the following cases. 

・ After setting the scenario applying schedule, the date and the time of the 
Management Server are changed beyond the scenario schedule. (from the future to 
the past or from the past to the future) 

・ The scenario schedule and the Power ON/Shutdown schedule are set at the same 
date and time. 

 For a monthly schedule, the schedule may not be run if you select the 29th, 30th or 31st 

as there are months that do not have those days. 
Example)  

If the monthly date is set to be the 31st, the schedule will not be run in February, 
April, June, September or November. The schedule will be executed in January, 
March, May, July, August, October and December. 

 
 See Section 3.6.1, "Batch Execution" regarding Batch Execution - Assign Scenario for 

batch operations for all managed machines. 
 

3.8.4. Remove Scenario Assignment 
Remove the assignment of the scenario from the managed machine. 
You can operate Remove Scenario Assignment for only one managed machine or two or more selected 
managed machines by Machine Individual Operations. 
 
・ To operate on only one managed machine  
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group icon. 

 
(3) The Machine List group box appears in the main window. Click the name of the Managed Machine to 

Remove Scenario. 
 

(4) The Operation menu for the managed machine will be displayed, and then click Remove Scenario 
Assignment. 
 

・ To operate selected two or more managed machines  
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group icon. 

 
(3) The Machine List group box appears in the main window. Select the check box on the left of the Machine 

to Remove Scenario. 
 

(4) Click Remove Scenario Assignment of Machine Individual Operations... from the Action menu. 
 

 See Section 3.6.1, "Batch Execution" regarding Batch Execution - Remove Scenario 
Assignment for batch operations for all managed machines. 
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3.8.5. Power Management Schedule 
Set the power management schedule for the managed machine. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group icon. 

 
(3) The Machine List group box appears in the main window. Click the name of the Managed Machine to 

Schedule Power Management. 
 

(4) The Operation menu for the managed machine will be displayed, and then click Set Power Management 
Schedule -> OK. 
 

(5) Click OK to display the Power Management Schedule screen in the main window. Set each item. 
 

Also, the Power Management Schedule screen can be displayed in the following procedure. 
 

(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 
 

(2) In the tree view, click Resource icon -> Machines icon -> Machine Group icon. 
 

(3) The Machine List group box appears in the main window, then select the checkbox on the left side of 
Managed Machine to Schedule Power Management. 
 

(4) From Machine Individual Operations of Action menu, select the Set Power Management Schedule. 
The dialog box appears. 
 

(5) Click OK to display the Power Management Schedule screen in the main window and then set each item. 
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Power Management Schedule  

 Power Management 
Schedule  

If you select the Power Management Schedule checkbox, you can 
manage the machine's power status. 
If this is selected, select either or both Power ON Time / Shutdown 
Time. 

Only 
Once  

The schedule is executed Only Once. 

Power On Time 
(You must set 
either or both 
of Power ON 
Time/Shutdow
n Time.) 

If you select the Power ON Time checkbox, you can set the power ON 
time. 
You can enter the date (year/month/day) or select the date from the 
displayed calendar by clicking the " " icon on the side of the textbox. 
When you enter a date, use YYYY/MM/DD format. 
Set the time from after 5 minutes from the current time. 
You can enter the following range in the textbox. 
・ "Hr" 0 - 23 
・ "Min" 0 - 59 

 

Shutdown 
Time 
(You must set 
either or both 
of Power ON 
Time/Shutdow
n Time.) 

If you select the Shutdown Time checkbox, you can set the shutdown 
time. 
You can enter the date (year/month/day) or select the date from the 
displayed calendar by clicking the " " icon on the side of the textbox. 
When you enter a date, use YYYY/MM/DD format. 
You can enter the following range in the textbox. 
・ "Hr" 0 - 23 
・ "Min" 0 - 59  
Set the time from after 5 minutes from the current time. If you set this at 
the same time as the Power ON Time, set the interval more than 10 
minutes. 

Do not show 
countdown 
dialog 

If you select the Do not show countdown dialog checkbox, the 
countdown dialog is not displayed at the time of shutdown. 

Specify 
Day 

The schedule will be executed on the set "Day of the Week" and "Time."  

Power On Time 
(You must set 
either or both 
of Power ON 
Time/Shutdow
n Time.) 

If you select the Power ON Time checkbox, you can set the power ON 
time. 
You can enter the following range in the textbox. 
・ "Hr" 0 - 23 
・ "Min" 0 - 59  

Shutdown 
Time  
(You must set 
either or both 
of Power ON 
Time/Shutdow
n Time.) 

If you select the Shutdown Time checkbox, you can set the shutdown 
time. 
You can enter the following range in the textbox. 
・ "Hr" 0 - 23 
・ "Min" 0 - 59  
If you set this at the same time as the Power ON Time, set the interval 
more than 10 minutes. 

  Do not show 
countdown 
dialog 

If you select the Do not show countdown dialog checkbox, the 
countdown dialog is not displayed at the time of shutdown. 
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Day of the 
Week Setting  
(Required)  

Set one or more of Sunday - Saturday. 

OK Saves the settings details on the Power Management Schedule screen 
and returns to the previous window. 

Cancel Returns to the previous window without saving the settings details from 
the Power Management Schedule screen. 

 

3.8.6. Execute Scenario 
Execute the scenario assigned to the managed machines. 
You can operate Execute Scenario for only one managed machine or two or more selected managed machines 
by Machine Individual Operations. 
 
・ To operate on only one managed machine  
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group icon. 

 
(3) The Machine List group box appears in the main window, then click the name of the Managed Machine to 

Execute Scenario. 
 

(4) The Operation menu for the managed machine will be displayed, and then click Execute Scenario. 
 

・ To operate selecting two or more managed machines  
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group icon. 

 
(3) The Machine List group box appears in the main window. Select the check box on the left of the Machine 

to Execute Scenario. 
 

(4) Click Execute Scenario of Machine Individual Operations... from the Action menu. 
 

  To execute a scenario of the backup/restore/disk configuration check, you need to set up 
Deploy-OS that corresponds to the machine model of the managed machine before 
executing the scenario. For details, see Section 3.7.2, "Edit Managed Machine." 

 In the case that the scenario except the remote update scenario does not run when the 
power of the managed machine is on, perform either of the following operations: 
• On the Edit Scenario screen, select the Forced Execution Of A Reboot Is Performed 

Before Execution checkbox in the Scenario Execution Operation Setting group box 
on the Option tab. 

* If the Windows managed machine has the following status, you cannot restart, even if 
you select the Forced Execution Of A Reboot Is Performed Before Execution 
checkbox. 

- The machine is locked by a workstation lock. 
- The machine is locked with a screensaver with a password 
- The machine is connected to Remote Desktop, Terminal Service, or other remote 

connection software 
- There is data that is being edited or there is an application that does not respond 

to a shutdown request. 
• Restart the managed machine manually. 
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  DPM executes UDP communication when data is sent by multicast. 

With UDP communication, if devices of a different transmission rate are located on the 
path, a difference occurs in the volume of data transmitted between the transmission side 
and reception side and the data transmission may fail. 
If this happens, it will take a longer time to complete the scenario. 

 If you install RUR(revision up release) module for Express 5800 Series by DPM, you need 
to log on to the target machine by an arbitrary user and execute the scenario without running 
screen saver. When the machine is locked even if you logged on, or screen saver is started 
during the installing, the automatic installing cannot be continued in some cases. 

 When you execute the scenario of a service pack, which switches the firewall function from 
disabled to enabled(Windows XP SP2 and so on), most ports are blocked when applying 
the service pack and the Management Server cannot communicate with the managed 
machine. Therefore, a scenario execution error will occur. In this case, open the port that 
DPM uses by Port Opening Tool after removing the error. 
See Section 7.1, "Port Opening Tool" about Port Opening Tool. 

 
  A managed machine before rebooting can execute 100 scenarios specified under 

Execute At Next Startup under Execution Timing Setting on the Package tab of the 
scenario. If you execute 101 or more scenarios, reboot the managed machine. 
Rebooting allows you to execute another 100 scenarios. 

 If you specified an application at the same time as the service pack, hotfix, or Linux patch 
file, the service pack, hotfix, or Linux patch file will first be applied followed by application 
installation. 

 See Section 3.6.1, "Batch Execution" regarding Batch Execution - Execute Scenario 
about batch operations for all managed machines. 
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Also, if Password or Warning is set in Execute Scenario in the Management view -> DPM Server -> 
Guard Parameter Setting screen, the following Confirm Scenario Setting screen will be displayed when 
the scenario runs. 

 

 
 

Confirm Scenario Setting  

 Scenario Name  Displays the scenario name. 

Scenario Information 

 Scenario Name  Displays the scenario name. 

Scenario Group Name  Displays the scenario group name. 

Type  Displays the scenario type. 

The scenario information displayed here will differ depending on type of scenario selected in 
Scenario Name. See Section 3.15, "Scenario Detail Information" regarding the details. 

Options  

 The Scenario Execution Option Setting set in the Add Scenario screen -> Option tab will be 
displayed. See Section 3.13.5, "Option Tab" regarding the settings. 

Target Machine  

 Machine Name Displays the identification name of the managed machine on which 
the scenario will be executed. (When the identification name is not 
specified, the machine name is displayed.) 
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OK The scenario is run using the settings details on the Confirm 
Scenario Setting screen and it returns to the previous window. 

Cancel Returns to the previous without running the scenario using the 
settings details from the Confirm Scenario Setting screen. 

 

3.8.7. Interrupt Scenario Execution 
Stop the execution of the scenario assigned to the managed machines. 
You can operate Scenario Execution Stop for only one managed machine or two or more selected managed 
machines by Machine Individual Operations. 
 
・ To operate on only one managed machine  
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group icon. 

 
(3) The Machine List group box appears in the main window, then click the name of the Managed Machine to 

Stop Scenario Execute. 
 

(4) The Operation menu for the managed machine will be displayed, and then click Scenario Execution 
Stop. 

 
・ To operate selecting two or more managed machines 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group icon. 

 
(3) The Machine List group box appears in the main window. Select the check box on the left of the Machine 

to Stop Scenario Execute. 
 

(4) Click Scenario Execution Stop of Machine Individual Operations... from the Action menu. 
 

In the case of Scenario Execution Stop, the machine icon becomes " " and Scenario Execution Stop is 
displayed. An error message will be displayed if Scenario Execution Stop fails. 
 

  You cannot restart a scenario when the scenario was stopped. In order to re-run the 
scenario, execute the scenario again after the scenario interrupt process has completed. 

 The managed machine, for which you stopped the scenario execution, is powered off at 
the timing of PXE boot after running scenario is stopped. 

 When a scenario is executed on the managed machine over Machines For 
Simultaneous Execution, the processing of the scenario execution stop may be 
executed after the processing of the execution is started on the machine, depending on 
the timing. 

 
 The Scenario Execution Stop status will automatically clear and return to normal once the 

interrupt process has completed. The interrupt process for the executed scenario may take 
some time. 

 
 See Section 3.6.1, "Batch Execution" regarding Batch Execution - Scenario Execution Stop 

regarding batch operations for all managed machines. 
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3.8.8. Error Cancellation 
Remove the Scenario Execution Error for the scenario assigned to the managed machine and Remote Power 
ON Error. 
You can operate Remove Error for only one managed machine or two or more selected managed machines by 
Machine Individual Operations. 
 
・ To operate on only one managed machine  
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 
 
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group icon. 
 
(3) The Machine List group box appears in the main window, then click the name of the Managed Machine to 

Remove Error. 
 
(4) The Operations menu for the managed machine will be displayed, and then click Remove Error. 
 
(5) Click OK. 
 
・ To operate selecting two or more managed machines 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group icon. 

 
(3) Select the checkbox in the left column of the Managed Machine to Remove Error on the Machine List 

group box in the main window. 
 

(4) Click Remove Error of Machine Individual Operations... from the Action menu. 
 

(5) Click OK. 
 

3.8.9. Remove Interruption 
Remove Interruption for the scenario assigned to the managed machines. 
You can operate Remove Interruption for only one managed machine or two or more selected managed 
machines by Machine Individual Operations. 
 
You do Remove Interruption in the following cases. 
- The latest information is still Scenario Execution Stop when more than 2 hours have passed since the 

Scenario Execution Stop. 
- The managed machine has been powered OFF manually. 
Normally, after the process of Scenario Execution Stop is completed, the status returns to normal. Therefore, it 
is not necessary to do Remove Interruption. 
 
・ To operate on only one managed machine  
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 
 
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group icon. 
 
(3) The Machine List group box appears in the main window, then click the name of the Managed Machine to 

Remove Interruption. 
 
(4) The Operation menu for the managed machine will be displayed, and then click Remove Interruption. 
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・ To operate selecting two or more managed machines  
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 
 
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group icon. 
 
(3) Select the checkbox in the left column of the Managed Machine to Remove Interruption on the Machine 

List group box in the main window. 
 
(4) Click Remove Interruption of Machine Individual Operations... from the Action menu. 

 
  If the status of the machine on the Web Console is still Scenario Execution Stop after 

selecting Remove Interruption, click Refresh in the Operation menu to refresh the 
latest information. 

 When you execute Remove Interruption, there may be cases where the interrupt 
processing does not proceed properly and the following status may occur. In this case, 
please manually turn the power of the managed machine ON or OFF. 

•You cannot turn the power ON or OFF for the managed machine from the Web 
Console. 

•You cannot execute a scenario. 
 

3.8.10. File/Folder List 
The list of files and folders on the managed machine is displayed. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 
 
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group icon. 
 
(3) The Machine List group box appears in the main window, then click the name of the Machine that the list 

of files and folders is displayed. 
 
(4) The Operation menu for the managed machine will be displayed, and then click File/Folder List. 
 
You can also display the File/Folder List screen by the following steps. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group icon. 
 
(3) Select the checkbox in the left column of the Machine that the list of files and folders is displayed on the 

Machine List group box in the main window. 
 

(4) Click File/Folder List of Machine Individual Operations... from the Action menu. 
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(5) File/Folder List screen appears in the main window. 
 

 
 
File/Folder List 

 Base Information Displays the basic information of the managed machine. 
This group box is not displayed by default. 
Expand it by clicking the arrow ( ) in the right. 

 Name Displays the identification name of the managed machine. (When the 
identification name is not specified, the machine name is displayed.) 

 Group Displays the group name to which the managed machine belongs. 

 UUID Displays the UUID. 

 IP Address Displays the IP address. If there are two or more IP addresses for the 
managed machine, all of the IP addresses will be displayed. 

 MAC Address Displays the MAC address. 

Deploy-OS Displays Deploy-OS to be used by the managed machine when you 
execute backup/restore/disk configuration check. 

OS Name Displays the OS name. 

Service Pack Displays the service pack information on the machine. 
This is not displayed if a service pack is not applied. 
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 Folder Path Displays the path of the current folder. 

 Display Count Select the number of items to be displayed in the list. 

 "Action" Link If you click File Delete, you can delete a file which is selected in the 
left check box. 

 (Checkbox) Select this check box to delete a file. See Section 3.8.12, "File 
Deletion" for details. 

 File Name Displays the name of folders or files. This cannot be edited. 
If you click the link of the drive name or the folder name, the contents 
directly under the corresponding drive or folder are displayed. 
If you click  link, the upper layer is displayed. 

 Updated Date Displays the updated date of the folder or the file. This cannot be 
edited. 
In the case of a drive, this is not displayed. 

 Size Displays the file size. This cannot be edited. 
In the case of a drive or a folder, this is not displayed. 

 
  If the status of the managed machine has one of the following status, this screen 

cannot be displayed. 
・ Status column  

- Scenario Executing 
- Scenario Execution Error 
- Scenario Execution Stop 
- Remote Power ON Error 
- Automatic Update Progress 
- Transferring Files(Automatic Update) 
- Applying A Package(Automatic Update) 
- Setting Automatic Update Time 

・ Power column 
- Off 
- Unknown 

Also, if the following functions are being executed for the managed machine, this 
screen cannot be displayed. These statuses are not displayed in the Status column. 
・ File distribution 
・ File deletion 

 
 In either case of the following, the name of the corresponding folder or file cannot be 

displayed correctly. 
・ When OS on the managed machine is Linux, the following symbols are included in 

the folder path or the file path. 
\ : * ? " < > | $ ~ ` 

・ When the length of the folder path or the file path is 260Byte or more. 
 

3.8.11. File Distribution 
Distributes a file to the managed machine. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group icon. 
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(3) The Machine List group box appears in the main window, then click the name of the Machine to Which 

You Distribute the File. 
 
(4) The Operation menu for the managed machine will be displayed, and then click File Distribution. 

 
(5) The File Distribution screen appears in the main window. Set each item. 

 
You can also display the File Distribution screen by the following steps. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group icon. 
 
(3) The Machine List group box appears in the main window. Select the checkbox in the left column of the 

Machine to which You Distribute the File. 
 

(4) Click File Distribution of Machine Individual Operations... from the Action menu. 
 

(5) The File Distribution screen appears in the main window. 
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File Distribution 

 Source File Path 
(Required) 

Specify a file on the Management Server which is distributed to the 
managed machine. 
Specify the file by selecting it from Browse button or entering the file 
path directly. 
259 characters or less can be entered. Alphanumeric characters and 
symbols can be entered. 
The following symbols cannot be entered. 
\ / : * ? " < > | 
Environment variables are not supported. 
Separate the file path by "/" necessarily. 
The size of the file which can be distributed is 2GByte or less (before 
compressing). 
In the case of x64 OS, specify the file under the folder which is not 
redirected. 

Destination File Path 
(Required) 

Specify the folder path or the file path on the managed machine as 
destination. 
When you specify the folder path, enter "/" at the end necessarily. 
259 characters or less can be entered. 
Alphanumeric characters and symbols can be entered. 
The following symbols cannot be entered. 
\ / : * ? " < > | 
In the case of Linux OS, the following symbols cannot be also 
entered. 
$ ~ ` 
Environment variables are not supported. 
Separate the file path by "/" necessarily. 
Also, when you change the file name between the source and the 
destination, specify the changed file name. 

Compress Select the Compress checkbox to compress the file and then 
distribute it. (*1) 

Replace Select the Replace checkbox to overwrite the file when the same file 
name as the source file exists in the destination. 
When the same file name exists, an error occurs if you do not select 
this checkbox.  

Encryption Select the Encryption checkbox to encrypt the file and distribute it. 

After Operating Setting 

 Delete File After 
File Distribution 

Select the After File Operating Delete File checkbox to delete the 
file which is specified in the Source File Path after executing the file 
distribution. 
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 Access Setting(*2) 

 Windows  

 User Enter the name of the user to whom the access authority for the file is 
set. 
You can set the access authority for the file in the destination when 
the file is distributed. Specify the name of the user who exists. 
256 characters or less can be entered. 
Alphanumeric characters and symbols can be entered. 
The following symbols cannot be entered. 
\ / [ ] : | < > + = ; , . ? * @ " 

Full Control Select the Full Control checkbox to set the authority of Full Control 
to the user who is specified in User. 

Modify Select the Modify checkbox to set the authority of Modify to the user 
who is specified in User. 

Read And 
Execute 

Select the Read And Execute checkbox to set the authority of Read 
And Execute to the user who is specified in User. 

Read Select the Read checkbox to set the authority of Read to the user who 
is specified in User. 

Write Select the Write checkbox to set the authority of Write to the user 
who is specified in User. 

  Linux 

 Directory 
Permission
  

Specify the directory permission. 
Octal digit can be entered. (0-7) 
Enter this in the form "xxx". 
If you do not enter this item, "755" is set. 

File Permission 

 Owner 

  
 
 

Read Select the Read checkbox to set the authority of Read to the owner of 
the file (root). 

Write Select the Write checkbox to set the authority of Write to the owner of 
the file (root). 

Execute Select the Execute checkbox to set the authority of Execute to the 
owner of the file (root). 

 Group 

  
 
 

Read Select the Read checkbox to set the authority of Read to users in the 
same group with the owner. 

Write Select the Write checkbox to set the authority of Write to users in the 
same group with the owner. 

Execute Select the Execute checkbox to set the authority of Execute to users 
in the same group with the owner. 

 Other 

  
 
 

Read Select the Read checkbox to set the authority of Read to other users 
(except the owner and users in the same group with the owner). 

Write Select the Write checkbox to set the authority of Write to other users 
(except the owner and users in the same group with the owner). 
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Execute Select the Execute checkbox to set the authority of Execute to other 
users (except the owner and users in the same group with the owner). 

OK Distributes the file with the setting in the File Operation screen and 
returns to the previous window. 

Cancel Returns to the previous window without distributing the file with the 
setting in the File Operation screen. 

*1 
When you distribute a large volume file to two or more managed machines at the same time, the CPU load 
may get higher if the Compress checkbox is selected. In that case, you can lower the CPU load by 
clearing the Compress checkbox. 

*2 
When you do not specify Access Setting, the following is set as the access authority of the distributed file. 
・ In the case of Windows OS: 

The access authority of the destination folder is inherited. (When the specified folder does not exist in 
the destination, a new folder is created and the access authority of the parent folder is inherited.) 

・ In the case of Linux OS: 
The root is set as the owner and 644 is set as the file permission. When the specified directory does not 
exist in the destination, a new directory is created (the directory permission is 755). 

 
 If the managed machine has one of the following status, you cannot distribute the file. 

・ Status column  
- Scenario Executing 
- Scenario Execution Error 
- Scenario Execution Stop 
- Remote Power ON Error 
- Automatic Update Progress 
- Transferring Files(Automatic Update) 
- Applying A Package(Automatic Update) 
- Setting Automatic Update Time 

・ Power column 
- Off 
- Unknown 

Also, if the following functions are being executed for the managed machine, you 
cannot distribute the file. These statuses are not displayed in the Status column. 
・ File deletion 
・ Obtaining the information in File/Folder List screen 

 

3.8.12. File Deletion 
Deletes a file on the managed machine. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click Resource icon -> Machines icon -> Machine Group icon. 

 
(3) The Machine List group box appears in the main window, then click the name of the Machine on Which 

You Delete the File. 
 
(4) The Operation menu for the managed machine will be displayed, and then click File/Folder List. 
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(5) The File/Folder List screen appears in the main window. Select the checkbox in the left column of the File 

to Delete and click File Delete of the Action link. 
 

 
 

  You can delete only one file at one time. 
 If the managed machine has one of the following status, you cannot delete the file. 

・ Status column  
- Scenario Executing 
- Scenario Execution Error 
- Scenario Execution Stop 
- Remote Power ON Error 
- Automatic Update Progress 
- Transferring Files(Automatic Update) 
- Applying A Package(Automatic Update) 
- Setting Automatic Update Time 

・ Power column 
- Off 
- Unknown 

Also, if the following functions are being executed for the managed machine, you 
cannot delete the file. These statuses are not displayed in the Status column. 
・ File distribution 
・ Obtaining the information in File/Folder List screen 
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3.9. "New Machine" Icon 
The new machine is managed with the New Machine icon. 
You can access the New Machine icon from the Machines icon -> New Machine icon on the tree view of the 
Operations view. 
Click the New Machine icon to display the New Machine List group box in the main window. 
 
If the managed machine supports PXE boot, the New Machine icon is automatically displayed in the tree view 
when a PXE packet is received. 
Also, even if the machine does not support PXE boot, if DPM Client is installed on the machine, DPM Client 
communicates with the Management Server when the machine is started up, and the New Machine icon will 
automatically be displayed in the tree view. 

 

 
 

New Machine List  

 Display Count Select the number of items to be displayed in the list. 

"Action" Link ・ When you click Add Machine, the new machine which is selected 
on the left checkbox will be added. 
You can add two or more new machines by selecting two or more 
checkboxes. 

・ When you click Delete Machine, the new machine which is 
selected on the left checkbox will be deleted. 
You can delete two or more new machines by selecting two or 
more checkboxes. 

(Checkbox) You can select all of the new machines in the list if you select the 
top checkbox. 

MAC Address Displays the MAC address of the new machine. 
Click the MAC address to display the Base Information group box 
in the main window. See Section 3.9.1, "New Machine Detailed 
Information" regarding the base information. 

UUID Displays the UUID of the new machine are displayed. 

IP Address  Displays the IP address of the new machine. 
If there are two or more IP addresses, the IP address for 
communicating with the Management Server will be displayed. This 
will be displayed as blank if there is no IP address information. 
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3.9.1. New Machine Detailed Information 
Displays the new machine detailed information. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click the Resource icon -> New Machine icon. 

 
(3) The New Machine List screen appears, and then click the MAC Address for the new machine to display 

detailed information. 
 

(4) The Base Information group box appears in the main window. Then, confirm the base information for the 
new machine. 

 

 
 

Basic Information  

 UUID Displays the UUID. This cannot be edited. 

MAC Address Displays the MAC address. This cannot be edited. 

IP Address  Displays the IP address. This cannot be edited. 
If there are two or more IP addresses, the IP address for 
communicating with the Management Server will be 
displayed. This will be displayed as blank if there is no IP 
address information. 
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3.9.2. Register New Machine 
Add a new machine. 
You can select one machine or two or more machines and add them to a group. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click Resource -> Machines -> New Machine. 

 
(3) The New Machine List screen appears in the main window. Then select the left column of the New 

Machine to Add and click the Action link for Add Machine. 
 
(4) The Add New Machine screen appears in the main window. Set each item. 

 
You can also display the Add New Machine screen by the following steps. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click Resource -> Machines -> New Machine icon -> MAC Address of the New 

Machine to Add. 
 

(3) The Configuration menu for the new machine will be displayed. Then click Add Machine. 
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(4) The Add New Machine screen appears in the main window. Set each item. 
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Add New Machine  

 Group Name Select the group name, to which the machine will be added, from 
the tree. 

Machine Name Displays the new machine name. 
You can edit the name of the managed machine when you add 
one new machine. 63 characters or less can be entered. 
Alphanumeric characters and symbols can be entered. The 
following symbols and space cannot be used. Also, you cannot 
use a machine name with only numbers. 
. , ; ` ~ ! @ # $ ^ & * = + { } % \ | : ' " < > / ? [ ] 
The default is "PC-xxx_xxx_xxx_xxx(yy-yy-yy-yy-yy-yy)". 
xxx_xxx_xxx_xxx is the IP address and yy-yy-yy-yy-yy-yy is the 
MAC address.  
When the IP address cannot be obtained, the machine name is 
displayed as "PC-(yy-yy-yy-yy-yy-yy)". 
When you add two or more new machines, all of the new 
machines are displayed in the list box. In this case, the machine 
name cannot be edited. 
If DPM Client is installed, even if the name of the added machine 
and the actual machine is different, the name on the Web 
Console will be automatically changed to the actual machine 
name when the machine is powered ON. 

Identification Name Enter the identification name of the managed machine when you 
add one new machine. 
63 characters or less can be entered. Alphanumeric characters 
and symbols can be entered. 
The following symbols and space cannot be entered. Also, you 
cannot use a name with only numbers. 
. , ; ` ~ ! @ # $ ^ & * = + { } % \ | : ' " < > / ? [ ] 
You cannot add a machine with the same name under the same 
DPM Server. 
When you add two or more new machines, this item is not 
displayed. 

MAC Address When you add only one new machine, the MAC address is 
automatically obtained and displayed.  
When you add two or more new machines, this item is not 
displayed. 

UUID When you add only one new machine, the UUID is automatically 
obtained and displayed.  
When you add two or more new machines, this item is not 
displayed. 

IP Address When you add only one new machine, the IP address is 
automatically obtained and displayed. When you edit it, numeric 
characters can be entered. Enter them in the form 
"xxx.xxx.xxx.xxx". 
You cannot add a machine with the same IP address under the 
same DPM Server. 
If there are two or more IP addresses on the managed machine, 
enter the IP address communicating with DPM Server. 
When you add two or more new machines, this item is not 
displayed. 
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 Deploy-OS Select Deploy-OS to be used by the managed machine when you 
execute backup/restore/disk configuration check. 
Please contact your sales or support representative about the 
setting values for each machine model. 
Deploy-OS installed in DPM Server is displayed in the list box. 
If Deploy-OS for the machine that is being used is not displayed in 
the list box, obtain the module for the machine model from your 
sales or support representative and install it on DPM Server. 
Deploy-OS will be displayed in the list box. 

Scenario Setting 

 Assign scenario  Select to assign a scenario. 
If you select this, Browse in the Scenario Name text box is 
enabled. 

Scenario Name  Set the scenario which will be assigned to the added managed 
machines. If you click Browse, Select Scenario screen appears. 
Select a scenario and click OK. 

Remove Scenario 
Assignment  

Select to remove the scenario assignment. 

Scenario Applying 
Schedule  

If you select the Scenario Applying Schedule checkbox, you 
can set the scenario applying schedule. If you do not set the 
scenario, you cannot select the checkbox. Setting is required if 
this is checked. 

 Only 
Once 

The schedule is executed Only Once. 

Date 
(Required) 

Set the date. 
You can enter the date (year/month/day) or select the date from 
the displayed calendar by clicking the " " icon on the side of the 
textbox. 
When you enter a date, use YYYY/MM/DD format. 

Time 
(Required) 

Set the time. 
You can enter the following range in the textbox. 
・ "Hr" 0 - 23  
・ "Min" 0 - 59 

 Daily The schedule is executed on the set "Day" and "Time" from Start Date. 

Start Date 
(Required) 

Set the start date. 
You can enter the date (year/month/day) or select the date from 
the displayed calendar by clicking the " " icon on the side of the 
textbox. 
When you enter a date, use YYYY/MM/DD format. 

End Date Set the end date. 
You can enter the date (year/month/day) or select the date from 
the displayed calendar by clicking the " " icon on the side of the 
textbox. 
When you enter a date, use YYYY/MM/DD format. 
If the End Date is not set, the schedule will repeatedly run 
following the set content. This is optional. 

  Time 
(Required) 

Set the time. 
You can enter the following range in the textbox. 
・ "Hr" 0 - 23 
・ "Min" 0 - 59 
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  Interval  

(Required)  
Edit the interval in day units. This can be set in the range of "1 - 
99" days. 
The default value is "1" (once per day). 

Weekly  The schedule is executed weekly on the set "Day of the Week" and "Time." 

Start Date  
(Required)  

Set the start date. 
You can enter the date (year/month/day) or select the date from 
the displayed calendar by clicking the " " icon on the side of the 
textbox. 
When you enter a date, use YYYY/MM/DD format. 

End Date  Set the end date. 
You can enter the date (year/month/day) or select the date from 
the displayed calendar by clicking the " " icon on the side of the 
textbox. 
When you enter a date, use YYYY/MM/DD format. 
If the End Date is not set, the schedule will repeatedly run the set 
content. This is optional. 

Time 
(Required) 

Set the time. 
You can enter the following range in the textbox. 
・ "Hr" 0 - 23 
・ "Min" 0 - 59 

Day of the 
Week Setting  
(Required)  

Set one or more of Sunday - Saturday. 

Monthly The schedule is executed monthly on the set "Date" and "Time."  

Start Month 
(Required)  

Set the start month. 
You can enter the date (year/month) or select the date from the 
displayed calendar by clicking the " " icon on the side of the 
textbox. 
When you enter a month, use YYYY/MM format. 

End Month  
 

Set the end month. 
You can enter the date (year/month) or select the date from the 
displayed calendar by clicking the " " icon on the side of the 
textbox. 
When you enter a month, use YYYY/MM format. 
If the End Month is not set, the schedule will repeatedly run the 
set content. This is optional. 

Time 
(Required) 

Set the time. 
You can enter the following range in the textbox. 
・ "Hr" 0 - 23 
・ "Min" 0 - 59 
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  Day  

(You Must Set 
Either Day/ 
Week 

If you select Day, select the day. 
・ 01 - 31 
・ End of Month  
Example) "End of Month" day 

Day of the Week  
(You Must Set 
Either Day/ 
Week 

If you select Week, set the day of the week. 
Example) "1" - "Mon." 

 Left List Box Select from the following. 
・ 1st - 4th 
・ Last  

Right List 
Box  

Select from the following. 
・ Monday - Sunday• 

Power 
Management  
Schedule  

If you select the Power Management Schedule checkbox, you can 
manage the machine's power status. 
If you select the checkbox, select either or both Power ON Time / 
Shutdown Time. 

Only 
Once  

The schedule is executed Only Once. 

Power 
On Time 
(You must set 
either or both of 
Power ON 
Time/Shutdown 
Time.) 

If you select the Power ON Time checkbox, you can set the power ON 
time. 
You can enter the date (year/month/day) or select the date from the 
displayed calendar by clicking the " " icon on the side of the textbox. 
When you enter a date, use YYYY/MM/DD format. 
Set the time from after 5 minutes from the current time. 
You can enter the following range in the textbox. 
・ "Hr" 0 - 23 
・ "Min" 0-59 

Shutdown Time 
(You must set 
either or both of 
Power ON 
Time/Shutdown 
Time.) 

If you select the Shutdown Time checkbox, you can set the shutdown 
time. 
You can enter the date (year/month/day) or select the date from the 
displayed calendar by clicking the " " icon on the side of the textbox. 
When you enter a date, use YYYY/MM/DD format. 
You can enter the following range in the textbox. 
・ "Hr" 0 - 23 
・ "Min" 0 - 59 
Set the time from after 5 minutes from the current time. If you set this at 
the same time as the Power ON Time, set the interval more than 10 
minutes. 

Do not show 
countdown 
dialog 

If you select the Do not show countdown dialog checkbox, the 
countdown dialog is not displayed at the time of shutdown. 
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 Specify 

Day 
The schedule is executed on the set "Day of the Week" and "Time."  

Power 
On Time 
(You must set 
either or both 
of Power ON 
Time/Shutdow
n Time.) 

If you select the Power ON Time checkbox, you can set the power ON 
time. 
You can enter the following range in the textbox. 
・  "Hr" 0 - 23 
・  "Min" 0 - 59 

Shutdown 
Time 
(You must set 
either or both 
of Power ON 
Time/Shutdow
n Time.) 

If you select the Shutdown Time checkbox, you can set the shutdown 
time. 
You can enter the following range in the textbox. 
・ "Hr" 0 - 23 
・ "Min" 0 - 59 

Do not show 
countdown 
dialog 

If you select the Do not show countdown dialog checkbox, the 
countdown dialog is not displayed at the time of shutdown. 

Day of the 
Week Setting  
(Required)  

Set one or more of Sunday - Saturday. 

 Network Setting Edit the network settings for a managed machine. 
The default is Subnetwork is same with DPM Server. 

 Subnetwork is same 
with DPM Server 

Select this when the managed machine is on the same Subnetwork as 
DPM Server. 

Subnetwork is not 
same with DPM Server 

Select this when the managed machine is on a different Subnetwork 
than DPM Server. 
Select this when the machine goes through a router and belongs to a 
different network than DPM Server. 
The following items will be enabled if the setting is Subnetwork is not 
same with DPM Server. 
・ Default Gateway  
・ Subnet Mask  
They are required if this item is enabled. 

 Default Gateway  
(Required)  

Set the default gateway when the managed machine is on a different 
Subnetwork than DPM Server. The top order of the IP address (first 
octet) is set in the range of "1-223." 

Subnet Mask 
(Required)  

Set the subnet mask when the managed machine is on a different 
Subnetwork than DPM Server. 
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 Automatic Update Setting  Execute automatic update settings for a new managed machine. 

The default is the value set on the Management view –> DPM Server 
icon -> Automatic Update Setting screen. 
See Section 2.7.4, "Automatic Update Setting" regarding the Automatic 
Update Setting screen. 

 Automatic Update Set the automatic update function. You can select from the following. 
・ Constantly OFF 
・ ON At Startup  
・ OFF At Startup  
The default is OFF At Startup. 
The following setting will be disabled if the setting is Constantly OFF. 
・ Automatic Update Time 
・ Application Timing 
・ Retry Count 
・ Retry Interval (Min.) 
When you set the automatic update function to Constantly OFF, the 
managed machine will not request not applied packages to the 
Management Server. (*See Section 2.7.4, "Automatic Update Setting" 
regarding "The example of the automatic update setting and action".) 

Automatic Update Time Set the automatic update time. 

 Left List Box  You can set the day for executing the automatic update. You can select 
from the following. 
・ Everyday  
・ Sun - Sat  
The default is blank. 

Right List Box  You can select hourly increments from "0:00" to "23:00". 

Application Timing  Set the operation for the automatic update application timing when a 
new managed machine is registered to the group. You can select from 
the following. 
・ Immediately 
・ At Next Startup 
・ Show Confirmation 
If the application timing is Immediately or At Next Startup, the 
confirmation screen will not be displayed on the managed machines. 
(*See Section 2.7.4, "Automatic Update Setting" about selection and 
action of the Application Timing.) 

Retry Count If the connection to the Management Server failed, the connection will 
be re-tried the set number of re-try times. This can be set in the range of 
"0 - 5" times. 

Retry Interval (Min.)  If the connection to the Management Server failed, the connection will 
be re-tried at the set time interval. This can be configured in five minute 
increments from "5" to "30" minutes. 

OK Adds the new machine with the setting on the Add New Machine 
screen and returns to the previous window. 

Cancel Returns to the previous window without adding the new machine with 
the setting from the Add New Machine screen. 
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3.9.3. Delete New Machine 
Delete a new machine. 

 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click Resource -> Machines -> New Machine. 

 
(3) The New Machine List screen appears. If you select the checkbox in the left column of the New Machine 

to Delete and click Delete Machine of the Action link, a confirmation dialog box appears. 
 

(4) Click OK. 
 
You can also delete the new machine, following steps below. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click Resource -> Machines -> New Machine. 

 
(3) The New Machine List screen appears, and then click the MAC Address for the New Machine to Delete. 

 
(4) The Configuration menu for the new machine will be displayed. Then click Delete Machine. 

 
(5) The confirmation dialog box appears. Click OK. 

 

3.10. "Scenario" Icon 
You can manage the scenario group and scenario from the Scenarios icon. 
You can access the Scenarios icon from the Scenarios icon at the top of the tree view of the Operations view 
or from Scenarios in the Summary Information group box displayed in the main window of the Operations 
view. 
Click the Scenarios icon to display the Group List group box in the main window. 
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Scenario Group List  

 Display Count Select the number of items to be displayed in the list. 

"Action" Link When you click Delete Group, the scenario group which is 
selected on the left checkbox will be deleted. 
You can delete two or more scenario groups by selecting two or 
more checkboxes. 

(Checkbox) You can select all of the scenario groups in the list if you select 
the top checkbox. 

Name Displays the scenario group name. This cannot be edited. 

Subgroup Number 
(Directly/Subordinates)  

Displays the number of subgroups directly under/subordinate 
to the concerned group. 

Scenario Number 
(Directly/Subordinates) 

Displays the number of scenarios directly under/subordinate to 
the concerned group. 

Edit Edit a scenario group name. Click the " " icon to display the 
Edit Scenario Group screen in the main window. 
See Section 3.12.1, "Edit Scenario Group" regarding the Edit 
Scenario Group screen. 
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3.10.1. Add Scenario Group 
Add the scenario group to which the scenario belongs before adding the scenario. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click the Resource icon -> Scenarios icon. 

 
(3) The Configuration menu for the Scenarios icon will be displayed, then click Add Group. 

 
(4) The Add Scenario Group screen appears in the main window. Set each item. 

 

 
 

Add Scenario Group  

 Name  
(Required) 

Enter the scenario group name. 64 characters or less can be entered. You 
cannot set the same name in the same layer. 
Alphanumeric characters and symbols can be entered. 
The following symbols cannot be used. 
; / 

OK The scenario group is created with the setting on the Add Scenario Group 
screen and it returns to the previous window. 

Cancel Returns to the previous window without creating the scenario group with 
the setting from the Add Scenario Group screen. 

 
The following table shows the upper limit related to the number of scenario groups and scenario files. 
Item Upper Limit 

Total number of scenario groups (total number of scenario groups including 
sub-scenario groups) 1000 

Number of scenario group layer 20 

Number of scenario files that can be registered per a scenario group Unrestricted 

Total number of scenarios (total number of scenarios affiliated with all scenario 
groups, including sub-scenario groups) Unrestricted 
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3.10.2. Delete Scenario Group 
Delete a scenario group. 

 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click the Resource icon -> Scenarios icon. 

 
(3) The Group List group box appears in the main window. Then select the left checkbox of Scenario Group 

to Delete. 
 

(4) When you click the Action link for Delete Group, a confirmation dialog will be displayed. 
 

(5) Click OK. 
 
You can also delete a scenario group, following steps below. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click Resource icon -> Scenarios icon -> Scenario Group to Delete icon. 

 
(3) The Configuration menu for the Scenario Group icon appears, and then click Delete Group. 

 
(4) The confirmation dialog box appears. Click OK. 

 
  When you delete a scenario group, the sub-scenario groups and scenarios under the 

corresponding group will also be deleted. 
 When the status of the scenario in the scenario group is either of the following in the 

managed machine, you cannot delete the corresponding scenario group. 
・ Scenario Executing 
・ Scenario Execution Error 
・ Scenario Execution Stop.  

 

3.11. "Scenario Group" Icon 
The scenarios are classified by scenario group and managed in the Scenario Group icon. 
You can access the Scenario Group icon from the Scenarios icon -> Scenario Group icon at the top of the tree 
view of the Operations view or from Scenarios icon -> Scenario Group icon in the Summary Information 
group box displayed in the main window of the Operations view. 
Click the Scenario Group icon to display the Base Information, the Scenario List, and the Subgroup List 
group box in the main window. 
See Section 3.12, "Scenario Group Details" regarding the screen. 
 

 When you upgraded from the version earlier than DPM Ver6.0, scenarios that you created 
before you upgraded are stored in "Existing Scenarios" scenario group. 
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3.11.1. "Built-in Scenarios" Scenario Group 
When you install DPM Server, "Built-in Scenarios" scenario group is created and the following scenarios under 
the group are created. 
・ System_AgentUpgrade_Multicast 
・ System_Backup 
・ System_DiskProbe 
・ System_LinuxAgentUpgrade_Multicast 
・ System_LinuxChgHostName 
・ System_LinuxChgIP 
・ System_LinuxChgPassword 
・ System_LinuxMasterSetup 
・ System_Restore_Unicast 
・ System_WindowsChgHostName 
・ System_WindowsChgIP 
・ System_WindowsChgPassword 
・ System_WindowsMasterSetup 
・ System_WindowsMasterSetupVM 

 

3.11.1.1. System_AgentUpgrade_Multicast/System_LinuxAgentUpgrade_
Multicast 

By the following scenarios, you can upgrade DPM Client to this version. 
・ System_AgentUpgrade_Multicast：For Windows OS 
・ System_LinuxAgentUpgrade_Multicast：For Linux OS 

 
For details, see Section 3.3.2, "Manually Upgrading DPM Client" in Installation Guide. 
 

3.11.1.2. System_Backup 
By "System_Backup" scenario, you can backup the managed machine. 
For details, see Section 3.1, "Backup" in Operation Guide. 
 

3.11.1.3. System_DiskProbe 
By "System_DiskProbe" scenario, you can execute disk configuration check for the managed machine. 
For details, see Section 7.2, "Disk Configuration Check Tool". 
 

3.11.1.4. System_LinuxChgHostName/System_WindowsChgHostName 
By the following scenarios, you can change the machine name of the managed machine. 

・ System_WindowsChgHostName：For Windows OS(Windows Server 2008/Windows Vista or later) 
・ System_LinuxChgHostName：For Linux OS(Red Hat Enterprise Linux 6 or later, or SUSE Linux Enterprise 

10 or later) 
 

The procedure to use this scenario is as follows. 
 
(1) Display the screen to edit this scenario. 

About the procedure to display this screen, see Section 3.14.1, "Edit Scenario." 

javascript:Utility.openSettingView('Resource/Scenario/ScenarioDetail.aspx','Resource/Scenario/Action/ScenarioDetailAction.aspx',%7bparameters:%7baction:'show',id:'U3lzdGVtX0JhY2t1cA==',parentID:'MDAwMDAwMDFfQnVpbHQtaW4gU2NlbmFyaW9zX1NH'%7d,actionParameters:%7baction:'show',id:'U3lzdGVtX0JhY2t1cA==',parentID:'MDAwMDAwMDFfQnVpbHQtaW4gU2NlbmFyaW9zX1NH'%7d%7d);
javascript:Utility.openSettingView('Resource/Scenario/ScenarioDetail.aspx','Resource/Scenario/Action/ScenarioDetailAction.aspx',%7bparameters:%7baction:'show',id:'U3lzdGVtX0JhY2t1cA==',parentID:'MDAwMDAwMDFfQnVpbHQtaW4gU2NlbmFyaW9zX1NH'%7d,actionParameters:%7baction:'show',id:'U3lzdGVtX0JhY2t1cA==',parentID:'MDAwMDAwMDFfQnVpbHQtaW4gU2NlbmFyaW9zX1NH'%7d%7d);
javascript:Utility.openSettingView('Resource/Scenario/ScenarioDetail.aspx','Resource/Scenario/Action/ScenarioDetailAction.aspx',%7bparameters:%7baction:'show',id:'U3lzdGVtX0JhY2t1cA==',parentID:'MDAwMDAwMDFfQnVpbHQtaW4gU2NlbmFyaW9zX1NH'%7d,actionParameters:%7baction:'show',id:'U3lzdGVtX0JhY2t1cA==',parentID:'MDAwMDAwMDFfQnVpbHQtaW4gU2NlbmFyaW9zX1NH'%7d%7d);
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(2) The Edit Scenario screen appears in the main window. Select the Package tab, set the updated machine 

name in Setup Parameter, and click OK.  
 

 When you specify the machine name, be careful about the following. 
・ 63 characters or less can be entered. 
・ Alphanumeric characters or symbols can be entered. The following symbols and 

space cannot be entered. 
` ~ ! @ # $ % ^ & * ( ) = + _ [ ] { } \ | ; : . ' " , < > / ? 

・ You cannot specify the machine name with only numbers. 
・ The machine name cannot be the same with other machine names, Domain Name, 

or Workgroup Name. 
 
(3) Assign the scenario to the managed machine. 

For details, see Section 3.8.3, "Assign Scenario." 
 

(4) Execute the scenario. 
For details, see Section 3.8.6, " Execute Scenario." 

 
 After you executed the "System_WindowsChgHostName" scenario, the managed 

machine is restarted. 
 

3.11.1.5. System_LinuxChgIP/System_WindowsChgIP 
By the following scenarios, you can add, change, or delete IPv4 address of the managed machine. 

・ System_WindowsChgIP：For Windows OS(Windows Server 2008/Windows Vista or later) 
・ System_LinuxChgIP：For Linux OS(Red Hat Enterprise Linux 6 or later, or SUSE Linux Enterprise 10 or 

later) 
 

  IP address of Bonding setting or Teaming setting is not supported. 
 When you use "System_LinuxChgIP" scenario, be careful about the following. 
・ For the managed machine of Red Hat Enterprise Linux, when two or more IP 

addresses are described in one interface configuration file, the first IP address is 
the target. 

・ The file name of the interface configuration file needs to be the same with the 
name which is set in DEVICE(in the case of Red Hat Enterprise Linux) or LABEL(in 
the case of SUSE Linux Enterprise) in the file. 

・ Disable NetworkManager daemon. 
For details of the procedure, see "If the NetworkManager daemon is enabled, the 
DNS setting in the disk duplication data file is not reflected." in the note of Section 
3.4.1.3, "Preparing for Creating the Master Image" in Operation Guide. 

・ In the case of SUSE Linux Enterprise, remove the dependency of the MAC 
address. 
For details of the procedure, see "The network configuration of the machine is 
associated with the MAC address" -> "For SUSE Linux Enterprise" -> "Remove the 
dependency of the MAC address by implementing the following procedure on the 
master machine" of Section 3.4.4, "Precautions/Other" in Operation Guide. 

 
The procedure to use this scenario is as follows. 

 
(1) Display the screen to edit this scenario. 

About the procedure to display this screen, see Section 3.14.1, "Edit Scenario." 

javascript:Utility.openSettingView('Resource/Scenario/ScenarioDetail.aspx','Resource/Scenario/Action/ScenarioDetailAction.aspx',%7bparameters:%7baction:'show',id:'U3lzdGVtX0JhY2t1cA==',parentID:'MDAwMDAwMDFfQnVpbHQtaW4gU2NlbmFyaW9zX1NH'%7d,actionParameters:%7baction:'show',id:'U3lzdGVtX0JhY2t1cA==',parentID:'MDAwMDAwMDFfQnVpbHQtaW4gU2NlbmFyaW9zX1NH'%7d%7d);
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(2) The Edit Scenario screen appears in the main window. Select the Package tab, set IP address in Setup 

Parameter as follows, and click OK. The following is described in two lines. Enter it by one line in the actual 
screen. 

 
・ When you add IP address 

- When you specify fixed IP address 
/ADD /M MAC address [/IP IP address [/MASK Subnet Mask] [/GW Gateway]]  
[/DNS IP address of DNS Server] [/WINS IP address of WINS Server] 

- When you assign IP address by DHCP server 
/ADD /M MAC address [/IP DHCP] [/DNS IP address of DNS Server] [/WINS IP address of WINS 
Server] 
 
Example) 

/ADD /M 00-16-57-1a-b2-47 /IP 192.168.0.5 /MASK 255.255.255.0 /GW 192.168.2.120/DNS 
172.28.181.1 /WINS 172.28.181.2 

 
・ When you change IP address 

- When you specify fixed IP address 
          /SET /M MAC address [/IP IP address [/MASK Subnet Mask] [/GW Gateway]] 

[/DNS IP address of DNS Server] [/WINS IP address of WINS Server] 
- When you assign IP address by DHCP server 

/SET /M MAC address [/IP DHCP] [/DNS IP address of DNS Server] [/WINS IP address of WINS 
Server] 
 

         Example) 
/SET /M 00-16-57-1a-b2-47 /IP 192.168.0.5 /MASK 255.255.255.0 /GW 192.168.2.120/DNS 
172.28.181.1 /WINS 172.28.181.2 

 
・ When you delete IP address 

/DEL /IP IP address [/GW Gateway] [/DNS IP address of DNS Server] [/WINS IP address of WINS 
Server] 

 
Example) 

/DEL /IP 192.168.0.5 /GW 192.168.2.120 /DNS 172.28.181.1 /WINS 172.28.181.2 
 

  When you add or change IP address, specify either of /IP, /DNS, or /WINS 
necessarily. 

 When you change IP address, specified content is set after information such as IP 
address which is set for MAC address was all deleted. 

 Do not change the following setting of the Package tab. 
・ Select Execute Immediately After Distribution in the Execution Timing 

Setting group box. 
・ Clear Restart After Applying in the After Operating Setting group box. 

 About the "System_LinuxChgIP" scenario, be careful about the following. 
・ When you add IP address, if you specify "/GW Gateway", the gateway is not 

added but changed. 
・ When you assign IP address by DHCP server, even if you specify "/DNS IP 

address of DNS Server", it is ignored. 
・ Even if you specify "/WINS IP address of WINS Server ", it is ignored. 

 
  You can omit options which are in brackets("[", "]"). 

 Enter the value of each option by the following format. 
・ MAC address: "xx-xx-xx-xx-xx-xx", or "xx:xx:xx:xx:xx:xx" 
・ IP address/Subnet Mask/Gateway/IP address of DNS Server/IP address of 

WINS Server: "xxx.xxx.xxx.xxx" 
 

javascript:Utility.openSettingView('Resource/Scenario/ScenarioDetail.aspx','Resource/Scenario/Action/ScenarioDetailAction.aspx',%7bparameters:%7baction:'show',id:'U3lzdGVtX0JhY2t1cA==',parentID:'MDAwMDAwMDFfQnVpbHQtaW4gU2NlbmFyaW9zX1NH'%7d,actionParameters:%7baction:'show',id:'U3lzdGVtX0JhY2t1cA==',parentID:'MDAwMDAwMDFfQnVpbHQtaW4gU2NlbmFyaW9zX1NH'%7d%7d);
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(3) Assign the scenario to the managed machine. 

For details, see Section 3.8.3, "Assign Scenario." 
 

(4) Execute the scenario. 
For details, see Section 3.8.6, "Execute Scenario." 
 

(5) Check the scenario execution result. 
For details, see Section 4.5, "Scenario Execution Result List Details." 

 

3.11.1.6. System_LinuxChgPassword/System_WindowsChgPassword 
By the following scenarios, you can change the password of Administrator or root of the managed machine. 

・ System_WindowsChgPassword：For Windows OS(Windows Server 2008/Windows Vista or later) 
・ System_LinuxChgPassword：For Linux OS(Red Hat Enterprise Linux 6 or later, or SUSE Linux Enterprise 

10 or later) 
 

The procedure to use this scenario is as follows. 
 
(1) Display the screen to edit this scenario. 

About the procedure to display this screen, see Section 3.14.1, "Edit Scenario." 
 
(2) The Edit Scenario screen appears in the main window. Select the Package tab, set the updated password 

in Setup Parameter, and click OK. 
 

 About specifying the password, be careful about the following. 
・ Enclose the password in double quotation("). 
・ See also the password setting policy of each OS. 
・ Alphanumeric characters or symbols can be entered. The following symbols cannot 

be entered. 
" ! ` $ \ | 

 
(3) Assign the scenario to the managed machine. 

For details, see Section 3.8.3, "Assign Scenario." 
 

(4) Execute the scenario. 
For details, see Section 3.8.6, "Execute Scenario." 
 

(5) Check the scenario execution result. 
For details, see Section 4.5, "Scenario Execution Result List Details." 

 

3.11.1.7. System_Restore_Unicast 
By the "System_Restore_Unicast" scenario, you can restore the manage machine by unicast. 
For details, see Section 3.2, "Restore" in Operation Guide. 
 

3.11.1.8. System_LinuxMasterSetup/System_WindowsMasterSetup/Syste
m_WindowsMasterSetupVM 

By the following scenarios, you can create a master image for OS installation by disk duplication. 
・ System_WindowsMasterSetup: For Windows OS 
・ System_WindowsMasterSetupVM: For Windows OS(Virtual machine) 
・ System_LinuxMasterSetup: For Linux OS 

 
For the details, see Section 3.3, "OS Installation by Disk Duplication (Windows)" in Operation Guide and Section 
3.4, "OS Installation by Disk Duplication (Linux)" in Operation Guide. 

 

javascript:Utility.openSettingView('Resource/Scenario/ScenarioDetail.aspx','Resource/Scenario/Action/ScenarioDetailAction.aspx',%7bparameters:%7baction:'show',id:'U3lzdGVtX0JhY2t1cA==',parentID:'MDAwMDAwMDFfQnVpbHQtaW4gU2NlbmFyaW9zX1NH'%7d,actionParameters:%7baction:'show',id:'U3lzdGVtX0JhY2t1cA==',parentID:'MDAwMDAwMDFfQnVpbHQtaW4gU2NlbmFyaW9zX1NH'%7d%7d);
javascript:Utility.openSettingView('Resource/Scenario/ScenarioDetail.aspx','Resource/Scenario/Action/ScenarioDetailAction.aspx',%7bparameters:%7baction:'show',id:'U3lzdGVtX0JhY2t1cA==',parentID:'MDAwMDAwMDFfQnVpbHQtaW4gU2NlbmFyaW9zX1NH'%7d,actionParameters:%7baction:'show',id:'U3lzdGVtX0JhY2t1cA==',parentID:'MDAwMDAwMDFfQnVpbHQtaW4gU2NlbmFyaW9zX1NH'%7d%7d);
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 You cannot delete or edit this scenario because there is processing to work normally in the 
scenario. Though you can copy the scenario, the processing is deleted if you edit the 
scenario after copying it. Therefore, you cannot create the master image. 

 

3.12. Scenario Group Details 
Displays the scenario group details information. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click Resource icon -> Scenarios icon -> Scenario Group to Display Details icon. 

 
(3) Displays the Base Information, Scenario List and Subgroup List group box in the main window. 

 

 
 

Base Information  Displays the scenario group basic information. 
This group box is not displayed by default. 
Expand it by clicking on the arrow ( ) in the right. 

 Parent Group Name  Displays the Parent Group Name only when it is a sub-scenario 
group (The scenario group level is the second level or is lower than 
the second level). The Parent Group Name will not be displayed 
for scenario groups (first level scenario groups) directly under the 
Scenarios icon. 

Name Displays the scenario group name. 
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Scenario List  

Display Count Select the number of items to be displayed in the list. 
 "Action" Link ・ When you click Move Scenario, the scenario, which is selected 

in the left checkbox, is moved between groups. You can move 
two or more scenarios between groups by selecting two or more 
checkboxes. 

・ When you click Copy Scenario, the scenario, which is selected 
in the left checkbox, is copied. You cannot copy two or more 
scenarios at the same time. 

・ When you click Delete Scenario, the scenario, which is 
selected in the left checkbox, is deleted. You can delete two or 
more scenarios by selecting two or more checkboxes. 

・ When you click Assign Scenario, the scenario, which is 
selected in the left checkbox, is assigned to the managed 
machine. You cannot assign two or more scenarios at the same 
time. 

(Checkbox)  You can select all of the scenarios in the list if you select the top 
checkbox. 

Scenario Name  Displays the name of the scenario registered with this scenario 
group. 

Type  Displays the scenario type. 

Edit Edit a scenario. Click the " " icon to display the Edit Scenario 
screen in the main window. 
See Section 3.13.1, "HW Settings Tab" - Section 3.13.5, "Option 
Tab" regarding the Edit Scenario screen. 

Subgroup List  

 Display Count Select the number of items to be displayed in the list. 

"Action" Link When you click Delete Group, the sub-group, which is selected in 
the left checkbox, is deleted. 

(Checkbox) You can select all of the sub-groups in the list if you select the top 
checkbox. 

Name Displays the name of the sub-group registered with this group. 

Subgroup 
Number(Directly/Subo
rdinates)  

Displays the number of sub-groups directly under/subordinate to 
the concerned group. 

Scenario 
Number(Directly/Subo
rdinates) 

Displays the number of scenarios directly under/subordinate to the 
concerned group. 

Edit Edit a scenario group name. Click the " " icon to display the Edit 
Scenario Group screen in the main window. See Section 3.12.1, 
"Edit Scenario Group" regarding the Edit Group Scenario screen. 
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3.12.1. Edit Scenario Group 
Edit the scenario group name. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click Resource icon -> Scenarios icon -> Scenario Group to Edit icon. 

 
(3) The Configuration menu for the Scenario Group icon will be displayed, and then click Edit Group. 

 
(4) The Edit Scenario Group screen appears in the main window. Then edit the scenario group name. 

 

 
 

Edit Scenario Group  

 Name 
(Required) 

Edit the scenario group name. 64 characters or less can be 
entered. You cannot set the same name in the same layer. 
Alphanumeric characters and symbols can be entered. 
The following symbols cannot be used. 
; / 

OK Saves the settings details on the Edit Scenario Group screen 
and returns to the previous window. 

Cancel Returns to the previous window without saving the setting from 
the Edit Scenario Group screen. 
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3.12.2. Delete Scenario Group 
Delete a scenario group. 
See Section 3.10.2, "Delete Scenario Group" for details. 
 

3.12.3. Add Sub-scenario Group 
Add a sub-scenario group. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click Resource icon -> Scenarios icon -> Scenario Group to Add Sub-scenario Group 

icon. 
 

(3) The Configuration menu for the Scenario Group icon will be displayed, then click Add Subgroup. 
 

(4) The Add Scenario Group screen appears in the main window, and then set the sub-scenario group name. 
 

 
 

Add Scenario Group  

 Parent Group Name  Displays the parent scenario group name. This cannot be edited. 

Name 
(Required)  

Set the scenario group name. 
64 characters or less can be entered. You cannot set the same name in 
the same layer. Alphanumeric characters and symbols can be entered. 
The following symbols cannot be used. 
; / 

OK The sub-scenario group is created with the setting on the Add 
Scenario Group screen and it returns to the previous window. 

Cancel Returns to the previous window without creating the sub-scenario group 
with the setting from the Add Scenario Group screen. 
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The following table shows the upper limit related to the number of scenario groups and scenario files. 
Item Upper Limit 

Total number of scenario groups (total number of scenario groups including 
sub-scenario groups) 1000 

Number of scenario group layers 20 

Number of scenario files that can be registered per scenario group Unrestricted 

Total number of scenarios (total number of scenarios affiliated with all scenario 
groups, including sub-scenario groups) Unrestricted 

 

3.12.4. Delete Sub-scenario Group 
Delete a sub-scenario group. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click Resource icon -> Scenarios icon -> Scenario Group to Delete Sub-scenario 

Group icon. 
 

(3) The Subgroup List group box appears. Then select the left checkbox of Sub-scenario Group to Delete. 
 

(4) When you click the Action link for Delete Group, a confirmation dialog appears. 
 

(5) Click OK. 
 
You can also delete the sub-scenario group, following steps below. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click Resource icon -> Scenarios icon -> Scenario Group to Delete Sub-scenario 

Group icon. 
 

(3) The Subgroup List group box appears, and then click the name of the Sub-scenario Group to Delete. 
 
(4) The Configuration menu for the Sub-scenario Group icon appears, and then click Delete Group. 
 
(5) The confirmation dialog box appears. Click OK. 

 

3.12.5. Add Scenario 
Add a scenario. 
See Section 3.13, "Add Scenario" for details. 
 

3.12.6. Move Scenario 
Move a scenario between groups. You can move a scenario regardless of the managed machine's status 
(automatic update status/scenario status/power status). 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click the Resource icon -> Scenarios icon -> Scenario Group icon. 
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(3) Select the checkbox in the left column of the Scenario to be Moved on the Scenario List group box that is 

displayed in the main window. 
 

(4) Click Move Scenario under the Action link. 
 
(5) The Move Scenario dialog box appears and then set Target Group. 

 

 
 
(6) Click OK. 

 
You can also move the scenario, following steps below. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click the Resource icon -> Scenarios icon -> Scenario Group icon. 

 
(3) The Scenario List group box appears in the main window, then click the name of the Scenario to Move. 

 
(4) The Configuration menu for the Scenario will be displayed, and then click Move Scenario. 

 
(5) The Move Scenario dialog box appears and then set Target Group. 

 
(6) Click OK. 

 
 You can select and move two or more scenarios that are under the same group. 

 

3.12.7. Copy Scenario 
Copy a scenario between groups. You can copy a scenario regardless of the managed machine's status 
(automatic update status/scenario status/power status). 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 
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(2) In the tree view, click the Resource icon -> Scenarios icon -> Scenario Group icon. 

 
(3) Select the checkbox in the left column of the Scenario to be Copied on the Scenario List group box that 

is displayed in the main window. 
 

(4) Click Copy Scenario under the Action link. 
 

(5) The Copy Scenario screen appears in the main window. Then select Copy To -> Target Group. 
 

 
 

(6) Click OK. 
 
You can also display the Copy Scenario screen by the following steps. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click the Resource icon -> Scenarios icon -> Scenario Group icon. 
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(3) The Scenario List group box appears in the main window, then click the Scenario Name to Copy. 

 
(4) The Configuration menu for the Scenario will be displayed, and then click Copy Scenario. 

 
(5) The Copy Scenario screen appears in the main window. Then select Copy To -> Target Group. 

 
(6) Click OK. 

 
Copy Scenario  

 Scenario Name 
(Required) 

Displays the scenario name on the target. The scenario name is 
displayed as "Original Scenario Name_YYYY-MM-DD hh-mm-ss". 
You can edit the scenario name. 58 characters or less can be 
entered. 
Alphanumeric characters and symbols can be entered. 
The following symbols cannot be used. 
. , \ / : ; * ? " < > | 

Copy To  Select the scenario group of the target. 

OK Copy the scenario with the settings details on the Copy Scenario 
screen and returns to the previous window. 

Cancel Returns to the previous window without copying the scenario with the 
settings details on the Copy Scenario screen. 

 
 The contents of each tab on the original scenario are displayed and can be edited. See 

Section 3.13.1, "HW Settings Tab" - Section 3.13.5, "Option Tab" regarding editing. 
 

3.12.8. Delete Scenario 
Delete a scenario. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click the Resource icon -> Scenarios icon -> Scenario Group icon. 

 
(3) Select the checkbox in the left column of the Scenario to Delete on the Scenario List group box that is 

displayed in the main window. 
 

(4) When you click the Action link for Delete Scenario, a confirmation dialog will be displayed. 
 

(5) Click OK. 
 
You can also display the Delete Scenario screen by the following steps. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click the Resource icon -> Scenarios icon -> Scenario Group icon. 

 
(3) The Scenario List group box appears in the main window, then click the name of the Scenario to Delete. 

 
(4) The Configuration menu for the Scenario will be displayed, and then click Delete Scenario. 

 
(5) The confirmation dialog box appears. Click OK. 
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3.12.9. Assign scenario 
Assign a scenario. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click the Resource icon -> Scenarios icon -> Scenario Group icon. 

 
(3) Select the checkbox in the left column of the Scenario Name on the Scenario List group box that is 

displayed in the main window. 
 

(4) Click Assign Scenario in the Action link. 
 

(5) The Assign scenario screen appears in the main window. Then select a Group. 
 

 
 

(6) The machine list under the group selected in (5) is displayed in the Machine List group box. Then select 
the Machine to Assign Scenario. 

 
(7) Click OK and run. 

 
You can assign the scenario, following steps below. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click the Resource icon -> Scenarios icon -> Scenario Group icon. 

 
(3) The Scenario List group box appears in the main window. Then click the Scenario Name. 

 
(4) The Configuration menu for the Scenario will be displayed, and then click Assign Scenario. 

 
(5) The Assign scenario screen appears in the main window. Then select a Group. 
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(6) The machine list under the group selected in (5) is displayed in the Machine List group box. Then select 

the Machine to Assign Scenario. 
 

(7) Click OK. 
 

3.13. Add Scenario 
Add a scenario. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click Resource icon -> Scenarios icon -> Scenario Group to Add Scenario icon. 

 
(3) The Configuration menu for the Scenario Group icon will be displayed, then click Add Scenario. 

 
(4) The Add Scenario screen appears in the main window. Set each item. 

 

 
 

Add Scenario  

 Group Name Displays the scenario group name. This cannot be edited. 

Scenario Name  
(Required) 

Set the scenario name. 58 characters or less can be entered. 
Alphanumeric characters and symbols can be entered. 
The following symbols cannot be used. 
. , \ / : ; * ? " < > | 

 
 See Section 3.13.1, "HW Settings Tab" - Section 3.13.5, "Option Tab" for an 

explanation of each of the tabs (HW Setting, OS, Package, Backup/Restore and 
Option). 
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3.13.1. "HW Settings" Tab 
Set the HW Setting tab of the scenario. 

 

 
 

HW Setting  

 Image File Name  

 1. - 8. Select the image file from the 8 list boxes. 
Select Floppy Disk Image created using Image Builder as the 
image file. 
You cannot select the image file name here if you selected the 
Disk Configuration Check option button in Execute 
Backup/Restoration on the Backup/Restore tab. 

 
 You cannot perform registration or deletion of the image file at the same time as creating 

or editing a scenario. Do not operate Image Builder at the same time the scenario 
creation/editing screen is open. 
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3.13.2. "OS" Tab 
Set the OS tab of the scenario. 
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OS  

 OS  

 OS Name  Select the OS name. 
The OSs displayed in the list box are "Linux" and "Linux(gPXE)" 
Usually, select "Linux" 
If you select the OS, the Setup Parameter File setting will be 
enabled. 
You cannot set the OS Name if you select Restore or Disk 
Configuration Check option button in Execute Backup/Restoration 
on the Backup/Restore tab. 

OS Type If you select "Linux" or "Linux(gPXE)" in the OS Name, "Linux" is 
displayed in the OS Type. 

Setup Parameter File  

 It Assigns By The 
Machine Name  

Select this when assigning by the machine name. 
It Assigns By The Machine Name is selected by default. 
If there are the machines which have the same machine name, do 
not select this. 

  Specify File Name 
 

Select this when specifying the name of the setup parameter file 
created by Image Builder in advance. 
You can specify the file name in the list box by selecting the option 
button. Setting is required if this item is enabled. 

 
 When you set the OS tab, you cannot set Restore on the Backup/Restore tab. 
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3.13.3. "Package" Tab 
Set the Package tab of the scenario. 
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Package 

 Package 

 Name Displays the name of the package to be executed. 

Type Displays the type of the package to be executed. 
There are the following two types. 
・ Service packs/hotfixes/Linux patch files 
・ Applications 

Setup Parameter Set the setup parameter for the executed package. 
・ 128KByte or less can be entered. Alphanumeric characters and 

symbols can be entered. 
The default is the value which was set for the setup parameter when 
creating the package. 
About the set value, there are notes which are the same as when 
creating a package. For details, see "Execution Settings tab" in 
Section 5.5.1, "Create Windows Package" or Section 6.2.2, 
"Execution Settings Information." 

・ By specifying the character string in the following table, the string is 
converted to the real content of the managed machine when the 
scenario is executed. Specify capital letters.  

Specified character 
string 

Converted content when the 
scenario is executed 

|MAC| MAC address of the manage 
machine 

|UUID| UUID of the manage machine 

|IPADDR| IP address of the manage 
machine 

|COMPUTERNAME| the machine name of the 
manage machine 

Also, if you want to specify the character string in the above table 
without converting it when the scenario is executed, specify "\" before 
"|". 
Example) 

\|UUID\| 
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  "Action" Link ・ The Add Package group box appears when you click Add. 

 
You can select and add two or more packages by selecting the checkbox 
in the left column of the package to add. The added package will be 
displayed in the Package group box. 
Furthermore, use Image Builder or PackageDescriber to create the 
package to be added. See Section 5.5, "Package 
Registration/Modification" or Section 6.2, "Create Package" regarding 
creating a package. 
・ When you click Delete, the package, which is selected in the left 

checkbox, will be deleted. You can delete two or more packages by 
selecting two or more checkboxes.• 

(Checkbox) You can select all of packages in the list if you select the top checkbox. 

Up The package, which is selected in the left checkbox, will move up one 
place. 

Down The package, which is selected in the left checkbox, will move down one 
place. 

Add Package 

 (Checkbox) Select the checkbox in the left column of the package to add. 
When you select the checkbox and click OK, the package will be added 
to the Package group box. 
8 packages or less can be added for each type of service packs, 
hotfixes, patches, and applications. 

Name Displays the name of the package. 

Type Displays the type of the package. 
There are the following two types. 
・ Service packs/hotfixes/Linux patch files  
・ Applications  

  Default Setup 
Parameter 

Displays the setup parameter specified when creating a package. 

OK Adds the package and closes the Add Package group box. 

Cancel Closes the Add Package group box without adding the package. 
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 Execution Timing Setting 

 Execute Immediately 
After Distribution 

Select this option button when executing the package immediately after 
distribution. 

 Execute At Next 
Startup 

Select this when executing the package at the time of the next startup. 
A managed machine before rebooting can execute 100 scenarios 
specified under Execute At Next Startup under Execution Timing 
Setting on the Package tab of the scenario. If you want to execute 101 
or more scenarios, reboot the managed machine. Rebooting allows you 
to execute another 100 scenarios. 
Be careful of the following if Execute At Next Startup is selected. 
・ If you select the Turn Off Power After Scenario Execution under 

the Option tab, the managed machine's power will not turn OFF 
when the update is completed, but will turn OFF after the data 
distribution. 

・ The managed machine will have a scenario execution error if there is 
an update or an application scenario execution during update at next 
startup. Please retry executing the scenario after the update is 
completed. 

 After Operating Setting  

 Restart After Applying  If you select the Restart After Applying checkbox, the managed 
machine will be restarted after the package execution. 
Restart After Applying takes priority in the case of scenarios set only 
on the Package tab, and the managed machine will be restarted after 
the package execution. 

 Distribution Condition Setting 

  Transmit Data By 
Unicast 

Select this to send data by unicast. 
Transmit Data By Unicast is the default. 
Select Transmit Data By Unicast in cases when you cannot send the 
data by multicast such as to perform an update on another network 
segment beyond the router. 
Furthermore, it is not necessary to set the multicast IP for scenarios 
where Transmit Data By Unicast is checked. 

Transmit Data By 
Multicast  

Select this to send data by multicast. The following items are valid.(*1) 
・ Maximum Targets (1-1000)  
・ Maximum Waiting Time (1-1440 minutes)  
・ Multicast IP Address(Package) 
・ Multicast TTL  
・ Maximum Transmission Rate  

 Maximum Targets 
(1-1000)  
 

Set the maximum number of machines on which the scenario is 
executed simultaneously. 
When the machines whose number is specified at this setting are ready, 
the scenario will start. 
This can be set in the range of "1 - 1000". 
The default is blank. 

 Maximum Waiting 
Time (1-1440 
minutes)  
 

Set the maximum wait time when sending data by multicast. This can be 
set in the range of "1 - 1440". 
The default value is "10" minutes. 
If you exceed the Maximum Wait Time, the update will start only on the 
managed machines which are waiting for the file transferring. 
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 Multicast IP 
Address(Package) 
(Required) 

Set the multicast IP address. 
The multicast IP is the IP address specified for the multicast. The 
multicast IP address can be set in the range of "224.0.0.0 - 
239.255.255.255." However, the range of "239.192.0.0 - 
239.255.255.255" is recommended. (*1) 
When you execute two or more scenarios of installing service packs, 
hotfixes, Linux patch files, and applications at the same time, please 
configure not to duplicate the multicast IP address for the each 
scenario. 

 Multicast TTL 
(Required) 

Sets the number for multicast TTL. This can be specified in the range of 
"1 - 127." The default value is "16." (*2) 

 Maximum 
Transmission Rate 
(Required) 

When you select the Maximum Transfer Rate checkbox, you can 
control the scenario transfer rate. 
The maximum transfer rate is set as the maximum data volume in 
MByte that will transfer in 1 minute. This can be set in the range of "1 - 
99999999". The default value is "500" MByte/minute. 
By default, the checkbox is not selected. Set the value to match the 
environment to use. 

*1 
 Multicast is a communication method of using a single packet and sending the same data to two or more 

machines at the same time. With this, you can reduce the traffic on the LAN. 
 Executing packages will wait for until the number of the machines, on which the preparation for execution 

has been completed, equals to the Maximum Targets, or until the Maximum Waiting Time has passed, 
after the scenario execution has been directed. There is no function for immediately executing packages on 
a machine that is in a waiting state. 

 If neither the maximum number of target nor the maximum wait time has been specified, it will immediately 
run without waiting for other computers after the scenario runs. 

*2 
The packet lifetime is indicated in TTL. This value is decremented by 1 each time it passes through the router, 
and it is disposed of once it reaches "0." The packet cannot pass through the router if it is set to "1."  

 
 When you set the Package tab, you cannot set Restore on the Backup/Restore tab. 

 
 When you set also application installation with service packs, hotfixes, or Linux patch files, 

the application is installed after service packs, hotfixes, or Linux patch files are applied. 
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3.13.4. "Backup/Restore" Tab 
Set the Backup/Restore tab of the scenario. 
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Backup/Restore  

 Execute Backup/Restoration  

 (Checkbox)  If you select the checkbox, the backup, restore and disk 
configuration check scenario setting items will be enabled. By 
default, the checkbox is not selected. 

 Backup Select this to create a backup scenario. 

Restore Select this to create a restore scenario. 
You cannot select this with the setting of the OS tab and the 
Package tab at the same time. 

Disk Configuration 
Check  

Select this to create a disk configuration check scenario. 
You cannot set Disk Configuration Check with other setting items 
except Option tab. (*1) 

Image File  
(Required) 

Set the backup image name of backup/restore scenario and the 
stored location. Enter the file path including the file extension (.lbr) 
in the Image File column, or click Browse and specify the backup 
image file. If you select backup and do not enter the file extension 
(.lbr), it will automatically be added. 
・ If entering the file path, the number of characters that can be 

entered for backup/restore are as follows. 
- Backup: 120 characters or less 

* The above number of characters is the maximum number of 
characters when all of the Machine Name/MAC 
Address/UUID checkboxes are selected. In other cases, 
128 characters or less can be entered. 

- Restore: 236 characters or less 
* The above number of characters is the maximum number of 

characters when either of the Machine Name/MAC 
address/UUID checkbox is selected. If any of them are not 
selected, 260 characters or less can be entered. 

・ Alphanumeric characters and symbols can be entered for both 
backup and restore. The following symbols cannot be used. 
/ * ? < > | ; : " 

・ When specified using Browse  
- This can be selected when entering a check in the backup or 

restore checkbox. 
- You cannot specify a folder that does not exist. A scenario 

error will occur when the backup scenario runs if the folder that 
does not exist is specified. 

Also, if the stored location of the backup image file is a drive 
formatted by FAT format, you can only create a backup image file 
that is less than 4GByte(2GByte for FAT16) based on the system 
limitations. 
Also, if checks are entered for Machine Name, MAC Address 
and UUID at the time the backup scenario is created, select the 
same checkboxes when creating the restore scenario. If you 
select the Machine Name, MAC Address and UUID, they will be 
added to the backup image file name. If you do not check the 
same boxes, a restore file will be specified with a different name 
than the backup file and the restore cannot be executed.(*2) 
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   Browse  Specify the backup image file of the backup scenario or the restore 
scenario from Browse. 
When you click Browse, the Image File Setting screen appears. Select 
the backup image file (.lbr). 
Or, enter the backup image file name in the Image File Name column. 

 

Machine Name If you select the Machine Name checkbox, the machine name will be 
automatically added to the backup image file name. 
Example) BackUp_Server01.lbr 

An underscore will be added between the backup image file name 
(BackUp) and the machine name (Server01). 
Also, the Machine Name, MAC Address and UUID will be added in 
order if two or more items of the Machine Name, MAC Address and 
UUID are specified. 

You can select the checkbox in the following cases. 
・ When creating a backup scenario or a unicast restore scenario  
・ When the machine of the backup and the restore target are the same  
If there are the machines which have the same machine name, set this 
item by the combination of MAC Address and UUID. 

   MAC Address If you select the MAC Address checkbox, the MAC address will be 
automatically added to the backup image file name. 
Example) BackUp_00-16-57-1a-b2-47.lbr  

An underscore will be added between the backup image file name 
(BackUp) and the MAC address (00-16-57-1a-b2-47). 
Also, the Machine Name, MAC Address and UUID will be added in 
order if two or more items of the Machine Name, MAC Address and 
UUID are specified. 

You can select the checkbox in the following cases. 
・ When creating a backup scenario or a unicast restore scenario  
・ When the machine of the backup and the restore target are the same 
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   UUID If you select the UUID checkbox, the UUID will be automatically added to 

the backup image file name. 
You can select the checkbox in the following cases. 
・ When creating a backup scenario or a unicast restore scenario  
・ When the machine of the backup and the restore target are the same  

Comment Comments about the backup image file can be added as information. 
638 characters or less can be entered. 
Alphanumeric characters and symbols can be entered. 
This is optional. 

Backup/Restore Target 

 Disk Number  
(Required) 

Specify the disk number.  
The default value is "1." 
About this setting, be careful about the following. 
・ Execute disk configuration check necessarily and specify the number 

which is displayed in Disk Information(Disk Viewer) screen. (The 
disk number may differ depending on the DPM Version,) See Section 
7.2, "Disk Configuration Check Tool" for details.  

・ Specify this in the range of "1 - 1000". 
・ When you specify two or more disk numbers, specify numbers by 

separating them by comma (,) or specify the range by hyphen (-). 
Example) 

1,3-5,7-9,11 
・ Do not specify duplicated number. 
・ In the case of restore scenario, 

- The disk data in the backup image file is restored to the disk 
number, which is specified in this item, sequentially. 

- When you specify "0", the data of the corresponding disk number 
is out of range of restoration. 

- Specify this matching the number of disks in the backup image file. 
(If it is not matched, a scenario execution error occurs.)(*3) 

Partition Setting(*4) 

 
 
 

Entire Disk  You can select this in case of backup/restore. 
If you select this, the entire disk is backed up or restored. 
When you specify two or more disks in Disk Number, select this. 

Specify  You can select this in case of backup/restore. 
Select this if you specify the partition number. If you select this, Partition 
Number can be specified. 



 

169 

 
   Partition Number 

(1-1000)  
(Required) 

Set the partition number. This can be set in the range of "1 - 1000." The 
default value is "1."  
Usually the Partition number is assigned sequentially from the 
beginning of the disk. If there are hidden partitions or expansion partitions 
on the disk, however, the way in which the numbers are assigned 
changes. 
Execute disk configuration check necessarily and specify the number 
which is displayed in Disk Information(Disk Viewer) screen. See 
Section 7.2, "Disk Configuration Check Tool" for details. 
Also, when you restore by specifying a partition, specify the same place 
as the original backup partition and match the partition size and the type 
of the file system between the original backup partition and the restoring 
partition. 
When you specify two or more disks in Disk Number, this setting is 
invalid. (backup or restoration is executed by entire disk.) 

 Hidden Partition Is 
Disregarded 
(Backup/Restore) 

When you back up or restore specifying the partition number, if you select 
the Hidden Partition Is Disregarded checkbox, the hidden partitions will 
be ignored. By default, the checkbox is selected. 
If you select the Hidden Partition Is Disregarded (Backup/Restore), 
the hidden partitions are not counted. 
Therefore, when the disk is separated into four partitions  
(A) - (D) as the following example, specify "2" as the partition number if 
you want to specify partition (D). 
 
Example) Disk device 

Hidden 
Partition 

(A) 

Normal 
Partition 

(B) 

Hidden 
Partition 

(C) 

Normal 
Partition 

(D) 
Specify the partition number "4" if Hidden Partition Is Disregarded 
(Backup/Restore) is not selected. 
When you back up or restore the entire disk without specifying the 
partition number, this setting is ignored. 

In the case of disk configuration check scenario, hidden partition is 
counted regardless of this setting.(*5) 

 Distribution Condition 
Setting  

The distribution condition setting can be set only if Restore is selected in 
the Execute Backup/Restoration group box. 

 Transmit Data By 
Unicast 

Select this to send data by unicast. The settings can be done only if 
Restore is selected from Execute Backup/Restoration. 
Transmit Data By Unicast is the default. 
Select Transmit Data By Unicast when you cannot send the data by 
multicast such as to execute restoring on another network segment 
beyond the router. 
Furthermore, it is not necessary to set the multicast IP for scenarios 
where Transmit Data By Unicast is checked. 

Transmit Data By 
Multicast  

Select this to send data by multicast. The following settings become valid 
if Restore is selected from Execute Backup/Restoration. 
・ Maximum Targets (1-1000)  
・ Maximum Waiting Time (1-1440 Min.) 
・ Multicast IP Address (Restore) 
・ Multicast TTL  
・ Maximum Transmission Rate  
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  Maximum Targets 

(1-1000)  
Set the maximum number of machines on which the scenario is executed 
simultaneously. 
When the machines whose number is specified at this setting are ready, 
the scenario will start. 
The maximum number of packets can be set in the range of "1 - 1000".  
The machine will wait for the restore if the number of executing scenario 
exceeds the setting. At the time when the restore completes on the 
machine executing restore, if the Maximum Targets or Maximum 
Waiting Time condition is met, or you click Run Now on the 
Backup/Restore Execute List screen, the restore begins on machines 
in a standby state. 
Furthermore, DPM executes UDP communication when data is sent by 
multicast. 
With UDP communication, if a device with a different transmission rate is 
located on the path, a difference occurs in the volume of data transmitted 
between the transmission side and reception side, which can result in 
data transmission failure. 
In this case, the time may take longer until the scenario is completed . 

Maximum Waiting Time 
(1-1440 minutes)  

Set the maximum wait time when sending data by multicast. This can be 
set only when restore is selected. When the wait time specified here 
exceeds, restore will start only on the machines whose status are 
"Restore StandBy". This can be set in the range of "1 - 1440". 
The default value is "10" minutes. 

Multicast IP Address 
(Restore)  
(Required)  

Set the multicast IP address. 
The multicast IP is the IP address specified for the multicast. The 
multicast IP address can be set in the range of "224.0.0.0 - 
239.255.255.255." However, the range of "239.192.0.0 - 
239.255.255.255" is recommended. 
To execute two or more restore scenarios at the same time, set not to 
duplicate the multicast IP address on the each scenario. (*6) 

Multicast TTL  
(Required)  

Sets the number for multicast TTL. This can be specified in the range of 
"1 - 127". The default value is "16." (*7) 

Maximum 
Transmission Rate  
(Required)  

When you select the Maximum Transfer Rate checkbox, you can control 
the transfer rate. 
The maximum transfer rate is set as the maximum data volume in MByte 
that will transfer in 1 minute. This can be set in the range of "1 - 500." 
The default value is "500" MByte/minute. 
By default, the checkbox is not selected. Set the value to match the 
environment to use. 

Backup Setting  

 Full Sector When you select this check box, backup is executed by full sector. 

Data Compression 

 Compress When you create the backup image as compressed data, select this. 

Not Compress When you create the backup image as not compressed data, select this. 

Image Type 

 Disk Copy OS 
Install Image 

When you create the image for OS installation by disk duplication, select 
this. 

Recovery Image When you create the image for recovery, select this. 
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  The Number Of 

Backup Image File 
Generations To Be 
Managed (0-99)  
(Required) 

Sets the generation management number of the backup image file. 
Generation management is a function used to specify the number of 
backup data copy generations you would like to save. 
This can be set in the range of "0 - 99". The default value is "0."  
When you use generation management function, the number of image 
files to be created is the number of generation management + 1. Pay 
attention to free space in HDD where image files are to be stored. 
(*8) 
Example) 

When the number of generation management is 5 and the size of the 
image file is approximate 5GByte, free space of approximate 30GByte 
is necessary at maximum. 

5GByte x (5 + 1) = 30GByte 

Create Verification 
Data 

If you select the Create Verification Data checkbox, the verify data will 
be created. 
Verification data is a function used to verify whether backup data has 
been damaged since the time of backup. 
When restoring, you can check whether or not the backup data is invalid 
(whether data has been damaged and so on) by the Backup Image File 
Verification Tool in advance. 

*1 
About disk configuration or partition configuration which can be checked by disk configuration check scenario, 
there are same restrictions as backup or restore. See Section 2.2.2, "Backup/Restore" in First Step Guide and  
"Support for File System and Disk Type" of Appendix A, "Function Tables" in First Step Guide. Also, for these 
restrictions, a scenario execution error does not occur even when it fails to recognize the disk or the partition. 

 
*2 
 The following warnings are for the case of a restore scenario. 

・ If you select the Machine Name, MAC Address or UUID checkbox, and then change the machine name 
and so on for that machine, you will not be able to continue to manage the backup image for backups 
before the change. For this reason, please remove the check from the Machine Name, MAC Address or 
UUID checkboxes and specify an existing backup image in the Image File Column in order to restore 
an existing backup image. 

・ If you select Transmit Data By Multicast, do not select the Machine Name, MAC Address or UUID 
checkbox. If you select it, a scenario will fail. 

・ If you select Transmit Data By Unicast and select the Machine Name, MAC Address or UUID 
checkbox, the backup image file name will be obtained following the set contents. 

・ When you specify the backup image file which is managed by generations, specify the file name by 
deleting the part of "yyyymmddhhmmss" (the same value with the file path which is specified in Image 
File of the backup scenario). Automatically, the restore scenario is executed by the backup image file 
whose name has the latest date. 

 If you back up without selecting the Machine Name, MAC Address or UUID checkboxes. 
It is not recommended to execute the backup of two or more managed machines with one scenario. If it is 
executed with one scenario, the backup image file will be overwritten. 

 For backup, the backup data is created as a temporary file. The temporary file is renamed by the name 
specified in the scenario when the backup is completed. Therefore, when there is a backup image file 
which was already created, the disk volume is necessary for the size of the existing image file and the 
temporary file. 
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 When specifying the path of an image file in another computer connected to the network 
(hereafter referred to as "file server"), perform the following. 

Example) 
If you use Windows Server 2008/ Windows Server 2008 R2 as the OS of the Management Server and 
file server, configure the following settings: 
Perform the operations indicated in the Steps 1) to 3) below on the Management Server. 
1) Log on to the machine, on which DPM Server is installed, by a user with administrator authority. 
2) From Start, select Management tool, then select Services. Open the following service 

property, select Account in Log On tab, and enter account and its password used when you 
install DPM Server. 

・ DeploymentManager Backup/Restore Management 
・ DeploymentManager API Service 

Also, set on DeploymentManager PXE Management only when Management view -> DPM 
Server icon ->Detail Setting -> DHCP Server tab ->Do Not Use A DHCP Server is selected on the 
Web Console. 
Specify a password that meets the password policy in the case of Windows Server 2008 and 
Windows Server 2008 R2. 
The following important notes are for the file server. 

・ Create a user with the account and the password used when DPM Server was installed on the 
file server. 

・ Configure that the account indicated here has access rights with full control to the Folder for 
Image on the file server. 

3) Restart services you changed the settings in Step 2). 
 

Perform the operations indicated in the following Steps 4) to 6) on the file server. 
4) Log on using an account with administrator authority. 
5) Create a Folder for Backup Image by Explorer and so on to save backup image files. 
6) Add an account that has administrator authority configured in Step 2) to permit the access to the 

Folder for Backup Image that is created in Step 5). 
 

Perform the following 7) to 8) on the Web Console. 
7) When creating a scenario, enter the file path under the folder created in Step 5) for the Image 

File of Backup/Restore tab. For the path of the folder of image file, enter a UNC (Universal 
Naming Convention) format (\\Machine Name\ 
Folder for Backup Image\Sub-folder) path name in Image File. 

8) Execute the scenario 
 You cannot perform registration or deletion of image file at the same time as creating or editing a scenario. 

Do not operate Image Builder if the scenario creation/editing screen is open. 
*3 
 When you change the configuration of the disk which is connected to the managed machine, the disk 

number may change. When you change the configuration of the disk, execute disk configuration check 
and reconfirm the disk number. 
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 If any one of the following is relevant, back up all disks in which necessary data are stored. Until the 

backup or restore of all disks are completed, make sure that the OS does not start up. In order to prevent 
the OS from starting up when the scenario is executed, select the Turn Off Power After  
Scenario Execution from Option tab. 

・ If the backup source and restoring destination are located in different devices. 
・ The data required for OS startup are stored over two or more disks 
・ If the data required for OS startup and the data required for OS installation by disk duplication 

(Windows: sysprep, Linux: /opt/dpmclient) are stored over two or more disks 
・ When files, needed as the system, are stored in a different HDD. 
・ When disks are connected over two or more disks or two or more partitions, such as mounting other 

drives. 
・ When it is necessary to have consistency in the data between disks or partitions (dynamic disk, 

LVM1/LVM2 and so on) 
*4 

About the range that you can recover by backup/restore function for logical failure or physical failure of hard 
disk, see "Regarding the range that can be recovered with the backup/restore function in response to a 
physical defect or logical defect with a hard disk" in Section 2.2.2, "Backup/Restore" in First Step Guide. 

*5 
 Systems, depending on the manufacturer, may not recognize a maintenance partition as a hidden 

partition. 
Example) 

The maintenance partition used by the EXPRESSBUILDER for Express5800 series is not  
recognized as a hidden partition. 

 The partition number is assigned in the order of primary partitions and then logical drives in extended 
partitions. (There may be difference between the order which is managed by DPM and the order which is 
displayed in Disk Management of Windows OS.) 
Example) 

When the disk configuration is as the following, partition (A) is "1," logical drive (B) of the extended 
partition is "3," logical drive (C) of extended partition is "4" and partition (D) is "2." 

 

Primary Partition 
(A) 

Extended Partition 
Logical Drive (B) Logical Drive (C) 

 

Primary Partition 
(D) 

*6 
Multicast is a communication method of using a single packet and sending the same data to two or more 
machines at the same time. With this, you can reduce the traffic on the LAN. 

*7 
TTL means the packet lifetime. This value is decremented by 1 each time it passes through the router, and it is 
disposed of once it reaches "0." The packet cannot pass through the router if it is set to "1." 

*8 
 If you are doing generation management, a time stamp (year/month/day/hour/minute/second) which is the 

time of creating the backup image file is added to the name of the file. 
 

・ If The Number Of Backup Image File Generations To Be Managed is 0 
The timestamp is not added to the backup image file name. If the backup image file name specified 
by the scenario exists before backup, the backup image file will be deleted. 

 
・ If The Number Of Backup Image File Generations To Be Managed is 1 or higher 

If the backup image file name specified by the scenario exists before backup, the update time for this 
backup image file is obtained and a timestamp is added to the backup image file name for generation 
management. 
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 For a scenario that the generation management is disabled, if you change it to enabled on 

operation, a timestamp will be added to the backup image file name from the time of the next 
backup. 
In this case, the previous backup images that were created when generation management was 
disabled will be renamed adding a time stamp when the scenario was executed. 

 
 If the generation management is enabled and there is already a backup image with the same 

file name including the time stamp, the backup image file will not be overwritten, but a scenario 
error will occur. 

 
 If backup exceeds the specified number of times, the oldest image file is deleted automatically. 

Example)  
If 10 backup data except the latest backup data should be saved, enter "10." If you execute the backup, 
the backup image file, whose name is <Specified file name>timestamp.lbr, is saved. 

 
 You can only select the Machine Name, MAC Address and UUID checkboxes if the machine 

to backup and the machine to restore are the same. 
・ You can select the checkbox in the following case. 

- Backup/restore (for the same machine) 
・ You cannot select the checkbox in the following case. 

- OS installation by disk duplication 
- Backup/restore (for different machines ) 

 
  You cannot set OS tab or Package tab at the same time in the restore scenario. 

 When you decreased the number of The Number Of Backup Image File Generations To 
Be Managed, the backup image file is deleted from the oldest one automatically. 
Example) When you changed from "10" to "3" in The Number Of Backup Image File 
Generations To Be Managed and executed backup, 7 files from the oldest backup image 
file are deleted automatically. 
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3.13.5. "Option" Tab 
Set the Option tab of the scenario. 
You can control the power status of the managed machines before and after the scenario execution from the 
Options tab. 
 

 
 
Option  

 Scenario Execution Option Setting  

 Forced Execution Of A 
Reboot Is Performed 
Before Execution  

When all following conditions are met, the managed machine is restarted 
before the scenario is executed if you select the Forced Execution Of A 
Reboot Is Performed Before Execution checkbox. 
・ DPM Client is installed on the managed machine  
・ You use either of the following functions  

- Backup  
- Restore  
- Disk configuration check 
- OS clear installation  
- Distribution of floppy disk image for BIOS/firmware 

Turn Off Power After 
Scenario Execution  

If you select the Turn Off Power After Scenario Execution checkbox, 
the managed machine will be powered OFF after the scenario execution. 

OK The scenario is added using the setting from the Add Scenario screen 
and it returns to the previous window. 

Cancel Returns to the previous window without adding the scenario using the 
setting from the Add Scenario screen. 
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  Be sure to select the Forced Execution Of A Reboot Is Performed Before Execution to 

execute the scenario on the machine on which OS is running. However, if you are 
executing a remote update (independently installing service packs, Installing service 
packs, hotfixes, Linux patch files, and applications) scenario, it is not a problem if the OS 
is running, so you do not need to select the Forced Execution Of A Reboot Is 
Performed Before Execution. The machine will not restart even if you select it and the 
scenario runs. 

 If the Windows managed machine has the following status, you cannot shut down, even if 
you select the Forced Execution Of A Reboot Is Performed Before Execution. 
・ The machine is locked by a workstation lock. 
・ The machine is locked with a screensaver with a password  
・ The machine is connected to Remote Desktop, Terminal Service, or other remote 

connection software  
・ There is data that is being edited or there is an application that does not respond to a 

shutdown request. 
 

3.14. Menu Operations for a Scenario 
The menus related to the operations for the scenario will be explained. 
 

3.14.1. Edit Scenario 
Edit a scenario. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click the Resource icon -> Scenarios icon -> Scenario Group icon. 

 
(3) The Scenario List group box appears in the main window, then click the Scenario Name to Edit. 

 
(4) The Configuration menu for the Scenarios icon will be displayed, then click Edit Scenario. 

 
(5) The Edit Scenario screen appears in the main window. Edit each item. 

 
You can also display the Edit Scenario screen by the following steps. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click the Resource icon -> Scenarios icon -> Scenario Group icon. 

 
(3) The Scenario List group box appears in the main window, then click the Edit icon( ) for the scenario to 

edit. 
 
(4) The Edit Scenario screen appears in the main window. Edit each item. 
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Edit Scenario  

 Group Name Displays the scenario group name. This cannot be edited. 

Scenario Name  Displays the scenario name. This cannot be edited. If you want to edit 
it, re-create the same scenario and specify another scenario name. 

OK Saves the settings details from the Edit Scenario screen and returns 
to the previous window. 

Cancel Returns to the previous window without saving the setting on the Edit 
Scenario screen. 

 
 See Section 3.13.1, "HW Settings Tab" - Section 3.13.5, "Option Tab" regarding editing each 

tab. 
 

3.14.2. Copy Scenario 
Copy a scenario. 
See Section 3.12.7, "Copy Scenario" for details. 
 

3.14.3. Move Scenario 
Move a scenario. 
See Section 3.12.6, "Move Scenario" regarding the details. 
 

3.14.4. Delete Scenario 
Delete a scenario. 
See Section 3.12.8, "Delete Scenario" for details. 
 

3.14.5. Assign Scenario 
Assign a scenario. 
See Section 3.12.9, "Assign Scenario" for details. 
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3.15. Scenario Detail Information 
Displays the scenario detail information. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click the Resource icon -> Scenarios icon -> Scenario Group icon. 

 
(3) The Scenario List group box appears in the main window. Then click the Scenario Name. 

 
(4) Displays the Scenario Detail, Option and Machine List group box in the main window. 
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Scenario Detail 

 Scenario Name Displays the scenario name. This cannot be edited. 

Scenario Group Name Displays the scenario group name. This cannot be edited. 

Type Displays either of the following types. 
・ Disk Configuration check 
・ Restore 
・ Backup 
・ Package 
・ OS 
・ HW setting 
The displayed type and the setting are shown in the Scenario Detail 
group box. 

HW Setting If HW Setting is displayed in the Type column, HW Setting will be 
displayed in the Scenario Detail group box. 
The image file name set in the Add Scenario screen -> HW Setting 
tab will be displayed. 

 Image File Name Displays the image file name. 

OS Install If OS is displayed in the Type column, OS Install will be displayed in the 
Scenario Details group box. Only the status set in the Add Scenario 
screen -> OS tab will be displayed. 

 OS Name Displays the OS name. 

OS Type Displays the OS category. 

Setup Parameter File Displays the setup parameter file. 

Backup If Backup is displayed in the Type column, Backup will be displayed 
on the Scenario Details group box. The backup scenario will be 
created by specifying on the Add Scenario screen -> Backup/Restore 
tab and only the set status will be displayed. 

 Image File Displays the backup image file of the backup scenario. 

Image File Comment Displays comments that are entered in the Comment column. 

Full Sector Displays the setting status of full sector. 

Disk Number Displays the disk number. 

Partition Setting Displays the partition settings. 
When two or more disk numbers are displayed in Disk Number, this 
item is not displayed. 

A Hidden Partition Is 
Disregarded 

Displays whether a hidden partition will be disregarded. 

Compress Data Setting Displays whether to compress the data. 

The Number Of Backup 
Image File Generations 
To Be Managed 

Displays the number of the backup image file generation to be 
managed. 

Create Verification Data Displays whether to create the verify data. 
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 Restore If Restore is displayed in the Type column, Restore will be displayed 

on the Scenario Details group box. The restore scenario will be 
created by specifying on the Add Scenario screen -> Backup/Restore 
tab and only the set status will be displayed. 

 Image File Displays the backup image file of the restore scenario. 

Full Sector Displays the setting status of full sector. 

Disk Number Displays the disk number. 

Partition Setting Displays the partition settings. 
When two or more disk numbers are displayed in Disk Number, this 
item is not displayed. 

A Hidden Partition Is 
Disregarded 

Displays whether a hidden partition will be ignored. 

Distribution Condition 
Setting 

Displays "Transmit Data Using Unicast" or "Transmit Data Using 
Multicast".  

Maximum Targets Displays the maximum number of targets. 
When "Transmit Data Using Unicast" is displayed in Distribution 
Condition Setting, this item is not displayed. 

Maximum Waiting Time Displays the maximum wait time. The unit is minute. 
When "Transmit Data Using Unicast" is displayed in Distribution 
Condition Setting, this item is not displayed. 

Multicast IP Address 
(Restore) 

Displays the multicast IP address. 
When "Transmit Data Using Unicast" is displayed in Distribution 
Condition Setting, this item is not displayed. 

Multicast TTL Displays the number for multicast TTL. 
When "Transmit Data Using Unicast" is displayed in Distribution 
Condition Setting, this item is not displayed. 

Maximum Transmission 
Rate 

Displays the maximum transfer rate. The unit is MByte/minute. 
When "Transmit Data Using Unicast" is displayed in Distribution 
Condition Setting, this item is not displayed. 

Package If Package is displayed in the Type column, Package will be displayed 
on the Scenario Details group box. Only the status set in the Add 
Scenario screen -> Package tab will be displayed. 

 Package Name Displays the name of service packs/hotfixes/applications. 

Execution Timing 
Setting 

Displays the scenario execution timing. 

After Operating Setting Displays if DPM Client is restarted after package execution. 

Distribution Condition 
Setting 

Displays "Transmit Data Using Unicast" or "Transmit Data Using 
Multicast". 

Maximum Targets Displays the maximum number of targets. 
When "Transmit Data Using Unicast" is displayed in Distribution 
Condition Setting, this item is not displayed. 

Maximum Waiting Time Displays the maximum wait time. The unit is minute. 
When "Transmit Data Using Unicast" is displayed in Distribution 
Condition Setting, this item is not displayed. 
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Multicast IP Address 
(Package) 

Displays the multicast IP address. 
When "Transmit Data Using Unicast" is displayed in Distribution 
Condition Setting, this item is not displayed. 

Multicast TTL Displays the number for multicast TTL. 
When "Transmit Data Using Unicast" is displayed in Distribution 
Condition Setting, this item is not displayed. 

Maximum Transmission 
Rate 

Displays the maximum transfer rate. The units is MByte/minute. 
When "Transmit Data Using Unicast" is displayed in Distribution 
Condition Setting, this item is not displayed. 

Option 

 Forced Execution Of A 
Reboot Is Performed 
Before Execution  

Displays whether the managed machine is rebooted forcibly before the 
scenario execution. 

Turn Off Power After 
Scenario Execution  

Displays whether the managed machine is powered off after the 
scenario execution. 

Machine List  

 Display Count Select the number of items to be displayed in the list. 

Machine Name Displays the Identification Name of the managed machine that the 
scenario is assigned. (Displays the machine name when the 
Identification Name is not specified.) 

IP Address  Displays the IP address of the managed machine that the scenario is 
assigned. 

MAC Address Displays the MAC address of the managed machine that the scenario is 
assigned. 

Group Name Displays the name of the group, in which the managed machine that the 
scenario is assigned is registered. 

 

3.16. "Images" Icon 
You can manage the different types of image information such as package, backup image, HW image or OS 
image from the Images icon. 
You can access the Images icon from the Images icon at the top of the Operations view tree view or from the 
Images icon in the Summary Information group box displayed in the Operations view main window. 
Click the Images icon to display the Search Conditions and Image List group boxes in the main window. 
See Section 3.17, "Image Detailed Information" regarding the screen. 
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3.17. Image Detailed Information 
Displays the detailed information for the each image, the package, backup image, HW image and OS image. 
 

(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 
 

(2) In the tree view, click the Resource icon -> Images icon. 
Or, the Summary Information group box appears in the main window. Click Images. 

 
(3) The Search Conditions and Image List group box appears in the main window. 
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Search Conditions  

 Image Type  Select the search image type. You can select from the following. 
・ All Type  
・ HW Image  
・ OS Image  
・ Package  
・ Backup Image  
The default is All Type. 
If you select Package or Backup Image, You can search the image 
that meets the conditions that you specified. The condition that can 
be specified varies depending on Package or Backup Image. 
・ Package  

OS, Type, Date 
・ Backup image  

Date, Machine Name 

OS  If you search by OS type, you can select the type of OS to search. 
The default is "All OS." 
About the backup image, only the backup image which is saved in 
the Folder for Backup Image is the target to search. 
About the Folder for Backup Image, see Section 2.7.1.1, "General 
Tab." 

Type  If you search by type, you can select the type of package to search. 
You can select from the following. 
・ All Type  
・ HotFix 
・ Service Pack 
・ Linux Patch 
・ Application 
The default is All Type. 

Date If you search by date, you can enter the start date and the end date 
to search. 
You can enter the date (year/month/day) or select the date from the 
displayed calendar by clicking the " " icon on the side of the 
textbox. 
When you enter a date, use YYYY/MM/DD format. 
・ If you specify only the start date, it will search with the search condition 

of dates after the start date. 
・ If you specify only the end date, it will search with the search condition of 

dates up to the end date. 
・ If you specify the start date and end date, it will search with the 

search condition within the specified period. 

Machine Name Enter the machine name to search by the machine name. 
63 characters or less can be entered. 
Alphanumeric characters and symbols can be entered. 

Search If you click Search, images will be searched with the specified 
search conditions. 
The search results will be displayed in the Image List group box. 
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Image List  

 Display Count Select the number of items to be displayed in the list. 

Image Name  Displays the image name. 
You can check the basic information for the Package and Backup 
Image by clicking on the image name. 
See Section 3.17.1, "Package Image Detailed Information" 
regarding the Package. 
See Section 3.17.3, "Backup Image Detailed Information" regarding 
the Backup Image. 
You cannot click the image name for a HW Image or an OS Image. 

Summary Displays the summary of the image. 

Image Type  Displays the image type. 

Date Displays the date and time that the image is created. 

Applying Status  If the Image Type is Package, a ">>" will be displayed in the 
Applying Status column. 
Click >> to display the Package Applying Status (Machine List) 
screen in the main window. See Section 3.17.2, "Package Applying 
Status (Machine List)" regarding the screen. 
If the Image Type is other than Package, the Applying Status will 
be blank. 

 

3.17.1. Package Image Detailed Information 
Displays the package image detail information. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click the Resource icon -> Images icon. 

 
(3) The Image List group box appears in the main window. Then click the Image Name. 

 
(4) Displays the Base Information and Applicable OS and language group box in the main window. 

 
You can also display the package image basic information screen by the following steps. 
 
(1) The Summary Information group box appears in the main window. Click the Packages icon. 

 
(2) The Image List group box appears in the main window. Then click the Image Name. 
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(3) Displays the Base Information and Applicable OS and language group box in the main window. 

 

 
 

Base Information 

 Package Name Displays the package name. 

Summary Displays the summary of the package. 

Type  Displays the package type. 

Release Date Displays the package released date. 

MS Number Displays the MS Q Number or the KB number for hotfixes or service 
packs. 

Major Version Displays the major version of the service pack. 

Minor Version Displays the minor version of the service pack. 

Application Name Displays the application name of the package. 

Applicable OS and language 

 OS Name Displays the name of the OS that is the target of the package. 

Language Displays the OS language that is the target of the package. 

Base Service Pack Displays the list of the Base Service Pack. 

Absorbing Service Pack Displays the list of the Absorbing Service Pack. 
 

3.17.2. Package Applying Status (Machine List) 
Display the Package Applying Status (Machine List). 
The package applying status is only displayed for Windows OS packages. Linux OS packages are not displayed. 
 
(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 

 
(2) In the tree view, click the Resource icon -> Images icon. 

 
(3) The Image List group box appears in the main window. Then click ">>" in Applying Status. 
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(4) Displays the Base Information and Package Applying Status (Machine List) group box in the main 
window. 

 
You can also display the Package Applying Status (Machine List) screen by the following steps. 
 
(1) The Summary Information group box appears in the main window. Click the Packages icon. 

 
(2) The Image List group box appears in the main window. Then click ">>" in Applying Status. 

 
(3) Displays the Base Information and Package Applying Status (Machine List) group box in the main 

window. 
 

 
 

Package Applying Status(Machine List)  

 
 

Base Information  

 Package ID  Displays the package ID. 

The Number Of  
Machines  Displays the number of managed machines related to the package. 

Applied  Displays the number of the managed machines that the package was 
applied. 

Not Applied  Displays the number of the managed machines that the package was 
not applied. 

Unnecessary  Displays the number of the managed machines that it is unnecessary 
to apply the package. 

Unrecognized Displays the number of the managed machines that the applying 
status of the package cannot be recognized. 

Package Applying Status(Machine List)  

 Display Count Select the number of items to be displayed in the list. 

Group Name Displays the name of the group that the managed machine is 
registered. 
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Machine Name Displays the identification name of the managed machine. (When the 
identification name is not specified, the machine name is displayed.) 

MAC Address Displays the MAC address of the managed machine. 

Applied Status  Displays the applied status of the package. 
See Section 3.7.1.2, "Package Applying Status (Package List)" for 
details on the applied status. 

 

3.17.3. Backup Image Detailed Information 
Display the backup image detailed information. 
 

(1) On the Web Console, click Operations in the title bar to switch to the Operations view. 
 

(2) In the tree view, click the Resource icon -> Images icon. Or in the Summary Information group box in 
the main window, click Images -> Backup Images. 
 

(3) The Image List group box appears in the main window. Then click the Image Name. 
 

(4) The Image Base Information Of Image, Original Base Information and Original Applied Packages 
group boxes are displayed. 
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Base Information Of Image  

 Image Name  Displays the folder for backup image and image file name. 

Create Date Time  Displays the date when the backup image was created. 

Disk Number  Displays the disk number. 

Partition Number  Displays the partition information. 

Compress Or Not Displays if the backup image is compressed or not. 

Image Type Display the type of the backup image. 
When the backup image was created in the version earlier than DPM 
Ver6.31, "Unknown" is displayed. 

Specify Verification Data 
Or Not  

Displays if the backup image verify data exists or not. 

A Hidden Partition Is 
Disregarded Or Not  

Displays whether hidden partitions will be ignored or not. 

Backup Execution Time  Displays the time taken for backup execution. 

Image File Size  Displays the image file size. 

Specify Full Sector Or Not  Displays the setting status of full sector. 

Product Version (DPM 
Server)  Displays the DPM version of the Management Server. 

Original Base Information  

 Machine Name Displays the name of the machine from which the backup image was 
created. 

Summary Displays the comment of the backup image. 

IP Address  Displays the IP Address of the machine that the backup image was 
created. 

MAC Address Displays MAC address of the machine that the backup image was 
created. 

UUID Displays UUID of the machine that the backup image was created. 

OS Name  Displays OS Name of the machine that the backup image was 
created. 

Original Applied Packages 

 Display Count Select the number of items to be displayed in the list. 

Package Name Displays the package name. 

Summary Displays the summary of the package. 

Type  Displays the package type. 
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4. Monitor 
 

4.1. "Monitor" view 
In the Monitor view, you can monitor the information necessary to use DPM, such as scenario execution status, 
automatic update status, file distribution status, file deletion status, and so on.  
 
When you click Monitor in the title bar, the screen will switch to the Monitor view. The Monitor Function List 
group box appears in the main window. 
 

 
 

4.2. "Scenario Execution List" Icon 
You can view the execution status list for Scenario Execution on the DPM, and batch clear the abnormal 
statuses. 
You can access the Scenario Execution List icon from the Scenario Execution List icon at the top of the 
Monitor view tree view or from Scenario Execution List in the Monitor Function List group box displayed in 
the Monitor view main window. 
Click the Scenario Execution List icon to display the Scenario Execution List group box in the main window. 
See Section 4.3, "Scenario Execution List" regarding the screen. 
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4.3. Scenario Execution List 
Display the Scenario Execution List screen by the following procedure. 
 
(1) On the Web Console, click Monitor in the title bar to switch to the Monitor view. 

 
(2) In the tree view, click the Scenario Execution List icon. Or in the Monitor Function List group box in the 

main window, click Scenario Execution List. 
 

(3) The Scenario Execution List group box appears in the main window. 
 

 
 
Scenario Execution List 

 Display Count Select the number of items to be displayed in the list. 

Status The scenario execution status can be selected and displayed from 
the following three types. 
・ All Status 
・ Normal Status 
・ Error Status 
Select Normal Status to check the running status. 
The default is All Status. 

Machine Name Displays the identification name of the managed machine that the 
scenario is running or completed. (When the identification name is 
not specified, the machine name is displayed.) When you click the 
name, the Operation view - Machine Detail group box appears. 
See Section 3.7, "Managed Machine Details" regarding the 
Machine Detail. 

IP Address Displays the IP address of the managed machine that the scenario 
is running or completed. This will be blank for managed machines 
without IP address information. 

MAC Address Displays the MAC address of the managed machine that the 
scenario is running or completed. 
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 Group Name Displays the group name of the managed machine that the scenario 

is running or completed. If the group is layered, the parent group 
name for the managed machine that is running the scenario or has 
completed scenario execution is displayed. 
When you click the group name, the Operation view - Group 
Detail group box appears. See Section 3.5, "Machine Group 
Details" regarding the Group Detail group box. 

Scenario Name Displays the name of the running scenario or the completed 
scenario. 

Status Displays the status of the managed machine that the scenario is 
running or completed. (*1) 

Execute Status Progressing status of the scenario execution is displayed in the 
progress bar(0% - 100%). 

Detail In the case of the scenario of backup, restore, and OS installation 
by disk duplication, when the progressing status of backup or 
restore can be confirmed, ">>" is displayed in the Detail column. In 
the case of other scenarios, it is blank. 
If you click ">>", the Backup/Restore Execute List screen 
appears. See Section 4.3.2, "Backup/Restore Execute List" 
regarding the screen. 

*1 
The content, which is displayed in the Status column, is as follows. 
Execute Status Description 

Backup Under preparation This is displayed when backup is in preparation. 

Backup Standby mode This is displayed when backup is in waiting status. 

Backup Running This is displayed when backup is being executed. 

Backup Successful 
completion 

This is displayed when backup was completed normally. 

Backup Verifying This is displayed when verify data of the backup scenario is being 
created. 

Backup Stop processing This is displayed when backup is being stopped. 

Backup Error stops 
processing 

This is displayed when backup is being stopped by error. 

Backup Stop This is displayed when backup was stopped by user. 

Backup Error stop This is displayed when backup was stopped by error. 

Backup Pausing This is displayed when backup is being stopped temporarily. 

Restore Under preparation This is displayed when restoring is in preparation. 

Restore Standby mode This is displayed when restoring is in waiting status. 

Restore Running This is displayed when restoring is being executed. 

Restore Successful 
completion 

This is displayed when restoring was completed normally. 

Restore Stop processing This is displayed when restoring is being stopped. 

Restore Error stops 
processing 

This is displayed when restoring is being stopped by error. 

Restore Stop This is displayed when restoring was stopped by user. 
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Restore Error stop This is displayed when restoring was stopped by error. 

Restore Pausing This is displayed when restoring is being stopped temporarily. 

Scenario Executing This is displayed when the scenario(except backup and restore) is 
being executed. 

Scenario Execution Stop This is displayed when the running scenario was stopped. 

Scenario Execution Error This is displayed when a scenario execution error occurred. 

Remote Power ON Error This is displayed when the remote power on of the managed 
machine was failed. 

Execution Completed This is displayed when scenario execution was completed. 
 

4.3.1. Batch Clear Status 
Batch clear the status for scenarios run by DPM. 
 
(1) On the Web Console, click Monitor in the title bar to switch to the Monitor view. 

 
(2) In the tree view, click the Monitor icon -> Scenario Execution List icon. Or in the Monitor Function List 

group box in the main window, click Scenario Execution List. 
 

(3) In the Operation menu, click Batch Clear Status. 
 

(4) The Status Clear screen appears in the main window. Then select the status information to be cleared. 
 

(5) Click OK. 
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Clear Status Information 

 Scenario Execution 
Completed 

The status when scenario is completed. 

Scenario Execution Stop  The status when scenario is interrupted. 

Scenario Execution Error  The status when there is a scenario execution error. 

Remote Power ON Error The status when there is a remote power on error. 

OK The selected statuses will be cleared collectively and it returns 
to the previous window. 

Cancel Returns to the previous window without clearing the selected 
statuses. 

 

4.3.2. Backup/Restore Execute List 
Manage the backup/restore scenario execution status. 
 
(1) On the Web Console, click Monitor in the title bar to switch to the Monitor view. 

 
(2) In the tree view, click Scenario Execution List. Or in the Monitor Function List group box in the main 

window, click Scenario Execution List. 
 

(3) The Scenario Execution List group box appears. Click ">>" in the Details column. 
 

(4) The Backup/Restore Execute List screen appears in the main window. 
Depending on unicast or multicast, the information that will be displayed in the Backup/Restore Execute 
List screen differs. 
 
<Data is transferred using unicast> 
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Machine Information 

 
 

Machine Name Displays the identification name of the managed machine 
(When the identification name is not specified, the machine 
name is displayed.) 

IP Address  Displays the IP address of the managed machine. 

MAC Address Displays the MAC address of the managed machine. 

Group Name Displays the group name to which the managed machine 
belongs. 

Execution Progress 

 Scenario Name  Displays the scenario name. 

Type  Displays Backup or Restore (Unicast). 

Transfer Disk Number Displays the processing status of the disk (the disk number of 
the disk which is being processed/the total number of disks). 
When the disk is being verified, "Transfer Verify" is displayed. 

Progress Status  Displays the progressing status of the scenario execution for 
each disk in the progress bar (0% - 100%). 
Displays also the progressing status of verifying the disk by 0% - 
100%. 

Start Time  Displays the scenario start time. 

Execution Lapsed Time  Displays Execution Lapsed Time while a scenario is being 
executed. 
Displays Scenario End Time when the scenario execution is 
completed. 

Transfer Size (MB)  Displays the transfer size(the size which was already 
transferred/whole size) by MByte(MB). When you verify the disk, 
the size which was already verified/whole size is displayed. 
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<Data is transferred using multicast> 

 
 
Machine Information  

 
 

Machine Name Displays the identification name of the managed machine. (When 
the identification name is not specified, the machine name is 
displayed.) 

IP Address  Displays the IP address of the managed machine. 

MAC Address Displays the MAC address of the managed machine. 

Group Name Displays the group name to which the managed machine belongs 

Execution Progress 

 Scenario Name Displays the scenario name. 

Type  Displays Restore(Multicast) 

Transfer Disk Number Displays the processing status of the disk (the disk number of the 
disk which is being processed/the total number of disks). 

Progress Status Displays the progressing status of the scenario execution in the 
progress bar (0% - 100%). 

Start Time Displays the scenario start time. 

Execution Lapsed Time Displays Execution Lapsed Time while a scenario is being 
executed. 
Displays Scenario End Time when the scenario execution is 
completed. 

Transfer Size (MB) Displays the transfer size(the size which was already 
transferred/whole size) by MByte(MB). 
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Multicast Execution Progress 

 Start Target Number Displays the number of managed machines until starting the 
scenario execution  
The scenario will start when the number of managed machines 
reaches the Start Target Number. 

Current Target Number Displays the number of managed machines ready for scenario 
execution. 
The scenario execution will start when this number reaches the 
Start Target Number or the Remainder Time has been 
exceeded. 

Remainder Time(Min.) Displays the time left until the scenario execution starts. 
Displayed by one minute increments. 

Multicast Machine List 

 Display Count Select the number of items to be displayed in the list. 

Machine Name Displays the identification name of the managed machine that the 
scenario is running or completed. (When the identification name is 
not specified, the machine name is displayed.) 

MAC Address Displays the MAC address of the managed machine. 

Group Name Displays the group name to which the managed machine belongs. 

Running Status Displays the scenario progress. (*1) 

Action Link ・ When you click Start Now, scenario will start for all of the 
machines to which the scenario is assigned. 

・ When you click Interrupt Scenario, scenario will be 
interrupted for all of the machines to which the scenario is 
assigned. 

*1 
The content, which is displayed in the Progress Status column, is as follows. 
Execute Status Description 

Restore Standby mode This is displayed when restoring is in waiting status.. 

Restore Running This is displayed when restoring is being executed. 

Restore Successful completion This is displayed when restoring was completed 
normally. 

Restore Stop processing This is displayed when restoring is being stopped. 

Restore Error stops processing This is displayed when restoring is being stopped by 
error. 

Restore Stop This is displayed when restoring was stopped by user. 

Restore Error stop This is displayed when restoring was stopped by error. 

Restore Pausing This is displayed when restoring is being stopped 
temporarily. 

 
 Click Refresh from the Operation menu and refresh the latest information in order to 

check the latest execute status. 
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4.3.3. Start Immediately 
Backup/restore immediately, even if the start conditions are not met. 
 
(1) On the Web Console, click Monitor in the title bar to switch to the Monitor view. 
 
(2) In the tree view, click Scenario Execution List. Or in the Monitor Function List group box in the main 

window, click Scenario Execution List. 
 
(3) The Scenario Execution List group box appears in the main window. Click ">>" in the Detail column. 
 
(4) The Backup/Restore Execute List screen appears. Then click the Start Now on the Action link. 
 
(5) Start the backup or restore immediately, even if the start conditions are not met. 

 
 Start Conditions are not Met indicates that the managed machines that have 

completed the execution preparation have not been reached the maximum number of 
targets or the execution time for the first managed machine for the restore has not 
reached the maximum wait time. 

 
 The execute status in the Backup/Restore Execute List for the managed machine 

that has completed execution preparation will be Waiting Execution. 
 

4.3.4. Scenario Execution Stop 
Stop the scenario at the time of backup/restore. 
 
(1) On the Web Console, click Monitor in the title bar to switch to the Monitor view. 

 
(2) In the tree view, click Scenario Execution List. Or in the Monitor Function List group box in the main 

window, click Scenario Execution List. 
 

(3) The Scenario Execution List group box appears in the main window. Click ">>" in the Detail column. 
 

(4) The Backup/Restore Execute List screen appears. Then click the Interrupt Scenario on the Action link. 
 

  The managed machine, for which you stopped the scenario execution, is powered 
off at the timing of PXE boot after running scenario is stopped. 

 When a scenario is executed on the managed machine over Machines For 
Simultaneous Execution, the processing of the scenario execution stop may be 
executed after the processing of the execution is started on the machine, depending 
on the timing. 

 
 If you click Interrupt Scenario by two or more times, the logs of Stop Execution are 

displayed in Scenario Execution Result List by the number of times you clicked. 
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4.4. "Scenario Execution Result List" Icon 
The Scenario Execution Result List icon displays the list of the scenario execution results which has been 
executed in the DPM. 
You can access the Scenario Execution Result List icon from the Scenario Execution Result List icon at the 
top of the Monitor view tree view or from Scenario Execution Result List in the Monitor Function List group 
box displayed in the Monitor view main window. 
Click the Scenario Execution Result List icon to display the Scenario Execution Result List group box in the 
main window. See Section 4.5, "Scenario Execution Result List Details" regarding the screen. 
 

4.5. Scenario Execution Result List Details 
Display the Scenario Execution Result List screen by the following procedure. 
The Scenario Execution Result List is displayed, sorted by the various items (Type, Date, MAC Address, 
Scenario Name, Machine Name and IP Address). 
 
(1) On the Web Console, click Monitor in the title bar to switch to the Monitor view. 

 
(2) In the tree view, click the Monitor icon -> Scenario Execution Result List icon. Or in the Monitor 

Function List group box in the main window, click Scenario Execution Result List. 
 

(3) The Basic Information and Scenario Execution Result List group box appear in the main window. 
 

 



 

199 

 
Basic Information  

 Scenario Execution Log(s)  Displays the number of scenario execution logs. 
You can confirm logs of the number shown here in 
the following Scenario Execution Result List group 
box. 

Scenario Execution Result List  

 Display Count Select the number of items to be displayed in the list. 

Type  Displays the scenario execution status. (*1) 

Date  Displays the scenario date and time. 

Scenario Name  Displays the scenario name. 

 Machine Name Displays the machine name of the managed 
machine. 
Furthermore, if it is upgraded from a version earlier 
than DPM Ver6.0, the machine name will not be 
displayed in the result of scenario executed before 
the upgrade. 

IP Address  Displays the IP address. 
Furthermore, if it was upgraded from a version earlier 
than DPM Ver6.0, the IP address will not be 
displayed in the result of scenario executed before 
the upgrade. 

MAC Address Displays the MAC address of the managed machine 
on which the scenario was executed. 
When you click the MAC address, the Operation 
view - Machine Detail group box appears. 
See Section 3.7, "Managed Machine Details" 
regarding the Machine Detail group box. 

*1 
 The displayed scenario execution results list status can be the following types. 

Type  Description 

Stop Execution This is displayed when the scenario execution is 
interrupted. 

Interrupt The Time Out This is displayed when the timeout time set in the 
Management view -> DPM Server -> Detail 
Settings -> Scenario tab is exceeded. 
Interrupt The Time Out is displayed only in the 
case of Hardware Setting or Linux Installation 
scenario execution. 

Start Execution This is displayed when the scenario execution 
starts. 

Completed Execution  This is displayed when the scenario execution is 
completed. 

Error This is displayed when an error occurs during the 
scenario execution. 

 
 Remove the error if there is a scenario execution error. See Section 3.8.8, "Error 

Cancellation" about removing the error. 
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4.5.1. Save in CSV Format 
The scenario execution results are saved in the CSV format. 
 
(1) On the Web Console, click Monitor in the title bar to switch to the Monitor view. 

 
(2) In the tree view, click the Monitor icon -> Scenario Execution Result List icon. Or in the Monitor 

Function List group box in the main window, click Scenario Execution Result List. 
 

(3) The Operation menu for the Scenario Execution Result List icon will be displayed, then click Save In 
CSV. 
 

(4) The File Download dialog box appears. Click Save to save the file. 
 
If the File Download dialog is not displayed, check the security settings for your browser. 
・ Internet Explorer 

Select Internet Options from the Tools menu, then click Custom level from the Security level for this 
zone on the Security tab and the Security Settings screen appears. 

 
1) Set Enable from Downloads – File Download. 
2) Set Enable from Downloads – Automatic prompting for file downloads. 

(Only Internet Explorer 7/8) 
 

4.5.2. Delete Log 
Delete the log file. 
 
(1) On the Web Console, click Monitor in the title bar to switch to the Monitor view. 

 
(2) In the tree view, click the Monitor icon -> Scenario Execution Result List icon. Or in the Monitor 

Function List group box in the main window, click Scenario Execution Result List. 
 
(3) The Operation menu for the Scenario Execution Result List icon will be displayed, then click Delete Log 

from the Operation menu. 
 
(4) Click OK. 

 
 The scenario execution results log file is saved in the following folder. Also, the log file 

can increase in size without limit until it is deleted. 
Default: C:\Program Files\NEC\DeploymentManager\Datafile\LogFile\SnrReport 

See Appendix E, "Log Files Output by DPM" regarding the log file. 
 

4.6. "Automatic Update Result List" Icon 
The Automatic Update Result List icon displays the list of the automatic update result which has been 
executed in the DPM. 
You can access the Automatic Update Result List icon from the Automatic Update Result List icon at the top 
of the Monitor view tree view or from Automatic Update Result List in the Monitor Function List group box 
displayed in the Monitor view main window. 
Click the Automatic Update Result List icon to display the Automatic Update Result List group box in the 
main window. See Section 4.7, "Automatic Update Result List Details" regarding the screen. 
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4.7. Automatic Update Result List Details 
Display the Automatic Update Result List screen by the following procedure. 
 
(1) On the Web Console, click Monitor in the title bar to switch to the Monitor view. 

 
(2) In the tree view, click Monitor icon -> Automatic Update Result List icon. Or in the Monitor Function 

List group box in the main window, click Automatic Update Result List. 
 

(3) The Automatic Update Result List group box appears in the main window. 
 

 
 
Basic Information  

 Auto Update Log(s)  Displays the number of automatic update logs. 

Automatic Update Result List 

 Display Count Select the number of items to be displayed in the list. 

Type  Displays the automatic update log type. (*1) 

Date  Displays the automatic update date and time. 

Machine Name Displays the machine name of the managed machine on which 
the automatic update was executed. 

MAC Address Displays the MAC address of the managed machine on which 
the automatic update was executed. 

Detail When you click " ", the Detail of Automatic Update Result 
screen appears. 

*1 
The displayed automatic update result list type can be the following types. 
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Type  Description 

Update Completed  This is displayed when the automatic update was successful. 

Update Warning  This is displayed when the execution conditions are not met during a check 
before the automatic update execution. The execution conditions are not 
met if there are more than the maximum number of automatic update clients 
or if the scenario is running and so on. 

Update Error  This is displayed when an error occurs in the automatic update. 
* File transfer error or failure of searching a package to apply and so on. 

Notice Completed  This is displayed when the automatic update notice was successful. 

Notice Error  This is displayed when an error occurs during the automatic update notice 
due to a communication error and so on. 

Time Setting 
Completed 

This is displayed when automatic update time setting is completed. 

Time Setting 
Warning  

This is displayed when it failed to set the automatic update time due to the 
failing of connection to the managed machine or the failing of 
communication and so on. 

 
 If there is an automatic update error, re-run or restart DPM Client. 

 

4.7.1. Automatic Update Result Details Display 
Display the detail information of the automatic update result. 
 
(1) On the Web Console, click Monitor in the title bar to switch to the Monitor view. 

 
(2) In the tree view, click Monitor -> Automatic Update Result List icon. Or in the Monitor Function List 

group box in the main window, click Automatic Update Result List. 
 

(3) The Automatic Update Result List group box appears in the main window. Then click the Detail ( ) icon 
to check the automatic update result for the managed machine. 
 

(4) The detail of automatic update result is displayed in the main window. 
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 When you click the Detail Icon ( ) of Automatic Update Result List group box, the 

Detail Of Automatic Update Result screen appears only if the automatic update 
result (xx-xx-xx-xx-xx-xx.rpt) exists in the DPM installation folder 
(Default value: C:\Programfiles\NEC\DeploymentManager\Datafile\LogFile\AuReport). 

 

4.7.2. Maximum Number of Logs Settings 
You can set the maximum output number for automatic updates. 
 
(1) On the Web Console, click Monitor in the title bar to switch to the Monitor view. 

 
(2) In the tree view, click Monitor -> Automatic Update Result List icon. Or in the Monitor Function List 

group box in the main window, click Automatic Update Result List. 
 

(3) The Configuration menu for the Automatic Update Result List icon will be displayed, then click 
Maximum Number of Log. 
 

(4) The Maximum Number of Log Setting screen appears in the main window. Then set the maximum 
number of logs. 

 

 
 

Maximum Number of Log Setting  

 Maximum Number of Logs 
(1-100000) 
(Required) 

Set the maximum number of output logs for the automatic 
updates. 
This can be set in the range of "1 - 100000."  
The default value is "10000."  

OK Saves the settings of the Maximum Number of Log Setting 
screen and returns to the previous window. 

Cancel Returns to the previous window without saving the settings 
details from the Maximum Number of Log Setting screen. 

 
  Only the specified maximum number of logs will be displayed on the screen. 

 If the Maximum Number of Logs is set to 10000 or less, the old logs that exceeds 
the maximum number of logs will be deleted in order. If the Maximum Number of 
Logs is set to more than 10000, 10% of the old logs that exceed the maximum 
number of logs will be deleted. 

 If you set the Maximum Number of Logs smaller than the previously set value, it is 
possible that part of the logs may be deleted. 
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  Change the Maximum Number of Logs according to the managed number of 

managed machines. 
 It is recommended that the Maximum Number of Logs be set higher than the number 

of managed machines. 
For example, If you are managing 100 managed machines, and if you set the 
Maximum Number of Logs to 100 or more, then you can check the automatic update 
result for the updates for all of the managed machines. 

 

4.7.3. Save in CSV Format 
The automatic update execution results and detailed information are saved in the CSV format. 
 

(1) On the Web Console, click Monitor in the title bar to switch to the Monitor view. 
 

(2) In the tree view, click Monitor -> Automatic Update Result List icon. Or in the Monitor Function List 
group box in the main window, click Automatic Update Result List. 

 
(3) The Automatic Update Result List screen appears. Click Save In CSV in Operation menu. 

 
(4) The File Download dialog box appears. Click Save and save the file. 

 
 If the File Download screen is not displayed, check the security settings for your browser. 

See Section 4.5.1, "Save in CSV Format" regarding the settings. 
 

4.7.4. Delete Log 
Delete the automatic update result log file. 
 

(1) On the Web Console, click Monitor in the title bar to switch to the Monitor view. 
 

(2) In the tree view, click Monitor -> Automatic Update Result List icon. Or in the Monitor Function List 
group box in the main window, click Automatic Update Result List. 

 
(3) The Automatic Update Result List screen appears. Click Delete Log in Operation menu. 

 
(4) Click OK. 

 
 The automatic update result log file is saved in the following folder. 

Default: C:\Program Files\NEC\DeploymentManager\Datafile\LogFile\AuReport 
See Appendix E, "Log Files Output by DPM" regarding the log file. 

 

4.8. "File Operation Result List" Icon 
The File Operation Result List icon displays the result list of file distribution and file deletion which has been 
executed by DPM. 
You can access the File Operation Result List icon from the File Operation Result List icon on the tree view of 
Monitor view or from File Operation Result List in the Monitor Function List group box which is displayed in 
the main window of Monitor view. 
Click File Operation Result List icon to display the File Operation Result List group box in the main window. 
See Section 4.9, " File Operation Result List Details" regarding the screen. 
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4.9. File Operation Result List Details 
Display the File Operation Result List screen by the following procedure. 
 
(1) On the Web Console, click Monitor in the title bar to switch to the Monitor view. 

 
(2) In the tree view, click Monitor icon -> File Operation Result List icon. Or in the Monitor Function List 

group box in the main window, click File Operation Result List. 
 

(3) The File Operation Result List group box appears in the main window. 
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Basic Information  

 Log(s)  Displays the number of file distribution and file deletion logs. 

File Operation Result List 

 Display Count Select the number of items to be displayed in the list. 

Type  Displays the result of file distribution and file deletion. 
When file distribution or file deletion is completed, Completed 
Execution is displayed. 
When an error occurs in file distribution or file deletion, Error is 
displayed. 

Start DateTime Displays the date and time when file distribution or file deletion was 
started. 

End DateTime Displays the date and time when file distribution or file deletion was 
finished. 

Operation Type Displays the type of the operation. 
When you executed file distribution(file copy or overwrite), FileCopy 
is displayed. When you executed file deletion, FileDelete is 
displayed. 

Operation Detail Displays the detail of the operation. 
When you executed file distribution(file copy or overwrite), the file 
path of source and destination is displayed. When you executed file 
deletion, the file path of deleted file is displayed. 

Machine Name Displays the machine name of the managed machine on which file 
distribution or file deletion was executed. 

MAC Address Displays MAC address of the managed machine on which file 
distribution or file deletion was executed. 
Click MAC address to display the Machine Detail group box in the 
Operations view. See Section 3.7, "Managed Machine Details" about 
the Machine Detail group box. 

 
 Maximum number of file distribution and file deletion logs is 10000. If the number of logs 

exceeds the maximum number, 10% of the logs will be deleted from the oldest. 
 

4.9.1. Save in CSV Format 
Save the result of file distribution and file deletion in the CSV format. 
 

(1) On the Web Console, click Monitor in the title bar to switch to the Monitor view. 
 

(2) In the tree view, click the Monitor icon -> File Operation Result List icon. Or in the Monitor Function 
List group box in the main window, click File Operation Result List. 

 
(3) The File Operation Result List appears, then click Save In CSV in the Operation menu. 

 
(4) The File Download dialog box appears. Click Save to save the file. 

 
 If the File Download dialog box does not appear, check the security setting of the browser. 

See Section 4.5.1, " Save in CSV Format" about the setting. 
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5. Image Builder 
This chapter explains Image Builder which is a tool to register an image. 
 

5.1. Connection Settings 
Set when using Image Builder (Remote Console). 
When changing the Management Server to which Image Builder (Remote Console) is connected, change the IP 
address and the port entered during the first startup using the following procedure. 
 
(1) (Remote Console) is installed, by a user with administrator authority. 

 
(2) From the Start menu, select All Programs -> DeploymentManager -> Image Builder. 

When you are logging on to the OS by the user except Administrator, execute it as an administrator. 
 
(3) Click Setting connection. The Setting connection screen appears. 

 

 
 
(4) Enter the IP address and the port of DPM Server and click OK. 

 
The connection setting is completed. 
 

  The IP address of the Management Server, to which Image Builder (Remote Console) 
connects, is the one specified in Management view -> DPM Server icon -> Detailed 
Setting -> General tab -> Server Information -> IP address. 

 The port of the Management Server, to which Image Builder (Remote Console) 
connects, is the port number configured in the Management Server. 
You can check the port number configured in the Management Server in the following 
file. 
<TFTP root folder>\Port.ini 
・ Key name: FTUnicast 
・ Default value:26508(It is 56023 when you upgraded DPM Server from the earlier 

version than DPM Ver6.1.) 
The default TFTP root folder is 
C:\Program Files\NEC\DeploymentManager\PXE\Images. 
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5.2. Creating a Floppy Disk Image 
By using the Creating Floppy Disk Image function, you can register floppy disk images of BIOS updates, firmware 
updates and distribute the images via the network. 
You can also register, distribute, and execute floppy images of other application programs that start up from a 
floppy disk. However, the size of the programs should be up to the floppy disk size, 1.44MByte. 
 
 This section describes how to create an image of a floppy disk. 
The image is created using Image Builder. After the image is created, it is registered on DPM Server. 
 
The following describes how to register a floppy disk image on DPM using Image Builder. 
 
(1) Prepare the floppy disk that automatically executes BIOS and firmware updates. And insert the disk into the 

floppy disk drive of the machine on which Image Builder is installed to register the image on DPM. 
 

(2) Log on to the machine, on which Image Builder is installed, by a user with administrator authority. 
When you use Image Builder on the Management Server, log on by the user who installed DPM Server. 
 

(3) From the Start menu, select All Programs -> DeploymentManager -> Image Builder. 
When you are logging on to the OS by the user except Administrator, execute it as an administrator. 

 
(4) Image Builder is launched. Click Creating Floppy Disk Image/Registering EFI application. 
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 When you start Image Builder and select a menu item for the first time, the 

following screen appears. Confirm the content and click I Accept. If you select I 
Decline, you cannot use the function. 
 

 
 
(5) The Select registration image screen appears. Select Creating Floppy Disk Image and click OK. 
 

 
 
(6) The Creating Floppy Disk Image screen appears. Enter image file name and click OK. 
 

 
 

Creating Floppy Disk Image 
 Image File Name  Enter the image file name. 

8 characters or less can be entered. Alphanumeric characters 
and the following symbols can be entered. 
. _ - 
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(7) A confirmation screen appears. Confirm that the floppy disk is inserted, and click OK. 
 
(8) The following screen appears. Click OK. 
 

 
 

5.3. Registering an Operating System 
 

 If you create an NFS public folder except <Folder for Image>\exports, you must register 
the operating system manually without using Image Builder. For details, see "About Linux 
Installation" in Section 3.5.6, "Precautions/Other" in Operation Guide. 

 
(1) Log on to the machine, on which Image Builder is installed, by a user with administrator authority. 

When you use Image Builder on the Management Server, log on by the user who installed DPM Server. 
 

(2) From the Start menu, select All Programs -> DeploymentManager -> Image Builder. 
When you are logging on to the OS by the user except Administrator, execute it as an administrator. 

 
(3) Image Builder is launched. Click Registering operating system. 
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(4) The OS Registration screen appears. Set each item and click OK. 
 

 
 

Registering operating system 
 Operating System Name Enter the operating system name. 

Names such as "Linux", "Linux(gPXE)", "ks", "daemon", and 
"pxelinux.*" are reserved and cannot be registered. 
In Linux, numeric characters and the following symbols can be 
used:  
. _- ( ) 

Operating System Type Select the following operating systems from the list box. 
・ Red Hat Enterprise Linux 3,4,5/VMware ESX 

/Citrix XenServer(*1) 
・ Red Hat Enterprise Linux 6 
・ Red Hat Enterprise Linux 7 

initrd.img/vmlinuz folder The floppy disk drive is displayed here. The default is "A:\". Click 
Browse and select the location of initrd.img/vmlinuz. 
If "Red Hat Enterprise Linux 6" or "Red Hat Enterprise Linux 7" 
was selected in  the  Operating System Type, specify 
"images\pxeboot" folder of the installation media directly, or 
mount the ISO file for installation and select "images/pxeboot". 

CD-ROM Source Folder 
("Install ISO" is displayed 
when "Red Hat Enterprise 
Linux 6" or  
"Red Hat Enterprise 
Linux 7" is selected as 
Operating System Type.) 

When Operating System Type is selected, the CD-ROM drive is 
displayed. 
Click Browse and select the location of the folder containing the 
OS. 
If "Red Hat Enterprise Linux 6" or "Red Hat Enterprise Linux 7" 
was selected in Operating System Type, specify the ISO file for 
installation. 

OK The OS image is created with the settings on the Registering 
operating system screen before returning to the previous 
window. 

Cancel The previous window is returned to without creating the OS 
image with the settings from the Registering operating system 
screen. 

*1 
Red Hat Enterprise Linux 3 is not supported.
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 To prepare a Linux image file, all under the source folder of the specified CD-ROM are 

copied as the image file. 
With Red Hat Enterprise Linux, two or more CD-ROMs are involved and thus a message 
prompting you to copy the next CD-ROM will appear after the first CD-ROM is copied. 
Insert the CD-ROMs in order, and continue copying. 
When an overwrite confirmation dialog box appears during this time, select Yes or Yes to 
All, and proceed. 

 
(5) Wait until the copy of the file of vmlinuz/initrd.img and CD is completed. 

The Red Hat CD Image copy screen appears. If there are any remaining Red Hat Enterprise Linux 
installation CDs to register, replace the CD and click Next. There are several Red Hat Enterprise Linux 
installation CDs. 

 

 
 
(6) When the screen to confirm the replacing appears during copying, click Yes to All. 
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(7) When all CDs have been copied, the Red Hat CD Image copy screen appears. Click Finish. 
 

5.4. Creating a Setup Parameter File 
The setup parameter file is a file which is used to execute OS installation by disk duplication or an OS clear 
installation. The managed machines are configured using this file. We will describe a method for creating a 
separate setup parameter file for each managed machine, and a batch creation method. 

5.4.1. Creating a Disk Duplication Data File (Windows) 
This section describes how to create a disk duplication data file for configuring individual machines when 
executing OS installation by disk duplication in Windows. 

5.4.1.1. Creating a Disk Duplication Data File (Windows Server 2003 
R2/Windows XP or earlier) 

To create a disk duplication data file for Windows Server 2000/Windows Server 2003/Windows Server 2003 
R2/Windows XP, create the data file and then create the disk duplication data file on the basis of that data file. 
See "1. Creating a Data File" through "2. Creating a Disk Duplication Data File." 
The various settings configured in "1. Creating a Data File" become the default values in the disk duplication data 
file created in "2. Creating a Disk Duplication Data File." 
 
1.Creating a Data File  

Create one data file which will act as the basis for creating the disk duplication data file. 
 

  The entry items vary depending on the type of Windows OS. 
 Depending on the item, other entry items sometimes have to be checked. If any such 

messages appear on the screen, follow them. 
 You must use a setup parameter file created using DPM. 

Setup parameters created using a product except DPM, such as using seamless setup 
with EXPRESSBUILDER which comes standard with the Express5800 Series, cannot 
be used. 

 
(1) Log on to the machine, on which Image Builder is installed, by a user with administrator authority. 

When you use Image Builder on the Management Server, log on by the user who installed DPM Server. 
 

(2) From the Start menu, select All Programs -> DeploymentManager -> Image Builder.  
When you are logging on to the OS by the user except Administrator, execute it as an administrator. 
 

(3) Image Builder is launched. Click Configure setup parameter file. 
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(4) The Select Parameter screen appears. Select Windows parameter file and click OK. 
 

 
 
(5) The Create Setup Parameter File screen appears. From the File menu, select Create New information 

files. 
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(6) The Basic information screen appears. Select the OS type in the red box of the following screen. The item 

in the red box must be set. 
The following items do not need to be set. 
・ Target machine 
・ OS Installation path 
・ System Partition 
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Basic Information  
 OS type Select the install OS type. 

- Windows 2000 Professional 
- Windows 2000 Server 
- Windows 2000 Advanced Server 
- Windows XP Professional 
- Windows Server 2003 Standard Edition 
Select this when you use Windows Server 2003 Standard 
Edition/Windows Server 2003 R2 Standard Edition. 

- Windows Server 2003 Enterprise Edition 
Select this when you use Windows Server 2003 Enterprise 
Edition/Windows Server 2003 R2 Enterprise Edition. 

- Windows Server 2003 Standard x64 Edition 
Select this when you use Windows Server 2003 Standard x64 
Edition/Windows Server 2003 R2 Standard x64 Edition. 

- Windows Server 2003 Enterprise x64 Edition 
Select this when you use Windows Server 2003 Enterprise x64 
Edition/Windows Server 2003 R2 Enterprise x64 Edition. 

(*1) 
Activation If Windows XP or Windows Server 2003 is selected in OS type, the 

Activation setting is enabled. 

 Retail Version or OEM 
Version other than NEC 

Select this if you are using a retail version or OEM version other than 
NEC. (*2) 

NEC OEM Version Select this if you are using an NEC OEM version. (*2) 
*1 
 Activation is enabled when you selected either of the following. 

Select either Retail Version or OEM Version other than NEC or NEC OEM Version. 
- Windows XP Professional 
- Windows Server 2003 Standard Edition 
- Windows Server 2003 Enterprise Edition 
- Windows Server 2003 Standard x64 Edition 
- Windows Server 2003 Enterprise x64 Edition 

 The setting data is not maintained if the OS type is changed. Make sure that each item is configured 
correctly. 

 The following is displayed in OS type. However, these are not supported in this version. 
・ Windows Server 2003 Datacenter Edition 
・ Windows Server 2003 Datacenter x64 Edition 

 An activation (license authentication) request might appear during OS installation by disk duplication. If this 
happens, follow the license authentication procedure in accordance with the instructions on the screen. 

*2 
 When you operate DPM Server in x64, the data file cannot be created if NEC OEM Version is selected for 

the following OS media of NEC. If OS installation by disk duplication is executed for these OS's, select 
Retail Version or OEM Version other than NEC and create the data file using the product key that came 
with the OS media or the hardware. 

- Windows XP Professional(no SP, SP1)(CD number:243-110442-007-A) 
- Windows XP Professional w/SP2(excluding 2006/06and after)(CD number:243-110442-007-C) 
- Windows Server 2003 Standard Edition(no SP)(CD number:243-110442-100-A/C) 
- Windows Server 2003 Enterprise Edition(no SP)(CD number:243-110442-101-A/B/C) 
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 If NEC OEM was selected under Activation, the following screen appears, so insert the CD-ROM for the 

OS into the CD-ROM drive and click OK. 
 

 
 
(7) Click Next to display the User Information screen and then set each item. 
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User Information 
 User Name 

(Required)  
Enter the name of the user. 
50 characters or less can be entered.  
Alphanumeric characters and symbols can be entered. 
The following symbols cannot be entered. 
, 

Company name Enter the name of the company. 
50 characters or less can be entered.  
Alphanumeric characters and symbols can be entered. 
The following symbol cannot be entered. 
, 
This is optional. 

Product-Key Enter the Windows OS product key. 
Enter it in the form "xxxxx-xxxxx-xxxxx-xxxxx-xxxxx". 
This does not need to be entered if NEC OEM Version is 
selected. 
In the case of a pre-installed machine, enter the product key on 
the sticker attached to the machine body. If the OS has been 
installed using a dedicated medium under a volume licensing 
contract with Microsoft, enter the product key that came with 
the medium. 

TimeZone Set the time zone. Select the appropriate region in the list box. 
This is optional. 
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(8) Select Next to display the Role of Computer screen. Items in red boxes in the screen below must be set. 

The item in the red box must be set. 
The following items do not need to be set. 

- Client License Mode 
- Specify an Account 
- Network setup 
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Role of Computer  
 Computer Name  

(Required)  
Enter the machine name registered in DPM. 
15 characters or less can be entered. 
Alphanumeric characters and symbols can be entered. 
The following symbols and space cannot be entered. 
. , ` ~ ! @ # $ & * % = + { } \ | ; : ' " < > / ? [ ] ^ ( ) 
Also, you cannot register a machine name of only numbers.  
Make sure the name is not the same as that of any other machine 
or domain/workgroup. 

Administrator Password Set the password for administrator authority. 
14 characters or less can be entered. 
Alphanumeric characters and symbols can be entered. 
The following symbols and space cannot be entered. 
, " 
This is optional. 
If you set a password, see also the password configuration policy 
of each OS. 

Administrator Password 
again 

Re-enter the password set in Administrator Password. This 
must be entered if Administrator Password was set. 

MAC Address This is used during OS installation by disk duplication. This item 
cannot be set. 

Domain Set the domain. Select Domain and enter the corresponding 
name. (*1) 
Alphanumeric characters and symbols can be entered. 
The following symbols and space cannot be used. 
. , " \ / ; : | * ? < > [ ] 

Workgroup Set the workgroup. Select Workgroup and enter the 
corresponding name. 
Alphanumeric characters and symbols can be entered. 
The following symbols cannot be used. 
, " \ ; : | * ? < > + = 

*1 
 When setting Domain, follow the policy of the password setting for the domain controller. If you do not 

follow the policy, the processing of OS installation by disk duplication may stop at every login screen. In this 
case, log in manually. 

 Do not omit the password. When you omit it, a scenario execution error occurs. 
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(9) Select Next to display the Display Setup screen. This does not need to be set for OS installation by disk 

duplication, so just click Next. 
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(10) Click Next to display the Network Setup screen and configure the NIC (LAN board). The items in red boxes 

in the screen below are set. The item in the red box must be set. 
The following items do not need to be set. 
- Network services 
- Network client 
 
When the NIC Settings are made, the Protocol Setting, IP Address, DNS, and WINS can be set. These 
settings can be indicated directly to the NIC of the machine. If the NIC is indicated, however, the MAC 
address must be entered. 
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Network Setup 
 NIC Settings 

 AutoDetect If the NIC is not specified, select "AutoDetect". 
If "AutoDetect" is added to the MAC addresses list of the NIC to be 
added, the numbers 1-4 are added to "AutoDetect". 
When executing OS installation by disk duplication by setting 
"AutoDetect", if there are two or more NICs, an arbitrary NIC is selected 
and the setting is done. 

MAC Address If the NIC is specified, select MAC Address and enter the MAC address 
in the text box. 
MAC address must be entered in the form "xx-xx-xx-xx-xx-xx". 
When executing OS installation by disk duplication setting MAC address, 
the settings are configured for the specified MAC address.  
For an NIC having a MAC address that is registered to the DPM, 
configure the settings so that network communication is possible 
regardless of whether the address is a static IP address or is obtained 
from the DHCP server. If network communication is impossible, the 
scenario may not be completed. 

Add Add any NIC's to the List of Added NIC MAC addresses. 
Select AutoDetect or enter MAC address and then click Add. 

MAC addresses list of 
the NIC to be added 

Displays a list of MAC address. 
Set one or more NIC's. Up to four items of AutoDetect and MAC 
addresses can be added in total. 

 Protocol setting Configure the protocol for added NIC's. Click Protocol Setting to display 
the Protocol Setting screen. See "Protocol setting" below for details on 
this screen. 

 
When adding an Internet Protocol (TCP/IP), Internet Protocols (TCP/IP) 
equal to the number of NIC's added by selecting NIC Settings -> Add are 
added to the Protocol list to be added. 
The following is an example where two NIC's, 00-00-00-00-00-00 and 
AutoDetect1, have been added by selecting NIC Settings -> Add. 
Example) Protocol list to be added 
 
 
 
 

Delete To delete an added MAC address or AutoDetect, select it from the list and 
click Delete. 

Internet Protocol (TCP/IP) 00-00-00-00-00-00 
Internet Protocol (TCP/IP) AutoDetect1  
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 Protocol setting 
This section describes the Protocol setting screen. 
 

 When setting several NIC's (LAN boards), repeat Steps 3)-4). 

 
1) In the Protocol Setting screen, select Internet Protocol (TCP/IP) from the Protocol list box, and click 

Add. 
 

 



 

225 

 
Protocol Setting 
 Protocol Configure the protocol for the NIC. 

The following protocols can be added. Note that the selectable items 
vary depending on the OS. 
- Internet protocol (TCP/IP) 
(Required)  

- NWLINK IPX/SPX/NetBIOS-compatible transport protocol 
- Apple Talk protocol 
- Network monitor driver 
- NetBEUI protocol 
- DLC protocol 
- Streams environment 

Protocol list to be added 
(Required)  

Displays the list of added protocols. 
Select Protocol and click Add to add a protocol to the Protocol list to 
be added. 

Details  Detailed settings for the internet protocol (TCP/IP) for each NIC are 
configured here. 
If you select Internet Protocol (TCP/IP) from the Protocol list to be 
added, you can click Details. 
Click Details to display the Internet Protocol (TCP/IP) and set each 
item. 
See the description below for details on the screen. 
This is optional.(*1) 

Delete  Deletes an added protocol. 
Select the protocol to delete from the Protocol list to be added and 
click Delete. 

OK Saves the settings on the Protocol Setting screen and returns to the 
previous window. 

Cancel Returns to the previous window without saving the settings in the 
Protocol Setting screen. 

*1 
When you do not set, Acquire Automatically is set as a default for all IP address, DNS, and WINS. The value 
of the scope ID is not reflected. 
Click OK in the Protocol Setting screen, click Next in the Network Settings screen, and go to (11) the 
Component Settings screen. 

 
2) Internet Protocol (TCP/IP) is added to the Protocol list to be added. Select the protocol and click Details. 
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3) The Settings Internet Protocol (TCP/IP) screen appears. Select the IP Setting tab in the Settings 

Internet Protocol (TCP/IP) screen and set each item. 
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 Settings Internet Protocol (TCP/IP) 
 IP Setting Here you can set the IP address, subnet mask, gateway, and 

metrics. The settings differ depending on whether they are acquired 
automatically or set manually. 

 Acquire the IP address  
automatically 
 

Selecting this option button causes the IP address to be acquired 
automatically. 
The default setting is Acquire the IP address automatically. 

Use the following IP 
address 

Selecting this option button enables setting of the IP address, 
subnet mask, gateway, and metric. 

 IP Address  
 Add Clicking Add causes the TCP/IP Address screen to be displayed, 

so enter the IP address and subnet mask. 

 
Enter these in the form "xxx xxx xxx xxx". 
If you click Add in the TCP/IP Address screen, IP address and 
subnet mask are added to the list of IP Address. 
Up to four IP addresses and subnet masks can be added for each 
NIC. 

Edit Select the IP address/subnet mask to be edited from the list of the 
IP Address and click Edit. The TCP/IP Address screen appears. 
Edit the IP address/subnet mask. 

Delete Select the IP address/subnet mask to be deleted from the list of the 
IP Address and click Delete. IP address/subnet mask will be 
deleted. 
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   Default gateway  

 Add Clicking Add causes the TCP/IP gateway address screen to be 
displayed, so enter the gateway and metric. 

 
Enter in Gateway by the form "xxx xxx xxx xxx". 
Enter numeric characters in Metric. This can be set in the range of 
"1-9999." The default value is "1." 
By clicking on Add in the TCP/IP gateway address screen, the 
gateway/metric will be added to the list of the Default Gateway. 
Up to four gateways and metrics can be added. 

    Edit Select the gateway/metric to be edited from the list of Default 
Gateway and click Edit. The TCP/IP gateway address screen 
appears. Edit the gateway/metric. 

    Delete Select the gateway/metric to be deleted from the list of the Default 
Gateway box and click Delete. The gateway/metric will be deleted. 

 
 When you select the Check the completion of a scenario by the communication with 

DPM Client checkbox (Web Console Management view -> DPM Server icon -> Detail 
setting in Configuration menu -> General tab), the completion of the scenario may not 
be detected if the managed machine cannot communicate with the Management Server by 
the set IP address. Set IP address by which the machine can communicate with the 
Management Server. 
When you clear the Check the completion of a scenario by the communication with 
DPM Client checkbox, the completion of the scenario can be detected regardless of 
whether the machine can communicate with the Management Server or not. 
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4) Set the items in the DNS/WINS tab on Settings Internet Protocol (TCP/IP) screen. 
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Settings Internet Protocol (TCP/IP)  
 DNS/WINS The DNS and WINS settings are made here. The settings differ 

depending on whether they are acquired automatically or set 
manually. 

 Acquire the address of 
DNS server 
automatically 

Select this to acquire the address of the DNS server automatically. 
Select this if the managed machine is a DNS server. 
The default setting is Acquire the address of DNS server 
automatically. 

Use the following 
address of DNS server 

Select this to set the IP address of the DNS server. 

DNS Server Address (the Order of Use) 
 Add By clicking Add, the TCP/IP DNS Server screen appears. Enter the 

address of the DNS server. 

 
Enter these in the form "xxx xxx xxx xxx". 
If you click Add in the TCP/IP DNS Server screen, IP address of 
the DNS server is added to the list of the DNS Server Address 
(the Order of Use). Up to four IP addresses of DNS server can be 
added. 

Edit Select IP address of the DNS server to be edited from the list of the 
DNS Server Address (the Order of Use) and click Edit. The 
TCP/IP DNS Server screen appears. Edit IP address of the DNS 
server. 

Delete Select IP address of the DNS server to be deleted from the list of 
the DNS Server Address (the Order of Use) and click Delete to 
delete IP address of the DNS server. 

Acquire the address of 
WINS server 
automatically 
 

Select this to acquire the address of the WINS server automatically. 
Select this if the managed machine is a WINS server. 
The default setting is Acquire the address of WINS server 
automatically. 

Use the following 
address of WINS server 

Select this to set the IP address of the WINS server. 
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  WINS Server Address (the Order of Use) 

 Add Clicking Add causes the TCP/IP WINS Server screen to be displayed, 
so enter the address of the WINS server. 

 
Enter these in the form "xxx xxx xxx xxx".  
If you click Add in the TCP/IP WINS Server screen, the address of the 
WINS server will be added to the list of WINS Address (the Order of 
Use). Up to four WINS server addresses can be added. 

Edit Select IP address of the WINS server to be edited from the list of the 
WINS Address (the Order of Use) and click Edit. The TCP/IP WINS 
server screen appears. Edit IP address of the WINS server. 

Delete Select IP address of the WINS server to be deleted from the list of the 
WINS Address (the Order of Use) and click Delete to delete IP 
address of the WINS server. 
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5) Set the ScopeID in the Settings Internet Protocol (TCP/IP) screen. 

 

 
 

Settings Internet Protocol (TCP/IP)  
 ScopeID Set the scope ID. 

The scope ID cannot be set for each NIC. If the internet protocol 
(TCP/IP) scope ID has been set for one NIC, the previously set scope 
ID is displayed, even if the Settings Internet Protocol (TCP/IP) screen 
is opened for the internet protocol (TCP/IP) of another NIC. 
This is optional. 

OK Saves the settings in the Settings Internet Protocol (TCP/IP) screen 
and returns to the previous window. 

Cancel Returns to the previous window without saving the settings in the 
Settings Internet Protocol (TCP/IP) screen. 
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(11) Select Next to display the Setting the Component screen. This does not need to be set for OS installation 
by disk duplication, so just click Finish. 
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(12) The agreement screen appears. Read this carefully and click I Accept. 

 

 
 

 If you select I Decline, you cannot use the function. 
 

(13) By clicking on I Accept, the Specify a file screen appears. Click Browse, select a file name, and save the 
data file. 
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Specify a file 
 File name Set the name of the data file that has been set and where it is 

contained. 
You can select where to save it with the Browse button or enter 
the file path directly. 
63 characters or less can be entered. 
Alphanumeric characters and symbols can be entered. 
The following symbols cannot be entered. 
" / \ ; : | , * ? < > 
If you use the Browse button to set the folder to be saved and 
the file name, set the file name so that it is 254 characters or 
less, including the path. 

OK Save the data file to the saving specified designated on the 
Specify a file screen. 

Cancel Closes the window without saving the data file with the settings. 
 

Creation of the data file is completed once the Create a Setup Parameter File screen appears. 
 

2. Creating a Disk Duplication Data File 
The disk duplication data file is created on the basis of the data file created in "1. Creating a Data File."  
 

 A disk duplication data file must be created for each machine to which the system will 
be deployed. 

 
(1) Log on to the machine, on which Image Builder is installed, by a user with administrator authority. 

When you use Image Builder on the Management Server, log on by the user who installed DPM Server. 
 

(2) From the Start menu, select All Programs -> DeploymentManager -> Image Builder.  
When you are logging on to the OS by the user except Administrator, execute it as an administrator. 
 

(3) Image Builder is launched. Click Configure setup parameter file.  
 

(4) The Select Parameters screen appears. Select Windows Parameter File and click OK. 
 
(5) The Create a Setup Parameter File screen appears. From the File menu, select Create New Disk copy 

information File for 2003/2000/XP(P).  
 

(6) The Open screen appears. Select the data file that you created in "1. Creating a Data File" of "5.4.1.1 
Creating a Disk Duplication Data File (Windows Server 2000/Windows Server 2003/Windows XP)" to open 
the file. 
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(7) The Setup Information File screen appears. Set the information required for the managed machine in 

which the setup is to be performed and click OK.  
Items in red boxes in the following screen must be set. 
The following tabs do not need to be set. 
・ Basic information 
・ Display Setup 
・ Setting the Components 
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Setup Information File (*1) 
 Role of Computer ・ Computer Name must be set. 

The MAC address is automatically entered by entering the 
name of the machine registered to DPM and placing the 
cursor over the MAC Address field. 

・ The following symbols cannot be used in the Administrator 
Password and the password for Specify an Account. 
" , 

・ For the MAC Address, enter the MAC address of the 
machine in which OS installation by disk duplication is 
executed. Enter it in the form "xx-xx-xx-xx-xx-xx". 

User Information ・ User Name must be set. 
・ On the ProductKey, set the product key used on the 

machine in which OS installation by disk duplication is 
executed. 

Network Setup Set as necessary. 
For an NIC having a MAC address that is registered to the 
DPM, configure the settings so that network communication 
can be done regardless of whether the address is a static IP 
address or is obtained from the DHCP server. If network 
communication cannot be done normally, an executed 
scenario may not be completed. 

*1 
Items are configured with the content of the data file that has been prepared. Change as needed. 

 
(8) The Specify a file screen appears. Click OK. 

Disk duplication data files(two files) are created as the following. 
・ MAC address.inf 
・ MAC address.bat 

 
  The file is named after MAC address which was entered automatically. The file 

name cannot be modified. 
 If the created disk duplication data files are unnecessary, delete them manually. 

(You cannot delete them from Delete registered data in Image Builder.) 

 
  If you click Cancel, the display returns to the previous window without saving 

the setting on the Setup Information File screen. 
 The default saved folder of disk duplication data files is 

<Folder for Image(C:\Deploy)>\Ansfile\sysprep 
 
Creation of disk duplication data files is completed. 
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5.4.1.2. Creating a Disk Duplication Data File (Windows Server 
2008/Windows Vista or Later) 

Create a disk duplication data file for Windows Server 2008/Windows Vista or later. 
The disk duplication data file for Windows Server 2008/Windows Vista or later includes the conventional Disk 
Duplication Data File (Windows Parameter File) used in the version earlier than DPM Ver6.0, and a Disk 
Duplication Data File (Windows parameter file(Express)) that enables rapid setup of machines. 
 

  A disk duplication data file created using the Windows parameter file(Express) 
cannot be edited in Image Builder by specifying the Windows parameter file. 
Furthermore, a disk duplication data file created using the Windows parameter file 
cannot be edited in Image Builder by specifying the Windows parameter 
file(Express). 

 Items which cannot be entered in the Image Builder screens are not used in 
settings of this procedure (creating a disk duplication data file for Windows Server 
20008/Windows Vista or later). 

 For Windows Server 2012/Windows 8 or later, only disk duplication data 
file(Windows parameter file(Express)) is supported. 

 
1. Creating a Disk Duplication Data File (Windows parameter file(Express)) 
In creating a disk duplication data file (Windows parameter file(Express)), the procedure for creating a disk 
duplication data file that can set a machine up rapidly. 
 
(1) Log on to the machine, on which Image Builder is installed, by a user with administrator authority.  

When you use Image Builder on the Management Server, log on by the user who installed DPM Server. 
 

(2) From the Start menu, select All Programs -> DeploymentManager -> Image Builder. 
When you are logging on to the OS by the user except Administrator, execute it as an administrator. 
 

(3) Image Builder is launched. Click Configure setup parameter file. 
 

(4) The Select Parameter screen appears. Select Windows parameter file(Express) and click OK. 
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(5) The Create Setup Parameter File screen appears. From the File menu, select Create new disk copy files 

for 2008/Vista or later (B). 
 

 
 

(6) The Basic information screen appears. Set the OS type. 
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Basic Information 
 OS type Select the OS to be installed.  

- Workstation x86 for vista or later 
When you use Windows Vista/Windows 7/Windows 8/Windows 
8.1 of x86, select this. 

- Workstation x64 for vista or later 
When you use Windows 7/Windows 8/Windows 8.1 of x64, select 
this. 

- Server x86 for 2008 or later 
When you use Windows Server 2008 of x86, select this. 

- Server x64 for 2008 or later 
When you use Windows Server 2008/Windows Server 2008 R2/ 
Windows Server 2012/Windows Server 2012 R2, select this. 

(*1)  
*1 
 In the case of Windows parameter file, select the corresponding OS or edition from the displayed list 

box. 
 For Windows Server 2012/Windows 8 or later, only Windows parameter file(Express) is supported. 
 The setting information is not maintained if the OS type is changed. Check that each item is set 

correctly. 
 An activation (license authentication) may be requested during OS installation by disk duplication. If 

it is requested, follow the license authentication procedure in accordance with the instructions on the 
screen. 

 
(7) After setting in the Basic Information screen, click Next to display the User Information screen and then 

set each item. 
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User Information 
 User Name 

(Required)  
Enter the name of the user. 
50 characters or less can be entered. 
Alphanumeric characters and symbols can be entered. 
The following symbol cannot be entered. 
, 

Company name Enter the name of the company. 
50 characters or less can be entered. 
Alphanumeric characters and symbols can be entered. 
The following symbol cannot be entered. 
, 
This entry is optional. 

Product-Key Enter the Windows OS product key. 
Enter it in the form "xxxxx-xxxxx-xxxxx-xxxxx-xxxxx". 
In the case of a pre-installed machine, enter the product key on the 
sticker attached to the machine body. If the OS has been installed 
using a dedicated medium under a volume licensing contract with 
Microsoft, enter the product key that came with the medium. 
This needs to be entered depending on the OS media or the 
environment. For example, when you do not enter this item in 
Windows Server 2012, it fails to execute OS installation by disk 
duplication. 

Timezone Set the time zone. Select the appropriate region from the list box. 
Language Select the language to use from the list box. 
Help protect Windows 
automatically 

This item is displayed and can be set only when you create a disk 
duplication data file for Windows Vista/Windows 7/Windows 
8/Windows 8.1. 
Select the setting to protect Windows automatically from the list 
box. The following three options are available. 
- Use recommended settings. 
- Install important updates only. 
- Ask me later. 

Select your computer's 
current location  

This item is displayed and can be set only when you create a disk 
duplication data file for Windows Vista/Windows 7/Windows 
8/Windows 8.1. 
Select the current location of the target managed machine from the 
list box. The following three options are available. 
- Home 
- Work 
- Public location 
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(8) After setting the User Information screen, select Next to display the Role of Computer screen. Items in 

red boxes in the screen below must be set. The item in the red box must be set. 
The following items do not need to be set. 
- Client License Mode 
- Network Setup 
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Role of Computer 
 Computer Name  

(Required)  
Enter the machine name registered in DPM. 
15 characters or less can be entered. 
Alphanumeric characters and symbols can be entered. 
The following symbols and space cannot be entered. 
. , ` ~ ! @ # $ & * % = + { } \ | ; : ' " < > / ? [ ] ^ ( ) 
Also, you cannot register a machine name made up only of 
numbers. 
Make sure the name is not the same as that of any other machine 
or domain/workgroup. 
If the name of a machine registered to DPM is used, the 
Management Server can automatically obtain the MAC address of 
the managed machine. 

Administrator Password Set the password for administrator authority. 
For setting the password, see also the password configuration 
policy of each OS. 
The number of characters that can be entered depends on the 
OS. 
・ In the case of Windows Server 2008/Windows Server 2008 

R2/Windows Server 2012/Windows Server 2012 R2: 
3-63 characters can be entered. Both alphabet and number 
must be included. 

・ In the case of Windows Vista/Windows 7/Windows 8/Windows 
8.1: 

63 characters or less can be entered. 
Alphanumeric characters and symbols can be entered. 
The following symbol and space cannot be entered. 

" 
This is optional. 

Administrator Password 
again 

Re-enter the password set in Administrator Password. This 
must be entered if Administrator Password is set. 

MAC Address If the NIC (LAN board) is specified, select MAC Address and 
enter the MAC address in the text box. 
MAC Address must be entered in the form "xx-xx-xx-xx-xx-xx". 
For an NIC having a MAC address that is registered to the DPM, 
configure the settings so that network communication is possible, 
regardless of whether the address is a static IP address or is 
obtained from the DHCP server. If network communication is 
impossible, an executed scenario may not be completed. 

Domain Set the domain. Select Domain and enter the corresponding 
name. 
Alphanumeric characters and symbols can be entered. 
The following symbols and space cannot be entered. 
, " \ / ; : | * ? < > [ ] 
When setting Domain, follow the password setting policy for the 
domain controller. If the policy is not followed, the OS installation 
by disk duplication will stop at every login screen. If this case, log 
in manually. 
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Workgroup When using the disk duplication data file (Windows parameter 
file), the workgroup name cannot be changed . Use the default 
Workgroup. 
When using the disk duplication data file (Windows parameter 
file(Express)), the workgroup name can be changed. 
Alphanumeric characters and symbols can be entered. 
The following symbols cannot be used. 
, " \ ; : | * ? < > + = 

 Specify an Account This can only be entered if Domain has been selected. 
Check this to set the account and password when participating in 
a domain. 
If this is selected, Account, Password, and Password again can 
be set. 

 Account  Enter the account name. 
32 characters or less can be entered. 
Alphanumeric characters and symbols can be entered. 
The following symbols cannot be entered. 
, " / ; : * ? < > + = [ ] | 

Password  Enter the password. 
- In the case of Windows Server 2008/Windows Server 2008 

R2/Windows Server 2012/Windows Server 2012 R2 
3-14 characters can be entered. Both alphabet (including upper 
or lower case) and number must be included. 
Alphanumeric characters and symbols can be entered. 
The following symbols cannot be entered. 
, " 

- In the case of Windows Vista/Windows 7/Windows 8/Windows 
8.1 
14 characters or less can be entered. 
The following symbols cannot be entered. 
, " 
Do not omit the Password. If you omit it, a scenario execution 
error occurs. 

Password again Enter the password entered in Password. 
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(9) After setting the Role of Computer screen, select Next to display the Network Setup screen. Items in red 

boxes in the screen below must be set. 
The following items do not need to be set. 
- Network services 
- Network client 
 
The protocol can be set and the IP address, DNS, and WINS settings can be configured for the NIC (LAN 
board). With these settings, the NIC of the computer can be specified directly. If the NIC is indicated, 
however, the MAC address must be entered. 
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Network Setup 
 NIC Setting 

 AutoDetect If the NIC is not specified, select AutoDetect. 
If AutoDetect is added to the MAC addresses list of the NIC to be 
added, the following numbers are added to AutoDetect. 
- Windows parameter file(Express): 1-8 
- Windows parameter file: 1-4 

When executing OS installation by disk duplication by setting 
"AutoDetect", an arbitrary NIC is selected and the setting is done. 

MAC Address If the NIC is specified, select MAC Address and enter the MAC 
address in the text box. 
MAC address must be entered in the form "xx-xx-xx-xx-xx-xx". 
If the data file is used in which the MAC address is set, the settings 
are made to the specified MAC address. 
For an NIC having a MAC address that is registered to the DPM, 
configure the settings so that network communication is possible 
regardless of whether the address is a static IP address or is obtained 
from the DHCP server. If network communication is impossible, an 
executed scenario may not be completed. 

Add Adds a NIC. Select AutoDetect or enter MAC address and then click 
Add. 

MAC Addresses list of 
the NIC to be added 

Displays a list of added NIC MAC addresses. 
Click Add and add a MAC address to the list. 
Set one or more NIC's. The following total number of AutoDetect and 
MAC addresses can be added: 
- Windows parameter file(Express): up to 8 
- Windows parameter file: up to 4 

NIC not configured here is configured to obtain an IP address 
automatically using DHCP. 

 Protocol Setting Configure the protocol for added NIC's. Click Protocol Setting to 
display the Protocol Setting screen. See "  Protocol Setting" below 
for details on this screen. 

 
When adding an Internet Protocol (TCP/IP), Internet Protocols 
(TCP/IP) equal to the number of NIC's added by selecting NIC 
Settings -> Add are added to the Protocol List to be Added. 
The following is an example where two NIC's, 00-00-00-00-00-00 and 
AutoDetect1, have been added by selecting NIC Settings -> Add. 
Example) Protocol list to be added 
 
 
 

Delete To delete an added MAC address or AutoDetect, select either from 
the list and click Delete. 

 

Internet Protocol (TCP/IP)  00-00-00-00-00-00 
Internet Protocol (TCP/IP)  AutoDetect1  
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 Protocol Setting 
This section describes the Protocol Setting screen. 

 
1) In the Protocol Setting screen, select Internet Protocol (TCP/IP) or Internet Protocol (TCP/IPv6) from 

the Protocol list box, and click Add. 
 
  Set IP address(IPv4) necessarily for the LAN board which communicate with 

the Management Server. 
 Only in the case of Windows parameter file(Express), IPv6 address can be set. 
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Protocol Setting 
 Protocol Configure the protocol for the NIC. 

The protocol which can be added is Internet Protocol 
(TCP/IP) or Internet Protocol (TCP/IPv6). 
The number of protocols that can be added depends on 
the disk duplication data file that was created. 
・ Windows parameter file(Express): up to 1 
・ Windows parameter file: up to 4 

Protocol list to be added 
(Required)  

Displays the list of added protocols. 
Select Protocol and click Add to add a protocol to the 
Protocol List to be Added screen. 

Details  Configure detailed settings for the protocol for each NIC. 
If you select Internet Protocol (TCP/IP) or Internet 
Protocol (TCP/IPv6) from the Protocol list to be added, 
you can click Details. 
Click Details to display the screen. Set each item, seeing 
the following description. 
This is optional. 
If you do not set NIC, all settings of IP address, DNS, and 
WINS are Acquire automatically by default. The value of 
the scope ID is not reflected. For the remaining settings, 
go to Step (10). 

Delete Delete an added protocol. 
Select the protocol to delete from the Protocol list to be 
added and click Delete. 

OK Saves the settings in the Protocol Setting screen and 
returns to the previous window. 

Cancel Returns to the previous window without saving the settings 
in the Protocol Setting screen. 

 
2) Add Internet Protocol (TCP/IP) or Internet Protocol (TCP/IPv6) to the Protocol list to be added and 

click Details. 
 

3) The screen for setting is displayed as the following. Configure on the IP Settings tab. 
 

 There is no area to enter the scope ID with the disk duplication data file (Windows 
parameter file(Express)). 

 
 When setting several NIC's (LAN boards), repeat Steps 3)-4). 
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 In the case of Settings Internet Protocol(TCP/IP) screen 
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Settings Internet Protocol (TCP/IP) 
 IP Setting Here you can set the IP address, subnet mask, gateway, and metrics. The 

settings differ depending on whether they are acquired automatically or set 
manually. 

 Acquire the IP 
Address 
Automatically 

If you select this option button, the IP address is acquired automatically. 
The option button is selected by default. 

Use the following 
IP Address 

Selecting this option button enables setting of the IP address, subnet 
mask, gateway, and metric. 

 IP address  
 Add If you click Add, the TCP/IP address screen appears. Enter the IP 

address and subnet mask. 

 
Enter these in the form "xxx xxx xxx xxx". 
If you click Add in the TCP/IP address screen, the IP address and subnet 
mask are added to the list of IP address. 
The total number of IP addresses and subnet masks that can be set for 
each NIC are as follows: 
・ Windows parameter file(Express): up to 16 
・ Windows parameter file: up to 4 

Edit Select the IP address/subnet mask to be edited from the IP address group 
box and click Edit. The TCP/IP address screen appears. Edit the IP 
address/subnet mask.  

Delete Select the IP address/subnet mask to be deleted from the IP address 
group box and click Delete. The IP address/subnet mask is deleted. 

Default Gateway 
 Add If you click Add, the TCP/IP gateway address screen appears. So enter 

the gateway and metric. 

 
Enter these in the form "xxx xxx xxx xxx" in the Gateway. 
Enter numeric characters in Metric. This can be set in the range of 
"1-9999." The default value is "1."  
If you click Add in the TCP/IP gateway address screen, the gateway and 
metric are added to the list of Default gateway. 
The total number of gateways and metrics that can be added is as follows:  
・ Windows parameter file(Express): up to 16 
・ Windows parameter file: up to 4 

Edit Select the gateway/metric to be edited from the list of Default gateway 
and click Edit. The TCP/IP gateway address screen appears. Edit the 
gateway/metric. 

Delete Select the gateway/metric to be deleted from the list of Default gateway 
and click Delete to delete the gateway/metric. 
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 When you select the Check the completion of a scenario by the communication with 

DPM Client checkbox (Web Console Management view -> DPM Server icon -> Detail 
setting in Configuration menu -> General tab), the completion of the scenario may not 
be detected if the managed machine cannot communicate with the Management Server by 
the set IP address. Set IP address by which the machine can communicate with the 
Management Server. 
When you clear the Check the completion of a scenario by the communication with 
DPM Client checkbox, the completion of the scenario can be detected regardless of 
whether the machine can communicate with the Management Server or not. 

 
 In the case of Settings Internet Protocol(TCP/IPv6) screen 

 

 
 

Settings Internet Protocol (TCP/IPv6) 
 IP Setting You can set the IPv6 address, subnet prefix, gateway, and metrics. The 

settings differ depending on whether they are obtained automatically or set 
manually. 

 Router 
Advertisement 

If you select the Router Advertisement checkbox, the machine will 
receive Router Advertisement. 
This is not selected by default. 

 Acquire the IP 
Address 
Automatically 

If you select this option button, the IPv6 address is obtained automatically. 
The option button is selected by default. 

 



 

252 

 
  Use the 

following IP 
Address 

If you select this option button, settings of the IPv6 address, subnet prefix, 
gateway, and metric are enabled. 

 IP address  
 Add If you click Add, the TCP/IPv6 address screen appears. Enter the IPv6 

address and subnet prefix. 

 
Enter IP address in the form "xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx". 

Example) 
fe80::1895:3454:53e3:40cc 

Enter the length of the prefix in Subnet Prefix by bit (numeric characters). 
You can set in the range of "0-128". 

Example) 
64 

If you click Add in the TCP/IPv6 address screen, the IPv6 address and 
subnet prefix are added to the list of IP address. 
The total number of IPv6 addresses and subnet prefix that can be set for 
each NIC is up to 16. 

Edit Select the IPv6 address/subnet prefix to be edited from the list of IP 
address and click Edit. The TCP/IPv6 address screen appears. Edit the 
IPv6 address/subnet prefix.  

Delete Select the IP address/subnet prefix to be deleted from the list of IP 
address and click Delete. The IPv6 address and subnet prefix are deleted. 

Default Gateway 
 Add If you click Add, the TCP/IPv6 gateway address screen appears. Enter 

the gateway and metric. 

 
Enter Gateway in the form "xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx". 

Example) 
fe80::1895:3454:53e3:40cc 

Enter numeric characters in Metric. 
You can set in the range of "1-9999". Default is "1". 
If you click Add in the TCP/IPv6 gateway address screen, the gateway 
and metric are added to the list of Default Gateway. 
The gateway and metric can be set up to 16. 

Edit Select the gateway/metric to be edited from the list of Default gateway 
and click Edit. The TCP/IPv6 gateway address screen appears. Edit the 
gateway/metric. 

Delete Select the gateway/metric to be deleted from the list of Default gateway 
and click Delete to delete the gateway/metric. 
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4) The screen for setting is displayed as the following. Configure the DNS/WINS tab(DNS tab). 
 
 In the case of Settings Internet Protocol(TCP/IP) screen 
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Settings Internet Protocol (TCP/IP)  
 DNS/WINS The DNS and WINS settings are made here. The settings differ 

depending on whether they are acquired automatically or set 
manually. 

 Acquire the address of  
DNS server automatically 

Select this to acquire the address of the DNS server 
automatically. 
Select Acquire the address of DNS server automatically if the 
destination machine is a DNS server. 
The option button is selected by default. 

Use the following address 
of DNS server  

Select Use the following address of DNS server to set the IP 
address of the DNS server. 

DNS server address (the order of use) 
 Add If you click Add, the TCP/IP DNS server screen appears. Enter 

the address of the DNS server. 

 
Enter these in the form "xxx xxx xxx xxx". 
If you click Add in the TCP/IP DNS server screen, IP address of 
the DNS server is added to the list of DNS server address (the 
order of use). 
The total number of IP addresses of DNS server that can be 
added is as follows:  
・ Windows parameter file(Express): up to 16 
・ Windows parameter file: up to 4 

Edit Select IP address of the DNS server to be edited from the list of 
DNS server address (the order of use) and click Edit. The 
TCP/IP DNS server screen appears. Edit IP address of the DNS 
server. 

Delete Select IP address of the DNS server to be deleted from the list of 
DNS server address (the order of use) and click Delete to 
delete IP address of the DNS server. 

Acquire the address of  
WINS server automatically 

Select this to acquire IP address of the WINS server 
automatically. 
Select Acquire the address for WINS server automatically if 
the destination machine is a WINS server. 
The option button is selected by default. 

Use the following address 
of WINS server 

Select the Use the following address of WINS server checkbox 
to set the IP address of the WINS server. 
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   WINS address (the order of use) 

 Add If you click Add, the TCP/IP WINS server screen appears. So 
enter the address of the WINS server. 

 
Enter these in the form "xxx xxx xxx xxx". 
If you click Add in the TCP/IP WINS server screen, IP address of 
the WINS server is added to the list of WINS address (the order 
of use). 
The total number of IP addresses of WINS server that can be 
added is as follows:  
・ Windows parameter file(Express): up to 16 
・ Windows parameter file: up to 4 

Edit Select IP address of the WINS server to be edited from the list of 
WINS address (the order of use) and click Edit. The TCP/IP 
WINS server screen appears. Edit the IP address of the WINS 
server. 

Delete Select IP address of the WINS server to be deleted from the list 
of WINS address (the order of use) and click Delete to delete IP 
address of the WINS server. 

 
 In the case of Windows Server 2008 or Windows Vista, the WINS server address may not be 

set on the machine after the OS installation by disk duplication even if you specify it in the 
Windows parameter file (Express). 
Contact your sales or support representative for the detail. 
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 In the case of Settings Internet Protocol(TCP/IPv6) screen 

 

 
 

Settings Internet Protocol (TCP/IPv6)  
 DNS The DNS settings can be configured. The settings differ 

depending on whether they are acquired automatically or set 
manually. 

 Acquire the address of  
DNS server automatically 

Select this to acquire the address of the DNS server 
automatically. 
Select Acquire the address of DNS server automatically if the 
destination machine is a DNS server. 
The option button is selected by default. 

Use the following address 
of DNS server  

Select Use the following address of DNS server to set IPv6 
address of the DNS server. 
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  DNS server address (the order of use) 

 Add If you click Add, the TCP/IPv6 DNS server screen appears. 
Enter IPv6 address of the DNS server. 

 
Enter these in the form "xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx:xxxx "  

Example) 
fe80::1895:3454:53e3:40cc 

If you click Add in the TCP/IPv6 DNS server screen, IPv6 
address of the DNS server is added to the list of DNS server 
address (the order of use). 
The total number of IPv6 addresses of the DNS server that can 
be added is up to 16. 

Edit Select IPv6 address of the DNS server to be edited from the list of 
DNS server address (the order of use) and click Edit. The 
TCP/IPv6 DNS server screen appears. Edit IPv6 address of the 
DNS server. 

Delete Select IPv6 address of the DNS server to be deleted from the list 
of DNS server address (the order of use) and click Delete to 
delete IPv6 address of the DNS server. 
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 In the case of Settings Internet Protocol (TCP/IP) screen. 
 

 
 

Settings Internet Protocol (TCP/IP)  
 Scope ID Set the scope ID. 

The scope ID cannot be set for each NIC. If the internet protocol 
(TCP/IP) scope ID has been set for one NIC, the previously set scope 
ID is displayed, even if the Settings Internet Protocol (TCP/IP) 
screen is opened for the internet protocol (TCP/IP) of another NIC. 
This is optional. 

OK Click OK when you reflect the settings in 3)-5). This saves the settings 
in the Settings Internet Protocol (TCP/IP) screen and returns to the 
previous window. 

Cancel Click Cancel when you do not reflect the settings in 3)-5). This saves 
the settings in the Settings Internet Protocol (TCP/IP) screen and 
returns to the previous window. 
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(10) In the case of the disk duplication data file (Windows parameter file(Express)), click Next after setting the 

Network Setup screen. The Command information screen appears. Set the each item. 
 

 
 

Command Information 
 Command to be 

executed at the end 
of disk copy 

Displays the list of commands to be executed when OS 
installation by disk duplication is finished. 
Commands are executed in the displayed order(from the top). 

Add If you click Add, the Command detail screen appears. Enter the 
command to be executed. 

 
1023 characters or less can be entered. Alphanumeric 
characters and symbols can be entered. 
260 characters or less are recommended because the entered 
command is executed on the Windows OS. (Even if you enter 
1023 characters, the command may not be executed by OS.) 

Example) 
When you want to execute a command from the command 
prompt: 
cmd /c mkdir D:\DPM 

Click Add in the Command detail screen to add the command to 
the list of Command to be executed at the end of disk copy. 
You can add the command up to 499. 
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Edit Select the command to be edited in the list of Command to be 
executed at the end of disk copy and click Edit. The 
Command detail screen appears. Edit the command. 

Delete Select the command to be deleted in the list of Command to be 
executed at the end of disk copy and click Delete. The 
command is deleted. 

Up Select the command whose order is to be changed in the list of 
Command to be executed at the end of disk copy and click 
Up. The command is moved up by one. 

Down Select the command whose order is to be changed in the list of 
Command to be executed at the end of disk copy and click 
Down. The command is moved down by one. 

 
(11) After setting in the Command information screen, click Finish. 

In the case of the disk duplication data file (Windows parameter file), the Command information screen 
does not appear. After setting in the Network Setup screen, click Finish. 
 

(12) The agreement screen appears. Check the content and click I Accept. 
 

 
 

 If you select I Decline, you cannot use this function. 
 
(13) The Specify a file screen appears. Click OK. 

Disk duplication data files(three files) are created as the following. 
・ MAC address.inf 
・ MAC address.bat 
・ MAC address.xml 

 
  The file is named after MAC address which was entered automatically. The file 

name cannot be modified. 
 If the created disk duplication data files are unnecessary, delete them manually. 

(You cannot delete them from Delete registered data in Image Builder.) 
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 The default saved folder of disk duplication data files is as the following. 

・ In the case of the disk duplication data file (Windows parameter file(Express)): 
<Folder for Image(C:\Deploy)>\Ansfile\ExpressSysprep 

・ In the case of the disk duplication data file (Windows parameter file): 
<Folder for Image(C:\Deploy)>\Ansfile\sysprep 

 
2.Creating a Disk Duplication Data File (Windows Parameter File) 

This section describes the procedure for creating the disk duplication data file (Windows parameter file). 
 
(1) Log on to the machine, on which Image Builder is installed, by a user with administrator authority.  

When you use Image Builder on the Management Server, log on by the user who installed DPM Server. 
 

(2) From the Start menu, select All Programs -> DeploymentManager -> Image Builder. 
When you are logging on to the OS by the user except Administrator, execute it as an administrator. 
 

(3) Image Builder is launched. Click Configure setup parameter file. 
 

(4) The Select Parameters screen appears. Select Windows Parameter File and click OK. 
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(5) The Create Setup Parameter File screen appears. From the File menu, click Create new disk copy 

information files for 2008/Vista or later(B). 
 

 
 

(6) The subsequent procedure is the same as the Windows parameter file(Express). See "1. Creating a Disk 
Duplication Data File (Windows parameter file(Express)). 

 

5.4.2. Batch Creation of Disk Duplication Data Files (Windows) 
This section describes batch creation of disk duplication data files when executing OS installation by disk 
duplication on two or more managed machines (Windows OS). 
 

5.4.2.1. Windows Parameter File 
This section describes batch creation of disk duplication data files (Windows parameter file). 
 
(1) Prepare a disk duplication data file which is the base for creating two or more disk duplication data files. 

 
 For details on how to create a disk duplication data file, see Section 5.4.1, 

"Creating a Disk Duplication Data File (Windows)." 

 
(2) Log on to the machine, on which Image Builder is installed, by a user with administrator authority.  

When you use Image Builder on the Management Server, log on by the user who installed DPM Server. 
 

(3) From the Start menu, select All Programs -> DeploymentManager -> Image Builder. 
When you are logging on to the OS by the user except Administrator, execute it as an administrator. 
 

(4) Image Builder is launched. Click Configure setup parameter file. 
 

(5) The Select parameter screen appears. Select Windows parameter file and click OK. 
 

(6) The Create Setup Parameter File screen appears. From the Option menu, select Creation of multiple 
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disk copy information files assistant -> Output disk duplication data file in CSV format (I). 
 
(7) The Open screen appears. Specify the disk duplication data file prepared in Step (1) and open it. 
 
(8) Specify the CSV file name to save and click OK. The CSV-format disk duplication data file is created and 

stored in <Folder for Image>\AnsFile\Sysprep\csv. 
 

 
 

 The CSV file created here is hereinafter described as a "template file". 
 

(9) Edit the template file created in (8). Open the CSV file created in (8) under <Folder for 
Image>\AnsFile\Sysprep\csv. 
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(10) Open and edit the created CSV-format template file under <Folder for Image>\AnsFile\Sysprep\csv. 

Each line in the template file is as follows: 
 

1) 1st line 
Name of the file that is the basis for the template file. 

2) 2nd line 
Items in the disk duplication data file that can be specified during batch creation. 

3) 3rd line 
Parameters specified by the file that is the basis for the template file. 

4) 4th line and later 
Fill in the items corresponding to the 2nd line to perform batch creation. Each line corresponds to 
one disk duplication data file. 
 

 Do not modify from 1st line to 3rd line. Any modification will make batch creation using 
the template file impossible. 

 
See the table below for details on configuring the 4th line and later. 
 

  If you edit the file as a text file, items are separated by commas ( , ). Let each 
item of the 4th line and later correspond with that of the 2nd line. 

 Do not include spaces before or after items when editing the 4th line and on in 
the CSV file. Do not use commas ( , ) or double quotes ( " ) in the items. This 
might prevent successful creation of the disk duplication data file. 

 If the format for each item in the 4th line is not indicated in the table below, see 
Section 5.4.1, " Creating a Disk Duplication Data File (Windows)" and follow the 
description. If the format for each item is indicated in the table below, ensure 
accurate capitalization. 

 The DNS/WINS for each LAN board corresponds to the DNS/WINS set for each 
LAN board in the file which is the basis for the template file. 
When creating the file that is the basis for the template file, the internet protocols 
(TCP/IP) equal to the number of LAN boards are added to the Protocol list to be 
added in the Protocol Setting screen. In the DNS/WINS settings, items line up 
as LAN board 1, LAN board 2, LAN board 3, and LAN board 4 from the above of 
the list. 
 
Example) of the correspondence is as below. 

Protocol list to be added 
 
  
 
 
 
 
 

 

Apple Talk protocol 
Internet Protocol (TCP/IP)  00-00-00-00-00-00 
Internet Protocol (TCP/IP)  00-00-00-00-00-11 
Internet Protocol (TCP/IP)  AutoDetect1  
Internet Protocol (TCP/IP)  AutoDetect2  
 

LAN board 1 
LAN board 2 
LAN board 3 
LAN board 4 
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Items in the 2nd line Explanation of input items in the 

4th line and later 
When items in the 4th line and 
later is blank spaces, how to 
handle in the batch creation in 
Step (11). 

Computer Name  
(Required)  

Input the computer name. Error. 

MAC Address 
(Displayed only for disk 
duplication data file.) 
(Required)  

Input the MAC address of the 
machine. 
 

Error. 

User Name Input the user name.  Same value as in parameter of 
3rd line in template file. 

Company name Input the company name. Same value as in parameter of 
3rd line in template file. 

Product Key Input product key for Retail Version 
or OEM Version other than NEC. 
For NEC OEM Version, NEC OEM is 
input (Enter a space between NEC 
and OEM). Note that if the product key 
in the 3rd line of the template file is not 
NEC OEM, an error will be returned 
during creation of a disk duplication 
information file. 

Same value as in parameter of 
3rd line in template file. 

Administrator Password Input administrator password in plain 
text. 

Same value as in parameter of 
3rd line in template file. 

Workgroup Input the workgroup name. 
Note that if Domain, Domain 
Account Name, or Domain Account 
Password is input when the 
workgroup is input, an error will be 
returned during creation of the disk 
duplication data file. 

If Domain is not input, the same 
value as the parameter on the 
3rd line of the template file is 
used. 

Domain Input the domain name. 
However, when both a domain and 
workgroup are entered, an error will 
be returned during creation of a disk 
duplication data file. 

If Workgroup is not input, the 
same value as the parameter on 
the 3rd line of the template file is 
used. 

Domain's Account Name Input the domain's account name. 
Note that if Workgroup is input when 
the domain is input, an error will be 
returned during creation of a disk 
duplication data file. 

If Workgroup, Domain, and 
Domain Account Name are not 
input, the same value as the 
parameter on the 3rd line of the 
template file is used. 

Domain's Account 
Password 

Input domain's account password in 
plain text. 
Note that if Workgroup is input when 
the domain is input, an error will be 
returned during creation of a disk 
duplication data file. 

If Workgroup, Domain, 
Domain Account Name, and 
Domain Account Password 
are not input, the same value as 
the parameter on the 3rd line of 
the template file is used. 

NIC1 Input the first LAN board If the NIC is 
specified, input the MAC address. 
If the NIC is not specified, input 
AutoDetect. 

Set as AutoDetect1, and the IP 
address for NIC1 is 
Automatically Acquire IP 
Address. The values of IP 
address1 (NIC1)-Metric4 (NIC1) 
are not reflected. 
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Items in 2nd line Explanation of input items in the 

4th line and later  
When items in the 4th line 
and later is blank spaces, 
how to handle in the batch 
creation in Step (11). 

IP Address 1 
(NIC1) 

Input the first IP address in LAN board 
1. 
DHCP is entered if automatically 
acquired. 

Set to Acquire the address of 
DNS server automatically. 
The values of SubnetMask1 
(NIC1)-SubnetMask4 (NIC1) 
are not reflected. 

SubnetMask1 
(NIC1) 

Input the first subnet mask in LAN 
board 1. 

Set to same value as the data 
in the file which is the basis of 
the template file only when IP 
address 1 (NIC1) has been 
input. 
No setting in all other cases. 

IP Address 2 (NIC1) Input the second IP address in LAN 
board 1. 

No setting. 

SubnetMask2 (NIC1) Input the second subnet mask in LAN 
board 1. 

Set to same value as the data 
in the file which is the basis of 
the template file only when IP 
address 2 (NIC1) has been 
input. 
No setting in all other cases. 

IP Address 3 (NIC1) Input the third IP address in LAN 
board 1. 

No setting. 

SubnetMask3 (NIC1) Input the third subnet mask in LAN 
board 1. 

Set to same value as the data 
in the file which is the basis of 
the template file only when IP 
address 3 (NIC1) has been 
input. 
No setting in all other cases. 

IP Address 4 (NIC1) Input the fourth IP address in LAN 
board 1. 

No setting. 

SubnetMask4 (NIC1) Input the fourth subnet mask in LAN 
board 1. 

Set to same value as the data 
in the file which is the basis of 
the template file only when IP 
address 4 (NIC1) has been 
input. 
No setting in all other cases. 

Gateway1 (NIC1) Input the first gateway in LAN board 1. No setting. 
Metric1 (NIC1) Input the first metric in LAN board 1. Set to 1 only when Gateway1 

(NIC1) has already been input. 
Gateway2 (NIC1) Input the second gateway in LAN 

board 1. 
No setting. 

Metric2 (NIC1) Input the second metric in LAN board 
1. 

Set to 1 only when Gateway2 
(NIC1) has already been input. 

Gateway3 (NIC1) Input the third gateway in LAN board 
1. 

No setting. 

Metric3 (NIC1) Input the third metric in LAN board 1. Set to 1 only when Gateway3 
(NIC1) has already been input. 

Gateway4 (NIC1) Input the fourth gateway in LAN board 
1. 

No setting. 
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Items in 2nd line Explanation of input items in the 

4th line and later  
When items in the 4th line 
and later is blank spaces, 
how to handle in the batch 
creation in Step (11). 

Metric4(NIC1) Input the fourth metric in LAN board 1. Set to 1 only when Gateway4 
(NIC1) has already been input. 

NIC2 Input the MAC address of the second 
LAN board or AutoDetect. 

No setting. 
The values of IP address 1 
(NIC2)-Metric4 (NIC2) are not 
reflected. 

IP Address 1 (NIC2) Input the first IP address of LAN board 
2 if LAN board 2 has been set. DHCP 
is entered if automatically acquired. 

Set to Automatically Acquire 
IP Address. The values of 
SubnetMask1 
(NIC2)-SubnetMask4 (NIC2) 
are not reflected. 

SubnetMask1(NIC2) Input the first subnet mask in LAN 
board 2. 

Set to same value as the data 
in the file which is the basis of 
the template file only when IP 
address 1 (NIC2) has been 
input. 
No setting in all other cases. 

IP Address 2 (NIC2) Input the second IP address in LAN 
board 2. 

No setting. 

SubnetMask2(NIC2) Input the second subnet mask in LAN 
board 2. 

Set to same value as the data 
in the file which is the basis of 
the template file only when IP 
address 2 (NIC2) has been 
input. 
No setting in all other cases.  

IP Address 3 (NIC2) Input the third IP address in LAN 
board 2. 

No setting. 

SubnetMask3(NIC2) Input the third subnet mask in LAN 
board 2. 

Set to same value as the data 
in the file which is the basis of 
the template file only when IP 
address 3 (NIC2) has been 
input. 
No setting in all other cases. 

IP Address 4 (NIC2) Input the fourth IP address in LAN 
board 2. 

No setting. 

SubnetMask4(NIC2) Input the fourth subnet mask in LAN 
board 2. 

Set to same value as the data 
in the file which is the basis of 
the template file only when IP 
address 4 (NIC2) has been 
input. 
No setting in all other cases. 

Gateway1(NIC2) Input the first gateway in LAN board 2. No setting. 
Metric1(NIC2) Input the first metric in LAN board 2. Set to 1 only when Gateway1 

(NIC2) has already been input. 
Gateway2(NIC2) Input the second gateway in LAN 

board 2. 
No setting. 

Metric2(NIC2) Input the second metric in LAN board 
2. 

Set to 1 only when Gateway2 
(NIC2) has already been input. 

Gateway3(NIC2) Input the third gateway in LAN board 
2. 

No setting. 

Metric3(NIC2) Input the third metric in LAN board 2. Set to 1 only when Gateway3 
(NIC2) has already been input. 
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Items in 2nd line Explanation of input items in the 

4th line and later 
When items in the 4th line 
and later is blank spaces, 
how to handle in the batch 
creation in Step (11). 

Gateway4(NIC2) Input the fourth gateway in LAN board 
2. 

No setting. 

Metric4(NIC2) Input the fourth metric in LAN board 2. Set to 1 only when Gateway4 
(NIC2) has already been input. 

NIC3 Input the MAC address of the third 
LAN board or AutoDetect. 

No setting. The values of IP 
address 1 (NIC3)-Metric4 
(NIC3) are not reflected. 

IP address 1(NIC3) Input the first IP address of LAN board 
3 if LAN board 3 has been set. 
DHCP is entered if automatically 
acquired. 

Set to Automatically Acquire 
IP Address. The values of 
SubnetMask1 
(NIC3)-SubnetMask4 (NIC3) 
are not reflected. 

SubnetMask1 
(NIC3) 

Input the first subnet mask in LAN 
board 3. 

Set to same value as the data 
in the file which is the basis of 
the template file only when IP 
address 1 (NIC3) has been 
input. 
No setting in all other cases. 

IP address 2(NIC3) Input the second IP address in LAN 
board 3. 

No setting. 

SubnetMask2(NIC3) Input the second subnet mask in LAN 
board 3. 

Set to same value as the data 
in the file which is the basis of 
the template file only when IP 
address 2 (NIC3) has been 
input. 
No setting in all other cases. 

IP address 3(NIC3) Input the third IP address in LAN 
board 3. 

No setting. 

SubnetMask3(NIC3) Input the third subnet mask in LAN 
board 3. 

Set to same value as the data 
in the file which is the basis of 
the template file only when IP 
address 3 (NIC3) has been 
input. 
No setting in all other cases. 

IP address 4(NIC3) Input the fourth IP address in LAN 
board 3. 

No setting. 

SubnetMask4(NIC3) Input the fourth subnet mask in LAN 
board 3. 

Set to same value as the data 
in the file which is the basis of 
the template file only when IP 
address 4 (NIC3) has been 
input. 
No setting in all other cases. 

Gateway1(NIC3) Input the first gateway in LAN board 3. No setting. 
Metric1(NIC3) Input the first metric in LAN board 3. Set to 1 only when Gateway1 

(NIC3) has already been input. 
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Items in 2nd line Explanation of input items in the 

4th line and later 
When items in the 4th line 
and later is blank spaces, 
how to handle in the batch 
creation in Step (11). 

Gateway2(NIC3) Input the second gateway in LAN 
board 3. 

No setting. 

Metric2(NIC3) Input the second metric in LAN board 
3. 

Set to 1 only when Gateway2 
(NIC3) has already been input. 

Gateway3(NIC3) Input the third gateway in LAN board 
3. 

No setting. 

Metric3(NIC3) Input the third metric in LAN board 3. Set to 1 only when Gateway3 
(NIC3) has already been input. 

Gateway4(NIC3) Input the fourth gateway in LAN board 
3. 

No setting. 

Metric4(NIC3) Input the fourth metric in LAN board 3. Set to 1 only when Gateway4 
(NIC3) has already been input. 

NIC4 Input the MAC address of the fourth 
LAN board or AutoDetect. 

No setting. 
The values of IP address 1 
(NIC4)-Metric4 (NIC4) are not 
reflected. 

IP address1(NIC4) Input the first IP address of LAN board 
4 if LAN board 4 has been set. DHCP 
is entered if automatically acquired. 

Set to Automatically Acquire 
IP Address. The values of 
SubnetMask1 
(NIC4)-SubnetMask4 (NIC4) 
are not reflected. 

SubnetMask1(NIC4) Input the first subnet mask in LAN 
board 4. 

Set to same value as the data 
in the file which is the basis of 
the template file only when IP 
address 1 (NIC4) has been 
input. 
No setting in all other cases. 

IP address 2(NIC4) Input the second IP address in LAN 
board 4. 

No setting. 

SubnetMask2(NIC4) Input the second subnet mask in LAN 
board 4. 

Set to same value as the data 
in the file which is the basis of 
the template file only when IP 
address 2 (NIC4) has been 
input. 
No setting in all other cases. 

IP address 3(NIC4) Input the third IP address in LAN 
board 4. 

No setting. 

SubnetMask3(NIC4) Input the third subnet mask in LAN 
board 4. 

Set to same value as the data 
in the file which is the basis of 
the template file only when IP 
address 3 (NIC4) has been 
input. 
No setting in all other cases. 

IP address 4(NIC4) Input the fourth IP address in LAN 
board 4. 

No setting. 

SubnetMask4(NIC4) Input the fourth subnet mask in LAN 
board 4. 

Set to same value as the data 
in the file which is the basis of 
the template file only when IP 
address 4 (NIC4) has been 
input. 
No setting in all other cases. 
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Items in 2nd line Explanation of input items in the 

4th line and later  
When items in the 4th line 
and later is blank spaces, 
how to handle in the batch 
creation in Step (11). 

Gateway1(NIC4) Input the first gateway in LAN board 4. No setting. 
Metric1(NIC4) Input the first metric in LAN board 4. Set to 1 only when Gateway1 

(NIC4) has already been input. 
Gateway2(NIC4) Input the second gateway in LAN 

board 4. 
No setting. 

Metric2(NIC4) Input the second metric in LAN board 
4. 

Set to 1 only when Gateway2 
(NIC4) has already been input. 

Gateway3(NIC4) Input the third gateway in LAN board 
4. 

No setting. 

Metric3(NIC4) Input the third metric in LAN board 4. Set to 1 only when Gateway3 
(NIC4) has already been input. 

Gateway4(NIC4) Input the fourth gateway in LAN board 
4. 

No setting. 

Metric4(NIC4) Input the fourth metric in LAN board 4. Set to 1 only when Gateway4 
(NIC4) has already been input. 

 
(11) Save the CSV file after editing it. 
 
(12) Select Creation of multiple disk copy information files assistant -> Create multiple disk duplication 

data files in Option menu of the Create Setup Parameter File screen. 
 
(13) When the Open File screen appears, select the CSV file saved in Step (11). The Result of creating 

multiple information files screen appears, showing the results of the creation. One disk duplication data 
file is created for each computer registered in the CSV file. 

 
 If "Data file creation failed" is displayed in the Batch Data File Creation Results 

screen, click Error Information. Detailed information about errors is displayed. 
Correct the CSV file accordingly and perform the operation again. 

 
(14) Click OK. Batch creation of disk duplication data files is completed. 
 

 If the created CSV files or disk duplication data files are unnecessary, delete them 
manually. (You cannot delete them from Delete registered data in Image Builder.) 

 
 

5.4.2.2. Windows Parameter File(Express) 
This section describes batch creation of disk duplication data files (Windows parameter file(Express)). 
 
(1) Prepare a disk duplication data file (Windows parameter file(Express)) which is the base for creating two or 

more disk duplication data files (Windows parameter file(Express)). 
 
 For details on how to create a disk duplication data file, see Section 5.4.1.2, 

"Creating a Disk Duplication Data File (Windows Server 2008/Windows Vista or 
Later)." 

 
(2) Log on to the machine, on which Image Builder is installed, by a user with administrator authority.  

When you use Image Builder on the Management Server, log on by the user who installed DPM Server. 
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(3) From the Start menu, select All Programs -> DeploymentManager -> Image Builder. 

When you are logging on to the OS by the user except Administrator, execute it as an administrator. 
 

(4) Image Builder is launched. Click Configure setup parameter file. 
 

(5) The Select parameter screen appears. Select Windows parameter file(Express) and click OK. 
 

(6) The Create Setup Parameter File screen appears. From the Option menu, select Creation of multiple 
disk copy information files assistant -> Output disk duplication data file in CSV format (I). 

 
(7) The Open screen appears. Specify the disk duplication data file (Windows parameter file(Express)) 

prepared in Step (1) and open it. 
 
(8) Specify the CSV file name to save and click OK. The CSV-format disk duplication data file is created and 

stored in <Folder for Image>\AnsFile\ExpressSysprep\csv. 
 

 
 

 The CSV file created here is hereinafter described as a "template file". 
 

(9) Edit the template file created in (8). Open the CSV file created in (8) under <Folder for 
Image>\AnsFile\ExpressSysprep\csv. 

 
(10) Open and edit the created CSV-format template file  

under <Folder for Image>\AnsFile\ExpressSysprep\csv. 
Each line in the template file is as follows: 
 

1) 1st line 
Name of the file that is the basis for the template file. 

2) 2nd line 
Items in the disk duplication data file that can be specified during batch creation. 

3) 3rd line 
Parameters specified by the file that is the basis for the template file. 

4) 4th line and later 
Fill in the items corresponding to the 2nd line to perform batch creation. Each line corresponds to 
one disk duplication data file. 
 

 Do not modify from 1st line to 3rd line. Any modification will make batch creation 
using the template file impossible. 
Also check that "," is not included in the parameter of the 3rd line. 

 
See the table below for details on configuring the 4th line and later. 

 



 

272 

  If you edit the file as a text file, items are separated by commas ( , ). Let each 
item of the 4th line and later correspond with that of the 2nd line. 

 Do not include spaces before or after items when editing the 4th line and on in 
the CSV file. Do not use commas ( , ) or double quotes ( " ) in the items. This 
might prevent successful creation of the disk duplication data file. 

 If the format for each item in the 4th line is not indicated in the table below, 
see Section 5.4.1.2, "Creating a Disk Duplication Data File (Windows Server 
2008/Windows Vista or Later)" and follow the description. If the format for 
each item is indicated in the table below, ensure accurate capitalization. 

 
Items in the 2nd line Explanation of input items in the 

4th line and later 
When items in the 4th line and 
later is blank spaces, how to 
handle in the batch creation in 
Step (11). 

Computer Name  
(Required)  

Input the computer name. Error. 

MAC Address 
(Displayed only for disk 
duplication data file.) 
(Required)  

Input the MAC address of the 
machine. 
 

Error. 

User Name Input the user name.  Same value as in parameter of 
3rd line in template file. 

Company name Input the company name. Same value as in parameter of 
3rd line in template file. 

Product Key Input product key. Same value as in parameter of 
3rd line in template file. 

Administrator Password Input administrator password in plain 
text. 

Same value as in parameter of 
3rd line in template file. 

Workgroup Input the workgroup name. 
Note that if Domain, Domain 
Account Name, or Domain Account 
Password is input when the 
workgroup is input, an error will be 
returned during creation of the disk 
duplication data file. 

If Domain is not input, the same 
value as the parameter on the 
3rd line of the template file is 
used. 

Domain Input the domain name. 
However, when both a domain and 
workgroup are entered, an error will 
be returned during creation of a disk 
duplication data file. 

If Workgroup is not input, the 
same value as the parameter on 
the 3rd line of the template file is 
used. 

Domain's Account Name Input the domain's account name. 
Note that if Workgroup is input when 
the domain is input, an error will be 
returned during creation of a disk 
duplication data file. 

If Workgroup, Domain, and 
Domain Account Name are not 
input, the same value as the 
parameter on the 3rd line of the 
template file is used. 

Domain's Account 
Password 

Input domain's account password in 
plain text. 
Note that if Workgroup is input when 
the domain is input, an error will be 
returned during creation of a disk 
duplication data file. 

If Workgroup, Domain, 
Domain Account Name, and 
Domain Account Password 
are not input, the same value as 
the parameter on the 3rd line of 
the template file is used. 

NIC1 Input 1st LAN board. If the NIC is 
specified, input the MAC address. 
If the NIC is not specified, input 
"AutoDetect". 

Set as AutoDetect1, and the IP 
address for NIC1 is " IP Address 
is automatically obtained ". The 
values of IP address1(NIC1)- 
IPv6DNS16(NIC1) are not 
reflected. 



 

273 

 
Items in 2nd line Explanation of input items in the 

4th line and later  
When items in the 4th line 
and later is blank spaces, 
how to handle in the batch 
creation in Step (11). 

IP Address1(NIC1) Input 1st IP address in LAN board 1. 
Input "DHCP" if automatically 
obtained. 

Set to "IP address is 
automatically obtained". The 
values of SubnetMask1(NIC1) 
-SubnetMask16 (NIC1) are not 
reflected. 

SubnetMask1(NIC1
) 

Input 1st subnet mask in LAN board 1. Set to same value as the data 
in the file which is the basis of 
the template file only when IP 
address 1 (NIC1) is input. 
No setting in all other cases. 

IP Address 2(NIC1) 
- 
IP Address 
16(NIC1)  

Input 2nd - 16th IP address in LAN 
board 1. 

No setting. 

SubnetMask2 
(NIC1) - 
SubnetMask16 
(NIC1) 

Input 2nd - 16th subnet mask in LAN 
board 1. 

Set to same value as the data 
in the file which is the basis of 
the template file only when 
corresponding IP 
address(NIC1) is input. 
No setting in all other cases. 

Gateway1(NIC1) - 
Gateway16(NIC1) 

Input 1st - 16th gateway in LAN board 
1. 

No setting. 

Metric1(NIC1) - 
Metric16(NIC1) 

Input 1st - 16th metric in LAN board 1. Set to 1 only when 
corresponding Gateway(NIC1) 
is input. 

DNS1(NIC1) Input 1st DNS address in LAN board 
1. 
Input "DHCP" if automatically 
obtained. 

No setting. 

DNS2(NIC1) - 
DNS16(NIC1) 

Input 2nd - 16th DNS address in LAN 
board 1. 

No setting. 

WINS1(NIC1) Input 1st WINS address in LAN board 
1. 
Input "DHCP" if automatically 
obtained. 

No setting. 

WINS2(NIC1) - 
WINS16(NIC1) 

Input 2nd - 16th WINS address in LAN 
board 1. 

No setting. 

EnableIPv6(NIC1) When IPv6 address of LAN board1 is 
used, input "YES". 
When IPv6 address is not used, input 
"NO". 
When "NO" is input, even if 
EnableRouterDiscovery(NIC1) 
-IPv6DNS16(NIC1) are specified, they 
are ignored. 

Set to"IPv6 address is not 
used". 

EnableRouterDisco
very(NIC1) 

When Router Advertisement of LAN 
board1 is received, input "YES". 
When Router Advertisement is not 
received, input "NO". 

Set to "Router Advertisement is 
not received". 
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Items in 2nd line Explanation of input items in the 

4th line and later  
When items in the 4th line 
and later is blank spaces, 
how to handle in the batch 
creation in Step (11). 

IPv6Address1 
(NIC1) 

Input 1st IPv6 address in LAN board 
1. 
Input "DHCP" if automatically 
obtained. 

Set to "IPv6 address is 
automatically obtained". The 
values of IPv6SubnetMask1 
(NIC1) - IPv6SubnetMask16 
(NIC1) are not reflected. 

IPv6SubnetMask1 
(NIC1) 

Input 1st IPv6 subnet mask in LAN 
board 1. 

Set to same value as the data 
in the file which is the basis of 
the template file only when IP 
address1(NIC1) is input. 
No setting in all other cases. 

IPv6Address2 
(NIC1) - 
IPv6Address16 
(NIC1)  

Input 2nd - 16th IPv6 address in LAN 
board 1. 

No setting. 

IPv6SubnetMask2 
(NIC1) - 
IPv6SubnetMask16
(NIC1) 

Input 2nd - 16th IPv6 subnet mask in 
LAN board 1. 

Set to same value as the data 
in the file which is the basis of 
the template file only when 
corresponding IPv6 address 
(NIC1) is input. 
No setting in all other cases. 

Pv6Gateway1(NIC1) - 
IPv6Gateway16 
(NIC1) 

Input 1st - 16th IPv6 gateway in LAN 
board 1. 

No setting. 

IPv6Metric1(NIC1) - 
IPv6Metric16(NIC1) 

Input 1st - 16th IPv6 metric in LAN 
board 1. 

Set to 1 only when 
corresponding Gateway(NIC1) 
is input. 

IPv6DNS1(NIC1) Input 1st IPv6 DNS address in LAN 
board 1. 
Input "DHCP" if automatically 
obtained. 

No setting. 

IPv6DNS2(NIC1) - 
IPv6DNS16(NIC1) 

Input 2nd - 16th IPv6 DNS address in 
LAN board 1. 

No setting. 

NIC2 Input MAC address of 2nd LAN board 
or "AutoDetect". 

No setting. 
The values of IP address1 
(NIC2)- IPv6DNS16(NIC2) are 
not reflected. 
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Items in 2nd line Explanation of input items in the 

4th line and later  
When items in the 4th line 
and later is blank spaces, 
how to handle in the batch 
creation in Step (11). 

IP Address 2(NIC2) 
- 
IP Address 
16(NIC2)  

Input 2nd - 16th IP address in LAN 
board 2. 

No setting. 

SubnetMask2(NIC2) 
- 
SubnetMask16 
(NIC2) 

Input 2nd - 16th subnet mask in LAN 
board 2. 

Set to same value as the data 
in the file which is the basis of 
the template file only when 
corresponding IP 
address(NIC2) is input. 
No setting in all other cases. 

Gateway1(NIC2) - 
Gateway16(NIC2) 

Input 1st - 16th gateway in LAN board 
2. 

No setting. 

Metric1(NIC2) - 
Metric16(NIC2) 

Input 1st - 16th metric in LAN board 2. Set to 1 only when 
corresponding Gateway(NIC2) 
is input. 

DNS1(NIC2) Input 1st DNS address in LAN board 
2. 
Input "DHCP" if automatically 
obtained. 

No setting. 

DNS2(NIC2) - 
DNS16(NIC2) 

Input 2nd - 16th DNS address in LAN 
board 2. 

No setting. 

WINS1(NIC2) Input 1st WINS address in LAN board 
2. 
Input "DHCP" if automatically 
obtained. 

No setting. 

WINS2(NIC2) - 
WINS16(NIC2) 

Input 2nd - 16th WINS address in LAN 
board 2. 

No setting. 

EnableIPv6(NIC2) When IPv6 address of LAN board 2 is 
used, input "YES". 
When IPv6 address is not used, input 
"NO". 
When "NO" is input, even if 
EnableRouterDiscovery(NIC2) 
-IPv6DNS16(NIC2) are specified, they 
are ignored. 

Set to"IPv6 address is not 
used". 

EnableRouterDiscov
ery(NIC2) 

When Router Advertisement of LAN 
board 2 is received, input "YES". 
When Router Advertisement is not 
received, input "NO". 

Set to "Router Advertisement is 
not received". 
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Items in 2nd line Explanation of input items in the 

4th line and later  
When items in the 4th line 
and later is blank spaces, 
how to handle in the batch 
creation in Step (11). 

IPv6Address1 
(NIC2) 

Input 1st IPv6 address in LAN board 
2. 
Input "DHCP" if automatically 
obtained. 

Set to "IPv6 address is 
automatically obtained". The 
values of IPv6SubnetMask1 
(NIC2) - IPv6SubnetMask16 
(NIC2) are not reflected. 

IPv6SubnetMask1 
(NIC2) 

Input 1st IPv6 subnet mask in LAN 
board 2. 

Set to same value as the data 
in the file which is the basis of 
the template file only when IP 
address1(NIC2) is input. 
No setting in all other cases. 

IPv6Address2 
(NIC2) - 
IPv6Address16 
(NIC2)  

Input 2nd - 16th IPv6 address in LAN 
board 2. 

No setting. 

IPv6SubnetMask2 
(NIC2) - 
IPv6SubnetMask16 
(NIC2) 

Input 2nd - 16th IPv6 subnet mask in 
LAN board 2. 

Set to same value as the data 
in the file which is the basis of 
the template file only when 
corresponding IPv6 address 
(NIC2) is input. 
No setting in all other cases. 

IPv6Gateway1 
(NIC2) - 
IPv6Gateway16 
(NIC2) 

Input 1st - 16th IPv6 gateway in LAN 
board 2. 

No setting. 

IPv6Metric1(NIC2) - 
IPv6Metric16(NIC2) 

Input 1st - 16th IPv6 metric in LAN 
board 2. 

Set to 1 only when 
corresponding Gateway(NIC2) 
is input. 

IPv6DNS1(NIC2) Input 1st IPv6 DNS address in LAN 
board 2. 
Input "DHCP" if automatically 
obtained. 

No setting. 

IPv6DNS2(NIC2) - 
IPv6DNS16(NIC2) 

Input 2nd - 16th IPv6 DNS address in 
LAN board 2. 

No setting. 

NIC3 - NIC8 Same description with NIC2. 
Input each item replacing with the 
above description. 

Same description with NIC2. 
Enter each item replacing with 
the above description. 

CMD1 - CMD499 Input the command which is executed 
after OS installation by disk 
duplication. 

No setting. 

 
(11) Save the CSV file after editing it. 
 
(12) Select Creation of multiple disk copy information files assistant -> Create multiple disk duplication 

data files in Option menu of the Create Setup Parameter File screen. 
 
(13) When the Open File screen appears, select the CSV file saved in Step (11). The Result of creating 

multiple information files screen appears, showing the results of the creation. One disk duplication data 
file is created for each computer registered in the CSV file. 

 
 If "Data file creation failed" is displayed in the Batch Data File Creation Results 

screen, click Error Information. Detailed information about errors is displayed. 
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Correct the CSV file accordingly and perform the operation again. 
 

(14) Click OK. Batch creation of disk duplication data files is completed. 
 

 If the created CSV files or disk duplication data files (Windows parameter 
file(Express)) are unnecessary, delete them manually. (You cannot delete them from 
Delete registered data in Image Builder.) 

 

5.4.3. Creating a Disk Duplication Data File (Linux) 
This section describes how to create a disk duplication data file for configuring individual machines when 
executing OS installation by disk duplication in Linux. 
Create the disk duplication data file by Image Builder on the Management Server or Image Builder (Remote 
Console). 
 
Create a new disk duplication data file. If you use an existing file, see "2. Other Operations and Displays" below. 
 

 The keyboard operations effective with buttons for creating a disk duplication data 
file are the Enter key and space key only. 

 
1. Creating a Disk Duplication Data File (New File) 
This section describes how to create a new disk duplication data file for configuring individual machines when 
executing OS installation by disk duplication in Linux. 
 
(1) Log on to the machine, on which Image Builder is installed, by a user with administrator authority.  

When you use Image Builder on the Management Server, log on by the user who installed DPM Server. 
 

(2) From the Start menu, select All Programs -> DeploymentManager -> Image Builder. 
When you are logging on to the OS by the user except Administrator, execute it as an administrator. 

 
(3) Image Builder is launched. Click Configure setup parameter file. 

 
(4) The Select parameter screen appears. Select Linux disk copy parameter file and click OK. 
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(5) When this screen is launched for the first time, or the environment configuration data file "LinuxSysRep.cfg" 

is not in the install directory, the LinuxOS Replicate Environment Set appears. Configure the settings to 
match your environment. 
 

 
 

 
LinuxOS Replicate Environment Set 
 Install Directory Displays the folder where Image Builder has been 

installed. 
This cannot be edited. 

Work Directory Displays the working folder in offline mode. This can be 
entered only when "Offline Mode" is selected in Select 
Working Mode. 
254 characters or less can be entered. Alphanumeric 
characters and symbols can be entered. 
The following symbols cannot be entered. 
, ; * ? " ' < > | [ ] @ 
The default is [Install Directory\linux\offline]. 

Select Working Mode  Select one of the following working modes. 
- Online mode 
- Offline mode 
The default is Online Mode. 

Management Server The IP address of the Management Server that was set 
during installation of Image Builder is obtained from the 
registry data and displayed here. 

Management Server 
Directory 

Displays the folder name on the Management Server 
where the disk duplication data file is to be saved when 
in online mode. (Fixed data) 

CANCLE Discards changes and closes the environment settings 
screen. 

SAVE Saves the settings to the environment settings file 
[LinuxSysRep.cfg] and closes the environment settings 
screen. 
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A confirmation message appears when the environment data for installation directory and the IP address of 
the Management Server cannot be obtained from the registry or the .ini file. 
Click OK to close without launching the creation tool of the disk duplication data file. 
 

 
 

 When creating a disk duplication data file, there are the following working modes:  
・ Online mode: Mode for normal use. 
・ Offline mode: Mode for creating files on a local machine without sending files to 

the Management Server. 
This section mainly explains the "Online Mode" that is used normally. 
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 Online Mode 

The disk duplication data file (Linux duplication parameter file) is created and managed in the Folder for 
Images on the Management Server over the network. 

 

 
 
 Offline Mode 

The disk duplication data file (Linux parameter file) is created and managed on the machine on which Image 
Builder is launched, using arbitrary folder as the working folder. 

 
 
 
 
 
 
 
 
 
 
 
 

 The default working folder is <Installation directory>\linux\offline. 
 
The working mode and working folder can be changed at any time. 
 

 The disk duplication data file is created in the text file format for Linux. Note when 
you edit the file using a text editor on a Windows machine or other application. 

 
(6) When the configuration is completed, click SAVE. 

Working Linux duplication parameter 
file 

Temporary folder: <Installation folder>\linux\online 
(Default:C:\Program Files\NEC\DeploymentManager\linux\online) 

Management Server 

Read and save a file 
 
 

Managed folder: <Folder for Image>\AnsFile\machineinf 

Receive a file Send a file 

Saved Linux duplication parameter file 

Image Builder 
(Remote Console) Machine 
 

Managed folder: Arbitrary working folder 
Image Builder 

(Remote Console) Machine 

Saved Linux duplication parameter file 
Read and save a file 
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(7) The confirmation screen appears. Click Yes. 

 

 
 

 If there is an error in the settings, an error message is displayed in red font and 
saving cannot be performed. Correct the settings and re-save. 

 
 
If you select CANCEL, the confirmation screen below is displayed. Clicking on 
Yes discards the settings and closes the screen. 
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(8) The LinuxOS Replicate Parameter Making screen appears. Configure settings to match your 

environment. 
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LinuxOS Replicate Parameter Making 
 
 

MAC Address 
(Required) 

Enter the MAC address of the Ethernet device of the 
managed machine which is registered in DPM in 12 
hexadecimal number. 
Example) "1A-2B-3C-4D-5E-6F", 
"1a-2b-3c-4d-5e-6f", and so on. 
When saving the file, the entered MAC address is 
used to create and save the disk duplication data file. 
The extension is .rep. 
Example) "1A2B3C4D5E6F.rep", 
"1a2b3c4d5e6f.rep", and so on. 

Primary DNS This is for entering the IP address of the primary DNS 
server as set in the managed machine. This entry is 
optional. 

Secondary DNS This is for entering the IP address of the secondary 
DNS server as set in the managed machine. This 
entry is optional. 

 
 Network Information Settings 
  

  When a computer with two or more LAN boards (Ethernet devices) is used and 
IP addresses in the same segment are assigned to the LAN boards, 
communication may fail if there are any LAN boards which are not connected to 
LAN cables. 
It is recommended that the LAN boards that are not connected with a LAN
  

cable should not have a static IP assigned, but be set with DHCP, or not 
set. 

 In an environment where the Network Manager daemon is enabled, the DNS 
settings set by the disk duplication data file will not be applied. 
If you perform DNS setting, please disable the NetworkManager daemon  
using the following method at the time of the master image creation. 

 
1) Confirm the start level of the NetworkManager  

#chkconfig --list NetworkManager 
 

(Example of execution results)  
NetworkManager  0:off  1:off  2:on   3:on   4:on   5:on   
6:off 

 
Run the following command if at least one is "on". 
All will be changed to "off". 

 
2) To disable the NetworkManager (run with root authority)  

#chkconfig NetworkManager off 
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Configure a TCP/IP network for Ethernet devices eth0 through eth6 in the Linux OS duplication target machine. 

 
1) Select the Ethernet device to be configured, and click EDIT. 
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2) The Network Data Set screen appears. Configure settings to match your environment. 
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Network Data Set 
 Device Name Displays the name of the Ethernet device being edited. 

Host Name Displays the host name. 255 characters or less can be 
entered. 
Alphanumeric characters and symbols can be entered. 
The following symbols and space cannot be entered. 
\ / : , ; * ? " < > ' | [ ] @ 
This must be entered for eth0. 

 IPv4 If you select IPv4 checkbox, you can configure for IP 
address. 
You need to configure for eth0 necessarily. 
This is selected by default. 

 
 
 
 

Network Type Select and set the type of TCP/IP network from below. 
- DHCP: IP addresses are set dynamically by a DHCP 
server. 
- Static IP: IP addresses are set manually. 

The default value is DHCP. 
IP Address Set the IP address. 

This must be entered only if Static IP has been selected 
as the network type. 
Example) "192.168.0.1" "192.168.100.150" and so on. 

Network Mask Set the network mask. 
This must be entered only if Static IP has been selected 
as the network type. 
Example) "255.255.0.0", "255.255.255.0" and so on. 

Gateway Enter the IP address of the gateway machine that 
corresponds to the IP address of the Ethernet device 
being configured. 
This does not need to be entered even if either DHCP or 
Static IP has been selected as the network type. 
Example) "192.168.0.250" "192.168.100.200" and so on. 

IPv6 If you select IPv6 checkbox, you can configure for IPv6 
address. 
This is supported only for Red Hat Enterprise Linux 
5/5AP/6/7. 
This is not selected by default. 

 Network Type Select the TCP/IP network type from the following. 
・ RA: Configures IPv6 address by the Router 

Advertisement. 
・ DHCP: Configures IPv6 address dynamically by 

DHCP server. 
・ Fixed IPv6: Configures IPv6 address manually. 
The default is "RA". 

IPv6 Address Set IPv6 address. 
This is required only when "Fixed IPv6" is selected in 
Network Type. 
Example) 

fe80::1895:3454:53e3:40cc 
Prefix Set the prefix. 

This is required only when "Fixed IPv6" is selected in 
Network Type. 
Example) 

64 
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Gateway Set IPv6 address of the gateway machine for IPv6 
address of the target ethernet device. 
You can enter only when "DHCP" or "Fixed IPv6" is 
selected in Network Type. This is optional. 
Example) 

fe80::1895:3454:53e3:40cc 
DNS Address Set IPv6 address of DNS server. 

This is optional. 
Example) 

fe80::1895:3454:53e3:40cc 
CANCEL Closes the Network Data Set without saving the 

Ethernet device settings. 
SAVE Saves the Ethernet device settings and closes the 

Network Data Set. 
 

  For a LAN board having a MAC address that is registered to the DPM, 
configure the settings so that network communication can be done, regardless 
of whether the address is a static IP address or is obtained from the DHCP 
server. 
If network communication cannot be done, an executed scenario may not be 
completed. 

 When you set the Gateway for Red Hat Enterprise Linux, set it on only either of  
eth0 - eth6. 

 In the case of Red Hat Enterprise Linux 7, the specific information is set by the 
order of devices which is displayed as the result of ip addr show command.  

 In the case of SUSE Linux Enterprise, the only setting of the gateway for the 
Ethernet device which is "eth0" is valid. 
For managed machines registered in DPM, assign a connectable IP address in 
the same segment. If an address which is not connectable is assigned, 
scenario execution may not be completed. 
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 If a setting is not correct, an error message is displayed in red at the bottom of the 

Network Data Set and saving cannot be performed. 
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 Time Zone 

 
Select the time zone to set for the Linux duplication target machine from the time zone list in the red box. 
The item in the red box must be set. The default is America/New_York. 

 

 
 



 

290 

 
 Script Data 

 
Set the Linux shell script to be executed after duplication is completed in the Linux OS duplication target 
machine. 

 

  
 

Script Data Enter the script data. 100 lines or less (256 characters or 
less per line) can be entered. 
Alphanumeric characters and symbols can be entered. 
The file cannot be read if the total of the entered data 
and the file that is read exceeds the above limit. 

 Read Displays the file selection dialogue screen, with the 
current work folder as the default folder. 
Select a file from among the file names to read the script 
data. 

Clear Deletes all currently entered script data. 
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(9) Save the disk duplication data file as the MAC address name. 

 
 Working Mode: Online 

Save the currently setting of Linux duplication parameters. 
 

1) File menu -> click Save As MacAddress. 
 

 
 

2) When the file save confirmation message is displayed for the disk duplication data file, check the name 
of the file to be saved and click Yes. 
The file is saved with the entered MAC address name under  
<Folder for Image>\AnsFile\machineinf> on the Management Server. The file name is 
"MACaddress.rep". 
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 If the disk duplication data files are unnecessary, delete them manually. (You 
cannot delete them from Delete registered data in Image Builder.) 

 
 If the following message is displayed, save the file again after checking the setting 

of the Management Server and network and resolving the problem. 

 
 

 Working Mode: Offline 
The file is saved as the entered MAC address name under the specified folder. 
The file name is MACaddress.rep. 

 
1) When the Select Directory screen appears, select the folder to save the disk duplication data file. 

 

 
 

2) When the file save confirmation message is displayed for the disk duplication data file, check the name 
of the file to be saved and click Yes. 

 
 If a file with the same file name already exists in the folder to be saved, the 

overwrite confirmation message is displayed. To overwrite, click Yes. If not, 
click No. 
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The following message is displayed when the file has successfully been saved to the selected folder. 
 

 
 

 If the following message is displayed, check whether there is a problem in the 
folder to be saved, and save it again. 

 
 
2. Other Operations and Displays 
 
 Opening the Disk Duplication Data File (Existing File) 
 
This section describes how to create the disk duplication data file using an existing file. 
 
(1) Log on to the machine, on which Image Builder is installed, by a user with administrator authority. 

When you use Image Builder on the Management Server, log on by the user who installed DPM Server. 
 
(2) From the Start menu, select All Programs -> DeploymentManager -> Image Builder. 

When you are logging on to the OS by the user except Administrator, execute it as an administrator. 
 

(3) Image Builder is launched. Click Configure setup parameter file. 
 

(4) The Select parameter screen appears. Select Linux disk copy parameter file and click OK. 
 

 
 

(5) The LinuxOS Replicate Parameter Making screen appears. From the File menu, click Open and select 
MACaddress.rep to open the file. 
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(6) The existing disk duplication data file is displayed. 

 

 
 

 Working Mode: Online 
The Select Host Name screen appears to select the disk duplication data file in  
<Folder for Image>\AnsFile\machineinf on the Management Server. Select the host file (the template file) 
and click Select. 
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 Working Mode: Offline 

A list of disk duplication data files in the current working folder is displayed in the Select File screen. Select 
the disk duplication data file and click Open. 

 

 
 

 If there is an error during reading of the disk duplication data file, the following 
message is displayed. Check the disk duplication data file. 

 
 

 Changing the working mode 
The working mode can be changed by the following procedure. 

 
(1) Log on to the machine, on which Image Builder is installed, by a user with administrator authority. 

When you use Image Builder on the Management Server, log on by the user who installed DPM Server. 
 

(2) From the Start menu, select All Programs -> DeploymentManager -> Image Builder. 
When you are logging on to the OS by the user except Administrator, execute it as an administrator. 

 
(3) Image Builder is launched. Click Configure setup parameter file. 

 
(4) The Select parameter screen appears. Select Linux disk copy parameter file and click OK. 
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(5) The LinuxOS Replicate Parameter Making screen appears. From the Working Mode menu, select 

the Set Online or Set Offline option button to switch the working mode. 
 

 
 

 Displaying Replicate Parameter 
 

The parameters set during OS installation by disk duplication can be displayed as a list or printed in the output 
format of the disk duplication data file. 

 
1) Open the File menu in the LinuxOS Replicate Parameter Making screen and click Display Replicate 

Parameter. 
 
2) When the LinuxOS Replicate Parameter List screen appears, click Print to print out the checklist. 
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 If there are any problems or errors in the current setting, the Duplication 

Parameter Error List screen is displayed instead of the LinuxOS Replicate 
Parameter List screen. 
Check the content displayed in the error list and correct any errors in the 
LinuxOS Replicate Parameter Making screen. 

 
 

 Error Message Display Area 
If any problems or errors are discovered during an operation, an error message is displayed in red. 
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5.4.4. Batch Creation of Disk Duplication Data File (Linux) 
When executing OS installation by disk duplication on two or more Linux managed machines, a disk duplication 
data file must be created for each machine. 
 
This section describes batch creation of Linux disk duplication data files. 
 
(1) Prepare the disk duplication data file which is the base batch creation of data files. See "5.4.3 Creating a 

Disk Duplication Data File (Linux)" to create the disk duplication data file. 
 
(2) Log on to the machine, on which Image Builder is installed, by a user with administrator authority.  

When you use Image Builder on the Management Server, log on by the user who installed DPM Server. 
 

(3) From the Start menu, select All Programs -> DeploymentManager -> Image Builder. 
When you are logging on to the OS by the user except Administrator, execute it as an administrator. 

 
(4) Image Builder is launched. Click Configure setup parameter file. 

 
(5) The Select parameter screen appears. Select Linux disk copy parameter file and click OK. 

 
(6) Open the file created in Section 5.4.3, "Creating a Disk Duplication Data File (Linux)." See "2. Other 

Operations and Displays" in Section 5.4.3, "Creating a Disk Duplication Data File (Linux)" to open an 
existing file. 

 
(7) The Creating Linux OS Duplication Parameters screen appears. From the Replicate Parameter menu, 

select Make Replicate Parameter. 
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(8) The Replicate Parameter Extensive creation screen appears. Configure the settings in the red box.The 

disk duplication parameter data can be set for up to 100 Linux duplication machines. Enter the network data 
for Ethernet device "eth0" of the target machine for duplication. 
 

 
 

Replicate Parameter Extensive creation  

 Model Host The disk duplication data file name used in the currently read template is 
displayed. 

Host Name 
(Required) 

Set the host name for Ethernet device eth0. 255 characters or less can 
be entered. 

MAC Address 
(Required) 

Set the MAC address of the Ethernet device. The address must be 
entered in 12 hexadecimal number format. 
Example) 1A-2B-3C-4D-5E-6F, 1a-2b-3c-4d-5e-6f 
When a file is saved, the Linux duplicate parameter file is created and 
saved by using the entered 
MAC address. The extension is ".rep." 
Example) 1A2B3C4D5E6F.rep or, 1a2b3c4d5e6f.rep 

DHCP(0:ON) Select and set the type of TCP/IP network for Ethernet device eth0 from 
below. 
・ DHCP: Enter 0 to have the DHCP server set the IP address 

dynamically. (Required) 
・ Static IP: Do not enter anything to have the IP address set manually. 

IP Address Set the IP address for Ethernet device eth0. 
Example) 192.168.0.11, or 192.168.100.150, and so on. 
This must be set if the network type is Static IP. 

Network 
mask 

Set the network mask for the IP address of Ethernet device eth0. 
Example) 255.255.0.0, 255.255.255.0, and so on. 
This must be set if the network type is Static IP. 

Gateway Enter the IP address of the gateway machine that corresponds to the IP 
address of Ethernet device eth0. 
Example) 192.168.0.250, 192.168.100.200, and so on. 
This does not need to be set, whether the network type is DHCP or Static 
IP, it is an optional input item. 

DNS Address Enter the IP address of the primary DNS that corresponds to the IP 
address of the Ethernet device. 
Example) 192.168.0.250, 192.168.100.200, and so on. 
This does not need to be set, whether the network type is DHCP or Static 
IP. 
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(9) Click Save and save the settings. See the following table about operations of each button outlined in red. 

 

 
 

Replicate Parameter Extensive creation  
 Clear Clears all the content entered in the current screen. 

Read Reads duplication parameter data saved in CSV file format and places it in 
the entry fields for Replicate Parameter Extensive creation. The file 
selection dialogue screen appears, with the CSV folder in the currently set 
working folder as the default folder. 
Select the file name and click Open. 

Check Checks consistency by the content which is currently input. 
If there are no problems or errors, the following message dialogue screen 
appears. 

 
If the setting is incorrect, the Replicate Parameter Error List screen 
appears. 
Check the content in the error list and correct errors on the Replicate 
Parameter Extensive creation screen. 

Save Saves the input content in CSV file format.  
It is saved to the CSV folder in the currently set working folder. 
The default is <Installation folder>\linux\offline\CSV. 
Clicking Save brings up the Save as..." dialogue box. Enter the file name 
and save the file. 
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 Extensive 
Creation 

Performs an extensive creation of disk duplication data files by the currently 
input content. 
If extensive creation is completed successfully, the Replicate Parameter 
Creation result list screen appears. (*1) 

 
If there is a problem of the duplication parameter, the Replicate Parameter 
Error List screen appears and files are not created. 
After checking the parameters and resolving problems, recreate files. 

Exit Closes the Replicate Parameter Extensive creation screen and 
terminates batch creation of duplication parameters.To end, click Yes. 
Otherwise, click No. 

*1 
 Working Mode: Online 

The file is saved with the entered MAC address name under <Folder for Image>\AnsFile\machineinf> 
on the Management Server. 

 Working Mode: Offline 
The file is saved with the entered MAC address in the current working folder. 
The file name is MACaddress.rep. 

 
 If the created CSV files or disk duplication data files are unnecessary, delete them 

manually. (You cannot delete them from Delete registered data in Image Builder.) 
 
Other Operations and Displays 
 
 Information of Linux OS Duplication Parameter Settings 
You can confirm the information of the Linux OS duplication parameter settings as follows. 
 
(1) Log on to the machine, on which Image Builder is installed, by a user with administrator authority.  

When you use Image Builder on the Management Server, log on by the user who installed DPM Server. 
 

(2) From the Start menu, select All Programs -> DeploymentManager -> Image Builder. 
When you are logging on to the OS by the user except Administrator, execute it as an administrator. 
 

(3) Image Builder is launched. Click Configure setup parameter file. 
 

(4) The Select parameter screen appears. Select Linux disk copy parameter file and click OK. 
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(5) The LinuxOS Replicate Parameter Making screen appears. From the Help menu, select Version. The 
LinuxOS Replicate Parameter Making Info screen appears. 
 

 

5.4.5. Creating a Parameter File for OS Clear Installation (Linux) 
A Linux installation parameter file is a file that stores all of the items required during Linux installation setup in 
advance, enabling unattended OS installation. This section describes how to create a Linux installation 
parameter file. 
 

  This file must be configured when you install Linux. 
 For a Linux installation parameter file that was created by Image Builder earlier 

than this version, be sure to read the Linux installation parameter file by Image 
Builder of this version and overwrite it. 
・ See "Other Operations and Displays" in this Section regarding reading a 

saved file. 
・ See " Overwrite of the Linux installation parameter file" in this Section 

regarding overwrite saving. 
 The root password is "deploymgr" that is set with the Linux install parameter 

setting tool. Use the following method if you want to change the password. 
(1) If the password is not encrypted: 

Change the "rootpw" line of the Linux installation parameter file (cfg file) 
saved below. 
<Folder for Image>:\exports\ks 

Example) rootpw –iscrypted  **********.. (encrypted password) 
 

rootpw deploy 
(2) If the password is encrypted: 

Set the password with the Linux standard kickstart file creation tool and 
create a kickstart parameter file. 
Copy the "rootpw" line in the created file to the "rootpw" line in Linux 
installation parameter file (cfg file), which was created using the Linux 
installation parameter setting tool, in the following folder. 
<Folder for Image>:\exports\ks 

Example) rootpw –iscrypted  **********... (encrypted password) 
 

rootpw --iscrypted  XXXXXXXXXX... (encrypted password) 
 

 For notes when installing the NFS server on the machine except the Management 
Server, see Section 3.5.6, "Precautions/Other" in Operation Guide. 
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  To create two or more Linux installation parameter files, see Section 5.4.6, 

"Batch Creation of Parameter File for OS Clear Installation (Linux)" 
 You can change the working mode and the working folder at any timing. 
 The keyboard operations which are effective with buttons of Linux installation 

parameter file creation tool are the Enter key and the Space bar only. 
 

 Initial settings for the creation of a Linux installation parameter file 
 

(1) Log on to the machine, on which Image Builder is installed, by a user with administrator authority. 
When you use Image Builder on the Management Server, log on by the user who installed DPM Server. 

(2) From the Start menu, select All Programs -> DeploymentManager -> Image Builder. 
When you are logging on to the OS by the user except Administrator, execute it as an administrator. 

 
(3) Image Builder is launched. Click Configure setup parameter file. 

 
(4) The Select parameter screen appears. Select Linux parameter file and click OK. 
 

 
 

(5) If this screen is launched for the first time, or the environment configuration data file "LinuxIParm.cfg" does 
not exist in the install directory, the LinuxOS Install Environment Set Screen appears. Set it to match your 
environment. 
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LinuxOS Install Environment Set 
 Install Directory Displays the folder where Image Builder has been installed. 

This cannot be edited. 
Work Directory Displays the working folder for offline mode. This can be 

entered only when "Offline mode" is selected in Select 
Working Mode. 
254 characters or less can be entered. Alphanumeric 
characters and symbols can be entered. 
The following symbols cannot be entered. 
, ; * ? " ' < > | [ ] @ 
Default is  
"C:\Program Files\NEC\DeploymentManager\linux\offline" 

Select Working Mode Select one of the following working mode. 
- Online mode 
- Offline mode 
The default is Online Mode. 

Management Server The IP address of the Management Server that was set during 
installation of Image Builder is obtained from the registry data 
and displayed here. 

"ks" Server Directory Displays the folder name on the Management Server where the 
Linux setup parameter file is to be saved when in online mode. 
This cannot be edited. 

 "syslinux" Server 
Directory 

Displays the folder name on the Management Server where the 
Linux boot parameter file is to be saved when in online mode. 
This cannot be edited. 

CANCEL This discards changes and closes the environment settings 
screen. 

SAVE Saves the settings to the environment settings file 
LinuxSysRep.cfg and closes the environment settings screen. 

 
When the environment information of the install directory and IP address of the Management Server cannot 
be obtained properly, the configuration tool for Linux install parameter does not start. 
 

 When you create the Linux installation parameter file, there are the following 
working modes: 
・ Online mode: Mode for normal use. 
・ Offline mode: Mode for setting up the NFS shared folder (exports) in locations 

except <Folder for Image>\exports. 
This section mainly describes "online mode" which is normally used. 

 
 Online Mode 

The Linux installation parameter file is created and managed over the network in the Folder for Images on the 
Management Server. 

 
 The Linux installation parameter file is comprised of and managed by two files. 

・ The Linux boot parameter file (no file extension) Example) nec_host  
・ The Linux setup parameter file (extension ".cfg")  Example) nec_host.cfg  
The root password is output to the file as "deploymgr". 
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 Offline Mode 

The Linux parameter file is created and managed on the machine on which Image Builder is launched, using 
any working folders. 

 

 
(6) Once the setting is completed, click Save. 

Temporary folder:<Installation folder>\linux\online 
(Default:C:\Program Files\NEC\DeploymentManager\linux\online) 

Read and save a file 

Managed directory 
:<Folder for Image>\AnsFile\ linux(Linux boot parameter file) 
:<Folder for Image>\exports\ks(Linux setup parameter file) 

Image Builder 
(Remote Console) Machine 

Receive a file Send a file 

Saved Linux installation parameter 
file 

Working Linux installation parameter file 

Managed folder: Arbitrary working folder 
(Default:C:\Program Files\NEC\DeploymentManager\linux\online) 

Image Builder 
(Remote Console) Machine 

Saved Linux installation 
parameter file 

Read and save a file 
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(7) The confirmation screen appears. Click Yes. 

 
 If there is an error in the settings, an error message is displayed in red font and 

saving cannot be performed. Correct the settings and re-save. 

 
 
 Linux installation parameter file creation 

 
(1) Log on to the machine, on which Image Builder is installed, by a user with administrator authority. 

When you use Image Builder on the Management Server, log on by the user who installed DPM Server. 
 

(2) From the Start menu, select All Programs -> DeploymentManager -> Image Builder. 
When you are logging on to the OS by the user except Administrator, execute it as an administrator. 
 

(3) Image Builder is launched. Click Configure setup parameter file. 
 

(4) The Select parameter screen appears. Select Linux parameter file and click OK. 
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(5) The LinuxOS Install Parameter Making is launched and the following screen appears. 
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(6) Set the Linux install parameter. 

The Linux install parameters are configured from the following nine types of information panels. 
 

Click each button to switch the information panel and set each item. 
 

 If there are any problems or errors with the information entered into each of the 
information panels, a red error message will be displayed at the bottom of each 
information panel. 
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 Basic Configuration setting panel  

Set the basic information for the Linux boot parameters and Linux setup parameters. 
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LinuxOS Install Parameter Making 
 Basic Configuration  

(Required)  
 Install Linux  

(Required)  
Select Linux OS as the type to install from the list box. 
The default is "Red Hat Enterprise Linux 5.1/5.1 AP."  
If the boot directory is not entered at the time the install OS is 
selected, the default value of the boot directory appropriate for 
the selected OS will be set as the boot directory. (*1) 

UEFI When "Red Hat Enterprise Linux 6" or "Red Hat Enterprise 
Linux 7" is selected in Install Linux, this item is displayed. 
When the managed machine is in UEFI mode, select this 
checkbox. When the managed machine is in BIOS mode, 
clear this checkbox. 
By default, this checkbox is cleared. 

Boot Directory  
(Required)  

Select the boot directory or enter the boot directory for the 
Linux OS to install. 255 characters or less can be entered. 
Alphanumeric characters and symbols can be entered. 
The following symbols and space cannot be entered. 
, ; * ? " ' < > | [ ] @ 
When you click "...", the Select Boot Directory screen will be 
displayed. Then select it from boot directory list on the 
Management Server 

 
In the case of offline, you cannot use the Select Boot 
Directory Selection screen, so you must enter and set the 
boot directory name. 

NFS Server  
(Required)  

The NFS server IP address is set. Normally this is set as the 
same IP address as DPM Server. 
The default value is the IP address of the Management 
Server. 

Install Device  
(Required)  

In the case of the version earlier than Red Hat Enterprise 
Linux 7, set the Ethernet device (the installation device which 
is used for the communication). 
The default value is "eth0". 
If you set a LAN board with a MAC address not registered 
with the Management Server, the scenario may not complete. 
In the case of Red Hat Enterprise Linux 7, this item is not 
displayed. 

Installation Number  Displays when "Red Hat Enterprise Linux 5.1/5.1 AP" is 
selected in Install OS. 
Enter the install number of the Red Hat Enterprise Linux at the 
time of the product purchase. 
This entry is not required. 
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Install Language  
(Required)  

Select the type of language used at the time of installation 
from the list. 
The default value is "English". 
In the case of Red Hat Enterprise Linux 6, "English" is set 
regardless of the selected content. 
In the case of Red Hat Enterprise Linux 7, "English" is set. 

  Keyboard  
(Required)  

Select the type of keyboard used by the managed machine 
from the list. 
The default value is U.S.English. 
In the case of Red Hat Enterprise Linux 6, U.S.English is set 
regardless of the selected content. 

Mouse  
(Required)  

Select the type of mouse used by the managed machine for 
the install from the list. 
The default value is Generic Mouse (PS/2). 
If the mouse is not set correctly after an OS clean installation, 
assign "Probe For Mouse" to the mouse and automatically 
search for the mouse. 
This item will not be displayed for Red Hat Enterprise Linux 6. 

3 Button Emulation  If the mouse device uses a 3 button emulation function, select 
this checkbox. 
By default, the checkbox is not selected. 
This is optional. 
This item will not be displayed for Red Hat Enterprise Linux 
6/7. 

Time Zone Select the time zone from the list box. The default value is 
America/New_York. This entry is not required. 

Support Language  
(Required)  

Set the language environment from the list. 
To select two or more items, press the Ctrl key while 
selecting. 
The default value is "English". You cannot deselect "English". 
In the case of Red Hat Enterprise Linux 5/5AP, all languages 
are set regardless of the selected content. 
In the case of Red Hat Enterprise Linux 6, "English" is set 
regardless of the selected content. 
In the case of Red Hat Enterprise Linux 7, this item is not 
displayed. 

*1 
You can select the install OS from the Linux OSs below from the list. 
 

Install OS  Boot Directory Default Value  Supported 
Architecture  

Red Hat Enterprise Linux AS 4 RedHatAS4 x86/x64 
Red Hat Enterprise Linux ES 4 RedHatES4 x86/x64 
Red Hat Enterprise Linux 5.1/5.1 AP RedHatServer5.1 x86/x64 
Red Hat Enterprise Linux 6 RedHatServer6 x86/x64 
Red Hat Enterprise Linux 7 RedHatServer7 x64 

 
 Select Red Hat Enterprise Linux 5.1/5.1 AP in the case of Red Hat Enterprise Linux 

5.2-5.6/5.2 AP-5.6 AP. 
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 Boot Configuration  

You can do settings related to the boot loader for the managed machine to install. 
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Boot Configuration(required)  

 A new boot loader is 
installed  

Select this to install a new boot loader. 
If you select A new boot is installed, the Boot Loader 
Options will be enabled. 
The default value is A new boot is installed. 

 A boot loader is not installed  Select this not to install a boot loader. 
If installing Linux and A boot loader is not installed is 
selected, the scenario will complete successfully, but you 
cannot run Linux from the partition where Linux was 
installed. 

 Boot Loader Options  Select boot loader option and a new boot loader will be 
installed. 

 GRUB is used as a boot 
loader 

Set this to install the GRUB boot loader. 
The LILO package will be cancelled for Red Hat Enterprise 
Linux AS4, ES4, and 5/5AP. Select Use GRUB as a Boot 
Loader when installing Red Hat Enterprise Linux AS4, ES4, 
5/5AP. 
This is optional. 
In the case of Red Hat Enterprise Linux 7, this item is 
selected. 

 GRUB Option  
GRUB Password  

This can be set when selecting GRUB is used as a boot 
loader. This is optional. 

LILO is used as a boot 
loader 

Set this to install the LILO boot loader. 
The default value is set as LILO is used as a boot loader. 
This item cannot be set for Red Hat Enterprise Linux 6/7. 

 LILO Option Set the working mode for LILO boot loader. 
Select one of the checkboxes below. 
・ Use linear mode 
・ Force use LBA32 mode 
This is optional. 

A boot loader is installed 
in a master boot record 
(MBR) / A boot loader is 
Installed on the head 
Sector of a boot partition 
(You must select one) 

Set the install destination for the boot loader. 
Select one of the following option buttons. 
・ A boot loader is installed in a master boot record 

(MBR) 
・ A Boot loader is installed on the head sector of a boot 

partition 
Select A boot loader is installed in a master boot record 
(MBR) when executing backup/restoring on the disk with 
boot loader installed. 
This item cannot be set for Red Hat Enterprise Linux 6. 

Kernel Parameter  Set the kernel parameters. 
255 characters or less can be entered. Alphanumeric 
characters can be entered. 
This item cannot be set for Red Hat Enterprise Linux 6. 
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 Partition Configuration 

Set the environment used for the disk drive of the managed machine for install. 
 

 
 

 You cannot set software RAID with this tool. 
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Partition Configuration 
(Required) 

 Master Boot Record 
(Required) 

Set the master boot record handling. 
Select one of the following option buttons. 
・ Clear the current master boot record 
・ Do not delete the current master boot record 

Partitions 
(Required) 

Set the partition handling. 
Select one of the following option buttons. 
・ Remove all of the current existing partitions 
・ Remove only the existing Linux partitions 
・ Keep the existing partitions 

Disk Label Set 
(Required) 

Set the disk level handling. 
Select one of the following option buttons. 
・ Initialize the disk label 
・ Do not initialize the disk label 

Add Set the new disk partition information at the time of install. 
Click Add when adding a disk partition. The Partition 
Information screen appears when you click the Add button. 

 
 Mount Point  Select the partition mount directory from the list box or enter 

it. Alphanumeric characters and symbols can be entered. 
The following symbols and space cannot be used. 
, ; * ? " ' < > | [ ] @ 
You cannot select this if the file system type is swap. 
It must be selected if the file system type is other than swap. 

File System Type  
(Required)  

Select the file system type from the list box. 
The default value is ext3 type. 

File System Size (MB)  Set the volume of the partition to create. Enter the units in 
MByte(MB). The default value is 1MByte. 
Setting is required when Fixed size is selected in 
Additional Size Options. 

Additional Size 
Options 
(Required if 
selectable)  

Set the volume of the partition. 
Select one of the following option buttons. 
・ Fixed size 
・ Fill all space up to (MB) 
・ Fill to maximum allowable size 
If you select Fill all space up to (MB), enter the increased 
volume in MByte. 
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  The swapfile size of 

recommendation is 
used  

If you select "swap" in the file system type, you can select 
the checkbox. 
If you select this, the volume of the swap files system will be 
automatically set at the time of install. 

Force to be a primary 
partition 

The partition is forcibly allocated as the primary partition. It 
will end abnormally when this cannot be executed.  
This is optional. 

Make partition 
on specific drive 
(Required)  

Create a new partition. 
Enter the disk drive name to add a partition. Alphanumeric 
characters can be entered. 
For an IDE disk, set the first as hda and the second as hdb. 
For a SCSI disk, set the first one as sda. 

Use existing partition  Set the existing partition name. 
Following the partition setting, the partition is set up on the 
existing partition. 
Alphanumeric characters can be entered. 
For the first partition of the primary IDE disk, hda1 should be 
specified, and for the second partition of the secondary IDE 
disk, hdb2 should be specified. Also, for the first partition of 
the first SCSI disk, sda1 should be specified.  

Format partition  Format a partition. 
The default value is Format partition. 

 CANCEL Closes the screen without saving the specified partition 
information. 

SAVE Saves the specified partition information and closes the 
screen. 
If there is a problem or error with the specified partition's 
information, the error list is displayed and it cannot be 
saved. 
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 Edit Edit the disk partition. 

Select the partition to be edited from the list and click Edit. 

 
Partition Information screen appears when you click Edit. 

 
 Delete Deletes the currently specified disk partition. 

Select the partition to be deleted from the partition list and click 
Delete. 
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 If installing on a machine with two or more disks and you do not specify the drive 

for install, the installer will automatically assign which disk is installed on. Set the 
installation drive with Create Partition on Specified Drive specifying the install 
disk. 

 
 Network Configuration 

Set the network information. Set the LAN board specified for the install device in the Basic Configuration 
panel. 
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Network Configuration 
 Host Name Enter the managed machine host name. 255 characters or less 

can be entered. 
Alphanumeric characters and symbols can be entered. 
The following symbols and space cannot be entered. 
\ / : , ; * ? " < > ' | [ ] @  

Network Type Select and set the type of TCP/IP network from below. 
- DHCP: IP addresses are set dynamically by a DHCP 

server. 
- Static IP: IP addresses are set manually. 
The default value is DHCP. 

IP Address  Enter the IP address. 
This must be entered only if Static IP has been selected as the 
network type. 

Network Mask Enter the netmask. 
This must be entered only if Static IP has been selected as the 
network type. 

Gateway Enter the IP address of the gateway machine that corresponds 
to the IP address of the Ethernet device being configured. 
This does not need to be entered, even if either DHCP or Static 
IP has been selected as the network type. 

Name Server  Enter the IP address for the DNS server. 
This does not need to be entered, even if either DHCP or Static 
IP has been selected as the network type. 

 
 For a LAN board having a MAC address that is registered to the DPM, configure 

the settings so that network communication can be done regardless of whether the 
address is a static IP address or is obtained from the DHCP server. If network 
communication cannot be done, an executed scenario may not be completed. 
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 Authentication Set 

Set the information for each authentication function used on the managed machine for install. 
 

 



 

321 

 
Authentication Set 
 Authentication Select the user authentication method. 

・ Use Shadow Password 
Select this to Use Shadow Password for the user 
password. 

・ Use MD5. 
Select this to Use MD5 encryption for the user 
password. 
In the case of Red Hat Enterprise Linux 5/5AP, 
select the Use Shadow Password. 

NIS Configuration Select the Enable NIS checkbox in the case of NIS 
(Network Information Service) authentication. 

 NIS Domain  
(Required) 

Set the NIS domain name. 
32 characters or less can be entered. 
Alphanumeric characters and symbols can be entered. 
The following symbols and space cannot be entered. 
\ / : , ; * ? " < > ' | [ ] @ = 

Use broadcast to find NIS 
Server  
(Required) 

Select the checkbox to use broadcast for NIS server 
search. 

NIS Server  
(Required) 

Enter the NIS server name. 
Alphanumeric characters and symbols can be entered. 
The following symbols and space cannot be entered. 
, ; * ? " ' < > | [ ] @ = 

LDAP Configuration Select the Enable LDAP checkbox in the case of LDAP 
(Lightweight Directory Access Protocol). 
In the case of Red Hat Enterprise Linux 7, this item 
cannot be set. 

 LDAP Server  
(Required) 

Set the LDAP server name. 
32 characters or less can be entered. 
Alphanumeric characters and symbols can be entered.  
The following symbols and space cannot be entered. 
\ / : , ; * ? " < > ' | [ ] @ = 

LDAP Database  
(Required) 

Set the LDAP database name. 
32 characters or less can be entered. 
Alphanumeric characters and symbols can be entered. 
The following symbols and space cannot be entered. 
\ / : , ; * ? " < > ' | [ ] @ = 

Kerberos 5 Configuration Select the Enable Kerberos 5 CCoonnffiigguurraattiioonn checkbox 
in the case of Kerberos 5 Configuration. 
In the case of Red Hat Enterprise Linux 7, this item 
cannot be set. 

 Realm (Required)  Set the realm name. 
32 characters or less can be entered. 
Alphanumeric characters and symbols can be entered. 
The following symbols and space cannot be entered. 
\ / : , ; * ? " < > ' | [ ] @ = 

Domain Controller (KDC) 
(Required) 

Set the domain controller(KDC) name. 
32 characters or less can be entered. 
Alphanumeric characters and symbols can be entered. 
The following symbols and space cannot be entered. 
\ / : , ; * ? " < > ' | [ ] @ = 
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  Master Server  

(Required)  Set the master server name. 
32 characters or less can be entered. 
Alphanumeric characters and symbols can be entered. 
The following symbols and space cannot be entered. 
\ / : , ; * ? " < > ' | [ ] @ = 
You must specify the KDC name where kadmind is 
running on the KDC belonging to the specified realm. 
This master server will become the KDC server that 
handles the changes in the user information and so on. 

HESIOD Configuration Select the Enable HESIOD checkbox in the case of 
HESIOD authentication. 
HESIOD authentication manages the user and group 
information by using DNS. 
In the case of Red Hat Enterprise Linux 7, this item 
cannot be set. 

 HESIOD LHS 
(Required) 

In HESIOD LHS (Left-hand side), set to the LHS that is 
used at the time of the search for the user information 
and so on. 
32 characters or less can be entered. 
Alphanumeric characters and symbols can be entered. 
The following symbols and space cannot be entered. 
\ / : , ; * ? " < > ' | [ ] @ = 

HESIOD RHS 
(Required) 

In HESIOD RHS (Right-hand side), set to the RHS that 
is used at the time of the search for the user information 
and so on. 
32 characters or less can be entered. 
Alphanumeric characters and symbols can be entered. 
The following symbols and space cannot be entered. 
\ / : , ; * ? " < > ' | [ ] @ = 

SMB Configuration Select the Enable SMB checkbox in the case of SMB 
authentication. 
In the case of Red Hat Enterprise Linux 6, this setting is 
invalid. 
In the case of Red Hat Enterprise Linux 7, this item 
cannot be set. 

 SMB Server  
(Required) 

Set the SMB server name. 
If there are two or more SMB servers, enter the server 
names, separated by commas. 
32 characters or less can be entered. 
Alphanumeric characters and symbols can be entered. 
The following symbols and space cannot be entered. 
\ / : , ; * ? " < > ' | [ ] @ = 

SMB Work Group  
(Required) 

Set the SMB workgroup. 
32 characters or less can be entered. 
Alphanumeric characters and symbols can be entered. 
The following symbols and space cannot be entered. 
\ / : , ; * ? " < > ' | [ ] @ = 

NSCD Configuration Select the checkbox for NSCD authentication. 
You can cache the information of user and group and 
so on if you select the Enable Name Switch Cash 
Domain (nscd) checkbox. 
In the case of Red Hat Enterprise Linux 6, this setting is 
invalid. 
In the case of Red Hat Enterprise Linux 7, this item 
cannot be set. 
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 Firewall Configuration 

This set the firewall environment information of the managed machine for install.  
This information cannot be set for Red Hat Enterprise Linux 6. 
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Firewall Configuration 
 Security Level  

(Required)  
Set the level of the firewall. 
・ In the case of Red Hat Enterprise Linux 4 

If you select High or Medium, the setting of the 
firewall is done. (If you select Disabled, the setting of 
the firewall is not done. 

・ In the case of Red Hat Enterprise Linux 5/5AP 
Select either of Enabled or Disabled. 
The default is Enabled. 

・ In the case of Red Hat Enterprise Linux 6 
Disabled is automatically set. 

・ In the case of Red Hat Enterprise Linux 7 
Select either of Enabled or Disabled. 
The default is Disabled. 

Customize Select the firewall rules to set. 
Select one of the following option buttons. 
・ Use default firewall rules 
・ Customize 

If you select Customize the Firewall Rules, select the 
checkbox for the following required setting items. 

・ Trusted devices 
Only eth0 can be selected. 
(If you select eth0, the setting of the firewall is 
not done on the eth0.) 
In the case of Red Hat Enterprise Linux 7, this 
cannot be set. 

・ Allow incoming 
Select the communication protocols allowing 
communication through the firewall. You can 
select two or more items. 
In the case of Red Hat Enterprise Linux 
5/5AP/7, SSH is always allowed regardless of 
the selected content. Also, in the case of Red 
Hat Enterprise Linux 7, DHCP and Telnet 
cannot be set. 

• WWW(HTTP) 
• FTP 
• SSH 
• DHCP 
• Mail(SMTP) 
• Telnet 

 Other Ports (1029:tcp)  Select the communication protocols and ports with 
authorization to communicate through the firewall. 
255 characters or less can be entered. 
Alphanumeric characters and symbols can be entered. 
The following symbols and space cannot be entered. 
\ / ; - * ? " < > ' | [ ] @ 
Enter it by the format of "Port Number:Protocol". 
When you enter two or more ports, describe them by 
separating ","(comma). 
Example) 1029:tcp,1040:udp  
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 If the Security Level is set to either of High, Medium, or Enabled, select 

Customize and add the following description to Other Ports. 
Protocol Port Number 
UDP 68 
TCP 26509(*1) 
TCP 26510(*1) 
TCP 26520 
UDP 26529(*1) 

*1 
When you upgraded DPM Server from the version earlier than DPM 
Ver6.1, used (opened) port number are different. For details, see *10 of 
"Communications between the Management Server and managed 
machines" in Appendix D, "Network Port and Protocol List." 

 
Also, if Security Level is Disabled and you configure the firewall after installing 
OS, open the ports described in the above table. 

 
 X-Window Configuration 

This set the X Window environment information of the managed machine for install. 
This information cannot be set for Red Hat Enterprise Linux 6. 
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X-Window Configuration  
 Configure the X Window 

System  
Set the X Window System. 
If you select the checkbox, X Window System will be forcibly 
selected in the install package. 
Also, you can configure the detailed settings for X Window. 

 Color Depth  
(Required)  

Set the color depth. Select this from the list. 
The default value is "8". 
In the case of Red Hat Enterprise Linux 5/5AP, it will be 
automatically set regardless of the selected content. 
In the case of Red Hat Enterprise Linux 7, this cannot be set. 

Resolution  
(Required)  

Set the resolution. Select this from the list box. 
The default value is "640x480". 
In the case of Red Hat Enterprise Linux 7, this cannot be set. 

Default Desktop  
(Required)  

Set the desktop environment. 
Select one of the following option buttons. The default value 
is KDE. 
• GNOME 
• KDE 
In the case of Red Hat Enterprise Linux 5.1~5.4, 5.1 
AP~5.4AP, it will be automatically set regardless of the 
selected content. 
Select the Start the X Windows system on boot to start X 
Window when the system starts. 
In the case of Red Hat Enterprise Linux 7, the default is 
GNOME. 

Select a Video Card  
 

Set the video card. 
Select the Probe for video card checkbox to set it 
automatically. 
Select it from the list to set it manually. 
In the case of Red Hat Enterprise Linux 7, this cannot be set. 

Select Monitor  Probe the monitor. 
Select the Probe for monitor checkbox to set it 
automatically. 
Select it from the list to set it manually. 
In the case of Red Hat Enterprise Linux 7, this cannot be set. 

 
 Package Group Selection 

Set the information for each software package to install on the managed machine. 
This information cannot be set for Red Hat Enterprise Linux 6. 

 
 In Red Hat Enterprise Linux 6, the following packages are installed by the fixed 

setting. 
・ Server Platform 
・ Deployment Tools 
・ Server Platform Development 
・ Compatibility libraries 
・ Network file system client 
・ japanese-support 
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Package Group Selection 
 The package Install Method Set the install method for the packages to be installed. 

Select one of the following option buttons. 
• A package dependency is solved automatically 
• A package dependency is disregarded 
In the case of Red Hat Enterprise Linux 7, this cannot be 
set. 

Install package group Set the package group to install during the installation. 
Select this from the list. You can select two or more 
items. 
The content of the list will change based on the content 
in the Install Linux in the Basic Configuration panel. 
In the case of Red Hat Enterprise Linux 7, select also the 
following items. 
・ Base 
・ Network File System Client 
・ GNOME(or KDE) 

Select either GNOME or KDE following the setting in 
the X-Window Configuration screen. 
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 If the managed machine is an x64 edition, /lib/libgcc_s.so.1 is required. 

If /lib/libgcc_s.so.1 does not exist, multicast remote updates will not be possible. 
Please install /lib/libgcc_s.so.1 by one of the following methods. 
1) Select the "Compatibility Arch Support" package when doing an OS clear install. 
2) Install libgcc-3.4.5-2.i386.rpm by unicast using a remote update after the OS 

clear install. 
 
 Script Set 

Set the shell script to run after the managed machine installation has completed. 
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Script Set  
 Run outside of the chroot 

environment  
Run outside the chroot environment. 
Normally, scripts are executed in the chroot environment. 
Select the Run Outside the chroot Environment checkbox 
to run outside the chroot environment. 

Use an interpreter  Set the interpreter file name to use. 
Enter the interpreter file name to use when using an 
interpreter except the default shell interpreter. 
255 characters or less can be entered. 
Alphanumeric characters and symbols can be entered. 
The following symbols and space cannot be entered. 
\ : , ; * ? " < > ' | [ ] @ 
Example) /usr/bin/python 

Input %post Script  
(Text box) 

Set the Linux shell script you want to run after the installation 
is completed. 320 characters or less per line and 600 lines or 
less can be entered for scripts. 
An error will occur if the script that is read in includes a line 
with more than 320 characters, and the post script will not be 
read in. 
If there is a line that exceeds 320 characters, correct it so that 
the character count for a line does not exceed 320 characters 
by starting a new paragraph by inserting a "\" at the position to 
start a new paragraph. 
Example) 

An example of modification is shown below. ("XXXX---YYY" 
is a line in a script.)  

 
Before modification-------------------------------------------------- 

: 
XXXXXXXXXXXXXXXXXXXXXXXXXZZZZZZZZZZZZZZZ 

: 
------------------------------------------------------------- 

After modification------------------------------------------------------- 
: 

XXXXXXXXXXXXXXXXXXXXXXXXX \ 
ZZZZZZZZZZZZZZZ 

: 
------------------------------------------------------------- 

READ The file is read in as script information. 
The file selection screen appears with the current working 
folder as the initial folder. Then open a file. 
When the file is read in, scripts for introduction and setup of 
DPM Client software are automatically configured. 
When a file is read in, the file cannot be read in if the number 
of lines in the combination of complete input content and the 
file content exceeds 600 or if any line exceeds 320 characters. 

CLEAR Deletes all currently entered script data. 
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(7) Save the Linux install parameter. 
 

LinuxOS Install Parameter Making 
 
 
 

SAVE The detail settings of the install parameter are saved as 
the Linux installation parameter file and it closes. 

EXIT Closes without saving the detail settings of the install 
parameter. 

 
 Working Mode: Online 

The file is transmitted from the temporary working folder to the managed folder. 
The default folder is as follows: 
<Folder for Image>\AnsFile\linux (Linux boot parameter file) 
<Folder for Image>\exports\ks (Linux setup parameter file) 

 

 
 

 Working Mode: Offline 
The folder that was specified in working folder appears, so specify the File Name and save. 
The default folder is as follows: 
C:\Program Files\NEC\DeploymentManager\linux\offline 

 
The following screen will be displayed if it is saved properly. 

 
Other Operations and Displays 
 
 Read an existing Linux installation parameter file  

In the File menu, select Open. 
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 Working Mode: Online 

 
(1) The Linux setup parameter file list that exists under the "<Folder for Image>\exports\ks" folder on the 

Management Server appears. 
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(2) Double-click the target Linux setup parameter file, or select the Linux setup parameter file and click 

SELECT. The Linux setup parameter file is read and the screen appears. 
 

 
 

 Do not use an installation parameter file of Linux OS that is not supported by this 
version. See Appendix A, "Function Tables" in First Step Guide for details of supported 
OSs. 

 
 If some error occurs when the Linux installation parameter file is read, then the 

following message is displayed. Check the contents of the Linux setup parameter file 
and Linux boot parameter file. 
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 Working Mode: Offline 

 
(1) A list of the Linux setup parameter files in the current working folder appears. 

 

 
 

(2) If you double-click the target Linux setup parameter file or select the Linux setup parameter file and click 
Open, the screen with the Linux setup parameter file read in will be displayed. 
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 Do not use an installation parameter file of Linux OS that is not supported by this 

version. See Appendix A, "Function Tables" in First Step Guide for details of 
supported OSs. 

 
 If some error occurs when the Linux installation parameter file is read, then the 

following message is displayed. Check the contents of the Linux setup parameter 
file and Linux boot parameter file. 

 
 
 Overwrite of the Linux installation parameter file 

The content of the currently displayed Linux installation parameter are overwritten and saved to the original 
file. 
In the File menu, select Overwrite. 

 
 Working Mode: Online 

The following file will be overwritten by the settings of the Linux installation parameter file. 
• Linux boot parameter file: <Folder for Image>\AnsFile\Linux on the Management Server 
• Linux setup parameter file: <Folder for Image>\exports\ks on the Management Server 

 
The following message is displayed when the file has successfully been saved to the Management 
Server. 

 

 
 

 The following message will be displayed if there is any problem when saving the 
file to the Management Server, so please save again after resolving the problems 
with the Management Server or the network. 
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 Working Mode: Offline 

The settings will be overwritten by the settings of the Linux install parameter under the currently specified 
working folder. 

 
The following message is displayed when the file has successfully been saved in the working folder. 

 

 
 

 The following message will be displayed if there is any problem in saving the file to 
working folder, so please save again after resolving the problems with the working 
folder to be saved. 

 
 
 Saves the Linux installation parameter file with the name 

The contents of the currently specified Linux installation parameter will be newly saved with the specified 
name. 
In the File menu, select Save As New Name. 

 
 Working Mode: Online 

A list of the files that exist in the <Folder for Image>\exports\ks on the Management Server are displayed 
in the Host Name List screen. Enter the Save File Name and click SELECT. 
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・ Linux boot parameter file:  

Saves with the file name without the extension in the <Folder for Image>\AnsFile\Linux on the 
Management Server. 

・ Linux setup parameter file: 
Saves with the file name with the extension ".cfg" in the <Folder for Image>\exports\ks on the 
Management Server. 

 
The following message is displayed when the file has successfully been saved to the Management Server. 

 

 
 

 The following message will be displayed if there is any problem in saving the file to 
the Management Server, so please save again after resolving the problems with 
the Management Server or the network. 

 
 
 Working Mode: Offline 

A list of the files that are in the currently set working folder appears in the Select File screen.Enter the File 
Name and click Save. 

 

 
 

・ Linux boot parameter file: 
Saves with the file name without an extension in the selected folder. 

・ Linux setup parameter file: 
Saves with the file name with the extension ".cfg" in the selected folder. 

The following message appears when the file has successfully been saved. 
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  The following message will be displayed if there is any problem in saving the file to working 
folder, so please save again after resolving the problems with the working folder to be 
saved. 

 
 If a file with the same file name already exists in the folder to be saved, the following screen 

appears. To overwrite, click Yes. If not, click No. 
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 Change working mode  

You can switch the current working mode. 
 

From the Working Mode menu, select the Set Online or Set Offline option button to switch the working 
mode. 

 

 
 
 Closing the install parameter setting tool 
 
(1) In the File menu, click Exit. 
 
(2) The LinuxOS Install Parameter Making close confirmation screen appears, then click Yes to close and No 

not to close. 
If you close, all of the screens will close and the Linux install setting tool will close. 
The EXIT on the lower left of the main screen will also close the install parameter setting tool. 
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 Displaying Settings Data 
 
(1) In the File menu, click Display Install Parameter. 
 
(2) The currently set install parameter details will be displayed in a list in the Linux install parameter output 

format. The currently set Linux install parameter details are displayed. 
 

 
 

LinuxOS Install Parameter List  
 PRINT  Prints the details of LinuxOS Install Parameter List. 

CLOSE Closes the currently displayed Install Setting Parameter 
Screen. 
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 The Install Parameter Error List screen from the previous item will be displayed 

if there is a problem or error with the details of the currently set Linux install 
parameters. Correct any items displayed in the error list. 

 
 
 Information of Linux installation parameter file creation tool  

You can confirm the information of Linux OS install parameter setting in the following procedure. 
 

(1) From the Help menu, select Version. The Linux Install Parameter Making screen appears. 
 

(2) Check the information. 
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5.4.6. Batch Creation of Parameter File for OS Clear Installation (Linux) 
This section describes an explanation of the method for creating two or more Linux installation parameter files. 
 
(1) Prepare the template Linux installation parameter file which is the base for two or more Linux installation 

parameter files. 
 
 Do not use an installation parameter file of Linux OS that is not supported by this 

version. See Appendix A, "Function Tables" in First Step Guide for details of 
supported OSs. 

 
 See Section 5.4.5, "Creating a Parameter File for OS Clear Installation (Linux)" 

about the procedure for creating a Linux installation parameter file. 
 

(2) Log on to the machine, on which Image Builder is installed, by a user with administrator authority.  
When you use Image Builder on the Management Server, log on by the user who installed DPM Server. 
 

(3) From the Start menu, select All Programs -> DeploymentManager -> Image Builder. 
When you are logging on to the OS by the user except Administrator, execute it as an administrator. 

 
(4) Image Builder is launched. Click Configure setup parameter file. 
 
(5) The Select parameter screen appears. Select Linux parameter file and click OK. 
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When this function is launched for the first time or if the environment configuration data file LinuxIParm.cfg 
is not in the install directory, the LinuxOS Install Environment Set screen appears. Configure the settings 
to match your environment. 
 

 
 

Install Directory Displays the folder where Image Builder has been installed.  
Default is "C:\Program Files\NEC\DeploymentManager". 

Work Directory You can change the working folder for Offline mode to any 
location. This can be entered only when "Offline Mode" is 
selected in Select Working Mode. 
The default is  
"C:\Program Files\NEC\DeploymentManager\linux\offline" 
Alphanumeric characters and symbols can be entered. 
The following symbols cannot be entered. 
, ; * ? " ' < > | [ ] @  

Select Working Mode  The working mode can be set to Online mode or Offline 
mode. The default is Online Mode. 

 Management Server The Management Server IP address is required. 
 [ks] Server Directory Displays the folder name on the Management Server where 

the Linux setup parameter file is to be saved when in online 
mode. This is fixed value and cannot be edited. 

[syslinux] Server Directory Displays the folder name on the Management Server where 
the Linux boot parameter file is to be saved when in online 
mode. This is fixed value and cannot be edited. 

CANCEL Discards changes and closes the environment settings 
screen. The confirmation message for canceling is displayed, 
then click Yes or No. 

SAVE Saves the settings to the environment settings file 
LinuxIParm.cfg and closes the environment set screen. 
The confirmation message for saving is displayed, then click 
Yes or No. 
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(6) The LinuxOS Install Parameter Making is launched. From the File menu, select Open. Select the setup 

parameter file in the Select Host Name screen and click SELECT. 
 

 
 

(7) The Setup Parameter File will be read. From the Install Parameter menu, select Make Install Parameter. 
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(8) The details of the currently set Linux installation parameter file are checked, and the Install Parameter 

Extensive creation screen appears. Then enter the Ethernet device eth0 network information for the target 
machine for the Linux install. 

 

 
 

Install Parameter Extensive creation  

 Model Host The name of the currently loaded Linux installation parameter file 
used for the template is displayed and configured. 

Host Name 
(Required) 

Set the host name for Ethernet device eth0. 255 characters or 
less can be entered. 

DHCP(0:ON) Select and set the type of TCP/IP network for Ethernet device 
eth0 from below. 
- DHCP: Enter 0 if the IP address is set dynamically with DHCP 
server. (Required)  

- Static IP: Do not enter anything if the IP address is set 
manually. 

IP Address Set the IP address for Ethernet device eth0. 
This must be set if the network type is Static IP. 

Network Mask Set the netmask value for the IP address of Ethernet device eth0. 
This must be set if the network type is Static IP. 

Gateway Enter the IP address of the gateway machine that corresponds to 
the IP address of Ethernet device eth0. This does not need to be 
set, whether the network type is DHCP or Static IP. 

DNS Address Enter the IP address of the primary DNS that corresponds to the 
IP address of the Ethernet device. This does not need to be set, 
whether the network type is DHCP or Static IP. 

CLEAR Clears all the content entered in the current screen. 
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READ Reads install parameter data saved with CSV file format and 
places it in the entry fields for install parameter batch creation. 
The file selection dialog screen appears, with the CSV folder in 
the currently set working folder as the default folder. Select the 
file name and click Open. 

 
CHECK Performs a prior check of the consistency of the batch creation 

install parameter information that is currently input. 
If there are no problems or errors, the following message 
dialogue screen appears. 

 
SAVE The batch creation install parameter information file is saved with 

the CSV file format. 
It is saved to the CSV folder in the currently set work folder. 
The default is <Installation folder>\linux\offline\CSV. 
By clicking Save, the Save As New Name dialog box appears. 
Enter the file name and save the file. 
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 Extensive Creation Performs a batch creation of Linux installation parameter files in 

accordance with the currently input batch creation install 
parameter data. 
If batch creation is completed successfully, the Install Parameter 
Creation Result List screen appears. 

 
• if the Working Mode is Online 

The Linux boot parameter file is saved with the input host name 
and without an extension in the folder "<Folder for 
Image>\AnsFile\Linux" on the Management Server. 
The Linux setup parameter file is saved with the input host name 
and ".cfg" extension in the "<Folder for Image>\exports\ks" on 
the Management Server. 

• if the Working Mode is Offline 
The Linux boot parameter file is saved with the input host name 
and without an extension in the currently set working folder. 
The Linux setup parameter file is saved with the input host name 
and with ".cfg" extension. 

EXIT The currently displayed Install Parameter Extensive Creation 
dialog screen will close and the Install Parameter Extensive 
Creation operation will end. 

 
 If the created CSV files are unnecessary, delete them manually. (You cannot delete 

them from Delete registered data in Image Builder.) 
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 The Install Parameter Error List screen appears if there is a problem with the 
description of the Linux installation parameter file when reading in the file. Confirm the 
content of the error and correct it. 

 
 You can create the installation parameter data for 100 or less machines at one time. 

  

5.5. Package Registration/Modification 
Perform package registration/modification. Follow the steps below. 
 
  Use PackageDescriber when you create or modify a package which includes the 

following setting. See Section 6, "PackageDescriber" about each 
setting. 

・ When specifying the following in file conditions of the Dependency Information tab 
or file conditions of the ID Information tab. 

- Specifying the path, which is described in the registry, in the file path 
- Specifying the file size 
- Specifying the update time 

・ When specifying the following in file conditions or registry conditions of the 
Dependency Information tab. 

- Exists(<) 
- Exists(<=) 
- Exists(>) 
- Exists(>=) 

・ When specifying two or more conditions using "and" or "or" in the Dependency 
Information tab. 

・ When specifying the following value type(ValueType) in registry conditions of the 
Dependency Information tab or registry conditions of the ID Information tab. 

- REG_EXPAND_SZ 
- REG_MULTI_SZ 

・ When specifying the path, which is described in the registry, in the file path of the ID 
Information tab. 

・ When specifying the machine group, on which the package will be applied, in the 
Group Information tab. 
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 When you register RUR(revision up release) module for Express 5800 Series as a 

package, register it after confirming the installation manual of RUR necessarily. 
 
(1) Log on to the machine, on which Image Builder is installed, by a user with administrator authority. 

When you use Image Builder on the Management Server, log on by the user who installed DPM Server. 
 

(2) From the Start menu, select All Programs -> DeploymentManager -> Image Builder.  
When you are logging on to the OS by the user except Administrator, execute it as an administrator. 

 
(3) Image Builder is launched. Click Package registration/modification. 
 
(4) The Package registration/modification screen appears. From the File menu, select each menu to create 

or modify the package. 
 

When creating a Windows package  -> Create Windows Package 
See Section 5.5.1, "Create Windows Package" for details. 

When modifying a Windows package -> Modify Windows Package 
See Section 5.5.2, "Modify Windows Package" for details. 

When creating a Linux package  -> Create Linux Package 
See Section 5.5.3, "Create Linux Package" for details. 

When modifying a Linux package  -> Modify Linux Package 
See Section 5.5.4, "Modify Linux Package" for details. 
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5.5.1. Create Windows Package 
Explains the Basic, Execution Settings, Applicable OS and language, Dependency information and ID 
information tab settings. 
 

  If you change Type on the Basic tab, the Urgency will change to default.  
Also, the Execution Settings tab settings will change to default. 
• If the type was changed to Service Pack 

Urgency is changed to "Normal". Also, the Restart after the installation and 
Apply independently check boxes on the Execution Settings tab are 
automatically selected. 
If two or more folders have been added to the copied folder, all folder settings 
are deleted from the package. 

• If the type was changed to HotFix 
Urgency is changed to "High". Also, the Restart after the installation and 
Apply independently check boxes on the Execution Settings tab are 
automatically cleared. 
If two or more folders have been added to the copied folder, all folder settings 
are deleted from the package. 

• If the type was changed to Application 
Urgency is changed to "Normal". Also, the Restart after the installation and 
Apply independently check boxes on the Execution Settings tab are 
automatically cleared. 

 When you created the package specifying the bat file in the Execution Settings 
tab -> Execution File in Create Windows package screen in the version of 
DPM Ver3.8 and earlier, re-create the package in this version. 

 When you register the package of a service pack, which switches the firewall function 
from disabled to enabled(Windows XP SP2 and so on), most ports are blocked 
when applying the service pack and the Management Server cannot 
communicate with the managed machine. Therefore, a scenario execution error 
will occur. In this case, open the port that DPM uses by Port Opening Tool after 
removing the error. See Section 7.1, "Port Opening Tool" about Port Opening 
Tool. 

 When you register a service pack of SP2 or later as a package, there are some 
service packs, which cannot be directly applied to the environment that a service 
pack is not applied, by the specification of the service pack. 
About the specification of the service pack, see the site of Microsoft Corporation 
and so on. 
 

Example) 
In the case of Windows Server 2008 SP2, SP1 needs to be already applied as 
the condition that SP2 will be applied.(SP2 cannnot be directly applied to the 
environment without SP.) 
・ When creating a package, specify the following in registry condition of 

Dependency information tab. 
Key name: HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows 

NT 
\CurrentVersion 

Name: CSDVersion 
Conditions: Exists 

・ When a package is distributed by the automatic update function, if there 
are two or more packages of service packs on the Management Server, 
the package of the latest service pack will be distributed. 
As the above, the package will not be applied to the managed machine 
without SP by the specification of the service pack. 
If you want to apply SP2 to the managed machine without SP, distribute by 
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either of the following. 
- The package of SP2 is not registered. 

Distribute the required service pack(SP1) by the automatic update 
function. After that, register SP2. 
 

- The package of SP2 is already registered. 
Distribute the required service pack(SP1) by the scenario. After that, SP2 
will be distributed by the automatic update function. 

 
(1) Set each item on each tab in the Create Windows package screen. 
 
 Basic tab  

Click Basic tab in the Create Windows package screen and set each item. The places (types) circled in red 
are settings that will vary depending on the selected type. 

 
• If HotFix was selected as the type  
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Basic 

 
 

Package ID  
(Required) 

Enter the package ID. 63 characters or less can be entered. 
Alphanumeric characters and the following symbols can be entered. 
- _ 

Company name Enter the name of the company that issued the package. 127 
characters or less can be entered. 

Release Date Enter the package release date. Enter it in the year/month/day format. 
Enter the year as four digits and the month and day as two digits. 
If you enter an invalid value, it will be ignored or automatically 
corrected. 

Package summary Enter package summary information. 511 characters or less can be 
entered. 

Type  Select the "Service Pack", "Hotfix", or "Application" from the list box. 
The default is "HotFix". 

Urgency Set the urgency (four types) of the package. 
The default is "High" when you select "HotFix". 
The default is "Normal" when you select "Service Pack" or 
"Application". (*1) 

MS number Enter the MS (KB) number appended to the "Service Pack" or "HotFix" 
issued by Microsoft. 31 characters or less can be entered. 
Example) KB889293 

Q819696 
・ In case of a Microsoft HotFix, the value entered in the MS number 

column is compared with the MS number written in the registry 
(KBXXXXXX or QXXXXXX), and if two values match, it is judged 
that the HotFix has been applied. Enter the correct value, including 
the "KB" or "Q." If a value is not entered in the MS number column, 
the application status is judged by the registry and file information 
entered in ID Information. 

・ Microsoft HotFixes for which information has not been entered in 
both MS number and ID Information are not automatically 
updated. Specify either one when specifying "Highest" or "High" 
urgency. 

・ You do not need to enter the MS number or the ID Information for 
service pack. 

*1 
The handling process will differ according to the type of urgency as shown in the table below. 
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Urgency Power Status of 

Computer 
Sending Process 

Highest Powered ON computer It will be immediately sent to a managed machine where 
it can be applied. 

Powered OFF computer An automatic update notice is immediately issued, but if 
the power is off, automatic update cannot be executed. 
Next time the computer is started up, it is judged whether 
or not the package has been applied based on 
information set in the package, and only packages that 
have not been applied are distributed. 

High Powered ON computer It will be sent at a time specified in advance on the 
Management Server side. 

Powered OFF computer Automatic update is executed the next time the computer 
is started up. 
It determines whether or not the package has been 
applied based on information set in the package, and 
only packages that have not been applied are distributed. 

Normal  
 

Create a scenario on the Management Server, and 
distribute it manually. Low 

 
• If Service Pack is selected as the type  
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Basic 
 
 

Major version/Minor 
version 

You must enter major version and minor version if the created package is a 
service pack. Values that can be entered are as follows. 
Major version: 0~65535  
Minor version: 0~65535  
In the case of a Microsoft service pack, the numbers entered in the Major 
Version column and Minor Version column are compared with the service 
pack versions currently installed in the OS, and it is judged whether the 
service pack has been applied. Enter the correct numbers. 

 
  If an invalid value is entered for major version or minor version, it is corrected 

automatically. 
 In the case of a service pack, the major version and minor version must be entered. See 

the following table. 
 
Example) For Windows 2000 and Windows XP 

 
OS Category Service Pack  Major Version  Minor Version  
Windows 2000 SP1 1 0 

SP2 2 0 
SP3 3 0 
SP4 4 0 

Windows XP SP1 1 0 
SP2 2 0 
SP3 3 0 

 

 
• If Application is selected as the type  
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Basic 
 
 

Display name Enter the application display name. 
This will become the same as the value for the DisplayName saved in 
the registry Uninstall sub-key after the application is installed. 511 
characters or less can be entered. 

Display version  Enter the application display version. This will become the same as 
the value for the DisplayVersion saved in the registry Uninstall 
sub-key after the application is installed. 127 characters or less can be 
entered. 

 
 Execution Settings tab 

Click Execution Settings tab in the Create Windows package screen and set each item. 
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Execution Settings 

 
 

Folder name Enter the folder name in which the patch or the application is stored. 
255 characters or less can be entered. 

 Browse  The Browse for Folder screen appears when you click Browse. 
Select the folder in which the patch or the application is stored. 

Added folder 
 Add The folder with the folder name entered will be added as an added 

folder. 
Delete The folder selected from the added folder will be deleted. 

The Delete will only be enabled if you select one or more folders from 
the added folder. 

 Execution file Enter the executable file name. 255 characters or less can be entered. 
Alphanumeric characters and symbols can be entered. The path will 
be automatically cleared if the entered path length is larger than 255 
characters. 
Do not register a file (example: file%9d.exe) with an executable file 
name including %xx(xx is hexadecimal number 0 - f) characters. If a 
package contains %xx, it cannot be properly downloaded to the 
Management Server. 
Specify the items in the executable file such that all of the following 
conditions are met. 
・ Silent install can be done. (You do not need to respond such as key 

entry while the file is being executed, or you can execute silent 
install by creating a batch file.)  

・ A reboot of the OS does not occur during the install. 
・ You can install with a local system account. (Network browsing is 

not performed.)  
・ The total file size does not exceed 2GByte. 
・ When an executable file generates descendant processes 

(executable file->child process-> grandchild process) in the 
execution, generated child process finishes after grandchild 
process finishes. Also, when an executable file is a script file such 
as bat or sh, the executable file finishes after generated child 
process finishes. 

 Browse  The open file screen appears when you click Browse. Select the 
folder in which the patch or the application is stored. 

 Setup Parameters Set the setup parameters for the executable file. 
128 characters or less can be entered. Alphanumeric characters and 
symbols can be entered. 
In the case of service pack or hotfix, specify two parameters: "Do not 
restart after execution", and "Unattended mode" or "Quiet mode". 
Example) 

In the case of Windows Server 2008 
・ Do not restart after execution: /norestart 
・ Unattended mode: /unattend 
・ Quiet mode: /quiet 

About the parameter of service pack or hotfix, execute the file by 
specifying "/h" or "-?" in advance and check the parameter. 
When you specify Windows XP SP2 or SP3 and OEM specific driver is 
installed, specify also "Execute processing without displaying the 
command prompt"("-o"). 

 Restart after the 
installation 

Set it to restart after the package is applied. Effective when applied by 
automatic update type. 

 Apply 
independently 
 

Select this for service pack and hotfix which need to be applied 
independently. If you select this, it will automatically restart before 
application. Effective when applied by automatic update type. 
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  The registered service pack/hotfix/Linux patch file/application must be copied 

to an internal folder on the Management Server. The free space required for 
registration is twice as much as the space of required for the service 
pack/hotfix/Linux patch file/application to be registered. 

 The service packs/hotfix/Linux patch files/applications registered here are 
limited to those which are silently installed and do not require restart after 
installation. (For those that display a security warning screen due to digital 
signature information, a confirmation screen appears on the managed 
machine when it is applied, and installation cannot continue.) 

*Silent installation means that when an executable file type (setup.exe or 
Update.exe) is run, setup is performed automatically and does not require 
clicking Next or entering values. 

*In the case of service packs, hotfixes, and so on that require a restart to be 
valid, register an image with the option not to perform restart and set the 
Restart After Applying option in the scenario. 

 

 A patch is registered in folder unit. Store only one patch in one folder. 

 
・ Applicable OS and language tab 

Click Applicable OS and language tab in the Create Windows package screen and set each item. 
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Applicable  OS and language 
 OS  Select the OS to which the package is to be applied. 

Set the OS supported by the service pack/hotfix correctly. 
If you select All OS, all OSs except "Other OS" will be target. 

Lang  Select the language of the OS to which the package is to be 
applied. 

 Add Add the selected OS and Lang. 
Delete Delete the selected OS and Lang. 

Base Service Pack Select a server pack that is required for applying the hotfix. 
 Add Add the selected Base Service Pack. 

Delete Delete the selected Base Service Pack. 
Absorbing Service Pack Select the next Server Pack. Use it combined with Base 

Service Pack. 
Example) 

If there is a Windows 2000 computer with SP4 applied; enter 
SP4 as the Base Service Pack, and SP5 as the Absorbing 
Service Pack. In this way, the conditions will be [this will 
apply to computers where SP4 is applied but SP5 is not 
applied]. 

 Add Add the selected Absorbing Service Pack. 
Delete Delete the selected Absorbing Service Pack. 

 
・ Dependency Information tab 

Click Dependency information tab in the Create Windows package screen and set each item. 
 

The dependent information is checked when a package is applied. It will be applied only when dependent 
conditions are met. 
 
Specify the dependent conditions from the following 3 types. 

• Package dependency 
• File dependency 
• Registry dependency  

 
 If you are adding a composite of package dependency, file dependency, and registry 

dependency, it will only apply if all of the condition items have been met. 
Example) If package dependency is A, file dependency information is B, and 

registry dependency is C. The composite application conditions are as 
below. 

 
Item Added 

information 
Application conditions Composite 

application 
condition 

A 1 All of 1, 2 and 3 are applied. A is met  
and 
B is met  
and 
C is met. 

2 
3 

B 1 Either Condition of 1 or 2 is met. 
2 

C 1 Either Condition of 1 or 2 is met. 
2 
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Dependency information 

 Check the package 
dependency relationship 

The settings become valid when the Check for package dependency 
relationship check box is checked. 

Required packages The package is applied only if the package it depends on has been 
installed. 
Select the Required package checkbox and set. 
Required packages are selected from other packages registered by 
Image Builder or PackageDescriber. Also, if two or more required 
packages have been added, the package will be applied if all required 
dependent packages have been applied. 
Example) 

You cannot apply the cumulative security update for Internet 
Explorer if Internet Explorer is not installed. 
In this case, the required condition for applying the cumulative 
security update is Internet Explorer. 
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 Add The Add package dependency screen appears when you click Add. 

 
The packages displayed on the Add package dependency screen 
are those currently registered on the Management Server. Select a 
dependent package from the list and click Add. 

Delete When you select a package from the dependent package list and click 
Delete, the dependent package is deleted. 

Apply depending on the 
existence of any of the 
following files 

It is determined if the package should be applied depending on 
whether a file exists or not by the dependent file information. If two or 
more files are added, it will be applied if at least one of them is met. 
Select the Apply depending on existence of any of the following 
files checkbox. 
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  Add When you click Add, the Add file dependency information screen 
appears. Add the package dependent information. 

 
• File path 

Enter the dependent file path and file name. 259 characters or less 
can be entered. 

• File version  
Enter the file version. Enter in "x.x.x.x" format with 31 characters or 
less. Numeric characters and symbol (only ".") can be entered. 
If a file version is not entered, the existence of the file is the 
condition of the dependency. 
You can check the file version in the Version tab of the file property. 
You do not need to enter anything if there is not the Version tab in 
the property or if the File version item in the Version tab is blank. 

• Conditions 
 - Exists: 

The package will be applied if the entered file exists. 
 - Does not exist: 

The package will be applied if the entered file does not exist. 
Modify When you select a file and click Modify, the Modify file dependency 

information screen appears. 
Delete When you select a file and click Delete, the dependent file is deleted. 

Apply depending on the 
existence of any of the 
following registries 

It is determined if the package should be applied depending on 
whether the registry exists or not by the dependent registry 
information. If two or more registry information is added, it will be 
applied if at least one of them is met. 
Select the Apply depending on the existence of any of the 
following registries checkbox. 
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  Add When you click Add, the Add registry dependency Information 

screen appears. Add the package registry. 

 
• Key name  

Enter the registry name including the root key. 255 characters or less 
can be entered. 

• Name 
Enter the value which belongs to the key name (ValueName). 255 
characters or less can be entered. 

• Data  
Enter the value data (ValueData). You can enter the following number 
of characters. 
-"REG_SZ" and "REG_BINARY": 1024 characters or less 
-"REG_DWORD": 

Numeric characters from 0 to 4294967295 
-"REG_QWORD": 

Numeric characters from 0 to 18446744073709551615 
• Type 

Select the value type (ValueType) from the list box. You can select 
the following. 
-REG_SZ 
-REG_BINARY 
-REG_DWORD 
-REG_QWORD 

• Conditions 
- Exists 

The package will be applied if the entered registry exists. 
- Does not exist 

The package will be applied if the entered registry does not exist. 
 Modify When you select a registry and click Modify, the Modify registry 

dependency information screen appears. 
 Delete When you select a registry and click Delete, the dependent registry is 

deleted. 
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 ID information tab 

Click ID Information tab in the Create Windows package screen and set each item. 
 
It determines whether a package has been applied to a machine using the ID information. 
File and registry changes occurring due to the fact that a service pack/hotfix/Application was installed are 
entered as ID information. 
Example) Patch A is registered, and distributed to machines. 

1) Before distribution: Which patches have been installed? 
How is the file information or the registry?  

2) After distribution: When patch A is distributed, what will the files and registry change to? 
The package application status is determined based on the difference information obtained by comparing 
1) and 2) above. If all entered file change information and registry change information are met, it is judged 
that the package was applied. 

 
 If the ID information is not entered when the package is registered, the package will 

become an unrecognized package and automatic update notice will not be sent. 
If either the MS number or the ID information is not entered when a hotfix is 
registered, a scenario will be created on the Management Server side and it must be 
sent. 

 
  If the created package file is a service pack or hotfix issued by Microsoft, even if 

no ID information was entered, the MS number entered on the Basic tab is 
compared with the MS number (KBXXXXXX or QXXXXXX) written in the 
registry, and if two values match, it is judged that the package has been applied. 

 ID information needs to be entered in the case of applying a package that does 
not have an MS number or whose MS number cannot be identified, or a package 
that the information remains only in the registry and so on. 

 

 
 



 

363 

 
ID Information 

 File change information Used to judge whether a package was applied based on change 
information occurring in the file system because the package was 
applied. 

 Add When you click Add, the Add file information screen appears. Add 
the package file information. 

 
• File path 
Enter the changed file path and file name. 259 characters or less 
can be entered. 
As the file path may vary depending on the environment, enter the 
system environment variable. 
Example) 

If there is a change in winsock.dll under C:\WINNT\system32\  
%WinDir%\system32\winsock.dll 

• File version  
Enter the file version. Enter in "x.x.x.x" format with 31 characters or 
less. Numeric characters and symbol (only ".") can be entered.  
If a file version is not entered, the existence of the file becomes ID 
information. 
You can check the file version in the file properties Version tab. You 
do not need to enter anything if there is nothing in the properties 
Version tab on the OS or if the File version item in the Version tab 
is blank. 

• Change type 
Select it from the list box. 
Create new: 

Select when the file is newly created by application of the 
package. 

Version up: 
Select when the file is overwritten by application of the package 
only in the case that it is newer than the existing file. 

Replace: 
Select when the file is unconditionally overwritten by application 
of the package. 

Delete: 
Select when the file is deleted by application of the package. 

Modify Modify file ID information of the added package. 
Delete Delete file ID information of the added package. 
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 Registry change  Used to judge whether a package was applied based on registry 

information that was changed because the package was applied. 
 Add When you click Add, the Add registry information screen appears. 

 
• Key name  
Enter the registry name including the root key. 

• Name 
Enter the value (ValueName) associated with the key name. 

• Type 
Enter the value Type (ValueType). 

• Data  
Enter the value data (ValueData). The item will be enabled if you enter 
Name. 

• Change  
Select it from the list box. 
Create new: 

Select when the registry is newly created by application of the 
package. 

Replace: 
Select when the registry is overwritten by application of the package. 

Delete: 
Select when the registry is deleted by application of the package. 

Modify Modify registry information of the added package. 
Delete Delete registry information of the added package. 

 
(2) When you click OK after entering the required information, the package is created. 

When you click Cancel, all entered information is discarded and the Create Windows package screen will 
close. 

 
Input of the information required for Windows package creation is completed. 
Click OK on the Create Windows package screen to create the Windows package. 
 

 You can create packages sequentially. When you create packages sequentially, enter the 
next package information and click OK. To complete creating packages, click Finish. 
(Cancel will become Finish once you click OK.) 
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5.5.2. Modify Windows Package 
(1) When you select the Modify Windows package, the Select Windows package screen appears. 
 

 
 
(2) Select the package from the Select Windows Package screen, and click Modify. 
 
(3) The Modify Windows package screen appears. Modify items on each tab of the screen. The following 

items can be modified. 
See Section 5.5.1, "Create Windows Package," regarding each tab of the screen. 
・ You can modify items except Package ID and Type on the Basic tab. 
・ You can modify items except Folder to be copied and Execution file on the Execution Settings tab. 
・ You can modify all items on the Applicable OS and language tab. 
・ You can modify all items on the Dependency information tab. 
・ You can modify all items on the ID Information tab. 
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5.5.3. Create Linux Package 
If you select the Create Linux package menu item, the Create Linux package screen appears. 

 
 Basic tab  

Click Basic tab in the Create Linux package screen and set each item. 
 

 
 

Basic 

 
 

Package ID  
(Required)  

Enter the package ID. 63 characters or less can be entered. 
Alphanumeric characters and the following symbols can be 
entered.  
- _ 

Company name Enter the name of the issuing source that issued the package. 
127 characters or less can be entered. 

Release date Enter the package release date. The date is entered in the 
YYYY/MM/DD format. 

Package summary  Enter package summary information. 511 characters or less can 
be entered. 

Type  Select the Linux patch or application. 
Urgency Select the package urgency level. It cannot be changed. 
OK After all of the required items are correctly entered, OK will be 

enabled. 
The Linux package will be created when you click OK. 

 Cancel The screen closes without any processing. 
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 Execution Settings tab 

Click Execution Settings tab in the Create Linux Package screen and set each item. 
 

 
 

Execution Settings 

 
 

Folder name Enter the folder in which the patch or the application is stored. 255 
characters or less can be entered. 

 Browse  The Browse for Folder is displayed when you click Browse. Select 
the folder in which the patch or the application is stored. 

Added Folder Display the folder that was added. 
- You can only add one folder in the case of a Linux patch. 
- For an application, two or more folders can be added. 

 Add The folder entered in the Folder Name text box will be added as an 
added folder. 

Delete The folder selected from the added folder column will be deleted. 
Delete will only be enabled if you select one or more folders from the 
added folder. 
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Execution File  Enter the executable file. 255 characters or less can be entered. The 
path will be automatically cleared if the entered path length is larger 
than 255 characters. 
Do not register a file with an executable file name including %xx (xx 
is hexadecimal number 0~f) characters. (example: file%9d.exe) If a 
package contains %xx, it cannot be properly downloaded to the 
Management Server. 
Specify the executable file that all of the following conditions are 
met. 
・ Silent install can be done. (You do not need to respond such as 

key entry while the file is being executed, or you can execute 
silent install by creating a batch file.) 

・ A reboot of the OS does not occur during the install. 
・ You can install with a local system account. (Network browsing is 

not performed.)  
・ The total file size does not exceed 2GByte. 
・ When an executable file(setup.exe/update.exe and so on), which 

installs the patch/application and so on, generates descendant 
processes(executable file->child process-> grandchild process) 
during the installation of the patch/application, generated child 
process finishes after grandchild process finishes. Also, when an 
executable file is a script file such as bat or sh, the executable file 
finishes after generated child process finishes. 

・ If a file path with "&" is entered, the executable file may not be 
applied properly. 

 Browse  The open file screen appears when you click Browse. Select the 
package executable file. 

 Setup parameters Set the package setup parameters. 
Set two parameters from Do not Restart After Execution and 
Unattended Mode, or Quiet Mode. Alphanumeric characters can 
be entered. 128 characters or less can be entered.  

Requires 
restarting after the 
installation 

This item is unavailable. 

Requires apply 
independently 

This item is unavailable. 

 
 When you register an rpm package, set the options for the install application with "-i" or 

"-U" and so on as the command options. 
 
  Do not output any messages on the console if you register a shell script. The scenario will 

fail if a message is output. If a message is required, it should be redirected to a log file, and 
unnecessary messages should be redirected to /dev/null and so on. 

Example) When you saves a log 
dmesg >> /tmp/dmesg.log 

Example) When you do not save messages 
/etc/rc.d/init.d/depagtd start > /dev/null 

 If you register a shell script and so on, the script should return 0 at the normal end. If 
the script returns a value except 0, a scenario that runs the script ends up in a state of 
Scenario Execution Error although the script ends successfully. 
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 When registering an RPM package, the package with "-i" option may not be properly installed 

depending on the package registered. The cause may be that there is a signature, or it may be 
an rpm with a dependency. Also, it might fail if it has already installed. 
Representative options are indicated below. Specify the setup parameters based on the 
content. 

Options  Sub-Options Contents 
-i  Installs a new package. 
-U  Upgrades the already installed packages. Installs 

when it is not installed. The installed package is 
uninstalled if an earlier version exists. 

-F  Updates older packages only if an older package  
exists. 

-i --oldpackage Installs packages that are older than the already  
installed packages. 

-i --replacefiles Installs the packages even if they replace files which has 
been installed in the already installed package. 

-i  --replacepkgs Installs the packages even if some of them are  
already installed. 

-i --force the same as the oldpackage, replacefiles, and 
replacepkgs options together 

-i --nodeps Forcibly installs ignoring dependencies. 
-i --nosignature Dose not examine the package or header  

signature when reading in. 
Also, when you specify options with a normal output, the install can fail so do not specify. 
The display system options are shown below 

-v, --verbose Displays more information. Normally, routine  
progress messages are displayed. 

-vv Prints debugging information. 
-h, --hash The progress status is displayed using 50 hash  

marks "#" as it is taken from the package archive. 
--percent  The percentage is displayed as the file is taken from the 

package archive. 
See the online help documents of the Linux you are using for option details. 

 
With the above, input of the information required for Linux package creation is completed. 
Click OK on the Create Linux Package screen to create the Linux package. 
 

 You can create packages sequentially. When you create packages sequentially, enter the 
next package information and click OK. To complete creating packages, click Finish. (The 
Cancel will become Finish once you click OK.) 
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5.5.4. Modify Linux Package 
1) When you select the Modify Linux Package, the Select Linux Package screen appears. 

 

 
 

2) Select the package to modify from the Select Linux Package screen, and click Modify. 
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3) The Modify Linux Package screen appears. Modify items on each tab of the screen. The following items 

can be modified. See Section 5.5.3, "Create Linux Package" regarding each tab of the screen. 
 
・ You can modify items except Package ID and Type and Urgency Level on the Basic tab 
・ You can modify items except Folder to be copied and Execution file on the Execution Settings tab. 

 

 
 

5.5.5. Exit Package Registration/Modification 
 
When you click Exit menu, the Package registration/modification screen closes. 
 
At this time, whether automatic update notification will be sent to the managed machine is decided based on the 
urgency level of the registered package. 
If the registered package has the Highest urgency level, automatic update notice will be sent to managed 
machines where the package is applicable and it will be promptly installed. 
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5.6. Delete Registered Data 
Delete registered data. Follow the procedure below. 
 
(1) Log on to the machine, on which Image Builder is installed, by a user with administrator authority. 

When you use Image Builder on the Management Server, log on by the user who installed DPM Server. 
 

(2) From the Start menu, select All Programs -> DeploymentManager -> Image Builder. 
When you are logging on to the OS by the user except Administrator, execute it as an administrator. 

 
(3) Image Builder is launched. Click Delete registered data.  

 
(4) The Delete registered data screen appears. Select the package to delete. 
 

 
 
Delete registered data  
 
 

Image type  
 

When you select the image type the applicable images are shown 
in the table below. 
You can select from the following. 
• Image file  
• Operating system  
• setup parameter file  
• Linux parameter file  
• Service Pack/HotFix/Linux patch  
• Application  
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 Delete Delete is enabled only if you select one of the image files from the 

image type. You can select and delete two or more image files. 
A confirmation dialog box appears when you click Delete. If you click 
Yes, the image file is deleted and the Delete Result Confirmation 
screen appears. 

 
Close The Delete registered data screen closes. 

 
  You can temporarily delete the package registered by automatic download using the 

function to delete the registered data by Image Builder . However, if you do not delete 
the corresponding package from the Package Web Server, it will be downloaded again 
at the set time of the automatic download. 

 Use PackageDescriber to delete the package from the Package Web Server. See 
Section 6, "PackageDescriber" for details. 

 You cannot delete disk duplication data files or CSV files from Delete registered data. 
Delete them manually. See Section 5.4, "Creating a Setup Parameter File" about the 
saved folder of each file. 
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5.7. Batch Registration 
 The image data created by Image Builder(Remote Console) is temporarily saved in the machine on which 

Image Builder(Remote Console) is installed, and is automatically sent to the Management Server. However, 
the data is not sent and it remains in the local machine in the following cases. 
・ When the network to the Management Server is disconnected after the temporary data is created. 
・ When you copied system updates or drivers from EXPRESSBUILDER CD-ROM. 

In these cases, perform either of the following to register the image data on the Management Server. 
・ Execute Register all. 
・ End Image Builder (Remote Console).(When you end Image Builder (Remote Console), the image data 

is sent to the Management Server.) 
 

 This section explains the procedure for registering the data to the Management Server by Register all. 
(1) Log on to the machine, on which Image Builder is installed, by a user with administrator authority. 

When you use Image Builder on the Management Server, log on by the user who installed DPM Server. 
 

(2) From the Start menu, select All Programs -> DeploymentManager -> Image Builder. 
When you are logging on to the OS by the user except Administrator, execute it as an administrator. 

 
(3) Image Builder is launched. Click Register all.  

 
(4) The Registration file list screen appears. The batch registration data list is displayed. 

 

 
 

Register file list  
 
 

Yes (register) Sends the image to the Management Server. 
Stop Cancels Register all. 
Delete all  Deletes the data that remains locally. 

 
(5) Click Yes(register). Batch registration to the Management Server is completed. 

 
 If you register an offline utility from Image Builder(Remote Console), one group 

of utilities can be split into two or more files and uploaded. If the detail of the file 
is unknown, upload all at the time of Register all. (If there are identical files, 
overwrite them.)  
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5.8. Agreement Display Settings 
When registering an image file, if you select the Do not show this screen again checkbox in the agreement 
screen and select I Accept, the agreement screen will not be displayed later. Select Agreement Redisplay (S) 
from the system menu to display the screen again. The screen will be displayed again when you register an 
image file. 
 

 
 

6. PackageDescriber 
 
This chapter explains PackageDescriber which is a tool to create packages and register them on the Package 
Web Server. 
 

6.1. Initial settings: Set Environment 
PackageDescriber is used in the following applications. 

・ Creation and modification of packages for Windows 
・ Registration and deletion of packages on the Package Web Server 
・ Online update of OS definition file and language definition file 

 
 PackageDescriber is a package creation tool for Windows. Use Image Builder to 

register Linux packages. 
 

 Configure the Package Web Server so that the Management Server can download packages stored in 
the Web shared folder of the Package Web Server using HTTP. For the configuration, see Section 
2.7.3. "Package Download Setting", and Appendix B, "Configuring the Package Web Server" in 
Installation Guide. 

 All created and modified packages are saved in the Temporary Folder of PackageDescriber. Register 
them to the Package Web Server as necessary. 

 When a package is registered in the Package Web Server from the Register in/Delete from the 
Package Web Server window, it will become downloadable to the Management Server. 
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The relationships among folders associated with PackageDescriber are illustrated in the diagram below. 

 
 

Temporary save folder 

 

Web shared folder 

4) Package Web Server registration 

5) Delete from Package 
Web Server 

 

1) Create package 
2) Modify package 

3) Delete package 

Recycle bin 

 
Recycle bin 

 

Package folder 

PD running machine Package Web Server 

 
 

Package ABC is described here as an example. 
 
(1) When you create the package, PackageDescriber copies the specified package ABC folder (file) to a 

PackageDescriber Temporary Folder. 
(2) When you modify the package, PackageDescriber modifies the package ABC stored in the 

PackageDescriber Temporary Folder. 
(3) When you delete the package, PackageDescriber deletes the package ABC from the 

PackageDescriber Temporary Folder. 
(4) When you register the package ABC in the Package Web Server, PackageDescriber copies from the 

PackageDescriber Temporary Folder to the Web shared folder. 
(5) When you delete the package ABC from the Package Web Server, PackageDescriber deletes the 

package ABC from the Web shared folder. 
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<<Initial Setting>> 
This section describes the initial setting of PackageDescriber. 
 
(1) Log on to the machine, on which PackageDescriber is installed, by a user with administrator authority. 

 
(2) From Start menu, select All Programs -> DPM PackageDescriber.  

 
(3) PackageDescriber is launched and the Initial settings:Set Environment screen appears. Set each item. 
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  If you do not set the Web shared folder, the Management Server cannot 

automatically download packages. Also, the Web shared folder and the 
Temporary Folder cannot be omitted. 

 Check that the read and write permission is set in Web shared folder. 
 The registered package will be stored in the Web shared folder. Be sure to secure 

enough free space. 
 If the shared folder of the network computer is specified as a Web shared folder, 

it is recommended to assign a local drive to the shared folder in advance. If a drive 
is not assigned, the shared folder of the network computer may not be accessible. 

 If you change the Web shared folder, you need to re-register packages which 
have been registered. 

 The <PackageDescriber installation folder> cannot be specified as the Web 
shared folder. 

 The Temporary Folder and the Web shared folder cannot be the same folder. 
 Note the combination of the folder to store packages(normally the Temporary 

Folder) and the package ID. 
In DPM, a folder with the name specified as the package ID is created under the 
folder in which the package is saved, and the package is managed. 
If a folder of the same package ID already exists, the folder is deleted and the 
package is created. Therefore, do not specify a folder used for except saving the 
package, such as system folders, as the folder in which the package is saved. 

 The file cannot be specified in the Temporary Folder. 
 The write permission is required for the folder specified as the Temporary Folder. 
 If UAC is enabled, note the following. 

・ Change the Temporary Folder from its initial setting, because even users with 
administrator authority do not have write permission for %ProgramFiles%. 

・ If you install PackageDescriber again in an environment where 
PackageDescriber has been uninstalled, the Initial settings:Set Environment 
screen may not be displayed. In this case, change the setting from Settings 
menu -> Set Environment. 

 When you launch PackageDescriber initially after switching the UAC setting 
(enable/disable), set Web shared folder and Temporary Folder which was set 
before switching UAC. 

 

  You can change the setting on this screen from Settings menu -> Set 
Environment. 

 You can set the folder to save when creating packages, in the Temporary Folder. 
The default is "<PackageDescriber installation folder>\Packages". 

 
(4) Click OK to save settings and close the Initial settings: Set Environment screen. 

 

  It may take time to launch PackageDescriber 
 If you have set the Web shared folder and Temporary Folder and click OK, 

information is written in the PackSerFolder (Web shared folder) and 
PackageSavePath (Temporary folder) of <PackageDescriber installation 
folder>\PDconfig. 

 When you modifiy PDconfig directly, the settings will be reflected after restarting 
PackageDescriber. 

 
<<Environment Settings>> 
This section describes how to configure the Package Web Server. 
 
(1) Log on to the machine, on which PackageDescriber is installed, by a user with administrator authority. 

 
(2) From Start menu, select All Programs -> DPM PackageDescriber. 
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(3) PackageDescriber is launched. From Settings menu, click Set Environment. 
 

(4) Initial settings:Set Environment screen appears. Set the Web shared folder and Temporary Folder. 
 

 
 

 The Package Web Server shared folder cannot be set if the Register in/delete from 
the Package Web Server screen or Online update screen is open. 

 
Environment Configuration 
 Web shared folder Cannot be omitted. The folder specified during the initial setting is 

displayed. 
259 characters or less can be entered. Alphanumeric characters 
and symbols can be entered. 
If the Web shared folder is changed, previously registered 
packages must be re-registered. 

Temporary Folder The folder specified during the initial setting is displayed. 
245 characters or less can be entered. Alphanumeric characters 
and symbols can be entered. 

Browse  Open the folder selection dialog box. 
Packages that are not registered to the Package Web Server 
cannot be automatically downloaded by the Management Server. 

OK Save the settings and closes the window. An error message 
appears if the setting failed or the Web shared folder was not 
specified. 

Cancel Closes the window without saving settings. 
 

  Confirm that the Web shared folder and Temporary Folder have Read and 
Write attributes. 

 The registered package will be stored in the Web shared folder and Temporary 
Folder. Be sure to secure enough free space. 

 If a network computer's shared folder is specified as the Web shared folder or 
Temporary Folder, it is recommended to assign a local drive to the folder in 
advance. If a drive is not assigned, the network computer's shared folder may not 
be accessible  

 
(5) Click OK to close the Window. Packages registered in Register in/delete from the Package Web Server 

window are all saved under the Web shared folder. 
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6.2. Create Package 
This section describes the procedure to create a package. 
 
  If you register RUR(revision up release) module for Express 5800 Series as a 

package, register it after confirming the installation manual of RUR necessarily. 
 When you register the package of a service pack, which switches the firewall function 

from disabled to enabled(Windows XP SP2 and so on), most ports are blocked when 
applying the service pack and the Management Server cannot communicate with the 
managed machine. Therefore, a scenario execution error will occur. In this case, 
open the port that DPM uses by Port Opening Tool after removing the error. See 
Section 7.1, "Port Opening Tool" about Port Opening Tool. 

 When you register a service pack of SP2 or later as a package, there are some 
service packs, which cannot be directly applied to the environment that a service 
pack is not applied, by the specification of the service pack. 
About the specification of the service pack, see the site of Microsoft Corporation and 
so on. 
 

Example) 
In the case of Windows Server 2008 SP2, SP1 needs to be already applied as the 
condition that SP2 will be applied.(SP2 cannnot be directly applied to the 
environment without SP.) 
・ When creating a package, specify the following in registry condition of 

Dependency information tab. 
Key name: HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows NT 

\CurrentVersion 
Name: CSDVersion 
Conditions: Exists 

・ When a package is distributed by the automatic update function, if there are 
two or more packages of service packs on the Management Server, the 
package of the latest service pack will be distributed. 
As the above, the package will not be applied to the managed machine without 
SP by the specification of the service pack. 
If you want to apply SP2 to the managed machine without SP, distribute by 
either of the following. 
- The package of SP2 is not registered. 

Distribute the required service pack(SP1) by the automatic update function. 
After that, register SP2. 

- The package of SP2 is already registered. 
Distribute the required service pack(SP1) by the scenario. After that, SP2 
will be distributed by the automatic update function. 

 
(1) Log on to the machine, on which PackageDescriber is installed, by a user with administrator authority. 

 
(2) From Start menu, select All Programs -> DPM PackageDescriber. 

 
(3) PackageDescriber is launched. From File menu, click Create package. 

 
(4) Create package screen appears. Set each item 
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  About the description of each tab(Basic, Execution settings, Applicable OS and 

language, Dependency Information, ID information, and Group Information), see 
from Section 6.2.1, "Basic Information," to Section 6.2.6, "Group Information." 

 If you click OK after entering required information, a package information file will be 
created. If you click Cancel, Create package screen will be closed without saving the 
setting. 

 

6.2.1. Basic Information 
Set Basic tab. 
The setting items will be changed depending on the set value(type) in red frame. 
 
 If the type has been changed, Urgency and Execution Settings information are 

changed to the default. Confirm it again. 
・ If the type was changed to Service Pack 

Urgency is changed to Normal. Also, the Requires restarting after the installation 
and Requires applying independently check boxes on the Execution settings tab 
are automatically checked. 
If two or more folders have been added to the folder to be copied, all folder settings 
are deleted from the package. 

・ If the type was changed to HotFix 
Urgency is changed to High. Also, the Requires restarting after the installation 
and Requires applying independently check boxes on the Execution Settings tab 
are automatically cleared. 
If two or more folders have been added to the folder to be copied, all folder settings 
are deleted from the package. 

・ If the type was changed to Application 
Urgency is changed to Normal. Also, the Requires restarting after the installation 
and Requires applying independently check boxes on the Execution settings tab 
are automatically cleared. 

 
• If HotFix was selected as the type 
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Basic 
 Package ID  

(Required) 
Enter the package ID. 
63 characters or less can be entered. Alphanumeric characters and the 
following symbols can be entered.  
- (hyphen), _ (underscore) 
Do not include hexadecimal number characters (%0D, %0A, and so on) 
in the package ID. 
The package cannot be properly downloaded to the Management 

Server. 
Company name Enter the name of the company from which patches and applications 

were issued. 
127 characters or less can be entered. Alphanumeric characters and 
symbols can be entered. 

Release date Enter the date when the patch or application was released. 
When you enter a date, use YYYY/MM/DD format. 
If an invalid value is entered, it will automatically become blank. 

 Package Summary Enter summary information of the package. 
511 characters or less can be entered. Alphanumeric characters and 
symbols can be entered. 

 Type  Select the package type. You can select from the following. 
・ HotFix 
・ Service Pack  
・ Application  
The default is HotFix. 
When the type is changed, the screen switches in accordance with the 
changed type. (If the screen does not switch, change the type by using 
the mouse.) 
If you change the type, the contents of the Urgency and the Execution 
Settings are changed to the default. 

 Urgency Set the urgency of the package. You can select from the following four 
types. 
・ Highest 
・ High 
・ Normal 
・ Low 
The default is Normal, but it is High only if the type is HotFix. 
If a package is registered as an automatically updated package, set the 
urgency to highest or high. (*1) 
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 MS number  Enter the MS (KB) number pre-assigned to the service pack or HotFix 

issued by Microsoft. 31 characters or less can be entered. 
Alphanumeric characters can be entered. 
Example) KB889293 

Q819696 
・ If service pack was selected as the type, there is no need to enter 

the MS number and ID information. 
・ In case of a Microsoft HotFix, the value entered in the MS number 

field is compared with the MS number written in the registry 
(KBXXXXXX or QXXXXXX), and if two values match, it is judged 
that the HotFix has been applied. Enter the correct value, including 
the "KB" or "Q." If a value is not entered in the MS number field, the 
applied status is judged by the information of registry, the files, and 
so on, entered in ID Information tab. 

・ When you create a package for a HotFix that does not write the MS 
number in the registry, if letters that cannot be entered by 
PackageDescriber are included in the MS number, ID information 
must be entered in order to execute automatic updates. 

・ If both MS number and ID information are not entered for Microsoft's 
HotFix, the HotFix will be excluded from the automatic update. 
When selecting the urgency Highest or High, make sure to enter at 
least one of these fields  

*1 
 The process will be different when the Management Server executes automatic download differs depending 

on urgency type. See the following table. 
 

Urgency Power Status of 
Computer 

Process After Package Registration 

Highest Power on An automatic update notice is immediately issued. 

Power off An automatic update notice is immediately issued, but if 
the power is off, automatic update cannot be executed. At 
the next startup of computers, it is judged whether or not 
the package has been applied based on information set 
in the package, and only packages that have not been 
applied are distributed. 

High Power on Automatic update is executed at the time specified by the 
Management Server. 

Power off Automatic update is executed when the computer is 
started up next time.  
It is judged whether or not the package has been applied 
based on information set in the package, and only 
packages that have not been applied are distributed. 

Normal  
 

There is no distribution with the automatic update. 
Create a scenario on the Management Server, and 
distribute it manually. 

Low 

 
 Other than urgency, the following items must be set in order to be a target of automatic updates. If they are 

not set, there will be no distribution with automatic updates even if urgency is Highest or High. Create a 
scenario on the Management Server, and distribute it. 

• HotFix:MS number (or ID information)  
• Service Pack:Major version and Minor version 
• Application:Display name and Display version (or ID information) 

 For a package with Highest urgency, an automatic update notice is issued to all computers whose operating 
systems are target OS of the package. However, automatic updates are not executed on computers whose 
power is off or whose automatic update notice is set to constantly off. 

*2 
 If an invalid value is input for major version or minor version, it is corrected automatically. 

In the case of a service pack, the major version and minor version must be entered. See the following 
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example. 
 

Example) Windows Server 2008 and Windows 7 
OS type Service Pack Major Version Minor Version 
Windows Server 
2008 

SP1 1 0 
SP2 2 0 

Windows 7 SP1 1 0 
 

・ If Service Pack is selected as the type 
 

  
 

Basic 
 Major version/Minor 

 version 
If service pack was selected as the type, enter the major version and 
minor version. 
This can be set in the range of "0~65535". 
In the case of a Microsoft service pack, the numbers entered in the 
Major version and Minor version field are compared with the service 
pack versions currently installed in the OS, and it is judged whether or 
not the service pack has been applied. Make sure to enter the correct 
numbers. (*2) 
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・ If Application is selected as the type  
 

   
 

Basic 
 Display Name • If Application was selected as the type, enter the display name. 

511 characters or less can be entered. 
In order to register as a target package of automatic update, enter 
the application name displayed in Programs and Features. (*3) 
For applications not displayed in Programs and Features even after 
being installed, enter the ID information. See Section 6.2.5, "ID 
Information" for details. 

Display Version  • If application was selected as the type, enter the Display version. 
Do not enter anything if the version number is not displayed in 
Programs and Features. 
In order to register as a target package of automatic update, enter 
the version displayed in Programs and Features. (*3) Do not enter 
anything if the version number is not displayed in Programs and 
Features.  
126 characters or less can be entered. 
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*3 

Example) Name and Version displayed in Programs and Features 
 

 
 

6.2.2. Execution Settings Information 
Set Execution settings tab. 
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Execution settings 
 Folder to be copied 

 Folder name Specify the folder where the patch or application is stored. 
255 characters or less can be entered. 
Alphanumeric characters and symbols can be entered. 

Browse  Click Browse, and select the folder where the patch or application is 
stored. 

Add Specify the Folder name and click Add to add it to the Added folder. 
Added folder Displays the folders that were added. 

• When the package type is Service Pack or HotFix, one folder can be 
added. 

• When the package type is Application, two or more folders can be 
added. 

Delete Click Delete, and delete the folder selected in Added folder. 
 Install 

 Execution  file  
(Required)  

Enter the execution file name. 
255 characters or less can be entered. 
Alphanumeric characters and symbols can be entered. 
Do not specify a file names that includes %xx. A file with such a file 
name cannot be properly downloaded to the Management Server. 
"xx" indicates hexadecimal number 0 ~ f. Example: file%9d.exe 
• For the Execution file, be sure to specify the one that all of the 

following conditions are met. 
- Silent install can be done. (You do not need to respond such as key 

entry while the file is being executed, or you can execute silent 
install by creating a batch file.) 

- OS is not restarted during installation. 
- Installation is possible by Local System account. (The network is not 

accessed.) 
- The total file size does not exceed 2GByte. 
- When an executable file generates descendant processes 

(executable file->child process-> grandchild process) in the 
execution, generated child process finishes after grandchild process 
finishes. Also, when an executable file is a script file such as bat or 
sh, the executable file finishes after generated child process 
finishes. 

Browse  Click Browse and select the execution file. 
Setup parameters Set the setup parameters for the executable file. 

128 characters or less can be entered. Alphanumeric characters and 
symbols can be entered. 
In the case of service pack or hotfix, specify two parameters: "Do not 
restart after execution", and "Unattended mode" or "Quiet mode". 
Example) 

In the case of Windows Server 2008 
・ Do not restart after execution: /norestart 
・ Unattended mode: /unattend 
・ Quiet mode: /quiet 

About the parameter of service pack or hotfix, execute the file by 
specifying "/h" or "-?" in advance and check the parameter. 
When you specify Windows XP SP2 or SP3 and OEM specific driver is 
installed, specify also "Execute processing without displaying the 
command prompt"("-o"). 

Requires restarting 
after the installation 

Set this parameter to perform restart after the package is applied. 
Effective when applying by automatic update type. 

 Requires applying 
independently 

Set for patches or applications which need to be applied independently 
(for example, service pack). When this check box is selected, restart is 
performed automatically before application. Effective when applied by 
automatic update type. 
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  The registered service pack/hotfix/application is copied to an internal folder on the 

Management Server. The amount of free space required for registration is 
approximately twice of the amount of the service pack/hotfix/application to be 
registered. 

 The service packs/hotfixes/applications registered here are limited to those which 
are silently installed and do not require restart after installation. (For those that 
display a security warning screen due to digital signature information, a 
confirmation screen appears on the managed machine when it is applied, and 
installation cannot continue.) 
*Silent installation means that when an executable file (setup.exe or Update.exe) 
is run, setup is performed automatically and you do not need to click Next or 
enter the key. 

*For service packs, hotfixes and so on that require a restart, register an image 
with the option not to perform restart and set the Restart After Applying option 
in the scenario. 

 
 A patch is registered in folder unit. Store only one patch in one folder. 

 

6.2.3. Applicable OS and Language Information 
Set Applicable OS and language tab.  
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Applicable  OS and language 
 OS  

(Required)  
Select the OS to which the package is to be applied. Select 
the OS to which the package corresponds. 
If All OS is selected, all OS except Other OS are the 
targets. Also, the package is applied to all machines without 
relating to OS information. 

Language  
(Required)  

Select the language of the OS to which the package is to be 
applied. 

Add Add the selected OS and Language. 
Delete Delete the selected OS and Language. 
Base Service Pack Set the base service pack to which service 

pack/hotfix/application can be applied. Add or delete the 
service pack using Add or Delete button. 

Absorbing Service Pack Set the next service pack. Set this with the Base Service 
Pack. Add or delete the service pack using Add or Delete 
button. 
Example) If "Windows Server 2008 SP2" is selected as 
Base Service Pack and "Windows Server 2008 SP3" is 
selected as Absorbing Service Pack, the package will be 
applied to the machine on which SP2 is applied and SP3 is 
not applied. 

 

6.2.4. Dependency Information 
Set Dependency Information tab. 
 
When the package is applied, the dependency information is checked. The package is applied only when the 
dependency conditions are met. 
Specify the dependency condition from the following three types. 

・ Package dependency 
・ File dependency 
・ Registry dependency 

 
 If ">" is used in the registry dependency, it may not be applied properly. 

 
 If a combination of package dependency, file dependency and registry dependency 

has been added, the package is applied only when the package dependencies are 
met and all the conditions set optionally in file dependency or registry dependency are 
met. 

Example) 
If the package dependency is A, the file dependency is B and the registry 
dependency is C, then the composite application condition is as follows. 

Item Added 
information 

Application conditions Composite 
application 
condition 

A 1 All of 1, 2 and 3 are applied. A is met, and 
conditions set 
in B and C are 
all met 

2 
3 

B 1 AND/OR can be set arbitrarily. 
Either condition of 1 or 2 is met. 2 

C 1 
2 
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(1) Select the Check the package dependencies relationship while applying the package check box, and 

set each item. 
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Dependency information 
 Check the package 

dependency 
relationship while 
applying the 
package 

The settings become valid when Check the package 
dependency relationship while applying the package check 
box is selected. 

Required packages Can be applied only if the package it depends on has been 
installed. Dependent packages are selected from other packages 
registered in PackageDescriber. Also, if two or more dependent 
packages have been added, the package will be applied if all 
dependent packages have been applied. 

  Add The Add package dependency screen appears when you click 
Add. 

 
The packages displayed on the Add package dependency 
screen are those currently registered on the Package Web Server. 
Select a dependent package from the list and click Add. 

Delete When you select a package from the dependent package list and 
click Delete, the dependent package is deleted. 

Condition List 
File Condition List About the file condition, the package is applied depending on 

whether either of files exists or not. To specify a file as a condition 
for applying package, select the File Condition List check box. 
The dependency condition is judged only after Select Conditions 
is set. Only when the File Condition List and Registry Condition 
List are added, it will not be judged. 
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  Add When you click Add, the Add file dependency information 
screen appears. Set each item and click OK. 

  
• File path 
259 characters or less can be entered. Alphanumeric characters 
and symbols can be entered. 
Enter system environment variable because the file path depends 
on the environment. 
You can specify the path, which is registered in the registry, in the 
File path. 
Specify the full-path registry name in brackets ("{", "}"). 
Example) 

When specifying EXCEL.EXE under 
C:\Program Files\Microsoft Office\Office  
Assume that the value of 

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Office\9.
0\Excel\InstallRoot\Path 

is set as C:\Program Files\Microsoft Office\Office\.  
In this case, specify 

{HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Office\9.
0\Excel\InstallRoot\Path}EXCEL.EXE  

as the file path. 
• File version/File size/Update time 

Select the item as the condition of dependency. 
You can select the item from the following. 
- File version 
- File size 
- Update time 

• Value 
Set the value following the item that you specified in the 
condition of dependency. 

- When you select File version 
31 characters or less can be entered. Enter in "x.x.x.x" format. 
Numeric characters and symbol ("." only) can be entered. 
If you do not enter the file version, the condition depends on 
whether the file exists or not. 
The file version can be checked on the Version tab of file 
properties. If the Version tab does not exist, or if the File 
version on the Version tab is blank, you do not need to enter it. 

- When you select File size 
Specify the file size by byte unit. Enter numeric characters from 0 
to 4294967295(4GByte). 
If you do not enter the file size, the condition depends on 
whether the file exists or not. 
The file size can be checked on the General tab of file 
properties. 
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  Modify If you select a file and click Modify, the Modify file dependency 

information screen appears. Modify the setting 
 

Delete If you select a file and click Delete, the dependent file is deleted. 
 Registry  

Condition List 
About the registry condition, a package is applied depending on 
whether either of registries exists or not. When you specify a 
registry as the condition of the dependency, select the Registry 
Condition List check box. 

  Add If you click Add, the Add registry dependency information 
screen appears. Set each item and click OK. 

 
• Key name 
Enter the registry key name including the root key. 255 characters 
or less can be entered. Alphanumeric characters and symbols 
can be entered. 

• Name 
Enter the value (ValueName) which belongs to the key name. 
255 characters or less can be entered. 
Alphanumeric characters and symbols can be entered. 

• Data 
Enter the value data (ValueData). The number and the type of 
characters vary depending on the type selected in Type. 
-"REG_SZ": 1024 characters or less 
-"REG_BINARY": 1024 characters or less  
-"REG_DWORD": Numeric characters from 0 to 4294967295  
-"REG_QWORD": Numeric characters from 0 to 
18446744073709551615 
-"REG_EXPAND_SZ": 1024 characters or less 
-"REG_MULTI_SZ": 1024 characters or less 

• Type 
Select the value type (ValueType). You can select from the 
following. 
-REG_SZ 
-REG_BINARY 
-REG_DWORD 
-REG_QWORD 
-REG_EXPAND_SZ 
-REG_MULTI_SZ 

• Condition 
Select the condition to apply the package. 
If you specify Exist, only the key name and name are compared. 
For REG_BINARY, only Does not exist, Exist and Exist (=) can 
be selected. 
(*2) 
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 Modify If you select a registry and click Modify, the Modify registry 

dependency information screen appears. Modify the setting. 
Delete If you select a registry and click Delete, the dependent registry is 

deleted. 
 *1 
 When reading a package, which was created in DPM Ver5.0 or earlier, in this version, the conditions are 

converted as follows. 
 

DPM Ver5.0 or Earlier This Version  
Does not exist Does not exist 
Exists 
(File version has been entered) 

Exist (=) 

Exists 
(File version has not been entered) 

Exist (Check does not Apply) 

 
 The judgement when you specified each condition is as the following. 
・ File version 

Set Value Managed Machine Status 
File 
version 

Condition The file exists (the version is shown 
below) 

The 
file 
does 
not 
exist 

1.0.0.0 2.0.0.0 3.0.0.0 None 

Not 
specified 

Does not exist No No No No Yes 
Exists 
(Check does not Apply ) 

Yes Yes Yes Yes No 

2.0.0.0 Does not exist Yes No Yes Yes Yes 
Exists(=) No Yes No No No 
Exists(<) Yes No No No No 
Exists (<=) Yes Yes No No No 
Exists(>) No No Yes No No 
Exists (>=) No Yes Yes No No 

(Yes: Dependency condition is met. No: Dependency condition is not met.) 
 

・ File size 
Set Value Managed Machine Status 
File 
size 

Condition The file exists (the size is shown 
below) 

The 
file 
does 
not 
exist 

100Byte 200Byte 300Byte None 

Not 
specified 

Does not exist No No No No Yes 
Exists 
(Check does not Apply ) 

Yes Yes Yes Yes No 

200Byte Does not exist Yes No Yes Yes Yes 
Exists(=) No Yes No No No 
Exists(<) Yes No No No No 
Exists (<=) Yes Yes No No No 
Exists(>) No No Yes No No 
Exists (>=) No Yes Yes No No 

(Yes: Dependency condition is met. No: Dependency condition is not met.) 
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・ Update time 

Set Value Managed Machine Status 
Update time Condition The file exists (the update time is shown 

below) 
The 
file 
does 
not 
exist 

2013/12/31 
23:59 

2014/01
/01 
00:00 

2014/01/01 
00:01 

None 

Not specified Does not exist No No No No Yes 
Exists 
(Check does not 
Apply ) 

Yes Yes Yes Yes No 

2014/01/01 
00:00 

Does not exist Yes No Yes Yes Yes 
Exists(=) No Yes No No No 
Exists(<) Yes No No No No 
Exists (<=) Yes Yes No No No 
Exists(>) No No Yes No No 
Exists (>=) No Yes Yes No No 

(Yes: Dependency condition is met. No: Dependency condition is not met.) 
 

*2 
 Key name, Name and Data are not case-sensitive. 
 Data comparison in REG_SZ, REG_EXPAND_SZ, or REG_MULTI_SZ is done by simple character 

string. In the case of "9.0.0.0" and "10.0.0.0", "9.0.0.0" is judged greater. 
 When you specify REG_MULTI_SZ, "\n" is entered if you press Enter key. 
 When reading a package, which was created in DPM Ver5.0 or earlier, in this version, the conditions 

are displayed as follows. 
 

DPM Ver5.0 or Earlier This Version  
Does not exist Does not exist 
Exists 
(data has been entered) 

Exist (=) 

Exists 
(data has not been entered) 

Exist 

 
 The operations when you specified each condition are as shown below. 
1) When only the Key name is specified 
Set Value Managed Machine Status 
Condition Exists Does not exist 
Does not exist No Yes 
Exists Yes No 
(Yes: Dependency condition is met. No: Dependency condition is not met.) 
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2) When the Name is specified 
・ REG_SZ 
Set Value Managed Machine Status 
Data Condition Name Exists Name 

does 
not 
exist 

1.0.0.0 2.0.0.0 3.0.0.0 Blank 

Blank Does not exist No No No No Yes 
Exists Yes Yes Yes Yes No 

2.0.0.0 Does not exist Yes No Yes Yes Yes 
Exists (=) No Yes No No No 
Exists (<) Yes No No Yes No 
Exists (<=) Yes Yes No Yes No 
Exists (>) No No Yes No No 
Exists (>=) No Yes Yes No No 

(Yes: Dependency condition is met. No: Dependency condition is not met.) 
 

・ REG_BINARY 
Set Value Managed Machine Status 
Data Condition Name Exists Name 

does 
not 
exist 

AA BB CC None 

Blank Does not exist No No No No Yes 
Exists Yes Yes Yes Yes No 

BB Does not exist Yes No Yes Yes Yes 
Exists (=) No Yes No No No 

(Yes: Dependency condition is met. No: Dependency condition is not met.) 
 

・ REG_DWORD 
Set Value Managed Machine Status 
Data Condition Name Exists Name does not 

exist 1 2 3 
Blank Does not exist No No No Yes 

Exists Yes Yes Yes No 
2 Does not exist Yes No Yes Yes 

Exists (=) No Yes No No 
Exists (<) Yes No No No 
Exists (<=) Yes Yes No No 
Exists (>) No No Yes No 
Exists (>=) No Yes Yes No 

(Yes: Dependency condition is met. No: Dependency condition is not met.) 
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・ REG_QWORD 
Set Value Managed Machine Status 
Data Condition Name Exists Name does not 

exist 1 2 3 
Blank Does not exist No No No Yes 

Exists Yes Yes Yes No 
2 Does not exist Yes No Yes Yes 

Exists (=) No Yes No No 
Exists (<) Yes No No No 
Exists (<=) Yes Yes No No 
Exists (>) No No Yes No 
Exists (>=) No Yes Yes No 

(Yes: Dependency condition is met. No: Dependency condition is not met.) 
 

・ REG_EXPAND_SZ 
Set Value Managed Machine Status 
Data Condition Name Exists Name 

does 
not 
exist 

1.0.0.0 2.0.0.0 3.0.0.0 Blank 

Blank Does not exist No No No No Yes 
Exists Yes Yes Yes Yes No 

2.0.0.0 Does not exist Yes No Yes Yes Yes 
Exists (=) No Yes No No No 
Exists (<) Yes No No Yes No 
Exists (<=) Yes Yes No Yes No 
Exists (>) No No Yes No No 
Exists (>=) No Yes Yes No No 

(Yes: Dependency condition is met. No: Dependency condition is not met. 
 

・ REG_MULTI_SZ 
Set Value Managed Machine Status 
Data Condition Name Exists Name does not 

exist 1.0.0.0 2.0.0.0 3.0.0.0 Blank 
Blank Does not exist No No No No Yes 

Exists Yes Yes Yes Yes No 
2.0.0.0 Does not exist Yes No Yes Yes Yes 

Exists (=) No Yes No No No 
Exists (<) Yes No No Yes No 
Exists (<=) Yes Yes No Yes No 
Exists (>) No No Yes No No 
Exists (>=) No Yes Yes No No 

(Yes: Dependency condition is met. No: Dependency condition is not met.) 
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(2) After configuring the File Condition List and Registry Condition List of the Condition List group box, click 

Select Conditions and configure the conditions. 
 

 
 

  Conditions used in an AND/OR condition cannot be deleted. 
 For the file condition below the deleting condition, if the registry condition is 

specified with AND, OR, this condition cannot be deleted. 
Example) 

When the third file condition is used AND, OR, the first and second file 
condition cannot be deleted  
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1) The Select Conditions screen appears, and then click Add. 
 

 
 

 The Condition Number is treated as "and" conditions, and the condition separated 
by pipes ("|") is treated as "or" conditions. 

 
2) The OR Condition Specification screen appears. Specify "and" and "or" of the conditions. 

By selecting file conditions or registry conditions and clicking ">>", you can add "or" condition to Condition 
Items. 
If you want to delete the "or" condition that you added to Condition Items, click "<<". 
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6.2.5. ID Information 
Set ID Information tab. 
 
It is judged whether or not a package has been applied to a managed machine using the ID information. 
 
Enter changes in the file and registry, occurring by installing the package, as ID information. 
Example) 

Package A is registered, and distributed to managed machines. 
・ Before distribution : Which patches are installed currently? 

How is file information or the registry? 
・ After distribution :By distributing package A, what are changed in files and registry? 

 
Register the difference information obtained by comparing 1) and 2) as ID information. 
DPM judges the package applied status based on the ID information specified here. If all entered file change 
information and registry change information are met, it is judged that the package is already applied. 
 

  When the created package file is a service pack or hotfix issued by Microsoft, even 
if ID information was not entered, the MS number on the Basic tab is compared 
with the MS number written in the registry (KBXXXXXX or QXXXXXX), and if two 
values are matched, it is judged that the package is already applied. 

 When the created package is a service pack issued by Microsoft, even if no ID 
information was entered, the major version and minor version on the Basic tab are 
compared with the service pack version currently installed in the OS, and it is 
judged whether or not the service pack is already applied. 

 You need to enter ID information in the case of applying a package that does not 
have an MS number or cannot be identified by MS number, or a package that the 
information remains only in the registry and so on. 

 

 
 



 

402 

ID Information 
 File change information Used to judge whether a package is already applied based on 

information which is changed in the file system by applying the 
package. 

 Add  When you click Add, the Add file information screen appears. 
Add the file ID information of the package. 

 
 
・ File path 

Enter the changed file path and file name. 259 characters or 
less can be entered. 
Alphanumeric characters and symbols can be entered. 
Enter system environment variable because the file path 
depends on the environment. 

・ File version/File size/Update time 
Select the item as the condition of identification. 
You can select the item from the followings. 

- File version 
- File size 
- Update time 

・ Value 
Set the value following the item that you specified in the 
condition of identification. 

- When you select File version 
31 characters or less can be entered. Enter in 
"x.x.x.x" format. 
Numeric characters or symbol ("." only) can be 
entered.  
If you do not enter the file version, the condition 
depends on whether the file exists or not. 

The file version can be checked on the Version tab of file 
properties. If the Version tab does not exist, or if the 
File version on the Version tab is blank, you do not 
need to enter it.  
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 - When you select File size 
Specify the file size by byte unit. Enter numeric characters 
from 0 to 4294967295(4GByte). 
If you do not enter the file size, the condition depends on 
whether the file exists or not. 
The file size can be checked on the General tab of file 
properties. 

- When you select Update time 
Enter in "YYYY/MM/DD hh:mm" format. Numeric characters, 
following symbols, and space can be entered. 
/ : 
If you do not enter the update time, the condition depends on 
whether the file exists or not. The update time can be 
checked on the General tab of file properties. 
The update time is not affected by the timezone on the 
managed machine. 

・ Change type 
Set the change type. You can select from the following. 
- Create new: Select when a new file is created by applying 

the package. 
- Replace: Select when the file is replaced unconditionally by 

applying the package. 
- Version up: Select when the file is replaced only when the 

file is newer than the existing file by applying the package. 
- Delete: Select when the file is deleted by applying the 

package. 
(*1) 

Modify When you select a file and click Modify, the Modify  file 
information screen appears. Modify the settings. 

Delete When you select a file and click Delete, the file is deleted. 
 Registry change 

information 
Used to judge whether a package is already applied based on 
registry information which is changed by applying the package. 
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  Add If you click Add, the Add registry information screen 
appears. Add the registry ID information of the package. 

 
・ Key name 

Enter the registry key name including the root key. 255 
characters or less can be entered. Alphanumeric 
characters and symbols can be entered. 

・ Name 
Enter the value (ValueName) which belongs to the key 
name. 
255 characters or less can be entered. 
Alphanumeric characters and symbols can be entered. 

・ Data 
Enter the value data (ValueData). The number and the 
type of characters vary depending on the type selected in 
Type. 
-"REG_SZ": 1024 characters or less 
-"REG_BINARY": 1024 characters or less 
-"REG_DWORD": Numeric characters from 0 to 

4294967295  
-"REG_QWORD": Numeric characters from 0  

to 18446744073709551615 
-"REG_EXPAND_SZ": 1024 characters or less 
-"REG_MULTI_SZ": 1024 characters or less 

・ Type 
Select the value type (ValueType). You can select from 
the following. 
-REG_SZ 
-REG_BINARY 
-REG_DWORD 
-REG_QWORD 
-REG_EXPAND_SZ 
-REG_MULTI_SZ 

・ Change type 
Select the change type. You can select from the following. 
- Create new: Select when a new registry is created by 

applying the package. 
- Replace: Select when the registry is replaced by 

applying the package. 
- Delete: Select when the registry is deleted by applying 

the package. 
(*2) 

Modify Modify the added registry ID information of the package. 
Delete Delete the added registry ID information of the package. 
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*1 
 The judgment when you specified each condition is as the following. 

・ File version 
Set Value Managed Machine Status 
File 
version 

Condition The file exists (the version is shown below) The file does 
not exist 1.0.0.0 2.0.0.0 3.0.0.0 None 

Unspecified Create new Yes Yes Yes Yes No 
Replace No No No Yes No 
Version up No No No Yes No 
Delete No No No No Yes 

2.0.0.0 Create new Yes Yes Yes Yes No 
Replace No Yes No No No 
Version up No Yes Yes No No 
Delete No No No No Yes 

(Yes: Identification condition is met. No: Identification condition is not met.) 
 

・ File size 
Set Value Managed Machine Status 
File 
size 

Condition The file exists (the size is shown below) The file does 
not exist 100Byte 200Byte 300Byte None 

Unspecified Create new Yes Yes Yes Yes No 
Replace No No No Yes No 
Delete No No No No Yes 

200Byte Create new Yes Yes Yes Yes No 
Replace No Yes No No No 

Delete No No No No Yes 
(Yes: Identification condition is met. No: Identification condition is not met.) 
 

・ Update time 
Set Value Managed Machine Status 
File 
size 

Condition The file exists (the update time is shown below) The file 
does not 
exist 

2013/12/31 
23:59 

2014/01/01 
00:00 

2014/01/01 
00:01 

None 

Unspecified Create new Yes Yes Yes Yes No 
Replace No No No Yes No 
Delete No No No No Yes 

2014/01/01 
00:00 

Create new Yes Yes Yes Yes No 
Replace No Yes No No No 

Delete No No No No Yes 
(Yes: Identification condition is met. No: Identification condition is not met.) 
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*2 
 When you specify REG_MULTI_SZ, "\n" is entered if you press Enter key. 
 The judgement when you specified each condition is as the following. 

1) When you specify only the key name 
Set Value Managed Machine Status 
Condition Exists Does not exist 
Create new Yes No 
Delete No Yes 

(Yes: Identification condition is met. No: Identification condition is not met.) 
 

2) When you specify the name 
• REG_SZ 
Set Value Managed Machine Status 
Data Condition Name exists Name does not 

exist 1.0.0.0 2.0.0.0 3.0.0.0 Blank 
Blank Create new Yes Yes Yes Yes No 

Replace No No No Yes No 
Delete No No No No Yes 

2.0.0.0 Create new Yes Yes Yes Yes No 
Replace No Yes No No No 
Delete No No No No Yes 

(Yes: Identification condition is met. No: Identification condition is not met.) 
 
• REG_BINARY 

Set Value Managed Machine Status 
Data Condition Name exists Name  

does not 
exist 

AA BB CC None 

Blank Create new Yes Yes Yes Yes No 
Replace No No No Yes No 
Delete No No No No Yes 

BB Create new Yes Yes Yes Yes No 
Replace No Yes No No No 
Delete No No No No Yes 

(Yes: Identification condition is met. No: Identification condition is not met.) 
 
• REG_DWORD 
Set Value Managed Machine Status 
Data Condition Name exists Name  

does not exist 1 2 3 
Blank Create new Yes Yes Yes No 

Replace No No No No 
Delete No No No Yes 

2 Create new Yes Yes Yes No 
Replace No Yes No No 
Delete No No No Yes 

(Yes: Identification condition is met. No: Identification condition is not met.) 
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• REG_QWORD 
Set Value Managed Machine Status 
Data Condition Name exists Name  

does not exist 1 2 3 
Blank Create new Yes Yes Yes No 

Replace No No No No 
Delete No No No Yes 

2 Create new Yes Yes Yes No 
Replace No Yes No No 
Delete No No No Yes 

(Yes: Identification condition is met. No: Identification condition is not met.) 
 

• REG_EXPAND_SZ 
Set Value Managed Machine Status 
Data Condition Name exists Name does not 

exist 1.0.0.0 2.0.0.0 3.0.0.0 Blank 
Blank Create new Yes Yes Yes Yes No 

Replace No No No Yes No 
Delete No No No No Yes 

2.0.0.0 Create new Yes Yes Yes Yes No 
Replace No Yes No No No 
Delete No No No No Yes 

(Yes: Identification condition is met. No: Identification condition is not met.) 
 

• REG_MULTI_SZ 
Set Value Managed Machine Status 
Data Condition Name exists Name does not 

exist 1.0.0.0 2.0.0.0 3.0.0.0 Blank 
Blank Create new Yes Yes Yes Yes No 

Replace No No No Yes No 
Delete No No No No Yes 

2.0.0.0 Create new Yes Yes Yes Yes No 
Replace No Yes No No No 
Delete No No No No Yes 

(Yes: Identification condition is met. No: Identification condition is not met.) 
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6.2.6. Group Information 
Set Group Information tab. 
 

 
 

Group Information 
 Apply to All Group 

(*1) 
If you select Apply to All Group checkbox, the package will be 
applied to all machine group. 
By default, the checkbox is selected. 

Unapplied Group Displays the list of machine groups to which the package will not be 
applied. 
(*2) 

>> If you click >>,,  the machine group which is selected in Unapplied 
Group will be moved to Applied Group. 

<< If you click <<,,  the machine group which is selected in Applied 
Group will be moved to Unapplied Group. 

Applied Group Displays the list of machine groups to which the package will be 
applied. 

*1 
When Apply to All Group checkbox is not selected and there is not a machine group in Applied Group, 
the package will not be applied even if the urgency of the package is High or Highest and there is a 
managed machine which is matched with the condition on other tabs. 

*2 
Create the list of machine groups to be displayed by editing the following file. (In the environment that UAC 
is enabled, launch text editor by administrator authority, and edit and save the file.) 
<PackageDescriber installation folder>\group.txt 
 

・ The format and description rule is as follows: 
Enter one machine group(full path of the machine group) in one line and insert line feeds.(Describe in 
1301Bytes or less.) 
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Example) 

/Group01/Group11/ 
/Group01/Group12/ 
/Group02/Group21/ 
/Group02/Group22/ 
/Group02/Group23/ 

 
・ If you restart PackageDescriber, the content of "group.txt" will reflected in Unapplied Group. 

 

6.3. Modify/Delete Package 
This section describes how to modify or delete a created package. 
 
(1) Log on to the machine, on which PackageDescriber is installed, by a user with administrator authority. 

 
(2) From Start menu, select All Programs -> DPM PackageDescriber. 

 
(3) PackageDescriber is launched. From File menu, click Modify/delete package. 

 
(4) Local package list screen appears. Click Select Folder. 

 

 
 

 The sort order of packages can be changed by clicking the name of each item 
on the Local package list screen. 
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(5) The dialog box to select a folder appears. Select the folder of the package to modify or delete and click 

Open. 
 

 
 
(6) The packages in the folder specified on the Local package list screen are displayed. Select a package, 

and modify or delete it. 
 
(7) In the case of modification, the Save screen is opened after modification. Select the folder to save and click 

Save. 
 

 
 

  The package list initially displayed on the Local package list screen is the 
package list of the folder specified as the Temporary folder. 

 File Name and File Type: All files are displayed on the screen. Select a folder. 
 When saving a folder in a folder except the Temporary folder, check that 

packages having the same package ID do not exist in that folder so as not to 
accidentally overwrite backup packages. 
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(8) Select a package from the Local package list screen and perform modification or deletion. 

 
Local package list  
 Modify When you click Modify, the Modify package screen opens. 

Delete When you click Delete, the selected package is deleted. 
Close When you click Close, the screen closes. 

 
(9) Click Modify on the Local package list screen to display the Modify package screen. Modify the items on 

the Basic, Execution Settings, Applicable OS and language, Dependency information, ID 
information, and Group Information tabs. 

 

 
 
 

 If you modify a package that was already added to the Package Web Server, click 
File menu ->Register in/Delete from the Package Web Server -> 
Register/Re-register. 
See Section 6.4, "Registration and Deletion on the Package Web Server," for details. 

 
 The Package ID and Type on the Basic tab cannot be modified. 

See Section 6.2.1, "Basic Information," through Section 6.2.6, "Group Information," 
for a description of each tab. 
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6.4. Registration and Deletion on the Package Web 
Server 

This section describes how to register or delete a created package on the Package Web Server. 
Created packages can be automatically downloaded from the Management Server by registering them on the 
Package Web Server. 

 
 When registering a package on the Package Web Server, perform operations after 

stopping the HTTP service. 
Example) •World Wide Web Publishing Service(IIS)  

•Apache Tomcat 
 

 Packages not registered on the Package Web Server cannot be automatically 
downloaded from the Management Server. 

 
(1) Log on to the machine, on which PackageDescriber is installed, by a user with administrator authority. 

 
(2) From Start menu, select All Programs -> DPM PackageDescriber. 

 
(3) PackageDescriber is launched. From File menu, click Register in/Delete from the Package Web Server. 

 
(4) The Register in/Delete from the Package Web Server screen appears. Do each operation. 
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Register in/Delete from the Package Web Server 

 Register/Re-regist

 

When you click Register/Re-register, the Local package list 
screen appears. See the procedure of Step (5) regarding the 
Local package list screen. 

Delete The package is deleted from the Package Web Server. 
If you select the package to delete and click Delete, a confirmation 
screen appears. To delete, click Yes. 
If the package selected for deletion is dependent on another 
package, the following confirmation screen appears. To delete, 
click Yes. Otherwise, click No. 

 
 
(5) When you click Register/Re-register, the Local package list screen appears. Click Select Folder and 

select a folder from the Open dialog box, and register or re-register the package on the Package Web 
Server. 
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Local package list  
 Select Folder The folder of the package you wish to register or re-register can be 

selected and changed on the Local package list screen. See 
Section 6.3, "Modify/Delete Package," for details. 

Add If you select the package you register and click Add, the package 
is copied to the Web Server folder and registered on the Package 
Web Server. 
It is also displayed on the Register in/Delete from the Package 
Web Server screen. 
When re-registering a package, if that package is dependent on 
another package, the following confirmation screen appears. To 
re-register, click Yes. Otherwise, click No. 

 
An error message will be displayed if the selected package does 
not exist. 

Cancel Click Cancel to end the operation and close the Local package 
list screen. 

 

6.5. Online Update 
When a new service pack is released for the OS that DPM supports (for example, when SP3 was released for 
Windows Server 2003), the OS definition file and language definition file must be updated and the new service 
pack information must be added. 
PackageDescriber downloads the latest definition files from the DPM product site and updates them using the 
Online update function. 
By using this function, the correct information files can be created in patches and applications released in the 
future as well. 
The information for using this function (OS information URL column and Language information URL column) 
is currently blank. When this function becomes available, the information will be provided on the product site. 
 
The following describes how to perform online updates. 

 
(1) Log on to the machine, on which PackageDescriber is installed, by a user with administrator authority. 
 
(2) Select Start -> All Programs -> DPM PackageDescriber. 
 
(3) PackageDescriber is launched. From Help menu, click Online update.  
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(4) The Online update screen appears. Set each item and click Update. 

The online update is started and the status and the result of the online update are displayed in the 
Description.  

 

 
 

Online update 
 OS information URL Enter the public URL of the OS definition file. There is 

no need to change it from the default value. 
Language information URL Enter the public URL of the language definition file. 

There is no need to change it from the default value. 
Proxy (check box) Select this check box when accessing the DPM 

website via a proxy server. 
It does not have to be selected when connecting 
directly to the Internet. 

Proxy  Enter the address of the proxy server. 259 characters 
or less can be entered. 
If you have checked the Proxy check box, the domain 
name or IP address must be entered. 

Port  Specify the port number of the proxy server. 
This can be set in the range of "1~65535". 

Update Download and save files from the entered OS 
information URL and language information URL. 

Save & Close Saves the OS information URL and language 
information URL to a file and Closes the screen. 

 
 If you do not know the proxy server and port number, please contact the 

administrator. 
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7. Other Tools 
This chapter explains the tools used in DPM. 
 

7.1. Port Opening Tool 
Port Opening Tool is a tool to open the ports or programs used by DPM when Windows firewall is enabled. 
The ports or programs are opened automatically by this tool when installing DPM Server or DPM Client. 
Also, you can open the ports or programs by this tool after installing DPM Server or DPM Client. (when you 
switch the firewall function to enabled, and so on.) 
 

7.1.1. Port Number Setting 
For Management Server and managed machines, see the corresponding part below about the setting of port 
numbers/programs when the firewall is enabled. 
 

• Management Server 
If you operate DPM, enabling the firewall, the following ports or programs used by DPM are automatically 
opened. 

 
<The ports which are opened automatically> 
Item Protocol Port Number 
Ports used by DPM Server TCP apiserv.exe 

UDP apiserv.exe 
TCP bkressvc.exe 
UDP bkressvc.exe 
TCP depssvc.exe 
UDP depssvc.exe 
TCP ftsvc.exe 
UDP ftsvc.exe 
TCP pxemtftp.exe 
UDP pxemtftp.exe 
TCP pxesvc.exe 
UDP pxesvc.exe 
TCP rupdssvc.exe 
UDP rupdssvc.exe 
TCP schwatch.exe 
UDP schwatch.exe 

 
<The ports which are not opened automatically> 
The following ports are not opened by Port Opening Tool automatically. 
Item  Protocol Port Number 
Ports used by DPM Server TCP 80 

* When the port number is changed from 80 (Default), replace it. 
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・ Managed machines 

When you operate DPM, enabling the firewall on the managed machine, the following ports or programs 
used by DPM are automatically opened. 

 
Item Protocol Port Number 
Check power status ICMP 8 (Echo 

incoming) 
Remote update 
Automatic update 
File distribution 
File deletion 
Obtaining the information 
in File/Folder List screen 

TCP rupdsvc.exe 
UDP rupdsvc.exe 

Shutdown 
 

TCP DepAgent.exe 
UDP DepAgent.exe 

 
  When the following services are stopped, ports or programs cannot be opened by 

Port Opening Tool.  
・ Windows Firewall/Internet Connection Sharing(ICS) 
・ Windows Firewall 

On Windows Server 2003 SP1/SP2 or Windows Server 2003 R2, these services 
are disabled by default. Execute Port Opening Tool after starting the services. 

 By the DPM remote update function, Port Opening Tool cannot be used on 
machines whose ports have not been opened. 

 In the environment of Server Core installation or Minimal Server Interface of 
Windows Server 2008 or later, execute the following command in the command 
prompt and open the port manually.  
(The following command is described in two or more lines. Enter it by one line in 
the actual screen.) 
 
netsh advfirewall firewall add rule  
name="ICMP Allow incoming V4 echo request" protocol=icmpv4:8,any 
dir=in action=allow 
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7.1.2. Executing the Tool on Each Machine 
This section describes how to use Port Opening Tool on the Management Server and managed machines. 

 
 To execute Port Opening Tool, DPM Server needs to be installed in the Management 

Server and DPM Client needs to be installed in the managed machine. 
 

(1) Insert the Installation media into the DVD drive of the machine on which you use Port Opening Tool. 
 

(2) Start the command prompt and execute the command as follows. 
 

- The Management Server 
D:\TOOLS\OPENPORT\DepOpnPt.exe -m 

- The managed machine 
D:\TOOLS\OPENPORT\DepOpnPt.exe -c 

 
(D: indicates the DVD drive.)  

 
 If "-s" is specified as a command option, it can be executed in silent mode without 

messages being displayed. 
Example) In case of the managed machine 

D:\TOOLS\OPENPORT\DepOpnPt.exe -s -c 
 
(D: indicates the DVD drive.)  

 
(3) A confirmation screen appears. Click OK to open ports. 
 

 
 
Port opening is completed. 
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7.2. Disk Configuration Check Tool 
This section describes the disk configuration check. 
Specify the disk number or the partition number that you specify when executing backup or restoring, referring to 
the disk information(the disk number, the partition number, and so on) that you obtained by executing the disk 
configuration check scenario. 
You can check the disk information in the Disk Information(Disk Viewer) screen on the Web Console.  
 
(1) Assign the disk configuration check scenario(System_DiskProbe scenario under Built-in Scenarios 

scenario group) to the managed machine. About assigning a scenario, see Section 3.8.3, "Assign Scenario." 
 

 You can create a disk configuration check scenario newly. 
For details, see Section 3.13.4, "Backup/Restore Tab." 

 
(2) Execute the disk configuration check scenario. 

For details of executing a scenario, see Section 3.8.6, "Execute Scenario." 
 
(3) Check the scenario execution result of the disk configuration check. 

For details of scenario execution result, see Section 4.3, "Scenario Execution List." 
 
(4) Specify the disk number and the partition number, that you checked in Disk Information(Disk Viewer) 

screen, in the backup or restore scenario.  
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Example) 
When you specify the disk number and the partition number in the backup scenario. 

 

 
 

 
 

 For details of each screen, see Section 3.7.1.3, "Disk Information" and 3.13.4, 
"Backup/Restore Tab." 
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7.3. Automatic Update Status Display Tool 
The Automatic Update Status Display Tool displays the automatic update status as an icon in the task tray of the 
managed machine. 
 

 The Automatic Update Status Display Tool cannot be used for the following 
managed machines. 
・ Remote Desktop of x64 Edition(Windows Server 2003/Windows XP only) 
・ When the environment is Server Core installation or Minimal Server 

Interface in Windows Server 2008 or later. 
・ Linux OS 

 
The icons displayed in the task tray are shown in the table below. 
 

Icon Managed Machine Status Description 

  

Ready This appears when automatic update and 
scenario execution are not being executed. 
(The icon at left also appears when there is 
a scenario execution error. 

 

Automatically Updating This appears after automatic update 
begins, while the package to be applied is 
searched for and judged. 

Transferring Automatic 
Update File  

This appears when transferring an 
automatic update file to a managed 
machine. 

Confirming Automatic 
Update User  

This appears when the Run Immediately 
or Run at Next Start Up dialog box 
appears. 

Waiting for Automatic 
Update Restart  

This appears under any of the following 
conditions:  
• Waiting for restart after Execute At Next 

Start Up is set 
• Waiting for restart after Cancel is clicked 

in Restart dialog 
Applying an Automatic 
Update Package 
(Package ID) 

This appears when applying an automatic 
update package. 
The package ID is also displayed. 

Running Scenario  This appears when a scenario is running. 

 

Automatic Update Error  This appears when an error has occurred 
in the automatic update. 

 
 A popup hint appears when you hover over an icon with the mouse pointer. 

 
The menu of the Client Setting Tool and About DeploymentManager can be used by right-clicking an icon. 
See Section 7.3.1, "Client Setting Tool," through Section 7.3.2, "About DeploymentManager," regarding these 
menus. 
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7.3.1. Client Setting Tool 
Configure display/non-display of the Automatic Update Status Display Tool. 
 
(1) Right-click the Automatic Update Status Display Tool icon. 
 
(2) Select Client Configuration from the displayed menu. 

Or, from the Start menu, select All Programs -> DeploymentManager -> Client Setting Tool to display the 
Client Setting Tool. 

 
(3) The Client Setting Tool appears. Configure whether or not to display the Client Automatic Update Status 

Display Tool icon, and click OK. 
 

 
 

7.3.2. About DeploymentManager 
If you right-click the Automatic Update Status Display Tool icon and select About DeploymentManager, the 
version of DPM Client is displayed. 
 

7.4. Backup Image File Verification Tool 
The Backup Image File Verification Tool is for checking before restoring whether a backup file is incorrect and 
can be restored properly. 
This section describes how to use the Backup Image File Verification Tool. 
 
(1) From the Start menu, select All Programs -> DeploymentManager -> Backup image file verification 

tool. 
 
(2) The following screen appears. Click Refer, select the backup file you want to check, and click Verify. 

 

 
 

(3) Until checking of the backup file is completed, wait a moment. 
A dialog box appears. Click OK. 
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8. DPM Command Line 
This chapter explains DPM Command Line. 
 

8.1. Operation from DPM Command Line 
By using DPM Command Line (dpmcmd.exe), you can view the information of the managed machine information, 
execute scenarios, and perform other tasks from the command line instead of the Web Console. Functions of 
DPM Command Line are described as the following . 
. 

Command Function 
clilist Displays the managed machine list or managed machine details. 
snrlist Displays the scenario list. 
powon Powers on. 
shutdown Shuts down. 
assign Assigns a scenario or remove the scenario assignment. 
snrexec Executes a scenario. 
snrstop Interrupts the scenario execution. 
progress Displays the scenario execution status. 
stsclear Clears the status. 
cliadd Registers a managed machine. 
cliremove Deletes the managed machine. 
liclist Displays the license information. 
? Displays help. 

 
 Execution Method for DPM Command Line 
 
(1) Log on to the machine, on which DPM Server or DPM Command Line is installed, by an arbitrary user. 

 
(2) Start the command prompt and go to the Folder where DPM Command Line is installed. 

Furthermore, when you log on the OS by the user except Administrator, execute the command prompt 
as an administrator. 

 
 The default installation folder is as the following: 

C:\Program Files\NEC\DeploymentManager  

 
(3) Execute the command. 

For the detail of each command, see from Section 8.1.1, "Display Managed Machine List and Managed 
Machine Details" to Section 8.1.13, "Help." 
 

  Do not perform the following to stop the command forcibly during command 
execution because it may cause abnormal termination. 
・ Press Ctrl + Break key 
・ Close the command prompt 
・ Log off 
・ Shut down 

 To specify options, be careful about the following. 
・ Specify the option by the following order listed in "Syntax" (from the left). 
・ To specify input value which includes space (DNS name of DPM Server and 

so on.), 
enclose the input value in double quotation marks(").  
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 Upper case and lower case are not distinguished for option specification. 
 When the command execution is succeeded, the return value is "0". 

When an error occurs, an error message appears. 
For the detail of the error information(the error message), contact your sales or 
support representative. 

 

8.1.1. Display Managed Machine List and Managed Machine Details 
Displays a list of managed machines which are registered on DPM Server or details of the managed machine. 
・ The list of managed machines displays the following information. 

- Machine name (Identification name when the identification name is set) 
- MAC address 
- Status(scenario execution status, automatic update status, or power status) 
- Scenario(the name of the assigned scenario) 

・ The detail of the managed machine displays the following information. 
- Machine name 
- Identification name 
- OS name 
- Service pack 
- Assigned scenario(the name of the assigned scenario) 
- Client status(scenario execution status, automatic update status, or power status) 
- UUID 
- MAC address 
- IP address(IPv4 address) 
- IPv6 address 
- Deploy-OS 

 
 Syntax 

・ When you display the list of managed machines  
dpmcmd.exe DPM Server [Management Server] clilist [/S] [/P Web Port] 

 
・ When you display the detail information of the managed machine 

dpmcmd.exe DPM Server [Management Server] clilist [/S] [/P Web Port] Managed Machine 
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 Option 

 
Option Explanation 
DPM Server Specify IP address of DPM Server or DNS name. 

Required. 
Management Server Specify IP address of DPM Server(Management Server) or DNS name. 

Specification is not required normally. 
This option helps to maintain the compatibility with old version(earlier 
than DPM Ver6.0). 

clilist Specify this to display the list of managed machines which are 
registered on DPM Server or the detail information of the managed 
machine. 
Required. 

/S Specify this to communicate by HTTPS.  
When you omit this option, the communication is done by HTTP. 

/P Web port Specify http/https port(1-65535) which is used by DPM Server(IIS). 
When you omit this option, the following port is used. 
・ When /S is specified: 443 
・ When /S is not specified: 80 

Managed Machine Specify either of machine name, identification name, or MAC address of 
the managed machine which is registered on DPM Server. 
Required when you display detail information of the managed machine. 
When you specify MAC address, enter it with "/M XX-XX-XX-XX-XX" 
format. 
Also, when you specify the machine name, if two or more managed 
machines with the same machine name are registered, the 
corresponding machines are displayed. 

 
Example) 
・ When you display the list of managed machines  

 
・ When you display the detail information of the managed machine 
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8.1.2. Display Scenario List 
Displays a list of scenarios which are registered on DPM Server 
The description of function which is specified on the scenario is as the following. 

・ HW:HW image 
・ OS:OS clear installation 
・ SP: Service pack/HotFix/Linux patch file 
・ PP: Application 
・ BK: Backup 
・ RS: Restore 
・ DC: Disk configuration check  

When above function is specified, "1" is displayed,  
When above function is not specified, "0" is displayed.  
 
 Systax 

dpmcmd.exe DPM Server [Management Server] snrlist [/S] [/P Web Port] 
 

 Option 
 
Option Explanation 
DPM Server Specify IP address of DPM Server or DNS name. 

Required. 
Management 
Server 

Specify IP address of DPM Server(Management Server) or DNS name. 
Specification is not required normally. 
This option helps to maintain the compatibility with old version (earlier than 
DPM Ver6.0). 

snrlist Specify this to display the list of scenarios which are registered on DPM Server. 
Required. 

/S Specify this to communicate by HTTPS.  
When you omit this option, the communication is done by HTTP. 

/P Web port Specify http/https port(1-65535) which is used by DPM Server(IIS). 
When you omit this option, the following port is used. 
・ When /S is specified: 443 
・ When /S is not specified: 80 
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Example) 

 

8.1.3. Power On 
Powers on the managed machine. 
 
 Syntax 

The following command is described in two or more lines. Enter it by one line in the actual screen. 
 
dpmcmd.exe DPM Server [Management Server] powon [/S] [/P Web Port] Managed Machine  
Password 
 

 Option  
 
Option  Explanation 
DPM Server Specify IP address of DPM Server or DNS name. 

Required. 
Management 
Server 

Specify IP address of DPM Server(Management Server) or DNS name. 
Specification is not required normally. 
This option helps to maintain the compatibility with old version(earlier than DPM 
Ver6.0). 

powon Specify this when you power on the managed machine. 
Required. 

/S Specify this to communicate by HTTPS.  
When you omit this option, the communication is done by HTTP. 

/P Web port Specify http/https port(1-65535) which is used by DPM Server(IIS). 
When you omit this option, the following port is used. 
・ When /S is specified: 443 
・ When /S is not specified: 80 
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Management  
Machine 

Specify either of machine name, identification name, or MAC address of the 
managed machine which is registered on DPM Server. 
Required. 
When you specify MAC address, enter it with "/M XX-XX-XX-XX-XX" format. 
When the identification name of one managed machine is the same as the 
machine name of another managed machine, the command is executed for the 
managed machine that the identification name is matched. 
When there are two or more machines with the same machine name, the 
command cannot be executed. 
In this case, specify identification name or MAC address. 

Password Specify the password of deployment_user which is registered on DPM Server. 
Required. 
Initial password is "dpmmgr". 

 
 The managed machine in the following statuses cannot be powered on. Re-execute power 

on after executing the status clear by seeing Section 8.1.9, "Status Clear." 
・ Scenario Execution Stop 
・ Scenario Execution Error 
・ Remote Power ON Error 

 
Example)  

 
 

8.1.4. Shutdown 
Shuts down the managed machine.  
 
 Syntax 

The following command is described in two or more lines. Enter it in one line in the actual screen. 
 
dpmcmd.exe DPM Server [Management Server] shutdown [/S] [/P Web Port] Managed Machine 
Password 
 

 Option 
 

Option Explanation 
DPM Server Specify IP address of DPM Server or DNS name. 

Required. 
Management  
Server 

Specify IP address of DPM Server(Management Server) or DNS name. 
Specification is not required normally. 
This option helps to maintain the compatibility with old version (earlier than 
DPM Ver6.0). 

shutdown Specify this when you shut down the managed machine. 
Required 

/S Specify this to communicate by HTTPS.  
When you omit this option, the communication is done by HTTP. 

/P Web Port Specify http/https port(1-65535) which is used by DPM Server(IIS). 
When you omit this option, the following port is used. 
・ When /S is specified: 443 
・ When /S is not specified: 80 
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Managed 
Machine 

Specify either of machine name, identification name, or MAC address of the 
managed machine which is registered on DPM Server. 
Required. 
When you specify MAC address, enter it with "/M XX-XX-XX-XX-XX" format. 
When the identification name of one managed machine is the same as the 
machine name of another managed machine, the command is executed for the 
managed machine that the identification name is matched. 
When there are two or more machines with the same machine name, the 
command cannot be executed. 
In this case, specify identification name or MAC address. 

Password Specify the password of deployment_user which is registered on DPM Server. 
Required. 
Initial password is "dpmmgr". 

 

  The managed machine in the following statuses cannot be shut down. Re-execute 
shutdown on after executing the status clear by seeing Section 8.1.9, "Status 
Clear." 
・ Scenario Execution Stop 
・ Scenario Execution Error 
・ Remote Power ON Error 

In the case of "Scenario Executing", wait until the scenario completes and then 
execute shutdown. 

 On the Web Console, the power status of managed machines which is managed 
by DianaScope is on at the timing the machine is powered on. 
However, if a shutdown command is executed in the time after the machine is 
powered on and before OS is started up and DPM Client is started, an error 
occurs and the shutdown fails. 
Check that the managed machine's OS is running before executing this command. 

 
Example)  

  

8.1.5. Assign Scenario/Remove Scenario Assignment 
Assigns a scenario for the managed machine or removes the scenario assignment.  
 
 Syntax 

The following command is described in two or more lines. Enter it by one line in the actual screen. 
 
・ When you assign a scenario: 

dpmcmd.exe DPM Server [Management Server] assign [/S] [/P Web Port] /A Managed Machine  
Password Scenario Name 
 

・ When you remove the scenario assignment: 
dpmcmd.exe DPM Server [Management Server] assign [/S] [/P Web Port] /U Managed Machine 
Password 

 
 Option  

 
Option  Explanation  
DPM Server Specify IP address of DPM Server or DNS name. 

Required  
Management  
Server 

Specify IP address of DPM Server(Management Server) or DNS name. 
Specification is not required normally. 
This option helps to maintain the compatibility with old version (earlier 
than DPM Ver6.0). 
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assign Specify this when you assign a scenario or remove the scenario 
assignment.  
Required. 

/S Specify this to communicate by HTTPS.  
When you omit this option, the communication is done by HTTP. 

/P Web Port Specify http/https port(1-65535) which is used by DPM Server(IIS). 
When you omit this option, the following port is used. 
・ When /S is specified: 443 
・ When /S is not specified: 80 

/A Required when you assign a scenario. 

/U Required when you remove the scenario assignment. 

Managed 
Machine 

Specify either of machine name, identification name, or MAC address of 
the managed machine which is registered on DPM Server. 
Required. 
When you specify MAC address, enter it with "/M XX-XX-XX-XX-XX" 
format. 
When the identification name of one managed machine is the same as 
the machine name of another managed machine, the command is 
executed for the managed machine that the identification name is 
matched. 
When there are two or more machines with the same machine name, the 
command cannot be executed. 
In this case, specify identification name or MAC address. 

Password 
 

Specify the password of deployment_user which is registered on DPM 
Server. 
Required. 
Initial password is "dpmmgr". 

Scenario Name Required when you assign a scenario. 
Specify the name of the scenario which is registered on DPM Server. 

 
 For managed machines in the following statuses, you cannot assign a scenario 

or you remove the scenario assignment. Re-execute this command after 
executing the status clear by seeing Section 8.1.9, "Status Clear." 
・ Scenario Execution Stop 
・ Scenario Execution Error 
・ Executing Remote Update 
・ Remote Power ON Error 

In the case of "Scenario Executing", wait until the scenario completes and then 
execute this command. 

 
Example)  
・ When you assign a scenario: 

 
・ When you remove the scenario assignment: 
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8.1.6. Execute Scenario 
Execute a scenario which is assign to the managed machine.  
 
 Syntax 

The following command is described in two or more lines. Enter it by one line in the actual screen. 
 
dpmcmd.exe DPM Server [Management Server] snrexec [/S] [/P Web Port] [/W Wait Time]  
Managed Machine Password 

 
 Option  

 
Option  Explanation  
DPM Server Specify IP address of DPM Server or DNS name. 

Required  
Management  
Server 

Specify IP address of DPM Server(Management Server) or DNS name. 
Specification is not required normally. 
This option helps to maintain the compatibility with old version (earlier than 
DPM Ver6.0). 

snrexec Specify this when you execute a scenario.  
Required. 

/S Specify this to communicate by HTTPS.  
When you omit this option, the communication is done by HTTP. 

/P Web Port Specify http/https port(1-65535) which is used by DPM Server(IIS). 
When you omit this option, the following port is used. 
・ When /S is specified: 443 
・ When /S is not specified: 80 

/W Wait Time Specify this when you wait for the scenario to be finished. 
When the scenario was completed or the scenario execution error 
occurred in the specified time or when the specified time passed, the 
command is ended. 
Specify from "0" to "360" minutes. 
When you specify "0", the command waits for the scenario to be finished. 
When you omit this option, the command is ended promptly without 
waiting for the scenario to be finished. 

Managed 
Machine 

Specify either of machine name, identification name, or MAC address of 
the managed machine which is registered on DPM Server. 
Required. 
When you specify MAC address, enter it with "/M XX-XX-XX-XX-XX" 
format. 
When the identification name of one managed machine is the same as the 
machine name of another managed machine, the command is executed 
for the managed machine that the identification name is matched. 
When there are two or more machines with the same machine name, the 
command cannot be executed. 
In this case, specify identification name or MAC address. 

Password 
 

Specify the password of deployment_user which is registered on DPM 
Server. 
Required. 
Initial password is "dpmmgr". 
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 For managed machines in the following statuses, you cannot execute a scenario. 

Re-execute this command after executing the status clear by seeing Section 
8.1.9, 
"Status Clear." 
・ Scenario Execution Stop 
・ Scenario Execution Error 
・ Remote Power ON Error 

In the case of "Scenario Executing", wait until the scenario completes and then 
execute this command. 
 
In the case of file distributing or file deletion, wait until file distribution or file 
deletion is completed and then execute this command. 

 
Example)  

 
 

8.1.7. Interrupt Scenario Execution 
Stops the scenario which is running on the managed machine.  
 
 Syntax 

The following command is described in two or more lines. Enter it by one line in the actual screen. 
 
dpmcmd.exe DPM Server [Management Server] snrstop [/S] [/P Web Port] Managed Machine  
Password 
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 Option  

 
Option  Explanation  
DPM Server Specify IP address of DPM Server or DNS name. 

Required  
Management  
Server 

Specify IP address of DPM Server(Management Server) or DNS name. 
Specification is not required normally. 
This option helps to maintain the compatibility with old version (earlier than 
DPM Ver6.0). 

snrstop Specify this when you stop the scenario execution.  
Required. 

/S Specify this to communicate by HTTPS.  
When you omit this option, the communication is done by HTTP. 

/P Web Port Specify http/https port(1-65535) which is used by DPM Server(IIS). 
When you omit this option, the following port is used. 
・ When /S is specified: 443 
・ When /S is not specified: 80 

Managed 
Machine 

Specify either of machine name, identification name, or MAC address of 
the managed machine which is registered on DPM Server. 
Required. 
When you specify MAC address, enter it with "/M XX-XX-XX-XX-XX" 
format. 
When the identification name of one managed machine is the same as the 
machine name of another managed machine, the command is executed 
for the managed machine that the identification name is matched. 
When there are two or more machines with the same machine name, the 
command cannot be executed. 
In this case, specify identification name or MAC address. 

Password 
 

Specify the password of deployment_user which is registered on DPM 
Server. 
Required. 
Initial password is "dpmmgr". 

 
  The managed machine, for which you stopped the scenario execution, is 

powered off at the timing of PXE boot after running scenario is stopped. 
 When a scenario is executed on the managed machine over Machines For 

Simultaneous Execution, the processing of the scenario execution stop 
may be executed after the processing of the execution is started on the 
machine, depending on the timing. 

 
 For managed machines in the following statuses, you cannot stop the scenario 

execution. 
・ Scenario Execution Stop 
・ Scenario Execution Error 
・ Remote Power ON Error 

 
Example)  
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8.1.8. Display Scenario Execution Status 
Displays the scenario execution status. 
 
 Syntax 

dpmcmd.exe DPM Server [Management Server] progress [/S] [/P Web Port] 
 

 Option  
 

Option  Explanation  
DPM Server Specify IP address of DPM Server or DNS name. 

Required  
Management  
Server 

Specify IP address of DPM Server(Management Server) or DNS name. 
Specification is not required normally. 
This option helps to maintain the compatibility with old version (earlier than 
DPM Ver6.0). 

progress Specify this when you display the scenario execution status.  
Required. 

/S Specify this to communicate by HTTPS.  
When you omit this option, the communication is done by HTTP. 

/P Web Port Specify http/https port(1-65535) which is used by DPM Server(IIS). 
When you omit this option, the following port is used. 
・ When /S is specified: 443 
・ When /S is not specified: 80 

Example) 

 

8.1.9. Status Clear 
Clears the status of the managed machine when the status is either of the following. 

・ Scenario Execution Stop  
・ Scenario Execution Error 
・ Remote Power ON Error 

 
 Syntax 

dpmcmd.exe DPM Server [Management Server] stsclear [/S] [/P Web Port] Managed Machine 
 

 Option  
 

Option  Explanation  
DPM Server Specify IP address of DPM Server or DNS name. 

Required  
Management  
Server 

Specify IP address of DPM Server(Management Server) or DNS name. 
Specification is not required normally. 
This option helps to maintain the compatibility with old version (earlier than 
DPM Ver6.0). 

stsclear Specify this when you clear the status of the managed machine. 
Required. 

/S Specify this to communicate by HTTPS.  
When you omit this option, the communication is done by HTTP. 
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/P Web Port Specify http/https port(1-65535) which is used by DPM Server(IIS). 
When you omit this option, the following port is used. 
・ When /S is specified: 443 
・ When /S is not specified: 80 

Managed 
Machine 

Specify either of machine name, identification name, or MAC address of 
the managed machine which is registered on DPM Server. 
Required. 
When you specify MAC address, enter it with "/M XX-XX-XX-XX-XX" 
format. 
When the identification name of one managed machine is the same as the 
machine name of another managed machine, the command is executed 
for the managed machine that the identification name is matched. 
When there are two or more machines with the same machine name, the 
command cannot be executed. 
In this case, specify identification name or MAC address. 

 
Example)  

 
 
 

8.1.10. Register Managed Machine 
Registers a managed machine on DPM Server.  
 
 Syntax 

The following command is described in two or more lines. Enter it by one line in the actual screen. 
 
dpmcmd.exe DPM Server [Management Server] cliadd [/S] [/P Web Port] /M MAC Address  
[/NAME Machine Name] [/I Identification Name] [/IP IP Address] [/D Deploy-OS ID]  
[/DNAME Deploy-OS Display Name] /G Path of Machine Group [/F] [/GW Default Gateway]  
[/MASK Subnet Mask] [/ASSIGN Scenario Name] Password 
 

 Option  
 

Option  Explanation  
DPM Server Specify IP address of DPM Server or DNS name. 

Required  
Management  
Server 

Specify IP address of DPM Server(Management Server) or DNS name. 
Specification is not required normally. 
This option helps to maintain the compatibility with old version (earlier 
than DPM Ver6.0). 

cliadd Specify this when you register a managed machine on DPM Server. 
Required. 

/S Specify this to communicate by HTTPS.  
When you omit this option, the communication is done by HTTP. 

/P Web Port Specify http/https port(1-65535) which is used by DPM Server(IIS). 
When you omit this option, the following port is used. 
・ When /S is specified: 443 
・ When /S is not specified: 80 

/M MAC Address Specify MAC address of the manage machine which is registered on 
DPM Server. 
Required. 
Hexadecimal number(0-9/a-f/A-F) can be entered. 
Enter it with "/M XX-XX-XX-XX-XX" format. 
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/NAME Machine 
Name 

Specify the machine name of the manage machine which is registered 
on DPM Server. 
63 characters or less can be entered. Alphanumeric characters and 
symbols can be entered. The following symbols and space cannot be 
entered. 
. , ; ` ~ ! @ # $ ^ & * = + { } % \ | : ' " < > / ? [ ] 
Also, you cannot register a machine name with only numbers. 
When OS is already installed on registered machine, specify the same 
name as the machine. 
When DPM Client is installed, the name is changed to the real machine 
name at the timing that the machine is powered on, even if the machine 
name, which was specified at this option, and real machine name were 
different. 

/I Identification 
Name 

Specify the identification name of the manage machine which is 
registered on DPM Server. 
63 characters or less can be entered. Alphanumeric characters and 
symbols can be entered. The following symbols and space cannot be 
entered. 
. , ; ` ~ ! @ # $ ^ & * = + { } % \ | : ' " < > / ? [ ] 
Also, you cannot register a identification name with only numbers. 
You cannot specify the same identification name under one DPM 
Server. When you specify the identification name which is already 
registered, an error occurs. 

/IP IP Address Specify IP address of the managed machine which is registered on DPM 
Server. 
Numbers can be entered. Enter it with "/IP XXX.XXX.XXX.XXX" 
format. 
You cannot specify the same IP address under one DPM Server. When 
you specify IP address which is already registered, an error occurs. 
When there are two or more IP addresses on the managed machine, 
specify IP address which communicates with DPM Server. 
When you do not install DPM Client on the managed machine, you 
need to specify IP address. 

/D Deploy-OS ID Specify the kernel ID of Deploy-OS which is used by the managed 
machine when backup, restore, or disk configuration check is executed. 
256 characters or less can be entered. Alphanumeric characters and 
symbols can be entered. 
When you specify this option, specify this with "/DNAME Deploy-OS 
Display Name". 

/DNAME 
Deploy-OS 
Display Name 

Specify the displayed name of Deploy-OS kernel of which is used by the 
managed machine when backup, restore, or disk configuration check is 
executed. 
256 characters or less can be entered. Alphanumeric characters and 
symbols can be entered. 
When you specify this option, specify this with "/D Deploy-OS ID". 
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/G Path of 
Machine Group 

Specify the full path of the machine group to which the managed 
machine is registered. 
Required. 
The number of the layer of the group path is 20 or less. 
Specify "/"(slash) to separate the layer of the machine group. 
64 characters or less can be entered as a group name for each layer. 
Alphanumeric characters and symbols can be entered. The following 
symbol cannot be entered. 
; 
When there is not a group corresponding to the specified path, a 
machine group is created automatically. 
In DPM Ver6.02 or later, the way to specify the group is changed from 
the name of the machine group to which the machine is registered, to 
the path name of the group to which the machine is registered. 
Therefore, when you use a script file for DPM Command Line which 
was created in earlier than DPM Ver6.02, modify the file as the path 
name of the group is described. When you specify only the group name, 
the specification is recognized as the group directly under root. If the 
group is not found, a group is created under root. 
Also, when you specify a machine group including "(double quotation), 
describe "" and enclose the item with ". 

Example) 
When the group name is /grou"p/, enter it as "/grou""p/". 

/F Specify this when you set the gateway and the subnet mask of the 
machine group, which is created automatically.  
The configuration of the group, which is already created, is not 
changed. 
When you do not specify this, the setting, that the group is in the same 
network as DPM Server, is done for created group. 
Specify this with "/GW Default Gateway" and "/MASK Subnet Mask".  
When you specify only this option and omit "/GW Default Gateway" 
and "/MASK Subnet Mask", the configuration of the gateway and the 
netmask for created group is inherited from the parent group. When you 
specify the group directly under the root, the setting, that the group is in 
the same network as DPM Server, is done. 

/GW  
Default Gateway 

Specify this when you set the default gateway of the machine group 
which is created automatically.. 
When /F is not specified, you do not need to specify this. 

When the network setting of the group and DPM Server have the same 
subnet mask, you do not need to specify this. 

/MASK  
Subnet Mask 

Specify this when you set the subnet mask of the machine group which 
is created automatically.. 
When /F is not specified, you do not need to specify this. 
When the network setting of the group and DPM Server have the same 
subnet mask, you do not need to specify this. 

/ASSIGN 
Scenario Name 

Specify the name of the scenario when you assign a scenario to the 
managed machine. 

Password 
 

Specify the password of deployment_user which is registered on DPM 
Server. 
Required. 
Initial password is "dpmmgr". 

 
Example)  

The following command is described in two or more lines. Enter it by one line in the actual screen. 

 



 

438 

 

8.1.11. Delete Managed Machine 
Deletes a managed machine on DPM Server.  
 
 Syntax 

The following command is described in two or more lines. Enter it by one line in the actual screen. 
 
dpmcmd.exe DPM Server [Management Server] cliremove [/S] [/P Web Port] Managed Machine 
Password 
 

 Option  
 

Option  Explanation  
DPM Server Specify IP address of DPM Server or DNS name. 

Required  
Management  
Server 

Specify IP address of DPM Server(Management Server) or DNS name. 
Specification is not required normally. 
This option helps to maintain the compatibility with old version (earlier 
than DPM Ver6.0). 

cliremove Specify this when you delete a managed machine on DPM Server. 
Required. 

/S Specify this to communicate by HTTPS.  
When you omit this option, the communication is done by HTTP. 

/P Web Port Specify http/https port(1-65535) which is used by DPM Server(IIS). 
When you omit this option, the following port is used. 
・ When /S is specified: 443 
・ When /S is not specified: 80 

Managed 
Machine 

Specify either of machine name, identification name, or MAC address of 
the managed machine which is registered on DPM Server. 
Required. 
When you specify MAC address, enter it with "/M XX-XX-XX-XX-XX" 
format. 
When the identification name of one managed machine is the same as 
the machine name of another managed machine, the command is 
executed for the managed machine that the identification name is 
matched. 
When there are two or more machines with the same machine name, 
the command cannot be executed. 
In this case, specify identification name or MAC address. 

Password 
 

Specify the password of deployment_user which is registered on DPM 
Server. 
Required. 
Initial password is "dpmmgr". 
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 If the Status column of the managed machine is either of the following status, the 

machine cannot be deleted.  
・ Scenario Executing 
・ Scenario Execution Stop 
・ Scenario Execution Error 
・ Remote Power ON Error 
・ Automatic Update Progress 
・ Transferring Files(Automatic Update) 
・ Setting Automatic Update Time 

Also, if the following functions are being executed for the managed machine, the 
machine cannot be deleted. These statuses are not displayed in the Status 
column. 

•File distribution 
•File deletion 
•Obtaining the information in File/Folder List screen 

 
Example)  

 
 

8.1.12. Display License Information 
Displays the list of licenses which are registered on DPM Server. 
The following information is displayed in the list. 
・  Total Number of Licenses(Total number of licenses which are registered on DPM Server) 
・  Number of Used Licenses(The number of used licenses) 
・  Number of Remained Licenses(The number of unused licenses) 
・ Registered license list(License Key, License Num, andRegistration Day) 

In the case of SSC product, the license information is not displayed because DPM license is included in the SSC 
product. 
 
 Syntax 

dpmcmd.exe DPM Server liclist [/S] [/P Web Port] Password 
 

 Option  
 

Option  Explanation  
DPM Server Specify IP address of DPM Server or DNS name. 

Required  
liclist Specify this when you display the list of licenses which are registered on 

DPM Server. 
Required. 

/S Specify this to communicate by HTTPS.  
When you omit this option, the communication is done by HTTP. 

/P Web Port Specify http/https port(1-65535) which is used by DPM Server(IIS). 
When you omit this option, the following port is used. 
・ When /S is specified: 443 
・ When /S is not specified: 80 

Password 
 

Specify the password of deployment_user which is registered on DPM 
Server. 
Required. 
Initial password is "dpmmgr". 
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Example)  

 

8.1.13. Help 
Displays the help of DPM Command Line. 
 
 Syntax 

・ When you display the help of DPM Command Line(the command list and the option list). 
dpmcmd.exe ? 

 
・ When you display the help of each command. 

dpmcmd.exe DPM Server [Management Server] Command ? 
 

 Option  
 

Option  Explanation  
DPM Server Specify IP address of DPM Server or DNS name. 

Required  
Management  
Server 

Specify IP address of DPM Server(Management Server) or DNS 
name. 
Specification is not required normally. 
This option helps to maintain the compatibility with old version (earlier 
than DPM Ver6.0). 

Command Required when you display the detailed help of each command. 
? Specify "?", "/?", or "/help". 

Required when you display the help. 
 
Example)  
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9. Maintenance 
This chapter explains the information about the maintenance of DPM. 
 

9.1. Procedure to Change the IP Address of the 
Management Server 

Explains the procedure to change the IP address of the Management Server on which DPM Server is installed 
while you operate DPM. 
 

 If procedures are not followed, DPM Server cannot work properly. 
When changing the IP address and network configuration at the same time, see 
Section 3.5.1, "Edit Machine Group" and modify also the Network Setting of each 
group. 

 
 If ANY is selected in IP Address of Management View -> DPM Server icon -> Detail Setting screen -> 

General tab on the Web Console. 
 

(1) Log on to the Management Server by a user with administrator authority. 
 

(2) Check that all operations of DPM (the following) are completed or ended. 
・ Operations for managed machines(scenario execution, automatic update, file distribution, file deletion 

and obtaining the information in File/Folder List screen) are completed. 
・ Web Console and various tools of DPM are ended. 
  

(3) Change IP address of the Management Server. 
 

(4) Restart the Management Server. 
 

(5) Restart managed machines. 
 
 If IP address except ANY is selected  

 
(1) Log on to the Management Server by a user with administrator authority. 

 
(2) Check that all operations of DPM (the following) are completed or ended. 

・ Operations for managed machines(scenario execution, automatic update, file distribution, file deletion 
and obtaining the information in File/Folder List screen) are completed. 

・ Web Console and various tools of DPM are ended. 
 

(3) Insert the installation media in the DVD drive of the Management Server.  
 

(4) Execute the following file. 
<Installation media>:\DPM\TOOLS\IP\<Machine architecture>\RegSet1.reg 

 
* The name of <Machine architecture> folder is as the following. 
・ In the case of x86: IA32 
・ In the case of x64: AMD64 
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Example)  
<Installation media>:\DPM\TOOLS\IP\IA32\RegSet1.reg 

 
(5) The following screen appears. Click Yes. 

 

 
 

(6) The following screen appears. Click OK. 
 

 
 

(7) Change IP address of the Management Server. 
 

(8) Restart the Management Server. 
 
(9) Select the IP address to be used by the Management Server from Management View -> DPM Server 

icon -> Detail Setting screen -> General tab -> IP Address on the Web Console and click OK. 
 

(10) Execute the following file in the installation media. 
<Installation media>:\DPM\TOOLS\IP\<Machine architecture>\RegSet2.reg 

 
* The name of <Machine architecture> folder is as the following. 
・ In the case of x86: IA32 
・ In the case of x64: AMD64 
Example)  

<Installation media>:\DPM\TOOLS\IP\IA32\RegSet2.reg 
 

 When you configure the cooperation of TFTP service between DPM Server and 
MasterScope Network Manager, execute the following RegTFTP1.reg. About the 
screen image in the following procedure, replace the description. 

<Installation media>:\DPM\TOOLS\TFTP\<Machine 
architecture>\RegTFTP1.reg 

 
* The name of <Machine architecture> folder is as the following. 

In the case of x86: IA32 
In the case of x64: AMD64 
Example)  
<Installation media>:\DPM\TOOLS\TFTP\IA32\RegTFTP1.reg 
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(11) The following screen appears. Click Yes. 

 

 
 

(12) The following screen appears. Click OK. 
 

 
 

(13) Restart managed machines. 
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9.2. Procedure to Change the IP Address of the 
Database Server 

Explains the procedure to change the IP address of the Database Server while you operate DPM. 
 

(1) Log on to the Management Server by a user with administrator authority. 
 

(2) Check that all operations of DPM (the following) are completed or ended. 
・ Operations for managed machines(scenario execution, automatic update, file distribution, file deletion 

and obtaining the information in File/Folder List screen) are completed. 
・ Web Console and various tools of DPM are ended. 

 
(3) Stop all services whose names begin with "DeploymentManager" from Start menu -> Management 

Tools -> Services on the Management Server.  
 

(4) Change the IP address on the Database Server. 
 

(5) Select Run from Start menu on the Management Server. Enter "regedit" in the name of the program to 
execute and click OK. 
 

(6) Registry editor is launched. Change the value in the Name of the following registry to the changed IP 
address of the Database Server . 

・ Key: 
- When OS is x86 

HKEY_LOCAL_MACHINE\SOFTWARE\NEC\DeploymentManager 
- When OS is x64 

HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\NEC\DeploymentManager 
・ Name: DBSrvIPAddress 

 
(7) Start ODBC Data Source Administrator screen following the procedure below. 

- When OS is x86 
From Start menu, select Management Tools -> Data Source(ODBC). 

- When OS is x64 
1) From Start menu, select Run. Enter "%WINDIR%\SysWOW64\cmd.exe" and click OK. 
2) The command prompt appears. Execute the following command. 

%WINDIR%\SysWOW64\odbcad32.exe
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(8) ODBC Data Source Administrator screen appears. After selecting System DNS tab, select DPM from 

the list of System Data Source and click Configure.  
 

 
 
(9) The following screen appears. Select the Database Server in Server of Which SQL Server do you 

want to connect to? and change it to IP address.Port of the Database Server after 
changing\Instance name and click Finish.  
 

 
 

(10) Start all services which were stopped in Step (3) on the Management Server.  
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9.3. Procedure to Change the IP Address of the 
Managed Machine 

If a managed machine's IP address is changed, the Management Server is notified automatically. It is not 
necessary to do further action. 
However, when changing Management Server's IP address and managed machine's IP address at the same 
time, the Management Server is not notified automatically. In this case, see "Upgrading DPM Client by 
installation media" in Section 3.3.2, "Manually Upgrading DPM Client" in Installation Guide to reconfigure the 
Management Server's IP address in DPM Client. 
Also, when DPM Client is not installed in the managed machine, the Management Server is not notified. In this 
case, see Section 3.7.2, "Edit Managed Machine" to reconfigure IP address information of the managed 
machine. 
It is recommended that you execute the backup scenario after changing IP address of the managed machine. If 
you restore the backup image before changing the IP address, the content of the disk is return to the original 
when executing the backup and IP address will be one before changing it. 
 

9.4. Data Backup Plan 
9.4.1. Procedure to Backup the Data 
Explains the procedure to backup the data while you operate DPM. 
 
(1) Log on to the Management Server by a user with administrator authority. 

When you configure the database on the same machine with DPM Server, log on by the user who installed 
DPM Server. 

 
(2) When you changed detailed settings of DPM Server after installing DPM Server, select Management view 

-> DPM Server icon -> Detailed Setting on the Web Console and note the setting values. 
 

(3) Check that all operations of DPM (the following) are completed or ended. 
・ Operations for managed machines(scenario execution, automatic update, file distribution, file deletion and 

obtaining the information in File/Folder List screen) are completed. 
・ Web Console and various tools of DPM are ended. 

 
(4) From Start menu, select Administrative Tools -> Services and stop all services whose names begin with 

"DeploymentManager". 
 

(5) Backup the data. 
Backup the following data. 
・ All files under <DPM Server installation folder>\Datafile 
・ All files under <DPM Server installation folder>\Linux 
・ All files under <DPM Server installation folder>\Log  
・ <DPM Server installation folder>\WebServer\App_Data\Data 

- Encypted.dat 
- DpmProfile.xml 

 
 The default installation folder of DPM Server is: 

"C:\Program Files\NEC\DeploymentManager". 
 

・ All files under Folder for Image 
 

 Select Management view -> DPM Server -> Detail Setting -> General tab on the Web 
Console and check Folder for Image of Image Setting. The default of Folder for 
Image is "C:\Deploy". 
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・ All files under Folder for Backup Image 
 

 Select Management view -> DPM Server -> Detail Setting -> General tab on the Web 
Console and check Folder for Backup Image of Image Setting. The default of Folder 
for Backup Image is "C:\DeployBackup". 

 
・ The following folders and files under TFTP root folder 

- backup 
- DOSFD 
- EFI64 
- EFIBC 
- EFIIA32 
- gpxelinux 
- HW 
- HW64 
- hwinfo 
- kernel 
- NBP 
- probe 
- pxelinux 
- pxelinux.cfg 
- uefipxelinux 
- nbprestvar.ini 
- Port.ini 

 
 When you configure the cooperation of TFTP service between DPM Server and 

MasterScope Network Manager, seeing Appendix F, "Configuring DPM Server and 
MasterScope Network Manager on the Same Machine" in Installation Guide, TFTP 
root folder is <TFTP root folder of MasterScope Network Manager>. 

 
 The default of TFTP root folder is  

"C:\Program Files\NEC\DeploymentManager\PXE\Images". 
 

・ Others 
Files or registries when you changed them manually 

 
(6) Backup the database. 

Enter the following backup command on the command prompt, and then extract the backup file 
(DPM.bak). 
When you configure the Database Server, log on by the user who configured the database on the 
Database Server and execute the following. 
 
sqlcmd.exe -E -S localhost\Instance name 
BACKUP DATABASE DPM 
TO DISK='DPM.bak' 
WITH INIT 
GO 

 
Example) 

sqlcmd.exe -E -S localhost\DPMDBI 
BACKUP DATABASE DPM 
TO DISK='DPM.bak' 
WITH INIT 
GO 
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  The database name is "DPM".(Fixed)  

 A backup file (DPM.bak) is created in the following folder: 
<Microsoft SQL Server installation folder>\Backup 
The default of <Microsoft SQL Server installation folder> is 
C:\Program Files\Microsoft SQL Server\MSSQL11.Instance name\MSSQL 

 
(7) Backup the registry data. 
・ DPM Server 

By executing the following command on the command prompt, extract the backup file 
(RegExportDPM.reg). 
(The following command is described in two or more lines. Enter it by one line in the actual screen.) 
 
- When OS is x86 
regedit /e RegExportDPM.reg 
"HKEY_LOCAL_MACHINE\SOFTWARE\NEC\DeploymentManager" 

- When OS is x64 
regedit/eRegExportDPM.reg"HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\NEC\ 
DeploymentManager" 

 
・ Database 

By executing the following command on the command prompt, extract the backup file 
(RegExportDPMDB.reg). 
When you configure the Database Server, log on by the user who configured the database on the 
Database Server and execute the following. 
(The following command is described in two or more lines. Enter it by one line in the actual screen.) 

 
- When OS is x86 
regedit /e RegExportDPMDB.reg "HKEY_LOCAL_MACHINE\SOFTWARE\NEC 
\DeploymentManager_DB" 

- When OS is x64 
regedit/eRegExportDPMDB.reg"HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\NEC\Dep
loymentManager_DB" 

 
 Backup files(RegExportDPM.reg and RegExportDPMDB.reg) will be created in the 

folder where the command is executed. 
 

(8) Start all services that were stopped in Step (4). 
 

The backup of data updated while you operate DPM is completed. 
 

9.4.2. Procedure to Recover the Data 
Recover the DPM environment by the data which were backed up in Section 9.4.1, "Procedure to Backup the 
Data", following the procedure below. 
 
(1) Log on to the Management Server by a user with administrator authority. 

When you only recover the data (DPM Server is already installed) and configure the database on the same 
machine with DPM Server, log on by the user who installed DPM Server. 
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 When you configure the database on the same machine with DPM Server, it is 
recommended that you log on by Administrator and install DPM Server. When you 
installed DPM Server by a user with administrator authority except Administrator, you 
need to launch Image Builder, which is installed on the same machine with DPM 
Server, as an administrator. 

 
(2) Install DPM Server and configure the detailed setting. 

・ When you install DPM Server and recover 
Install DPM server(and configure the detailed setting), following the description below. 
- Installation Guide 
- Setting values that you noted when you installed DPM Server 

If there are setting values that you noted in Step (2) of Section 9.4.1, "Procedure to Backup the Data" 
about the setting in Detailed Setting screen displayed when installing DPM Server, enter the values. 

・ When you only recover the data (DPM Server is already installed.) 
Configure the setting values that you noted in Step (2) of Section 9.4.1, "Procedure to Backup the Data", 
in Management view -> DPM Server icon -> Detailed Setting on the Web Console. 
If you have not changed the detailed setting after installing DPM Server, configure the setting that you 
noted when installing DPM Server. 

 
(3) From Start menu, select Administrative Tools -> Services and stop all services whose names begin with 

"DeploymentManager". 
 
(4) Overwrite the same folder or file path as when you backed up by the backup data that were collected in Step 

(5) of Section 9.4.1, "Procedure to Backup the Data". 
Also, configure the noted setting when there are the setting that you noted in Step (5) "Others" of Section 
9.4.1, "Procedure to Backup the Data." 

 
(5) Overwrite by the backup file of the database that had been collected in Step (6) of Section 9.4.1, "Procedure 

to Backup the Data", in the same folder path as when you backed up. 
When you configure the Database Server, log on by the user who configured the database on the Database 
Server and execute it. 
 

(6) Confirm the configuration of the database.  
When you configure the Database Server, log on by the user who configured the database on the Database 
Server and execute the following. 
1) From Explorer and so on, display the property of DPM.bak and confirm whether there is a user whose 

name begins with "MSSQL$Instance name" on Security tab. 
2) Click Detailed Setting tab, and if there is a user whose name begins with "MSSQL$Instance name" in 

1), confirm whether the Include inheritable permissions from this object's parent checkbox is 
selected. 
If there is not a user whose name begins with "MSSQL$Instance name" in 1), select the Include 
inheritable permissions from this object's parent checkbox. (If this checkbox is selected, a user 
whose name begins with " MSSQL$Instance name" will be added to the Security tab.) 

 
(7) Start the command prompt, and then execute the following command. 

When you configure the Database Server, log on by the user who configured the database on the Database 
Server and execute the following. 
 
sqlcmd.exe -E -S localhost\Instance name 
RESTORE DATABASE DPM 
FROM DISK = 'DPM.bak' 
WITH REPLACE 
GO 
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Example) 
sqlcmd.exe -E -S localhost\DPMDBI 
RESTORE DATABASE DPM 
FROM DISK = 'DPM.bak' 
WITH REPLACE 
GO 

 
(8) Apply the backup file of the registry data extracted in Step (7) of Section 9.4.1, "Procedure to Backup the 

Data" on the machine that you backed up. (Double-click from Explorer.) 
 

(9) Start all services that were stopped in Step (3). 
 

(10) Start the command prompt and execute the following command. 
iisreset /restart 

 
Recovering DPM data is completed. 
 

9.5. Procedure to Change the Port Used by DPM 
The section explains the procedure to change the port used by DPM. 
 

  If you do not follow the procedure, the Management Server and managed machines 
do not work properly. 

 When you change the port used by ftsvc.exe (TCP:26508) following this procedure, 
specify the same port in the Setting Connection screen of Image Builder (Remote 
Console). 

 When you install DPM Server of this version newly, DPM Client of the version earlier 
than DPM Ver6.1 cannot be upgraded automatically. 
Execute the either of the following. 
・ Before you install DPM Server newly, set the port, which was used before 

upgrading, in Port.ini following the procedure in this section. 
・ After you installed DPM Server newly, upgrade DPM Client by a scenario, seeing 

Section 3.3.2, "Manually Upgrading DPM Client" in Installation Guide. (It takes 
about 20 minutes until the scenario is completed.) 

 The master image for OS installation by disk duplication, created in the version earlier 
than DPM Ver6.1, cannot be used in the environment that DPM Server of this version 
is installed newly. Re-create a master image in this version, or set the port, which was 
used before upgrading, in Port.ini following the procedure in this section, before you 
install DPM Server newly. 

 
 The default values of the ports to be used differ in the version earlier than DPM Ver6.1. 

For details of the port number, see Appendix D, "Network Port and Protocol List." 
 
 The procedure to change the port before installing DPM Server newly. 
 
(1) Log on to the Management Server by a user with administrator authority. 

 
(2) Copy the following file to %SystemDrive%( Default C:)\DPMPort\. 

<Installation media>:\DPM\Setup\DPM\Port.ini 
 

(3) Specify the port to use in the copied file and save the file. 
 

(4) Install DPM Server newly. 
 

 When you upgrade DPM Server, the ports, which were used before upgrading, are taken 
over. 
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 The procedure to change the port after installing DPM Server. 

Execute the following procedure in the Management Server. 
 
(1) Log on to the Management Server by a user with administrator authority. 

 
(2) Check that all following DPM operations are completed. 

・ Operations which is being executed for managed machine(scenario execution, automatic update, file 
distribution, file deletion, and obtaining the information in File/Folder List screen) are completed. 

・ Web Console and each tool of DPM are ended. 
 
(3) Edit <TFTP root folder>\Port.ini. 
 

  The default of TFTP root folder is  
"C:\Program Files\NEC\DeploymentManager\PXE\Images". 

 When you change the port for Web Service (Default:26500), modify the following line 
in <TFTP root folder>\WebServer\App_Data\Config\MgrServerList.xml. 

 
<Port>The port to change</Port> 

 
(4) Restart the Management Server. 

 
(5) Restart managed machines. 
 

10. Precautions 
This chapter explains precautions about DPM. 
 

10.1. Notes for Device and Storage 
10.1.1. The Module for the Machine Model 
The module for the machine model is an update module that enables the machine model, not supported by 
Deploy-OS bundled with the product, to be used as managed machines. 
For notes about the module for the machine model, contact your sales or support representative. 
 

10.2. Notes when You Change the Computer Name 
(the Host Name) of the Management Server and 
the Managed Machine 
 

You can change the computer name (the host name) on the OS of the Management Server and the managed 
machine at any timing. 
When you use the host name in the URL on the Web Console, change it to match with the computer name of the 
Management Server,  
When you changed the computer name (the host name) of the managed machine, if you restore the backup 
image before changing the computer name (the host name), the content of the disk is returned to the original 
status when executing the backup and the computer name (the host name) will be one before changing it. It is 
recommended that you execute the backup after changing the name. 
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10.3. Notes when You Change the User Name/the 
Password on the OS of the Management Server 
and the Managed Machine 

When you change the user name/the password on the OS of the Management Server and the managed machine, 
it does not affect the operation later. 
However, if you restore the backup image before changing the user name/the password on the OS of the 
managed machine, the content of the disk is returned to the original status when executing the backup and the 
user name/the password will be one before changing it. It is recommended that you execute the backup after 
changing the user name/the password. 
 

10.4. Notes for OS Clear Installation 
When you cannot set up NFS server, you can execute OS clear installation of Red Hat Enterprise Linux 6 by 
setting up FTP/HTTP server on the Management Server. 
This chapter explains notes about the case. Explains as the folder for image has the following configuration. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
・ Seeing Section 3.5.1, "Creating and Registering an Image" in Operation Guide, create and register an image. 

Replace as the following about Section 3.5.1.1, 'Setting up NFS Service". 
 

Seeing manuals of FTP/HTTP server and so on, set "exports" folder under Folder for Image set on the Web 
Console as the virtual directory of FTP/HTTP server after configuring FTP/HTTP server,  

  

Management Server(IP address:192.168.0.1) 

Folder for image 

AnsFile\ 
 

Boot parameter file 

exports\ 

ks\ 

Install parameter file 

Boot directory (Boot directory name: RHEL6) 

Install image 

Linux\ 

daemon\ 



 

453 

 
・ Perform the following before the procedure of Section 3.5.2, "Creating a Scenario." 

- Open the boot parameter file by text editor and so on and modify the description of the file 
server(underlined) following the environment, seeing the following example. 

 
Example) 

Before modification: 
append initrd= RHEL6/initrd.img ks=nfs:192.168.0.1:/exports/ks/ks.cfg ksdevice=eth0 

After modification: 
- In the case of FTP server 

append initrd= RHEL6/initrd.img ks=ftp://192.168.0.1/exports/ks/ks.cfg ksdevice=eth0 
- In the case of HTTP server 

append initrd= RHEL6/initrd.img ks=http://192.168.0.1/exports/ks/ks.cfg ksdevice=eth0 
- Open the installation parameter file by text editor and so on, modify the description of the file 

server(underlined) following the environment, seeing the following example. 
  

Example) 
Before modification: 

... 
nfs --server 192.168.0.1 --dir /exports/RHEL6 
.. 
#Mount /mnt/exports 
mkdir /mnt 
mkdir /mnt/exports 
/bin/mount -o nolock -t nfs $NFSSERVER:/exports /mnt/exports 
... 

After modification: 
- In the case of FTP server 

... 
url -url ftp://192.168.0.1/exports/RHEL6 
... 
#Mount /mnt/exports 
mkdir -p /mnt/exports/daemon/redhatall/ia32/ 
cd /mnt/exports/daemon/redhatall/ia32/ 
wget ftp://192.168.0.1/exports/daemon/redhatall/ia32/depagt 
wget ftp://192.168.0.1/exports/daemon/redhatall/ia32/depagtd 
wget ftp://192.168.0.1/exports/daemon/redhatall/ia32/depagtd.res 
wget ftp://192.168.0.1/exports/daemon/redhatall/ia32/depcancel 
wget ftp://192.168.0.1/exports/daemon/redhatall/ia32/depinst 
wget ftp://192.168.0.1/exports/daemon/redhatall/ia32/depinst.res 
wget ftp://192.168.0.1/exports/daemon/redhatall/ia32/depinst.sh 
wget ftp://192.168.0.1/exports/daemon/redhatall/ia32/dpmversion.inf 
wget ftp://192.168.0.1/exports/daemon/redhatall/ia32/GetBootServerIP 
wget ftp://192.168.0.1/exports/daemon/redhatall/ia32/getinfo.sh 
wget ftp://192.168.0.1/exports/daemon/redhatall/ia32/server.inf 
wget ftp://192.168.0.1/exports/daemon/redhatall/ia32/xdpmmsg 
... 

 
- In the case of HTTP server 

... 
url -url http://192.168.0.1/exports/RHEL6 
... 
#Mount /mnt/exports 
mkdir -p /mnt/exports/daemon/redhatall/ia32/ 
cd /mnt/exports/daemon/redhatall/ia32/ 
wget http://192.168.0.1/exports/daemon/redhatall/ia32/depagt 
wget http://192.168.0.1/exports/daemon/redhatall/ia32/depagtd 
wget http://192.168.0.1/exports/daemon/redhatall/ia32/depagtd.res 
wget http://192.168.0.1/exports/daemon/redhatall/ia32/depcancel 
wget http://192.168.0.1/exports/daemon/redhatall/ia32/depinst 
wget http://192.168.0.1/exports/daemon/redhatall/ia32/depinst.res 
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wget http://192.168.0.1/exports/daemon/redhatall/ia32/depinst.sh 
wget http://192.168.0.1/exports/daemon/redhatall/ia32/dpmversion.inf 
wget http://192.168.0.1/exports/daemon/redhatall/ia32/GetBootServerIP 
wget http://192.168.0.1/exports/daemon/redhatall/ia32/getinfo.sh 
wget http://192.168.0.1/exports/daemon/redhatall/ia32/server.inf 
wget http://192.168.0.1/exports/daemon/redhatall/ia32/xdpmmsg 
... 

- Mount ISO file for installation of Red Hat Enterprise Linux 6 and copy all the contents in ISO to the 
boot directory.  

 

11. Troubleshooting 
This chapter explains how to handle when the problem occurs on DPM. 
 

11.1. Web Console 
 
  

 

When you click Detail under HotFix/Application on the Machine Detail screen, the 
HotFix/Application List screen items are not displayed. 

To manage the managed machine in this version, DPM Client for this version must 
be installed on the managed machine. If it is already installed, reinstall. About the 
installation, see Section 2.2, "Installing DPM Client" in Installation Guide. 
From Start menu on the managed machine, select Administrative Tools -> 
Services, and confirm that DeploymentManager Agent Service and 
DeploymentManager Remote Update Service Client are running. 

  

 

The screen Socket error has occurred. is displayed when you update information. Or, the 
following message is displayed as detailed information: 
No connection could be made because the target machine actively refused 
it. Management Server IP address:26500 

The Management Server may be shut down. From Start menu, select 
Administrative Tools -> Services and confirm that all of the services listed in 
" DPM Server" in Appendix A, "Services List" in Reference Guide are running. 
If the service is stopped, start all of the services that are not running. Furthermore, 
try to reconnect to Management Server after services started. 

  

 

If you start the Web Console from the Web browser, error The Page cannot be displayed 
appears. 
One of the following is possible: 

The URL to start the Web Console may be incorrect. Confirm that the URL is 
correct. 
The Web Server may not be running. From Start menu, select Administrative 
Tools -> Internet Information Services (IIS) Manager, and confirm that Default 
Web Site is running. 
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If you access the Web Console from two or more windows or tabs(Only tabs in the case of 
Internet Explorer 7), the following occurs due to the session sharing function of Internet 
Explorer. 

・ The user authority of the Web Console will be the same with the authority of the user 
who logged last. 

・ An error occurs when you switch the page in window or tab that you opened first, or 
change the number of lines to be displayed. 

When you open two or more Web Consoles, separate sessions in the following 
procedure. 

・ In case of Internet Explorer 8/9/10/11(compatibility mode) 
Launch Internet Explorer as new session and open the Web Console. To launch 
Internet Explorer as new session, select File -> New Session in Internet Explorer 
which is already launched. 
 

・ In case of Internet Explorer 7 
Open the Web Console in another window. 

  

 

Start the Web Console on Windows Server 2003/Windows Server 2003 R2 and the 
following message is displayed each time the screen switches. 
 

 
 

Click OK. 
  

 

Something is wrong with the display of the error message. 
If you use an HTML tag (<xx>) for a computer name or group name etc., the entered 
text is interpreted as HTML syntax and may not be properly displayed in the error 
message. However, operations are not affected. 
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Even if you start the Web Console from the Web browser, nothing is displayed on the Web 
browser. 
The following is possible : 

・ From Tools menu -> Internet Options in Internet Explorer, select Trusted Sites 
on the Security tab. After clicking Sites, add a URL which connects to the 
Management Server. 

Example) If the Management Server IP address is 192.168.2.41 
 

 
 

  

 

If you start the Web Console on Windows Server 2003/Windows Server 2003 R2, the 
following message is displayed: 
 

 
Confirm that the URL is not wrong, and then click Add and add the Web site to the 
Trusted Sites zone. 
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You performed one of the following operations, but the File Download screen is not 
displayed, and you could not download CSV files. 
・ On the Monitor view -> Scenario Execution Result List -> Scenario Execution 

Result List 
screen, click Save In CSV in Operation menu. 

・ On the Monitor view -> Automatic Update Result List -> Automatic Update Result 
List screen, click Save In CSV in Operation menu. 

・ On the Operations view -> Group List screen, click Export Machine Data in 
Configuration menu. 

Check Internet Explorer's security settings. 
Select the Internet Explorer Tools menu -> Internet Options, then click Security 
tab -> Security 
level for this zone -> Custom level button, and configure as follows: 
・ Set Enable from Downloads – File download. 
・ Set Enable from Downloads – Automatically prompting for file 

downloads.(Only Internet Explorer 7/8.) 
  

 

The Web Console cannot be started. In the screen, "Internet Explorer cannot display the 
webpage" is displayed. 

Web Server may not be running. From Start menu, select Administrative Tools -> 
Internet Information Services (IIS) Manager and confirm whether Default Web 
Site is launched. 
Anonymous access of IIS may be disabled. Change the setting as following. 
(1) From Start menu, select Administrative Tools -> Internet Information 

Services (IIS) Manager. 
(2) Internet Information Services (IIS) Manager screen appears. Click DPM 

directly under  
Default Web Site in the left side of the screen. 

(3) Select Authentication in IIS in the center of the screen and click Open 
Feature in Actions in the right of the screen. 

(4) Select Anonymous Authentication in Authentication screen in the center of 
the screen and click Edit... in Actions in the right of the screen. 

(5) Edit anonymous authentication qualification information appears. Confirm 
whether Specific User is selected and the user name is "IUSR". If it is not 
"IUSR", click Setting and set "IUSR" in the user name. 

(6) Close the screen by clicking OK in Anonymous authentication qualification 
information. 

(7) Select Anonymous Authentication in Authentication screen and click 
Enabled in Actions in the right of the screen. 

  

 

When you open the Web Console screen (such as Add Machine screen or Add Scenario 
screen) the characters displayed on the screen are garbled. 

This may be avoided by turning off Auto-Select of Encoding on Internet Explorer. 
You can set OFF by clearing View menu -> Encoding -> Auto-Select. 

  

 

On the Backup/Restore tab of the scenario, you click Browse on the Image File and a 
network drive or USB hard disk is not displayed. 

Only local disk is displayed as a drive. When you specify a network drive or USB 
hard disk, enter the image file path on Image File text box directly. 
See Section 3.13.4, "Backup/Restore Tab" for the detail. 

   

 

The managed machine's MAC address is not displayed on the Web Console. 
The MAC address may not be displayed temporarily because of replacing LAN 
board to other machines and so on. 
If such a phenomenon occurs, manually reboot the managed machine. 
If the phenomenon occurs after reboot, delete the corresponding managed machine 
from the Web Console and then reregister. 
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*If the managed machine's MAC address is not displayed, you cannot perform the 
following 
operations: 

・ Set the Automatic Update Time for the managed machine 
・ Obtain the power status 
・ Obtain the managed machine information 
・ Execute Scenario 
・ Power ON 
・ Shutdown 

The MAC address for a managed machine running on Linux OS and mounted with 
two or more LAN boards may not be displayed during operation. 
In such a case, the corresponding managed machine may be registered to a New 
Machine group. Delete the corresponding managed machine from the New Machine 
group, and then reboot DPM Client on the managed machine. If the phenomenon 
occurs after reboot, delete the corresponding managed machine from the Web 
Console and then reregister. 

  

 

After a certain amount of time passes without any operation, the display of the Web 
Console is returned to Deployment Manager Login screen at the next operation. 

If session timeout occurs on the Web Console, the display is returned to 
Deployment Manager Login screen. Login again. 
You can change the setting of timeout by the following procedure. 
(1) From Start menu, select Administrative Tools -> Internet Information 

Services (IIS) Manager. 
(2) Internet Information Services (IIS) Manager screen appears. Click 

Application Pools in the left side of the screen. 
(3) Select DeploymentManagerPool in Application Pools in the center of the 

screen and click Stop in Application Pool Task in the right side of the screen. 
(4) Click Default Web Site in the left side of the screen and click Stop in Manage 

Web Site in the right of the screen. 
(5) Click DPM directly under Default Web Site in the left side of the screen and 

select Session State in ASP.NET in the center of the screen. Click Open 
Feature in Actions in the right side of the screen. 

(6) Specify the value of timeout in Cookie Settings -> Time-out (in 
minutes)(O)(The default is 20 minutes) in Session State screen in the center 
of the screen. Click Apply in Actions in the right side of the screen. 

(7) Click DPM directly under Default Web Site in the left side of the screen. Select 
Authentication of IIS in the center of the screen. Click Open Feature in 
Actions in the right side of the screen. 

(8) Select Forms Authentication in Authentication screen in the center of the 
screen. Click Edit... in Actions in the right side of the screen. 

(9) Edit Forms Authentication Settings screen appears. Specify the value of 
timeout in Authentication cookie time-out (in minutes)(O)(The default is 30 
minutes). Click OK. 

(10) Click Application Pools in the left side of the screen. Select 
DeploymentManagerPool in Application Pools in the center of the screen. 
Click Advanced Setting in Edit Application Pools in the right side of the 
screen. 

(11) Advanced Settings screen appears. Specify the value of timeout in the 
following 2 items. Click OK. 
Process Model - Timeout in idle status(minute) (The default is 20 minutes) 
Recycle - Periodic Interval (minute) (The default is 1740 minutes) 

(12) Click Start in Application Pool Task in the right side of the screen. 
(13) Click Default Web Site in the left side of the screen and click Start in Manage 

Web Site in the right side of the screen. 
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11.2. Management Server 
  

 

When you set different machines as DHCP server and the Management Server, you cannot 
obtain the MAC address for the managed machine. 

The DHCP service on the Management Server may still be running. On the 
Management Server, from Start menu, select Administrative Tools -> Services, 
and confirm that Status under DHCP Server is not Started. If it is Started, open the 
Properties screen, disable Startup type, and stop the service. 
In Detail Setting, the DHCP server is installed on an another machine checkbox 
may not be checked. Select Management view -> DPM Server -> Detail Setting on 
the Web Console, click the DHCP Server tab, and confirm that the DHCP server is 
installed on an another machine checkbox is checked. If the checkbox is not 
selected, select it and click OK, and then reboot the Management Server. (If the 
Management Server cannot be rebooted, stop all services listed in Appendix A, 
"Service List" by selecting Administrative Tools -> Services from Start menu, and 
then start all of the stopped services.) 

  

 

DPM Server services are not running. 
A service may terminate if an error occurs during scenario execution. 
If a scenario is executing, wait until it completes and then perform the following 
operations. 
From Start menu, select Administrative Tools -> Services on the Management 
Server, and then restart the following services. 
(If a service is stopped, please start it.) 

DeploymentManager API Service 
DeploymentManager Backup/Restore Management 
DeploymentManager Get Client Information 
DeploymentManager PXE Management 
DeploymentManager PXE Mtftp (Restart is not needed when startup type is 
disabled.) 
DeploymentManager Remote Update Service 
DeploymentManager Schedule Management 
DeploymentManager Transfer Management 

By performing an overwrite installation of DPM Server, it will be recovered. 
  

 

You cannot start the DeploymentManager API Service service. 
Port (TCP:56050/26500) may be in use by other applications and so on. 

 

 

You cannot start the DeploymentManager Remote Update Service service. 
Furthermore, the following error log is listed in <DPM Server installation 
folder>\Log\rupdssvc.csv : 
"RUPDSSVC: FUNCTION: CreateSocket(): bind Failed, error code=10048"  

Port (TCP:56024/26506, TCP:56028/26507) may be in use by other applications and 
so on. 
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If you uninstall and then install DPM Server, scenarios and groups existing before the 
uninstall still remain. 

The uninstallation may not be performed properly. Follow the procedure below to 
reinstall: 

(1) Perform uninstall again. 
(2) Reboot the machine installed with DPM Server. 
(3) Delete the contents under the folder installed with DPM Server and the Folder 

for Image  
(the defaults are C:\Program Files\NEC\DeploymentManager and C:\Deploy). 

(4) Install again. 
  

 

If you perform an overwrite installation after interrupting uninstall, an error message 
appears and you cannot overwrite. 

Install DPM Server newly after it is completely uninstalled. 
 

  

 

There is no response even if you execute DPM Server silent installation. 
The network connection may not have been detectable. 
After confirming the network environment, install DPM Server again. 

 

11.3. Managed Machine 
  

 

The standby function did not appear when you terminate the managed machine. 
Check the following: 
・ If the Terminal Service is enabled, you cannot use the standby function. From 

the control panel, disable the Terminal Service. 
・ Unless the device driver and so on are properly installed, the standby function 

cannot be used. 
  

 

If you used Remote Desktop to perform installation, upgrading, or uninstallation of DPM 
Client, the following message was displayed: 
 

The following error occurred on the file, xxxxx\DepAgent.dll. 
Access is denied. 
(0x5) 
 
* xxxxx is a (variable) file path. 

 
If installation, upgrading, or uninstallation is performed while Event viewer on the 
managed machine is open, the above message may be displayed. 
To Install/Upgrade Install/Uninstall, after selecting the Ignore button and closing the 
above message, reboot the managed machine and re-execute. 
For Uninstall, the DepAgent.dll file is automatically deleted after the machine 
restarts, so it is not necessary to re-execute. 

  

 

You cannot start DeploymentManager Remote Update Service Client service. 
Furthermore, the following error log is listed in rupdsvc.log. 

* rupdsvc.log is located in the following folder: 
・ For x86: C:\Program Files\NEC\DeploymentManager_Client\ 
・ For x64: C:\Program Files (x86)\NEC\DeploymentManager_Client\ 

RUPDSVC: bind() failed, code = 10048  
Port (TCP:56000/26510, TCP:56025/26511) may be in use by other applications and 
so on. 
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You cannot start DeploymentManager Update Service Client service. 
Furthermore, the following error log is listed in rupdsvc.log. 

* rupdsvc.log is located in the following folder: 
・ For x86: C:\Program Files\NEC\DeploymentManager_Client\ 
・ For x64: C:\Program Files (x86)\NEC\DeploymentManager_Client\ 

"Multicast receive socket create error, code = 10048"  
Port (UDP:56001/26529) may be in use by other applications and so on. 
 

  

 

Joining a managed machine of Windows Server 2008/Windows Vista or later to the domain 
will initialize the Firewall's setting and enable it. 

This happens when the domain security policy is undefined in the domain server. 
Define the domain security policy before joining to the domain. 

 

11.4. Scenario 
  

 

You cannot assign a scenario to a managed machine. 
A scenario cannot be assigned to a machine in the following statuses: Scenario 
Executing, Scenario Execution Stop, Scenario Execution Error or Remote Power ON 
Error. Assign a scenario either after scenario execution completes, or clear the 
machine status. 

  

 

You want to change the scenario file name. 
The scenario name cannot be changed. Please create a new scenario. 
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11.5. Execute Scenario 
11.5.1. General 
  

 

You executed a scenario, but the managed machine Status is not Scenario Executing. 
If you click Refresh from Operation menu, or refresh the screen by pressing the F5 
key, the status changes to Scenario Executing. Until the machine icon displays 
Running, do not edit, delete or remove scenario assignment for any running 
scenario. The scenario may not execute properly. 

  

 

You checked the Forced Execution Of A Reboot Is Performed Before Execution 
checkbox on the scenario Option tab, but the machine does not reboot. 

When installing service packs, hotfixes, and applications, the machine does not 
reboot before executing a scenario. 

  

 

An error occurred while a scenario was running. 
Use the following method to remove the error. 
Next, check the error contents in the Event Viewer, confirm that the machine is in the 
correct status on the Web Console, and then re-execute the scenario. 
Example 1) Error Removal Method 

(1) Click the machine in error status on the Machine List, and a machine 
detail screen appears. 

(2) Click Remove Error under Operation menu on the machine detail screen. 
Example 2) Error Removal Method 

(1) Click Monitor view - Scenario Execution List. 
(2) In the tree view, click Scenario Execution List. 
(3) In the Operation menu, click Batch Clear Status. 
(4) On the Status Clear screen, select Scenario Execution Error. 
(5) Click OK. 

  

 

A Running Scenario does not complete. 
Confirm the following: 
・ Confirm that DPM Client is installed. 

If DPM Client is not installed, interrupt the scenario, install DPM Client, and 
re-execute the scenario. 

・ Confirm that the IP address of the Management Server set when DPM Client was 
installed on the managed machine is correct. 
If it is incorrect, either change the following registry, or reinstall DPM Client and set 
the correct IP address. 
<Windows> 

Key: 
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\depagent\Para
meters 
Key name: ServerIpAddress  

<Linux> 
Correct the following files in the /opt/dpmclient/agent/etc/ folder. 
File Name: server.inf  
Key name: dpmserverip= 

・ At the time a scenario completes, the setting is that DPM Client can communicate 
with the Management Server. 

・ When the scenarios is running, if you change the configuration of Management 
view -> DPM Server -> Detail Setting -> DHCP Server tab on the Web Console, 
PXE boot fails in the managed machine and the completion of the scenario cannot 
be detected. After stopping the scenario, re-execute the scenario after setting the 
item in DHCP Server tab matching the proper environment. 
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A scenario execution error occurred immediately after you executed a scenario. 
The location of installation or settings of DHCP may be wrong, or the DHCP server 
may not be operating properly. Check the current situation from the following: 
・ Select Management view -> DPM Server -> Detail Setting -> DHCP Server tab 

on the Web Console, and confirm that the settings are correct. 
・ Confirm that the lease IP address in the DHCP scope is not inactive. 
・ Confirm that the DHCP server is approved and the IP address can be leased. 
・ Confirm that the DHCP address pool has not run out. If the pool has run out, 

please secure a sufficient pool of addresses. 
・ If using a DHCP server except Windows, confirm that fixed addresses are 

configured. 
A remote update scenario may have been executed on a machine that exceeded the 
Distribution Condition Setting - Maximum Targets configured in the scenario. 
Reduce the number of machines to execute, or increase the value of Maximum 
Targets. 
HW configuration, OS installation, disk configuration check, or a Backup/Restore 
scenario may have been executed for a machine with power turned ON. 
To re-execute with the machine's power turned OFF, or to force execute on a 
machine with power turned ON, check the Forced Execution Of A Reboot Is 
Performed Before Execution checkbox on the scenario's Option tab. 
The command (execute file path + execute file name + setup parameter) of executed 
package for a remote update scenario may exceed 259 characters. Correct so that 
the length is 259 character or less by Image Builder and PackageDescriber. 

  

 

An error occurred while a scenario was running. 
In the Event Viewer, error log information is registered. 

Check the log information registered in the Event Viewer, and perform the 
processes for each item. 
A problem that still occurs after re-executing may cause incorrect behavior in related 
services. If a scenario is executing, wait until it completes and then perform the 
following operations from the Management Server. From Start menu, select 
Administrative Tools -> Services on the Management Server, and then restart the 
following services. (If a service is stopped, please start it.) 

DeploymentManager API Service 
DeploymentManager Backup/Restore Management 
DeploymentManager Get Client Information 
DeploymentManager PXE Management 
DeploymentManager PXE Mtftp (Restart is not needed when startup type 
is disabled.) 
DeploymentManager Remote Update Service 
DeploymentManager Schedule Management 
DeploymentManager Transfer Management 

- Log Information 1 
・ Error: Timeout error and stop run scenario. No response from 

target: 
Explanation 
The scenario execution timed out because there was no response from the 
machine within a given time. The machine may have stopped due to an awaiting 
input status, error display, or other reason. After checking the machine, scenario 
content, setup parameter files and other information, remove the error from the 
machine. Next, turn the machine power OFF and then re-execute the scenario. 

- Log Information 2 
・ Error cannot create thread (xxxxxxxxxxx) 
・ Error cannot allocate xxxxxxxxxxxxxxxx 
Explanation 
Failed to create the thread which processes machine requests and to allocate 
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buffer memory. There is the possibility that there are insufficient resources due to 
factors such as the Management Server's high load state. 
 
After checking the Management Server status, remove the error from the 
machine. Next, turn the machine power OFF and then re-execute the scenario. 

- Log Information 3 
・ Error cannot read CLF 
・ Error cannot change CLF 
Explanation 
Failed to read/write managing machine information. 
Remove the error from the machine, and then turn the machine power OFF. After 
waiting a while, re-execute the scenario. 

- Log Information 4 
・ Error cannot get xxxxxx path 
・ Error cannot read xxxxxx 
・ Error cannot open xxxxxx 
Explanation 
Failed to obtain the path for, open, and read file xxxxxx. 
There may be insufficient resources or registry information may be damaged due 
to factors such as the Management Server's high load state. After checking the 
Management Server status, remove the error from the machine. Next, turn the 
machine power OFF and then re-execute the scenario. 

- Log Information 5 
・ Starting process of the computer failed MAC = XX-XX-XX-XX-XX-XX 
Explanation 
Failed to power on the machine remotely. 
The network cable is not connected, or remote power ON is not configured. If the 
machine is forcibly shut down while the POST screen is displayed, remote power 
ON may not function the next time the machine boots up. 
Confirm HW settings and try again. 

- Log Information 6 
・ Starting process of the computer failed when execute scenario 

MAC = XX-XX-XX-XX-XX-XX  
Explanation 
Failed to power on the machine remotely. 
The network cable is not connected, or remote power ON is not configured. If the 
machine is forcibly shut down while the POST screen is displayed, remote power 
ON may not function the next time the machine boots up. 
Confirm HW settings and try again. 

- Log Information 7 
・ scenario start write shared memory MAC : error = 

XX-XX-XX-XX-XX-XX : XXX 
Explanation 
The service may have abnormally terminated. 

 
(1) From Start menu, select Administrative Tools -> Services on the 

Management Server, and then stop the following services:  
DeploymentManager API Service 
DeploymentManager Backup/Restore Management 
DeploymentManager Get Client Information 
DeploymentManager PXE Management 
DeploymentManager PXE Mtftp (Stop is not needed when startup type is 
disabled.)  
DeploymentManager Remote Update Service 
DeploymentManager Schedule Management 
DeploymentManager Transfer Management 
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(2) Start the services you stopped in Step (1). 
 
(3) Execute the scenario again. 

 
- Log Information 8 
       scenario start update module copy MAC : error = 
XX-XX-XX-XX-XX-XX : XXX 

・ scenario start dir delete error MAC = XX-XX-XX-XX-XX-XX 
Explanation 
The Management Server Folder for Image may not be accessible. 
Confirm access rights for Folder for Image, and then execute the scenario again. 

  

 

An error occurred while a scenario was running. 
When you connected the display to the machine, the following errors were displayed. 

Perform each process following the messages displayed. 
- Message 1 
Error: Partition is too small for install windows operation 
system. 
Explanation 
If you select Use Existing Partition during window installation, this message is 
displayed when the existing partition is smaller than 4GByte. 
If installing Windows in a partition smaller than 4GByte, perform the local setup 
manually. 

- Message 2 
Error: No partitions defined. 
Explanation 
If you select Use Existing Partition during Windows installation, this message is 
displayed when there is no existing partition. 
Select Create New Partition, and re-execute the operation. 

- Message 3 
Error: No disk found. 
Explanation 
This message is displayed if a hard disk drive is not connected during Windows 
installation. 
Confirm that the hard disk is connected correctly, and then re-execute the 
operation. 

  

 

The managed machine does not turn on when the power is turned on or a scenario is 
executed. 

If the power is forced turned off during POST, the system may fail in Wake On LAN 
when restarted. 
Turn off the power after completion of POST or start the operating system and 
perform the shutdown process. 

  

 

The power was turned off during scenario execution by mistake. 
On the Web Console, click Operations in the title bar to switch to the Operations 
view. In the tree view, click Machines icon, and then select the group to which the 
machine which power was turned off is registered. Select the specified machine, 
and then select Scenario Execution Stop to interrupt the scenario. After the status 
returns to normal, execute the scenario again. 

  

 

The managed machine is not booted through the network, and the scenario cannot be 
executed. 

The network boot priority in the BIOS settings may be lower than the hard disk boot 
priority. Make the network boot priority higher than the hard disk boot priority, and 
re-execute the scenario. 
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When you manage a machine of UEFI mode, if you start Windows OS after 
executing restoring or OS installation by disk duplication, two or more "Windows 
Boot Manager" are displayed in UEFI boot option and the boot order of network boot 
may be changed. 
Set the boot order of the network boot higher than "Windows Boot Manager" and 
execute the scenario again. 

 

When you execute DPM Command Line, the specified command does not run. 
In addition, an error does not appear at the command prompt. 

You may be using a previous version's DPM Command Line (Command Line for 
DPM). If you are using DPM Command Line (Command Line for DPM) from a 
previous version, perform an upgrade installation, see Section 3.5, "Upgrading DPM 
Command Line" in Installation Guide. 

 

When you executed a scenario to two or more managed machines simultaneously, a 
Remote Power On error occurred. 

In the case of executing a scenario to two or more managed machines 
simultaneously, the default timeout value of the Remote Power On, which is specified 
in the Management view -> DPM Server -> Detail Setting - Network tab, may 
cause a timeout error. 
As a guide, set the Remote Power On Timeout to the following value: 
(Remote Power On Interval) multiplied by (the number of scenario executing 
machines) plus (managed machine startup time). 

  

 

When a scenario finishes or a running scenario is stopped, the following message appears 
on the managed machine and the machine cannot be turned off: 
ERROR: Failed to power down by calling APM BIOS. The system has halted. 

A machine that does not support Advanced Power Management (APM) may not be 
automatically turned off at shutdown. In this case, turn off the managed machine 
manually. 

  

 

When you execute DPM Command Line, the following message appears, and you cannot 
execute the command: 
The system cannot execute the specified program. 

This message appears when runtime modules required for running DPM Command 
Line are not properly installed. 
Execute the following file to install the run-time modules: 
<Installation media>:\DPM\Setup\VCRTL\vcredist_x86_2010SP1.exe 

To install the modules, Windows Installer 3.1 or later is required. 
  

 

When you execute DPM Command Line, the following log is output to "System" in the 
[Event viewer]. 
Source: SideBySide  
Event ID:32 
Explanation: The dependent assembly Microsoft.VC90.CRT could not be 
detected. 
Error: The referenced assembly is not installed to the system. 

This message appears when runtime modules required for running DPM Command 
Line are not installed properly. 
Execute the following file to install the run-time modules: 
<Installation media>:\DPM\Setup\VCRTL\vcredist_x86_2010SP1.exe 
To install the modules, Windows Installer 3.1 or later is required. 
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11.5.2. Creating a Linux Install Parameter File 
  

  

When you select Open under File menu from the installation parameter setting tools and 
when reading the existing Linux installation parameter file, the following message appears: 
 

A candidate host file cannot be read. 
 

About the selected Linux installation parameter file, OS may not be supported in this 
version. For details, see Section 3.9.1, "System Requirements" or Appendix A, 
"Function Tables" in First Step Guide. 
 
The Linux installation parameter file may be damaged. 
Check the contents of the Linux setup parameter file and Linux boot parameter file. 

  

  

When you select Open under File menu from the installation parameter setting tools and 
when reading the existing Linux installation parameter file, the following message appears: 
 

The Linux OS installation parameter file cannot be read. 
 

About the selected Linux installation parameter file, OS may not be supported in this 
version. For details, see Section 3.9.1, "System Requirements" or Appendix A, 
"Function Tables" in First Step Guide. 
 
The Linux installation parameter file may be damaged. 
Check the contents of the Linux setup parameter file and Linux boot parameter file. 

 

11.5.3. OS Installation by Disk Duplication 
  

  

While you set up the OS by OS installation by disk duplication, the following message 
appeared on the machine screen and processing stopped. 
"The parameter file for this system is not prepared, or failed to be 
copied. Follow the wizard to setup displayed after reboot. Press any 
key to reboot." 

The number of machines trying to access the Management Server may exceed the 
maximum number of machines concurrently accessible. Reduce the number of 
machines concurrently accessing the Management Server concurrently. 
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During the Windows OS setup by OS installation by disk duplication, the process stopped 
under the condition of being logged onto the machine. 
Furthermore, machine names and so on that were specified by parameters are not set 
correctly. 

It may have failed to reflect the specific information because it took time to initialize 
the setting of Windows OS. 
Open <Folder for Image>\Sysprep\Windows\DepConfig.ini by Text Editor and so 
on, and change the following Timeout value (milliseconds). (Use numeric 
characters.) 
DepConfig.ini can be edited after Copy-ExpressSysprep.vbs script is executed on 
the master machine when the master image is created. 

 

 
Example) 

 
  

  

During the OS setup by OS installation by disk duplication of Windows Server 
2008/Windows Vista or later, either of the following messages appeared and the process 
stopped. 
・ "Windows could not parse or process the unattended answer file for 
pass [specialize]. The settings specified in the answer file cannot 
be applied. The error was detected while processing settings for 
component [Microsoft-Windows-Shell-Setup]." 

・ "The computer restarted unexpectedly or encountered an unexpected 
error. Windows installation cannot proceed. To install Windows, click 
"OK" to restart the computer and then restart the installation." 

The OS type in the disk duplication data file for the duplication destination machine 
may differ from the OS type of the master machine. Also, Product Key may not be 
specified in the disk duplication data file correctly. 
Change the OS type in the disk duplication data file so that it matches that of the 
master machine and specify Product Key correctly. Then, distribute the disk image 
again. 

  

 

While you setup the OS by OS installation by disk duplication, the following message 
appeared on the machine screen and processing stopped. 
"The system registry contains invalid file paths. Installation cannot 
proceed. This system image was applied without guaranteeing that 
drive-letter assignments would match across computers." 

This error may be displayed if the system configuration of the master image is 
multiboot. 
Confirm that the master image is not a system configuration of multiboot. OS 
installation by disk duplication in the multiboot environment cannot be executed. (Be 
sure to construct the master image as a single system.) 

  

 

After you set up the OS by OS installation by disk duplication, the characters of the 
connection name registered in Network and Dial-up Connections were garbled. 

If this occurs, change the connection name manually. 

  

[SYSPREP] 
Timeout=300000 
 

[SYSPREP] 
Timeout=60000 
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When you execute Sysprep command on the master machine in setting up OS by OS 
installation by disk duplication, Windows Security Alert dialog appears and the message 
that "Do you want to keep blocking this program? Name: Microsoft Remote Desktop Help 
Session Manager" is displayed. 

In the case of Windows Server 2003 R2, this may be displayed. The processing 
continues automatically after a while and there is no problem. Wait for a while. 

  

 

After OS installation by disk duplication, messages such as the following appear at Linux 
OS startup. Or, X-Window does not start. 
"Could not look up internet address for "Hostname"(*) This prevents GNOME 
from operating correctly. It may be possible to correct the problem 
by adding "hostname"* to the file /etc./hosts." 

* "Hostname" is the host name of each machine after OS installation by disk duplication. 
An error may occur at X-Windows startup because a host name is not registered to 
the file /etc./hosts. Register the hostname in the /etc./hosts file. If the environment 
uses a static IP address, register the line as the following. 
Example) 192.168.0.1 servername 

If the computer obtains an IP address from DHCP, register the hostname 
with a loopback address as follows: 

Example) 127.0.0.1 localdomain.localhost localhost servername 
  

 

IP address conflict occurred after OS installation by disk duplication. 
If an alias interface is configured in the master machine, IP address conflict occurs 
after OS installation by disk duplication. Use the following procedure to delete the 
alias interface configuration file, and then restart the machine. 

 
# cd /etc./sysconfig/network-scripts 
# rm -f ifcfg-eth*:* 
# rm -f ifcfg-bond*:* 

  

 

If you execute backup of OS installation by disk duplication of a Linux-installed VMware 
ESX/ESXi virtual machine as a master machine, the following error appears during POST 
process of the first reboot after completing the backup process, and then the machine was 
shut down. 
"Determining IP information for eth[]...failed; no link present. Check cable?" 

Configuration described in "Executing the tool in the installation media manually" of 
Section 3.4.1.3, "Preparing for Creating the Master Image" in Operation Guide may 
not have been done correctly in the preparation for OS installation by disk 
duplication on the master machine. 
Confirm the procedure and configuration, and then execute OS installation by disk 
duplication again. 

  

 

If you execute OS installation by disk duplication for a VMware ESX/ESXi virtual machine, 
the following error appears during POST operations at startup after the specific information 
are reflected, and the network adaptor is not recognized. 
"Determining IP information for eth[]...failed; no link present. Check 
cable?" 

When the disk duplication data file was created, the script data listed in Section 
5.4.3, "Creating a Disk Duplication Parameter File (Linux)" may not have been 
properly configured. 
Confirm the procedure and configuration, and then execute OS installation by disk 
duplication again. 
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Though execution of scenarios for setting up of a master machine 
(System_LinuxMasterSetup/System_WindowsMasterSetup/System_WindowsMasterSetup
VM) succeeded, OS installation by disk duplication fails. 

DPM Client earlier than DPM Ver6.12 may be used. After upgrading DPM Client to 
this version, execute OS installation by disk duplication again. 

 

11.5.4. OS Clear Installation 

 

After Distribution of floppy disk image for BIOS/firmware and an OS clear installation scenario was 
executed, a scenario execution error occurs before you reboot the machine. 

Is there a check-in on the Forced Execution Of A Reboot Is Performed Before Execution 
checkbox on the scenario Options tab? If not, a scenario will not be executed for any 
machine that has been turned ON. Modify the scenario or turn the machine OFF and 
execute the scenario again. 

  

 

Scenario execution has stopped and the following message appeared on the machine's screen 
during the execution of an OS clear installation scenario. 

"Cannot connect data server. Please stop running scenario on the 
Management Server and press any key to reboot" 
The maximum number of machines that accessing the Management Server simultaneously 
may have been exceeded. Reduce the number of machines that are accessing the 
Management Server simultaneously and execute again. 

  

 

The OS installation has stopped due to an error. 
OS installation will stop with error if you specified unusable character in the machine name. 
For a list of unusable characters, see the manual of the OS you are using and so on. 

  

 

During Linux installation, the following message appears, and the installation could not be 
completed. 

Could not allocate requested partitions; Partitioning failed: 
Could not allocate partitions as primary partitions 
The partition settings may be wrong. (For example, if the number of primary partitions on 
one basic disk exceeds the upper limit (4))  
While creating the Linux installation parameter file, select Disk Information Settings - 
Partition Settings - Delete All Existing Partitions and execute the Linux installation again. 

  

 

During Linux installation, the following message appears, and the installation could not be 
completed. 

+--------------- Kickstart Error ------------+ 
Error opening: kickstart file 
/tmp/ks.cfg: No such file or 
directory 

[OK] 
+-----------------------------------------+ 

Confirm that the NFS shared folder is configured correctly. 
See Appendix C, "Configuring NFS Server" in Installation Guide to configure the folder 
correctly, and then install Linux. 
If you uninstall DPM Server with the exports folder as an NFS shared folder as previously 
mentioned in Setting Up the NFS Service, and then reinstall DPM Server, the NFS shared 
property is configured in Explorer, but the above error may occur when you actually perform 
the installation. In this situation, release and then reconfigure the NFS shared property. 
Confirm that the install device you are using is configured to Installation Device of Linux 
installation parameters. 
See Section 5.4.5, "Creating a Parameter File for OS Clear Installation (Linux)" to configure 
Installation Device correctly, and then install Linux again. 
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11.5.5. Installing Service Packs / HotFixes / Linux Patch Files / 
Application  

  

 

Perform the following operations if scenario execution errors continue to occur in remote update. 
Restart the Management Server. (If the Management Server cannot be rebooted, stop all 
services described in Appendix A, "Service List" by selecting Management Tools -> 
Services from Start menu, and then start all of the services you stopped.) 

  

 

When you executed the scenario of installing service packs, hotfixes, Linux patch files, and 
applications, but the machine in the Status column of the Monitor view -> Scenario Execution 
List remains in Running Scenario, and the scenario execution does not complete. 

If the command option is not configured correctly, a confirmation dialog box appears on the 
machine and the scenario execution does not complete. You can check the command option 
by running the service pack or the hotfix with the option /h or -? , or see distributor's web site 
and so on. Make sure that you specify the command options to execute silent installation 
and not to restart after installation. 

  

 

Failed to create an image file during the registration of Installing service packs, hotfixes, Linux 
patch files, and applications by Image Builder. 

In installing service packs, hotfixes, Linux patch files, and applications, image file is saved in 
ZIP file. If these ZIP files size exceed 2GByte, creation of the image file fails. 

 

 

When you modified a package by Image Builder, the message "Failed to compress the file." 
or " Failed to register in the Management Server." is displayed and package modification 
fails. 

If the modification date is earlier than the package creation date, package modification fails. 
There may be some reasons, such as, the date-time of the machine was changed after 
creating the package, or that date-time of the Management Server is different from one of 
Image Builder (Remote Console) machine. After the date that the package was created, 
modify the package, or delete the package and create the package again. 
 
The packages are stored in Management Server's Folder for Image \HotFix, or Folder for 
Image \PP. 
(The default of the Folder for Image is  
C:\Deploy, and the package file name is "ServerID"-"PackageID".zip.) 

  

 

Even if applying a service pack/hotfix/Linux patch file fails, the Web Console displays that scenario 
execution completed successfully. 

When the execution of a service pack or hotfix fails, the failure may not be detected. In such 
case, fix the cause of the execution failure, and then execute the scenario again. 

  

 

A scenario execution error occurs if you execute a scenario Distribution of floppy disk image for 
BIOS/firmware or apply Installing service packs, hotfixes, Linux patch files, and applications install. 

Confirm that the execution interruption processing is completed properly. If interruption is 
cancelled before execution and then the scenario is executed, the scenario execution error 
may occur. 
Furthermore, if you want to execute the same scenario simultaneously on two or more 
machines, set the maximum target number of multicast distribution conditions to the number 
of machines you want to interruption process is completed, and then execute the scenario. 

  

 

A scenario execution error occurs if you try to execute two or more service pack/hotfix/Linux patch 
file/application install scenarios at the same time. 

See the Scenario Details screen and check whether the same multicast IP address is 
specified. If the same multicast IP address is not being used, reduce the maximum transfer 
rate, or execute the scenarios one by one. (If the scenario is the same, you may also 
execute the scenario on two or more machines.) 
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A scenario of installing service packs, hotfixes, Linux patch files, and applications does not start. 
If the maximum target is not configured, or is greater than the machine attempting to 
execute, the scenario executes after the maximum wait time passes. (The default setting of 
the maximum wait time is 10 minutes.) 

  

 

The maximum transmission rate has been set higher, but the scenario execution time does not 
decrease. 

Maximum transmission rate depends on varies widely with a customer's network 
environment. You cannot obtain a transmission rate higher than the network environment's 
performance. 

  

 

If you register an application or service pack/hotfix by Image Builder (Remote Console), the error 
Failed to register to Management Server is displayed. 

This error may occur when the size of the file to register is extremely large. 
To prevent this error, edit the timeout value (number of seconds) that is specified by the 
following registry: 

Hive : HKEY_LOCAL_MACHINE 
KEY : SOFTWARE\NEC\DeploymentManager 
NAME : DIBReqTimeOut 
Type : REG_DWORD 
Value : 120 
-> The default is 120 seconds. Set the timeout value. 
Even if an error is displayed, registration is successful. Re-registration is unnecessary. 
When you exit Image Builder, perform the following operations: 

(1) Select Yes (Register) at batch registration. 
(2) Select No (Delete) at the confirmation of overwriting. 

  

 

If you register a service pack/hotfix/Linux patch file by Image Builder (Remote Console), the data 
creation has succeeded. However, the registration to the Management Server fails. 

This may occur if the path for the setup command name is extremely long. 
If registering to the Management Server from the Remote Console, the upload process 
checks the full path, including the Folder for Image path on the Management Server side as 
the maximum path length. If the upper limit of the full path is exceeded, the registration fails. 
Register a shorter full path by moving the files to be registered to a location close to the drive 
root on the Remote Console, and register the files again. 

  

 

If you interrupt the execution of the scenario of installing service packs, hotfixes, Linux patch files, 
and applications, and then cancel the interruption and execute the scenario again, a scenario 
execution error occurs. 
 

If the interruption occurs when communications with the managed machine is disrupted for 
some reason, the interruption process cannot be completed, and the machine remains in an 
interrupt status. In this status, even if a scenario is executed after the interruption is 
cancelled, a scenario execution error occurs. 
In this case, wait for a while (about 10 minutes) and before executing the scenario again. 
If the scenario execution errors persist, perform the following operations. 
 
On the managed machine, select Management Tools ->Services from Start menu, and 
restart DeploymentManager Remote Update Service Client. (If the service is stopped, 
please start it.) 
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After executing DPM Client automatic upgrade scenario for a Linux managed machine, and then 
execute another remote update scenario, which does not start. 

When another remote update is executed within two minutes of executing DPM Client 
automatic upgrade scenario and DPM Client service does not start properly. Restart DPM 
Client service or restart the OS. To restart DPM Client service, start the Console and 
execute the following:  
・ In the case of earlier than Red Hat Enterprise Linux 7/SUSE Linux Enterprise 

>service depagt stop 
>service depagt start 

・ In the case of Red Hat Enterprise Linux7 
>systemctl stop depagt.service 
>systemctl start depagt.service 

  

 

If remote update is executed for a Linux managed machine, a scenario execution error occurs. 
When installing service packs, hotfixes, Linux patch files, and applications in Image Builder, 
an option that outputs to the console may be specified to Setup Parameters on the 
Execution Configuration screen. The option may be specified. 
See Section 5.5.3, "Create Linux Package," and confirm that relevant options are not 
specified. 
If the relevant options are specified, delete scenarios including that packages, correct the 
packages from which relevant options were removed. Recreate the scenario file with the 
corrected packages, and then execute the scenario again. 

  

 

If a remote update is executed by multicast for the x64 Linux managed machine, a scenario 
execution error occurs. 

The necessary libraries may not be installed. Confirm that /lib/libgcc_s.so.1 exists. 
If /lib/libgcc_s.so.1 does not exist, install the following rpm package: 

libgcc-3.4.5-2.i386.rpm 
After the installation, restart DPM Client service or restart the OS. 
To start DPM Client service, start the Console and execute the following: 
・ In the case of earlier than Red Hat Enterprise Linux 7 /SUSE Linux Enterprise  

>service depagt start 
・ In the case of Red Hat Enterprise Linux 7  
>systemctl start depagt.service 

  

 

When the remote update scenario is distributed by multicast, the scenario execution to a part of the 
managed machines fails. 

If all of the following is applied and a remote update scenario is distributed by multicast, 
scenario execution fails. 
If managed machines are connected to two or more LAN boards on the Management 
Server, create and execute different scenarios for each LAN board. 
・ ANY is selected on the Web Console screen under Management View -> DPM Server 

icon -> Detail Setting screen -> General tab -> IP Address. 
・ The managed machines are connecting with two or more LAN boards on the Management 

Server. 
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11.5.6. Backup/Restore 
  

 

The partition number specified when the scenario is created is different from the partition number 
displayed on the machine screen. 

A hidden partition may exist in the target hard disk. The hidden partitions will not be included 
in the total count if the check box was checked for Hidden Partition Is Disregarded in 
partition specification Backup/Restore. Clear the check box, or enter a supported partition 
number correctly. 

 

 

Only several tens of MBs are transferred per minute during Backup/Restore operations. 
The maximum transmission rate may be specified too low, such as 1-10MByte/minute. 
Confirm the Maximum transmission Rate column on the Multicast Condition Setting panel 
in Backup/Restore tab on the Scenario Edit screen. If you want to save time, clear the check 
box. If you want to reduce network workload, select the check box and specify the appropriate 
values. 
Data may not be transferred smoothly due to a high network workload. Minimize use of the 
network as much as possible during the scenario execution. 

  

 

A scenario execution error suddenly occurred suddenly while data transfer was in progress during 
backup. 

Data transmission may not be possible due to sufficient free space on the Management 
Server. Make sure there is insufficient free space on Management Server where the backup 
data is to be saved. Backup will not operate properly if there is not enough free space. 
Reconsider the backup file destination, or reserve sufficient free space. 

 

 

When you start the OS on the machine that is restored, the disk image of another machine was 
restored. 

The image files that you backed up may have been overwritten with the backup image of 
another machine. When executing backup, make sure that you do not use a redundant image 
file name. Otherwise, the previous data will be overwritten. 
Furthermore, if the same scenario is assigned to two or more machines and execute backup 
simultaneously, check whether machine name, MAC address, or UUID under the textbox on 
the scenario file Backup/Restore tab is selected. 

  

 
 

Even if restore is executed simultaneously, several of the managed machines do not execute 
scenarios, and Waiting for Restore Execution is displayed on the Backup/Restore Execution List 
screen. 

The Maximum Targets set for the scenario file may be less than the actual machine number 
you are trying to execute. In this case, after completing the execution of preceding scenario, 
and then the scenarios for the rest machines start. 

  

 

The restore operation has been in waiting for restore execution status and does not start. 
The setting of the Maximum Waiting Time under the Distribution Condition Setting group 
box on the Backup/Restore tab for the scenario file can not to be configured. If the column is 
blank, the scenario will not execute until the number of machines ready to execute scenarios 
reaches the Maximum Target value. Click Run Now on the Backup/Restore Execute List 
screen, or interrupt the execution and specify an appropriate value for Maximum Wait Time 
of the scenario file. 

 

 

Even if you the maximum target number as 10 in the restore scenario, and then execute the scenario 
on 10 machines simultaneously, the scenario executes on only 5 machines at once. 

If the Management view -> DPM Server -> Detail Setting -> Network tab ->Machines For 
Simultaneous Execution value is 5, the scenario executes on only 5 machines at once, 
although the maximum target value is specified as 10. If you want to execute on 10 machines 
simultaneously, change the value of Machines For Simultaneous Execution under Detail 
Setting to 10. 
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The maximum transmission rate has been set higher, but the scenario execution time does not 
decrease. 

Maximum transmission rate depends on customer's network environment. You cannot obtain 
a transmission rate higher than the network environment's performance. 

  

 

Even through the execution of a backup scenario, a unicast restore scenario, or disk configuration 
check scenario completed, the status of Scenario Execution List status remains Preparing. 

If you executed a backup scenario, a unicast restore scenario, or disk configuration check 
scenario on another machine before the same scenario execution has completed, the status 
of Scenario Execution List on the Web Console may display Preparing from the time the 
backup, restore, disk configuration check completes to the time that the execution of the 
scenario completes. However, it does not affect the operation. 

  

 
 

When checking scenario execution status on Backup/Restore Execution List while a multicast 
restore scenario is executing, the scenario status is displayed as already complete although 
execution was still in progress, or it may not be displayed. 

Backup/Restore Execution List cannot be updated immediately, even when the scenario 
was executed. The status is updated when reading or writing to the Backup/Restore disk 
starts. 
Until that time, the pre- execution status of the scenario is displayed. When the screen was 
displayed before an update, wait a moment, and then reopen the screen, and click Refresh. 

  

 

During backup, a scenario execution error occurs, but no error message is displayed. 
If the OS did not shut down properly when the machine was power off, the delayed write to 
disk process may not have been completed during shutdown, and the file system may be 
damaged. Furthermore, if the machine was power off and shutdown was not performed while 
the disk was accessing, physical damage on the disk may have occurred. 
If backup was executed on such a disk, a scenario execution error may occur. 
In such case, reinstall the OS, or use a file system fix tool, etc to fix the file system, and then 
execute backup again. 
Furthermore, if there is a physical damage on the disk (bad sector), you cannot 
backup/restore using a fix tool and so on. If there are bad sectors, change a new HDD and 
recover it by physically formatting and then execute a restore from a previous backup image. 

  

 

When two or more restore scenarios are executed simultaneously, a scenario starts on the first 
machine booted up, but after getting Backup System image is displayed on the other machines, a 
scenario execution error has occurred, and the error is displayed on the Scenario Execution List 
screen. On the machin 
e screen, the following error message was displayed: 
"ERROR: Received the error from the PXE server. 
Please contact your system administrator or support group." 

The same multicast IP address is specified when the scenario was created may be specified 
in all scenario files. Open the Edit Scenario screen, and check the value of multicast IP 
address on the Distribution Condition Setting group box in the Backup/Restore tab. If the 
specified IP address is the same to another restore scenario, one of two scenarios may not 
start properly. Enter a non-redundant IP address again on the Modify Scenario screen. If 
Remove Scenario Execute Error is selected for the machine on which an error was 
occurred, error display disappears, and the scenario can be executed again. 
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If you execute a restore scenario by specifying a partition, either of the following error messages is 
displayed and the scenario execution error occurs. 
Cannot restore the data to a partition of a different size than the size you 
backed up. 
Specify a partition with the following size. 
(required size of a partition to restore) 
(size of the specified partition) 
(XXXXX bytes) 
(XXXXX bytes) 
 
Cannot restore the data to a partition of a different type than the type 
you backed up.  
Specify a partition with the type same as you backed up. 
(ID of the backed-up partition) 
(ID of the specified partition) 
(0xXX) 
(0xXX) 

Confirm that the partition size and the type of file system are matched between the original 
disk and the destination disk. Open the Edit Scenario screen, set the applicable partition, and 
then execute the scenario again. 
You may have specified a partition which is different from one that you backed up. Restore the 
image file to the same partition when it was backed up. Open the Edit Scenario screen, set 
the applicable partition and then execute the scenario again. 
If the Hidden Partition Is Disregarded checkbox was selected and hidden partitions exist on 
the managed machine, you may specify a partition that is different from when backup. In this 
case, clear the Hidden Partition Is Disregarded checkbox, and then execute the scenario 
again. 

  

 

Processing without ending, while executing a backup/restore scenario, and the following messages 
are displayed on the managed machine: 

FS: Cannot open root device "" or xx:xx 
Please append a correct "root=" boot option 
Kernel panic: VFS: Unable to mount root fs on xx:xx 

There may be a problem in the LAN connection between the Management Server and the 
managed machine, or the workload on the Management Server may be high. Check the LAN 
connection and the Management Server workload, and then turn off the machine and execute 
the scenario again. 

  

 

While executing a restore scenario, the following message is displayed on the managed machine, 
and a scenario execution error occurs. 
The size of the backup data to be restored is larger than that of the destination 
storage device. It cannot be restored. Specify a destination device whose size 
is larger than or equal to the following size. 
(minimum required size of a destination device) 
(the specified device: its size) 
(XXXXX bytes) 
(DeviceName: XXXXX bytes) . 

Check the HDD sizes of the backup source and the restore destination. 
If the HDD size of the restore destination is smaller, this message may be displayed. 
Use a HDD with the same or larger size than the backup source 
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When you execute a backup scenario, the following message is displayed on the managed machine 
and the scenario exectuion error occurs. 
Failed to backup. 
There is something wrong with the management information of the GPT disk. 
Check and repair the disk by CHKDSK or other tools,  
and re-execute the scenario. 

When Hyper-V virtual disk is GPT type, this message may be displayed. 
In this case, execute the full sector backup. Select Full Sector Option on Backup/Restore 
tab of Edit Scenario screen and execute the scenario. 

  

 

When you execute a restore scenario, the following message is displayed on the managed machine 
and the scenario exectuion error occurs. 
Failed to restore. 
The data is not written to the destination storage device. 
Invalid data in the backup image. 
For this error, contact your sales or support representative. 

When original Hyper-V virtual disk is GPT type, this message may be displayed if you restore 
the backup image file created in the version earlier than DPM Ver6.2. 
You cannot restore it because the backup image file includes invalid data. 
In this case, recreate a backup image file by selecting Full Sector Option on 
Backup/Restore tab when creating a scenario, and executing the backup scenario. 

  

 

When the following error occurs and a process ends with error for some reason, you cannot execute 
a shutdown or re-boot even if you press p or r (Key input cannot be recognized). 

ERROR: <error message> 
Press the p key to power off, and the r key to reboot:  

Key input may not function on certain kinds of machines using a USB keyboard/mouse which 
cannot be recognized. 
Press (and hold down) the power button to turn off the power. 

  

 

If you interrupted the execution of a restore scenario, the following message was displayed on the 
managed machine: 
Failed to read or write the data in the managed machine. 
For this error, contact your sales or support representative. 

This message is displayed when a scenario execution is interrupted. This message displays 
because the data of the intended size could not be obtained due to a disconnected 
communication between Management Server and the managed machine. 
This is not problematic to the scenario execution interruption process. 
While executing a restore scenario, the restore data cannot be read. 
Confirm that the backup image is not damaged and there is no trouble on the network. 

  

 

When a restore scenario is multicast distributed, the restore does not executed, and scenario 
execution is interrupted. 
Furthermore, the following message was displayed on the managed machine, and then the machine 
restarted. 
(After the restarting, a scenario execution error was displayed on the status of the managed machine 
on the Web Console.) 
Failed to read or write the data in the managed machine. 
For this error, contact your sales or support representative. 
This System is rebooted after XX seconds. 
gzip: stdin: Unexpected end of file. 

This phenomenon may occur when both ANY is specified for the IP address used by 
Management Server and the restore scenario is distributed by multicast. Configure except 
ANY for the IP Address used by Management Server (the IP address configured by the using 
LAN board). For configuration method details, see Section 2.7.1.1, "General Tab." 
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When a scenario is running, "boot:" or "login:" is displayed on the manged machine, and the 
processing does not proceed. 

You may have entered the key to stop the processing, such as "Ctrl" + "C". Do not enter a key 
on the managed machine when a backup or restore scenario is running. 

  

 

PXE boot fails on the managed machine. 
Is the Management view -> DPM Server -> Detail Setting -> DHP Server tab set to Do Not 
Use a DHCP Server?  
If Do Not Use a DHCP Server is selected, a PXE boot cannot be executed on the managed 
machine. 
If a PXE boot is necessary, configure a DHCP server, and select Use a DHCP server. 
Furthermore, restart the Management Server after changing it since the configurations are 
enabled after Management Server restarts. 

 

When you execute backup/restore scenario, the following message is displayed on the screen of the 
managed machine and a scenario execution error occurs. 
ERROR: FC storage configuration is different from the result of the disk 
configuration check scenario. 
Please retry the disk configuration check scenario. 

When the configuration includes FC LUN, an error occurs because the information is different 
from that obtained by disk configuration check. When you change either of the following 
configuration, the error may occur. 
・ Adding, changing, or deleting LUN 
・ Changing the redundancy configuration of the path  
・ Change the configuration including FC LUN to other configuration (internal RAID 

configuration and so on.) and vice versa.  
Execute disk configuration check to obtain new configuration information and re-execute a 
scenario.  
Recheck the disk number as necessary. 

 When the configuration includes FC LUN(LUN configuration, redundancy configuration), an 
error occurs because the information is different from that obtained by disk configuration 
check. When the part of paths cannot be connected due to physical problem and so on, the 
above message may be displayed. 
Recheck the connection status of the path or the redundancy configuration, or execute disk 
configuration check to obtain new configuration information and re-execute a scenario. 
Recheck the disk number as necessary. 

 

11.5.7. Distribution of Floppy Disk Image for BIOS/Firmware  
  

 

The managed machine does not boot by the network boot after a scenario that Distribution of floppy 
disk image for BIOS/firmware is executed. 

If BIOS is upgraded, the BIOS configuration may return to the default settings. Check whether 
the priority order of the network boot is not changed. If the priority order is changed, set 
network boot to the top priority. 

  

 

A scenario execution error occurs when you execute a Distribution of floppy disk image for 
BIOS/firmware, Installing service packs, hotfixes, Linux patch files, and applications install scenario. 

Confirm that the execution interruption processing is completed properly. If interruption is 
cancelled before the process of the interruption completes and then the scenario is executed, 
a scenario execution error may occur. 
Are you trying to execute the same scenario which is being executed on another machine? If 
you want to execute the same scenario on two or more machines simultaneously, specify the 
maximum target number under Multicast Condition to the number of machines that you want 
to execute, and then execute the scenario. 
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A scenario execution error occurs before the machine restarts after a scenario of Distribution of 
floppy disk image for BIOS/firmware and a scenario of OS clear installation is executed. 

Did you specify the Forced Execution Of A Reboot Is Performed Before Execution on the 
scenario Options tab before execution? If not, a scenario is not executed for any machine that 
is power on. Modify the scenario, or turn off the machine and execute the scenario again. 

 

11.6. Registering a Managed Machine 
  

 

Even if you turn on a managed machine, a new registration is not performed. 
The DHCP configuration may be wrong, or the DHCP server may not operate properly. Check 
the following items: 
・ Select Management view -> DPM Server -> Detail Setting -> DHCP Server tab on the 

Web Console, and confirm that the Use A DHCP Server configurations are correct. 
・ Confirm that the lease IP address in the DHCP scope is not inactive. 
・ Confirm that the DHCP server is approved and the IP address can be leased. 
・ Confirm that the DHCP address pool has not run out. If the pool has run out, please 

secure a sufficient amount of addresses. 
・ If using a DHCP server except Windows, confirm that fixed addresses are configured. 

The managed machine may be a model that does not support PXE boot, or the network 
startup order may be set lower than the HDD. 
On an x86 architecture machine, check the network startup order in the BIOS settings. For 
methods to check the BIOS, contact your sales or support representative. 
If you operate without using the DHCP Server, and the setting is changed to Do Not Use A 
DHCP Server in the Management view -> DPM Server -> Detail Setting -> DHCP Server 
tab, it is necessary to restart the Management Server to enable the setting. Restart the 
Management Server, and then restart the managed machine. 
If two or more LAN boards are mounted on the managed machine, confirm that the LAN board 
used for DPM communications is registered on DPM Server. 
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11.7. Automatic Update 
  

 

Open Monitor view -> Automatic Update Result List screen, and check the detailed information of 
the corresponding machine and date/time, then registration of error log information can be confirmed. 

Check the detailed information, and fix each problem. 
If you execute automatic update after fixing the problem, reboot the managed machine. 
 
<Detailed Information 1> 
・ Machine: xxx (MAC:xx-xx-xx-xx-xx-xx)  
・ Automatic update begins 
・ An error occurred while preparing for the automatic update. 
・ ...... 

Explanation: Management Server resource may be insufficient. Restart the Management 
Server. 

 
<Detailed Information 2> 
・ Machine: xxx (MAC:xx-xx-xx-xx-xx-xx)  
・ Automatic update begins 
・ A socket error occurred. 
・ ...... 

Explanation: WinSock initialization failed. 
Check the network configuration of the Management Server (if TCP/IP protocol is installed). 
If there is no problem, restart the Management Server. 

 
<Detailed Information 3> 
・ Machine: xxx (MAC:xx-xx-xx-xx-xx-xx)  
・ Automatic update begins 
・ The connection to the client failed. 
・ ...... 

Explanation: The Management Server could not connect to the managed machine. 
(1) Use the following procedures to execute ping for the machine. 

From the Start menu, select Run, enter cmd in the name column, and click OK. The 
command prompt appears. Enter ping IP address or ping hostname and press 
Enter. (Enter a space between ping and the IP address/host name.) 
 
If there is no response, check whether there is a problem in the network configuration. 

(2) If there is no problem in the network, restart the following services on the machine 
side. (If a service is stopped, please start it.) 

DeploymentManager Agent Service 
DeploymentManager Remote Update Service Client 

 
<Detailed Information 4> 
・ Machine: xxx (MAC:xx-xx-xx-xx-xx-xx)  
・ Automatic update begins 
・ Search for the packages that are applicable to the client failed. 
・ ...... 

Explanation: Automatic update function may not be supported on the OS of the machine 
on which the error occurred. Check the machine's OS and language. The following is the 
list of OS that automatic update function is supported. The supported language is English 
only. 
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OS Name 
Windows 2000 Professional 
Windows 2000 Server 
Windows 2000 Advanced Server 
Windows XP Professional 
Windows Server 2003 Standard Edition 
Windows Server 2003 Enterprise Edition 
Windows Server 2003 Standard x64 Edition 
Windows Server 2003 Enterprise x64 Edition 
Windows Server 2003 R2 Standard Edition 
Windows Server 2003 R2 Enterprise Edition 
Windows Server 2003 R2 Standard x64 Edition 
Windows Server 2003 R2 Enterprise x64 Edition 
Windows Vista Business 
Windows Vista Enterprise 
Windows Vista Ultimate 
Windows Server 2008 Standard 
Windows Server 2008 Enterprise 
Windows Server 2008 Standard x64 
Windows Server 2008 Enterprise x64 
Windows Server 2008 R2 Standard 
Windows Server 2008 R2 Enterprise 
Windows Server 2008 R2 Datacenter 
Windows 7 Professional 
Windows 7 Ultimate 
Windows 7 Enterprise 
Windows 7 Professional x64 
Windows 7 Ultimate x64 
Windows 7 Enterprise x64 
Windows Server 2012 Standard 
Windows Server 2012 Datacenter 
Windows 8 Pro 
Windows 8 Enterprise 
Windows 8 Pro x64 
Windows 8 Enterprise x64 
Windows Server 2012 R2 Standard 
Windows Server 2012 R2 Datacenter 
Windows 8.1 Pro 
Windows 8.1 Enterprise 
Windows 8.1 Pro x64 
Windows 8.1 Enterprise x64 

 
<Detailed Information 5> 
・ Machine: xxx (MAC:xx-xx-xx-xx-xx-xx)  
・ Automatic update begins 
・ Reconfirmation of the connection to the client failed. 
・ ...... 

Explanation: A communication error occurred with the machine. 
(1) Use the following procedures to execute ping for the machine. 

From the Start menu, select Run, enter cmd in the name column, and click OK. The 
command prompt appears. Enter ping IP address or ping hostname and press Enter. 
(Enter a space between ping and the IP address/host name.) 
If there is no response, check whether there is a problem in the network configuration. 
 

http://www.microsoft.com/products/info/product.aspx?view=22&pcid=2abf99cd-a5e4-469c-802e-55ca8ec542d5
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(2) If there is no problem in the network, restart the following services on the machine 
side.(If a service is stopped, please start it.) 

DeploymentManager Agent Service 
DeploymentManager Remote Update Service Client 

 
 <Detailed Information 6> 

・ Computer: xxx (MAC:xx-xx-xx-xx-xx-xx)  
・ Automatic update Begins 
・ Creating file in the client failed. 
・ ...... 

Explanation: The disk space of the machine may be insufficient. 
Check the machine disk free space. Normally, it required free disk space that at least 
three times the size of the package to send. 
Example) To apply a 100MByte package, it is necessary that the free space of the 

managed machine system drive should be at least 300MByte. 
 
<Detailed Information 7> 
・ Machine: xxx (MAC:xx-xx-xx-xx-xx-xx)  
・ Automatic update Begins 
・ An error occurred while preparing for the file transfer. 
・ ...... 

Explanation: An error occurred in the process before the file is transferred. 
The Management Server may have insufficient resources. Restart the Management 
Server. 

 
<Detailed Information 8> 
・ Machine: xxx (MAC:xx-xx-xx-xx-xx-xx)  
・ Automatic update Begins 
・ Creating file transfer control thread failed. 
・ ...... 

Explanation: Failed to call WindowsAPI (CreateThread()). 
The resource on the Management Server may be insufficient. Restart the Management 
Server. 

 
<Detailed Information 9> 
・ Machine: xxx (MAC:xx-xx-xx-xx-xx-xx)  
・ Automatic update Begins 
・ Creating file transfer control thread failed. 
・ ...... 

Explanation: Failed to call WindowsAPI (CreateThread()). 
The resource on the Management Server may be insufficient. Restart the Management 
Server. 
 

<Detailed Information 10> 
・ Machine: xxx (MAC:xx-xx-xx-xx-xx-xx)  
・ Automatic update Begins 
・ An error occurred during the transfer of xxxxxxxx. 
・ ...... 

Explanation: A communications error occurred when sending a file. 
(1) Use the following procedures to execute ping for the machine. 

From the Start menu, select Run, enter cmd in the name column, and click OK. The 
command prompt appears. Enter ping IP address or ping hostname and press 
Enter. (Enter a space between ping and the IP address/host name.) 
If there is no response, check whether there is a problem in the network 
configuration. 
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 (2) If there is no problem in the network, restart the following services on the machine 
side.(If a service is stopped, please start it.) 

DeploymentManager Agent Service 
DeploymentManager Remote Update Service Client 

 
<Detailed Information 11> 
・ Machine: xxx (MAC:xx-xx-xx-xx-xx-xx)  
・ Automatic update Begins 
・ File transfer to the client failed. 
・ ...... 

Explanation: A communications error occurred when sending a file. 
(1) Use the following procedures to execute ping for the machine. 

From the Start menu, select Run, enter cmd in the name column, and click OK. The 
command prompt appears. Enter ping IP address or ping hostname and press 
Enter. (Enter a space between ping and the IP address/host name.) 
If there is no response, check whether there is a problem in the network 
configuration. 

(2) If there is no problem in the network, restart the following services on the managed 
machine side. 

(If a service is stopped, please start it.) 
DeploymentManager Agent Service 
DeploymentManager Remote Update Service Client 

(3) A file in transit may be in use by another process on the machine. 
If virus scan or other such software is running on the machine, a file in transit may be 
locked by the virus scan software, and transmission may fail. In such a case, when 
the next automatic update is executed, the file is sent again and applied. 

 
<Detailed Information 12> 
・ Machine: xxx (MAC:xx-xx-xx-xx-xx-xx)  
・ Automatic update Begins 
・ During the execution of xxxxxxxx package, an error occurred. 
・ ...... 

Explanation: The package was sent to the machine, but an error occurred during 
execution. 
(1) Use the following procedures to execute ping for the machine. 

From the Start menu, select Run, enter cmd in the name column, and click OK. The 
command prompt appears. Enter ping IP address or ping hostname and press 
Enter. (Enter a space between ping and the IP address/host name.) 
If there is no response, check whether there is a problem in the network configuration. 

(2) The disk space may be insufficient. 
This error occurs when the machine disk space is insufficient. Check the machine disk 
free space. Normally, it requires free disk space that at least three times the size of 
the package to send. 
Example)  

To apply a 100MByte package, it is necessary that the free space of the 
managed machine system drive should be at least 300MByte. 

(3) Uncompressing failed. 
Check whether there is a problem in the package sent to the machine. Confirm 
whether the package can be uncompressed on the machine. 

 
<Detailed Information 13> 
・ Machine: xxx (MAC:xx-xx-xx-xx-xx-xx)  
・ Automatic update Begins 
・ "Automatic update completed" response could not be received from the 
client. 

・ ...... 
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 Explanation: 
(1) Use the following procedures to execute ping for the machine. 

From the Start menu, select Run, enter cmd in the name column, and click OK. The 
command prompt appears. Enter ping IP address or ping hostname and press 
Enter. (Enter a space between ping and the IP address/host name.) 
If there is no response, check whether there is a problem in the network 
configuration. 

(2) If there is no problem in the network, restart the following services on the managed 
machine side. (If a service is stopped, please start it.) 

DeploymentManager Agent Service 
DeploymentManager Remote Update Service Client 

 
<Detailed Information 14> 
・ Machine: xxx (MAC:xx-xx-xx-xx-xx-xx)  
・ automatic update notice begins 
・ A socket error occurred. 
No such host is known. 

・ ...... 
Explanation: 

(1) Use the following procedures to execute ping for the machine. 
From the Start menu, select Run, enter cmd in the name column, and click OK. The 
command prompt appears. Enter ping IP address or ping hostname and press 
Enter. (Enter a space between ping and the IP address/host name.) 
If there is no response, check whether there is a problem in the network 
configuration. 

(2) If there is no problem in the network, restart the following services on the managed 
machine side. (If a service is stopped, please start it.) 

DeploymentManager Agent Service 
DeploymentManager Remote Update Service Client 

 
<Detailed Information 15> 
・ Machine: xxx (MAC:xx-xx-xx-xx-xx-xx)  
・ Automatic update time setting begins 
・ Automatic update or scenario execution is in progress in the client. 
Automatic update time setting will become valid after restarting the 
client. 

・ ...... 
Explanation: 
The automatic update time configurations will be enabled when the machine is started 
next time. 
 

<Detailed Information 16> 
・ Machine: xxx (MAC:xx-xx-xx-xx-xx-xx)  
・ Automatic update time setting begins 
・ Setting in the client failed. 
Automatic update time setting will be valid after restarting the 
client. 

・ ...... 
Explanation: 
Connection to the managed machine failed because the managed machine power status 
is OFF, or the communications port is closed. The automatic update time configurations 
will be enabled after the client is restarted. 
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The same package is distributed repeatedly in automatic update. 
Until the Management Server recognizes that the package has been applied, the distribution 
is repeated at every automatic update. Check the following items, and perform the process for 
each. 
<When the package type is HotFix>  
・ The MS number is wrong  

Check the MS number and correct it. 
・ The HotFix that cannot be discerned from the MS number  

Set the ID information. 
・ OS and language are not correct 

Check the OS and language, and correct them. 
・ ID information is wrong 

If a file such as text format (*.txt) without file version is specified for ID information file 
path, the applied status cannot be recognized if the file version is specified. If the file 
version is need to be specified, make the item blank. Also, if it is specified to replace or 
version up as the changed type using text format file, the applied status cannot be 
correctly recognized. In the case of text format, specify new or delete for the changed 
type 

<When the package type is service pack>  
・ Major version and minor version are wrong. 

Check major version and minor version and correct them. 
・ OS and language are not correct  

Check the OS and language, and correct them. 
・ ID information is wrong 

ID information is not necessary in the case of service pack. Set the correct values to for 
major version and minor version. 

<When the package type is application>  
・ Display name, display version is wrong. 

Check the display name and display version and correct them. 
・ OS and language are not correct. 

Check the OS and language, and correct them. 
・ ID information is wrong 

If a file such as text format (*.txt) without file version is specified for ID information file 
path, the applied status cannot be recognized if the file version is specified. If the file 
version is need to be specified, make the item blank. Also, if it is specified to replace or 
version up as the changed type using text format file, the applied status cannot be 
correctly recognized. In the case of text format, specify new or delete for the changed 
type. 

  

 

An automatic update error is displayed on the screen, and automatic update fails. 
The disk capacity of the Management Server may be insufficient. 
Check the disk capacity of the Management Server. If disk capacity is insufficient, secure the 
necessary disk capacity, and then restart the Management Server. 
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11.8. Automatic Download 
  

 

An error occurred in automatic download. In Management view -> DPM Server icon -> Package 
Download Settings screen -> Latest Download Information column, XXXX/XX/XX XX:XX:XX 
Automatic Download Failed is displayed, and check the Event Viewer to find an error log 
registered. 

Check the log information registered in the Event Viewer, and perform the processes for each 
item. 
After the processes complete, execute the automatic download again. 
 
<Log Information 1> 
・ DownloadFile: Failed to create the download directory, Dir = XXX. 

Explanation: 
Failed to create directory. 
This error occurs when the disk space of the managed machine is insufficient. Check the disk 
free space. 
 

<Log Information 2> 
・ DownloadFile: Failed to parse URL, URL = XXX. 

Explanation: 
Unable to analyze address. 
IP address of the Package Web Server may not be correct. Confirm items such as whether 
only valid characters are used, or port configurations are correct. For details, see Section 
2.7.3, "Package Download Setting." 

 
<Log Information 3> 
・ DownloadFile: Failed to connect proxy server, Serve Name = XXX. 

Explanation: 
Cannot connect to the proxy server. 
 

Check the below items in the following order: 
(1) The proxy server address may not be correct. Confirm items such as whether only valid 

characters are used, or port configurations are correct. 
(2) The network settings may not be correct. 

Check whether user identification is set to the proxy server. Use an HTTP proxy if using 
a proxy. 

 
<Log Information 4> 
・ DownloadFile: Failed to connect server, Serve Name = XXX. 

Explanation: 
Failed to connect to the Package Web Server. 
 

Check the below items in the following order: 
(1) IP address of the Package Web Server may not be correct. Confirm items such as 

whether only valid characters are used, or port configurations are correct. 
(2) The network settings may not be correct. 

Check whether user identification is set in the proxy server. Use the HTTP proxy if 
using a proxy. 

 
<Log Information 5> 
・ DownloadFile: Web server happened exception, Serve Name = YYY. 

Refer to the following detailed message in the log information registered to the event viewer. 
SendRequest: Http response error status = XXX. 
(Possible values for XXX are: 500, 501, 502, 503, 504, 505)  
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An error code in line with RFC2616 is added to an error message indicated by error code 
XXX. For details, see RFC2616. 
 

<Log Information 6> 
・ DownloadFile: Failed to get response or response is error, URL = YYY. 

Refer to the following detailed message in the log information registered to the event 
viewer. 
SendRequest: Http response error status = XXX. 
(Possible values for XXX are: 400, 401, 402, 403, 404, 405, 406, 407, 408, 409, 410, 
411, 412, 413, 414, 415)  
 
An error code following RFC2616 is added to an error message displayed by error code 
XXX. For details, see RFC2616. 

 
Example) SendRequest: Http response error status = 404 
 ->The specified URL does not exist. 

 
<Log Information 7> 

・ DownloadFile: The free disk isn't enough to download, URL = XXX. 
Explanation: 
This error occurs when the disk space of the Management Server is insufficient. Check the 
disk free space. 

 
<Log Information 8> 

・ DownloadFile: The file cannot be refresh, Filename = xxx. 
Explanation: 
Failed to update the file. Check whether a file named xxx is in use. 
If the file is in use, close it, and then download again. 

 
<Log Information 9> 

・ PmDlDownloadPackages: Failed to compress files, Web Server ID = xxx,  
Package ID = xxx. 

Explanation: 
This error occurs when the disk space of the Management Server is insufficient. Check the 
disk free space. 

  

 
 

Automatic download is configured, but it is not executed even when the set time is reached. 
Check the items below by the following order: 

(1) In Management view -> Package Download Setting screen, check Latest Download 
Information. 
If XXXX/XX/XX XX:XX:XX Automatic Download Failed is displayed, see Log Information 1 
through 9 of Section 11.8, "Automatic Download." 

(2) Check if the Package Web Server is added as the target of automatic download on the 
Package Download Setting screen. If none of the Package Web Servers are added, 
automatic download is not executed. After adding a Package Web Server, perform an 
automatic download again. 

(3) Check whether the Perform Automatic Download checkbox is selected on the Package 
Download Setting screen. If not, the automatic download cannot be performed. 

If the above procedure does not solve the problem, confirm that automatic update is not in progress, 
and then restart the Management Server. 
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11.9. Power On 
  

 

The machine cannot be turned ON when executing Power On or executing scenario. 
When the machine was forcibly shut down on the POST screen, Remote Power On may not 
function at the next time. 
In this case, turn off the power after POST is completed, or start up the OS and then shut it 
down. 

  

 

Although the power is ON, the icon displayed on the machine is power OFF. 
The screen may not be updated. Click Refresh on the Operation menu, or enter F5 to 
refresh the screen. 

  

 

The power is turned ON, but a remote power ON error is displayed on the machine list. 
The managed machine may not support PXE boot, or the network boot order may be set 
lower than the HDD. 
For x86, check the network boot order in the BIOS settings. For methods to check the BIOS, 
contact your sales or support representative. 

  

 

The VMware ESX/ESXi virtual machine cannot be turned ON when executing Power On or 
executing scenario. 

The VMware ESX/ESXi virtual machine cannot be turned on because Remote Power On is 
not support for these machines. Turn the power ON manually. 

 

11.10. Schedule Management 
  

 

Although you set the power management schedule, the machine power is not turned ON/shut down at 
the specified time. 

The machine may have been running a scenario. If the machine is running a scenario at the 
time set to Power ON/shutdown, the power will not be turned ON/shut down. 

 

11.11. Machine Information Import/Export 
  

 

Although the machine information is imported, the machine is not displayed on the managed 
machine list. 

Click Refresh on the Operation menu, or refresh the screen by pressing the F5 key, and 
then the machine will be displayed. 
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11.12. Network Settings 
  

 

The following error message was displayed: 
 
 
 

The machine may not be connected to the network. 
Check whether the network cable is connected to the machine, and then restart it. 

  

 

Once DHCP server and the Management Server have been separately on the different machines, the 
machine's MAC address cannot be obtained. 

The DHCP server on the Management Server may be running. On the Management Server, 
select Management Tools -> Services from Start menu, and confirm that "DHCP Server" is 
stop. If it is running, disable Startup Type on the Properties screen, and stop the service. 
On the Web Console, Management view -> DPM Server icon -> Detail Setting, -> DHCP 
Server tab -> DHCP Server is installed on an another machine checkbox may be cleared. 
Check if DHCP Server is installed on another machine is checked. If the checkbox is not 
selected, select it and click OK, and then reboot the Management Server. (If the Management 
Server cannot be rebooted, stop all services listed in Appendix A, "Service List" by selecting 
Management Tools -> Services from Start menu, and then start them.) 

  

 

The scenario cannot be executed because the managed machine cannot execute network boot. 
Network booting order may be set lower than the HDD in the BIOS configuration. Set the start 
order of the PXE network boot higher than the HDD, and then execute the scenario again. 

  

 

When you try to manage different network by using two or more LAN boards, the following errors are 
displayed. 
PXE-E51: No DHCP or proxyDHCP offers were received. 
PXE-E55: proxyDHCP service did not reply to request on port 4011. 

Perform the following procedures Step (1) and (2). 
(1) Change the IP address used by the DHCP server. 

1) From Start menu, select Administrative Tools -> DHCP. 
2) DHCP screen appears. Right-click the server name from the tree view, and then select 

Properties. 
3) Properties screen appears. Select the Advanced tab and click Binding. 
4) Binding screen appears. Select only the IP address to be used and click OK. 
5) From Start menu, select Management Tools -> Services, and then restart the DHCP 

Server. 
(2) Change the IP used by DPM. 

1) From Management View -> DPM Server icon -> Detail Setting screen -> General tab -> 
-> Server Information -> IP Address on the Web console screen, set the IP address 
which was set in Step (1). 

  

 

When DHCP Server and the Management Server have been separately on the different machines, the 
following error was displayed at network boot execution. 
PXE-E55: proxyDHCP service did not reply to request on port 4011. 

A DHCP server may exist which is set to option 60(060 Class ID) in DHCP server options. Check 
the DHCP server option settings, and delete the option 60(060 Class ID) setting. 

  

 

If you execute a scenario, the following error is displayed. 
PXE-E53:No boot filename received  

The DHCP server installation location configuration is incorrect. 
Open Management View -> DPM Server icon -> Detailed Setting screen on the DPM main 
window screen, and check that the setting of DHCP server tab is correct. 
Even if configuration is already correct, reconfigure the settings. 
 

 Failed to delete the computer name of the server. 
 Check the network environment, and restart. 
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If an error is displayed despite correct settings, first change the current settings to different 
settings (if the actual environment is DHCP Server is installed on the machine, then change it 
to DHCP Server is installed on an another machine, and if it is DHCP Server is installed on 
an another machine, then change it to DHCP Server installed on the machine), and then 
reconfigure the settings correctly. 
Example) If DHCP Server is installed on the machine is selected::  

(1) Select DHCP Server is installed on an another machine 
(2) Click OK  
(3) According to the message displayed on the screen to restart the services 
(4) Select DHCP Server is installed on the machine 
(5) Click OK  
(6) According to the message displayed on the screen to restart the services 

  

 

If you assigned IP addresses of the same segment to a machine with two or more LAN boards, power 
status cannot be detected properly. 

If static IP addresses are assigned to LAN boards which are not connected to LAN cables, the 
machine may not be able to communicate normally. If any LAN boards are not connected to LAN 
cables, either use DHCP settings without assigning static IP addresses, or set nothing for them. 

  

 

During network boot, the following message is displayed on the screen of the managed machine, and a 
scenario execution error occurs. 
PXE-E32: TFTP open timeout 

The TFTP port (port number: 69) may be blocked due to the port blocking functionality of 
Windows Firewall, or other security software. Confirm that the TFTP port is not blocked on the 
Management Server. It is necessary to unblock the TFTP port in order to perform operations on 
DPM. 

 

11.13. Operating Without DHCP Server 
  

 

An error occurs in Power ON, or Add Machine. 
Confirm if DPM Client is installed on the managed machine. See Section 2.2, "Installing 
DPM Client" in Installation Guide for the installation method. 

  

 

Failed to execute Backup scenario/restore scenario/ disk configuration check scenario from 
bootable CD. 

Check the following: 
Is the managed machine registered? 
Is a scenario assigned to the managed machine? 
Is the scenario assigned to the managed machine correct? 
Is a Multicast Scenario assigned? 
Does the scenario specify two or more tabs, such as specifying both the Backup/Restore 
tab and the HW Setting tab selected? 
An error occurs by scenarios excluding backup scenario, restore (unicast) scenario, or 
disk configuration scenario. 

  

 

If you insert a bootable CD into the managed machine and execute Backup/Restore Scenario 
from the Web Console, the scenario executes on a machine except the machine specified and the 
scenario completes properly, but a scenario execution error occurs on the machine specified in 
Operation. 

The machine may be mounted to two or more LAN boards which are executed the 
scenario, and each of those boards may be registered to DPM. If there are two or more 
registrations for the same machine, delete the unnecessary registrations, and then execute 
backup/restore again. 
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Even if you set a bootable CD to start the machine, the backup/restore scenario does not start. 
Is the CD the first in boot order? 
If not, change the boot order so that CD boot comes first. 

  

 

If you insert the bootable CD and start the machine, A state of communication was bad 
condition is displayed on the screen. 

Some kind of error may have occurred. 
・ If timeout occurs before the managed machine connect to the Management Server: 

Set a greater value for Remote Power ON Timeout on the Network tab of the Detail 
Setting screen, and then run backup/restore again. 
For details, see Section 2.7.1.3, "Network Tab." 

・ If using a bootable CD and Do Not Use A DHCP Server is not selected on the DHCP 
Server tab of the Management Server Detail Setting screen: 
see Section 2.7.1.4, "DHCP Server Tab" and set the DHCP Server tab items which 
correspond to the correct environment. 
*The Management Server must be restarted after the configuration is changed. 

・ If the MAC address of the LAN board on the managed machine is not registered to DPM, 
which is in communication with the Management Server: 
Register an appropriate MAC address to DPM, and execute backup/restore again. 

・  
・ If neither of the above apply: 

For reasons such as the network being unconnected or influences from the network, the 
Management Server and the managed machine may be under a condition where they 
cannot connect with each other. Check the network status between the Management 
Server and the managed machine, and then execute backup/restore again.  

  

 

If you insert the bootable CD and start the managed machine, the following message is displayed 
on the screen, and processing is interrupted: 
linuxrc: Cannot find CD-ROM Drives. 

This error occurs when the bootable CD is unable to recognize a device. 
If using a USB CD/FD drive, change the port which connects to the drive, and then try 
again. 
The CD drive used may not be supported by DPM. 
The following CD drives of Panasonic are not supported by DPM. 

KXL-840/RW11/RW20/RW21/RW31 
If you are using these drives, prepare another CD drive, or execute backup/restore by 
using Use A DHCP Server. 

  

 

Backup/restore does not start, and the following message appears on the screen. 
(The x below is a number. The following describes what to do if 5 is displayed for x.) 
ERROR: Failed to read a file (x) 

If backup target correspond to one of the following situation, error is displayed because the 
following target must be recognized earlier than disk, 
・ If a USB device is connected to backup target machine. 
・ When interface is existing for backup target machine in order to connect USB device. 
・ When CD-DVD drive is built in the chassis of BladeServer. 
In this case, change the disk number of the scenario, and then execute the scenario. 
Also, the recognized disk number depends on the device, so if the same error occurs after 
changes, change the device numbers again and then execute backup. 

  

 

If restore is interrupted, the following messages are displayed:  
ERROR: Found the eof during the input of a binary stream.  
gzip: stdin: unexpected end of file. 

If restore is interrupted during data transfer, these messages may be displayed. If this 
message was displayed after restore was interrupted, execute restore again, or setup the 
OS. 
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11.14. PackageDescriber 
  

 

If you try to start PackageDescriber on Windows Vista, the following error is displayed: 
"Unable to access jarfile PackageDescriber.jar" 

The configuration of Temporary Save Folder may not have been modified from the default. 
Perform one of the following procedures: 
・ Disable user account control (User Account Control: UAC), and use PackageDescriber. 

To disable UAC, select Control Panel -> User Account -> Turn User Account Control on 
or off from Start menu and clear Use User Account(UAC) to help protect your computer. 

・ Run as Administrator. 
(1) From Start menu, right-click All Programs -> DPM PackageDescriber, and then select 

Properties. 
(2) The DPM PackageDescriber Properties screen appears. Next, perform the following 

configurations, and then click OK. 
・ Shortcut tab 

Edit the Target as follows. 
[Before edit] 

C:\Windows\system32\javaw.exe -jar PackageDescriber.jar 
[After edit] 

%ProgramFiles%\Java\jreX\bin\javaw.exe -jar PackageDescriber.jar 
*Replace X with JRE version you are using . 

・ Compatibility tab 
Check the Run this program as an administrator on the Privilege level. 

(3) The Access Denied screen appears. Click Continue. 
(4) Right-click DPM PackageDescriber shortcut icon on the desktop, select Properties, 

and then perform configurations Step (2) to (3). 
 
The User Account Controls screen appears when PackageDescriber is launched first time 
after the above configuration is performed. Click Allow. 

 

11.15. Collecting the Data in Case of Trouble 
 When you would like to inquire a failure while you use DPM, please send the following information: 

・ Information of DPM version/the module for the machine model 
・ Managed machine information 

- Machine model/Product number 
- Configuration of optional products/Product number 
- Machine name 
- MAC address 
- OS type 

・ Date and time that the obstacle occurred 
・ Failure information 

- How to operate DPM, and what occurred. 
・ Display on screen 

- Management Server 
- Managed machine 

・ Repeatability 
- Always occurs 
- There is a case that it succeeds 
- Succeeded in the past, but it began to fail one day 
- On other managed machine, it occurred or not 
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・ DPM log collected by DPM Log tool 

- Management Server 
- Managed machine 
*When the failure occurred, please collect log immediately 

If a scenario is executed on the same machine again, the log file may be overwritten. 
After about 1 week since the failure occurred, the DHCP Server's log will be overwritten. 

・ The figure of network configuration 
 

The method to collect the DPM log is listed below. 
Target machines of collecting logs are the Management Server, the Database Server(only when the database 
is configured on the different machine from the Management Server), and managed machines. 

 
 Log collection Procedure (Windows x86/x64) 

Collect logs on the Management Server, the Database Server (only when the database is configured on the 
different machine from the Management Server), and the managed machine on which the error occurred, 
following the procedure below. 

 
(1) Check that all operations of DPM (the following) are completed or ended. 

・ Operations for managed machines (scenario execution, automatic update, file distribution, file 
deletion and obtaining the information in File/Folder List screen) are completed. 

・ Web Console and various tools of DPM are ended. 
 
(2) Log on to the machine by a user with administrator authority. 

Log on to the Management Server (in the environment that the database is configured on the same 
machine with DPM Server) by a user who installed DPM Server. 
Log on to the Database Server by a user who configured the database. 
 

(3) When you collect logs on the Management Server, it is unnecessary to do this procedure. 
Skip to Step (4). When you collect logs on the Database Server or the managed machine, copy the 
following folder to the arbitrary folder. 

<Installation media>:\DPM\TOOLS\DpmLog 
 

(4) Start the command prompt and move to the following folder. 
・ On the Management Server: 

<DPM Server installation folder>\DpmLog 
・ On the Database Server or the managed machine: 

The folder which was copied in the Step (3). 
Example) If the location of the folder copied in Step (3) is "C:\" 

cd /d C:\DpmLog 
 

(5) Add option -A, and execute DpmLog.exe. See the following message and send the collected log. 
 

 
 
 While DpmLog.exe is running, do not perform any DPM operation. 

 
(6) Delete the saved log folder because it is unnecessary after sending logs. 
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 Log collection Procedure (Linux) 

Collect the following files. When you collect the files, try not to change the time stamp (for example, -p option 
of cp command and so on), then use a command such as zip or gzip to compress on Linux, and then send. 

- System Setting File 
/etc/hosts 
/etc/resolv.conf 
/etc/sysconfig/network 
/etc/sysconfig/clock (only when you use earlier than Red Hat Enterprise Linux 7)  
/etc/sysconfig/iptables (only when you use earlier than Red Hat Enterprise Linux 7) 
/etc/sysconfig/ipchains (only when you use earlier than Red Hat Enterprise Linux 7) 
/etc/rc.d/rc (only when you use earlier than Red Hat Enterprise Linux 7) 
/etc./sysconfig/network-scripts/ifcfg-* 

 
- Version Information 

- In the case of earlier than Red Hat Enterprise Linux 7: 
 /etc./redhat-release 

- In the case of -Red Hat Enterprise Linux 7: 
/etc./redhat-release 
/etc/os-release 

- In the case of SUSE Linux Enterprise: 
/etc./SuSE-release 

 
- Files related to DPM Client 

All files located in folder /opt/dpmclient/ 
/var/log/messages* (All files whose name begin with "messages") 
All files located in folder /tmp/dpm/ (If existed) 
 

- Disk and partition Information 
Collect the execution result of the following command. 
fdisk -l 

 
- Network Information 

Collect the execution results of the following command. 
ifconfig -a 
ip addr show 
netstat -anp 
route 
ps -axm | grep depagtd 
iptables -L 
 

- System Information 
Collect the execution results of the following command. 
uname -a 
lspci -vx 
dmidecode 
biosdecode 
dmesg -s 524288 
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Appendix A Service List 
 
The following is DPM services and processes. 
 

 "Automatic" listed in the column of "Startup Type" in the following table is resident service. 
 
 DPM Server 
Service 
Name 

Display  
Name 

Startup 
Type 

Process Name 
*1 

The 
Number 
of 
Process 

Function 

APIServ DeploymentManager 
API Service 

Automatic apiserv.exe 1 Setting of scenario 
execution and each item 

 (Child process)  mkParams.exe 1 or 
more 

Tool to create a Windows 
disk duplication data file  

magicsend.exe 1 Executing remote power-on 

ipconfig.exe  1 or 
more 

Setting of Network 

nbtstat.exe 1 or 
more 

Setting of Network 

bkressvc DeploymentManager 
Backup/Restore 
Management 

Automatic bkressvc.exe 1 Executing backup/restore 

depssvc DeploymentManager 
Get Client 
Information 

Automatic depssvc.exe 1 Receiving the information of 
OS/service packs/patches 
from the managed machine 

PxeSvc DeploymentManager 
PXE Management 

Automatic pxesvc.exe 1 Controlling network (PXE) 
boot 

 (Child process)  ipconfig.exe 1 or 
more 

Setting of network 

nbtstat.exe 1 or 
more 

Setting of network 

PxeMtftp DeploymentManager 
PXE Mtftp 

Automatic 
(*2) 

pxemtftp.exe 1 TFTP server function 
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rupdssvc DeploymentManager 

Remote Update  
Service 

Automatic rupdssvc.exe 1 Executing remote update 

 (Child process)  zip.exe 1 File compressing command 
unzip.exe 1 File extracting command 

schwatch DeploymentManager 
Schedule 
Management 

Automatic schwatch.exe 1 Managing schedule 

 (Child process)  magicsend.exe 
 

1 Executing remote power-on 

ipconfig.exe  1 or 
more 

Setting of network 

nbtstat.exe 1 or 
more 

Setting of network 

ftsvc DeploymentManager 
Transfer 
Management 

Automatic ftsvc.exe 1 File transfer service 

  (Child process)  CHKOS32.exe 
 

1 or 
more 

Tool for obtaining OS type 

*1  
The default installation folder is 
C:\Program Files\NEC\DeploymentManager. 

*2  
When you install DPM Server, if you select Do not use the TFTP service of DPM on TFTP Server tab of the 
Detailed Setting screen, this item will be disabled. 

 
 Database *1 

Service Name Display Name Startup 
type 

Process Name 
*2 
 

The 
Number 
of 
Process 

Function 

MSSQL$ 
Instance Name 

SQL Server 
(Instance Name) 

Automatic sqlservr.exe 1 SQL database 
(DPM) 

*1 
This runs on the machine on which the database is configured. 

*2 
The default installation folder is 
C:\Program Files\Microsoft SQL Server\MSSQL11.Instance Name\MSSQL\Binn. 
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 Image Builder (Remote Console) 

Service Name Display Name Startup Type Process Name *1 The Number of 
Process 

Function 

None None  DIBuilde.exe 1 Image 
Builder 

  (Child 
process) 

 DIBPkgMake.exe 1 Tool for 
creating a 
package 

 DIBPkgDel.exe 1 Tool for 
deleting a 
package 

 mkParams.exe 1 Tool for 
creating a 
Windows 
disk 
duplicatio
n data file 

 ExecLinuxIParm.j
ar 

1 Tool for 
creating a 
Linux 
install 
paramete
rs 

 ExecLinuxSysRep
.jar 

1 Tool for 
creating a 
Linux disk 
duplicatio
n data file 

 winftc.exe 1 File 
transferrin
g tool 

 zip.exe 1 File 
compress
ing 
command 

 CHKOSCD.EXE 1 Tool for 
checking 
OS media 

*1  
The default installation folder is C:\Program Files\NEC\DeploymentManager. 
 
 DPM Command Line 

Service Name Display Name Startup 
Type 

Process 
Name *2 
 

The 
Number of 
Process 

Function 

None None  dpmcmd.exe 1 or more Scenario 
execution and so 
on from DPM 
Command Line  

*1  
The default installation folder is C:\Program Files\NEC\DeploymentManager. 
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 DPM Client (Windows) 

Service Name Display Name Startup 
Type 

Process 
Name *1 
 

The 
Number of 
Process 

Function 

depagent DeploymentManager 
Agent Service 

Automatic DepAgent.ex
e 

1 Powering off the 
managed 
machine from 
DPM Server 

rupdsvc DeploymentManager 
Remote Update 
Service Client 

Automatic rupdsvc.exe 1 Executing remote 
update 
Sending the 
information of 
OS/service 
packs/patches to 
DPM Server 

 (Child process)  unzip.exe 1 File extracting 
command 

Execution 
File 

1 Installer of the 
package 

GetBootServ
erIP.exe 

1 Searching the 
Management 
Server  

None None  DPMTray.ex
e 

1 or more Automatic update 
status display 

*1  
The default installation folder is: 
・ In the case of x86: C:\Program Files\NEC\DeploymentManager_Client 
・ In the case of x64: C:\Program Files (x86)\NEC\DeploymentManager_Client 
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 DPM Client (Linux) 

Service 
(daemon) Name 

Display Name Startup 
Type 

Process Name The 
Number 
of 
Process 

Function  

In the case of 
earlier than Red 
Hat Enterprise 
Linux 7/ 
SUSE Linux 
Enterprise: 
depagt 
 
In the case of 
Red Hat 
Enterprise Linux 
7: 
depagt.service  

None Automatic depagtd *1 1,2 DPM Client 
Service 

 (Child 
process) 
Executed by 
system 
function 

 depagtd 1 Powering off 
from DPM 
Server 
Executing 
remote 
update  
Sending the 
information of 
OS/patches of 
the managed 
machine to 
DPM Server 

rpm  1 rpm package 
installer 

shutdown 1 Shutdown 
command 

mv 1 Command for 
moving files 

echo 1 Command for 
displaying 
messages 

unzip 1 Command for 
extracting 
compressed 
files 

touch 1 Command for 
changing the 
time stamp 

GetBootServerIP 1 Searching the 
Management 
Server 

*1  
The installation directory is /opt/dpmclient/agent/bin (fixed value). 

 

Procedure and Order of Starting and Stopping the 
Service 
DPM Server is linked to and dependent on each DPM related service. Therefore, if you start or stop services 
manually, do in the following order. 
About DPM Client services (daemon), there is no start/stop order. 
 

・ Start service order 
(1) SQL Server (Instance name) 

 
(2) Services that begin with "DeploymentManager" 
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・ Stop service order 
(1) Services that begin with "DeploymentManager" 

 
(2) SQL Server (Instance name) 

 

Appendix B Event Log 
 
About the event log, contact your sales or support representative. 
 

Appendix C Error Information 
 
About error information, contact your sales or support representative 
 

Appendix D Network Port and Protocol List 
 

 Communication Ports used by DPM  
 
  When you configure DHCP server and NFS Server on the Management Server, the 

communication which is described in each table is done between the Management Server and a 
managed machines. 

 About opening the communication port (Windows OS), which is used by DPM, automatically or 
manually, see Section 7.1, "Port Opening Tool." 

 
・ Communications between the Management Server and managed machines 

Item Management Server Protocol Con
nec
tion  
Dire
ctio
n 

Address 
Specificati
on 

Managed Machine 
Executable 
File Name 

Port  
No. 

Availabil
ity of 
Modifyin
g Port 
No. 

Port  
No. 

Avail
abilit
y of 
Modi
fying 
Port 
No. 

Executa
ble File 
Name 

Power 
On 

magicsend. 
exe 

*1 No UDP -> DirectBroad
cast 
*2 

5561 No  

Shutdow
n 
/Monitori
ng DPM 
Client 
(Only for 
SSC 
product) 

apiserv.exe 
schwatch.exe 

*1 No TCP -> Unicast 26509 
*10 

Yes For 
Windows:  
DepAgen
t.exe 
For 
Linux:  
depagtd 

Existenc
e 
Confirma
tion 
(Power 
ON/OFF 
Status 
Check) 

apiserv.exe 
schwatch.exe 

- *3 No ICMP 
Echo 
request 

-> Unicast 8 *3 No  

apiserv.exe 
schwatch.exe 

0 *3 No ICMP 
Echo 
request 

<- Unicast - *3 No  
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Network 
Boot 

pxesvc.exe 67 No UDP 
(DHCP) 

<- Broadcast 
*4 *5 

68 No  

pxesvc.exe 67 No UDP 
(DHCP) 

-> Broadcast 
*4 *5 

68 No  

pxesvc.exe 67 No UDP -> Unicast 68 No  
pxesvc.exe 4011 No UDP <- Unicast 68 No  
pxesvc.exe 4011 No UDP <- Unicast 4011 No  
pxesvc.exe 67 No UDP -> Unicast 4011 No  
pxemtftp.exe 69 No UDP 

(TFTP) 
<- Unicast *6 No  

pxemtftp.exe 69 No UDP 
(TFTP) 

-> Unicast *6 No  

bkressvc.exe 26503 
*10 

Yes TCP <- Unicast *1 No  

bkressvc.exe 26502 
*10 

Yes TCP <- Unicast *1 No  

OS 
installati
on by 
disk 
duplicati
on *7 

ftsvc.exe 26508 
*10 

Yes TCP <- Unicast *1 No  

Restore 
(Multicas
t) *8 

ftsvc.exe 26508 
*10 

Yes TCP <- Unicast *1 No  

bkressvc.exe 26501 
*10 

Yes TCP <- Unicast *1 No  

bkressvc.exe 26530 
*10 

Yes UDP -> Multicast 26530 
*10 

Yes  

Restore 
(Unicast) 
*9 

ftsvc.exe 26508 
*10 

Yes TCP <- Unicast *1 No  

bkressvc.exe 26501 
*10 

Yes TCP <- Unicast *1 No  

Backup 
*9 

ftsvc.exe 26508 
*10 

Yes TCP <- Unicast *1 No  

bkressvc.exe 26501 
*10 

Yes TCP <- Unicast *1 No  

CD Boot pxesvc.exe 26505 
*10 

Yes TCP <- Unicast *1 No  

Disk 
Configur
ation 
Check *9 

ftsvc.exe 26508 
*10 

Yes TCP <- Unicast *1 No  
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Installing 
service 
packs, 
hotfixes, 
Linux 
patch 
files, and 
applicati
ons by 
remote 
update 

rupdssvc.ex
e 

*1 No TCP -> Unicast 26510 
*10 

Yes For Windows:  
rupdsvc.exe 
For Linux:  
depagtd 

rupdssvc.ex
e 

*1 No UDP -> Multicas
t 

26529 
*10 

Yes For Windows:  
rupdsvc.exe 
For Linux:  
depagtd 

rupdssvc.ex
e 

2650
7 
*10 
 

Yes TCP <- Unicast *1 No rupdsvc.exe (Windows 
only) 

Acquisiti
on of 
managed 
machine 
OS/HotFi
x 
informati
on 

depssvc.exe 2650
4 
*10 

Yes TCP <- Unicast *1 No For Windows:  
rupdsvc.exe 
For Linux:  
depagtd 

Automati
c Update 
Request 

rupdssvc.ex
e 

2650
6 
*10 

Yes TCP <- Unicast *1 No rupdsvc.exe 

rupdssvc.ex
e 

2650
7 
*10 

Yes TCP <- Unicast *1 No rupdsvc.exe 

Automati
c update 
notice 

rupdssvc.ex
e 

*1 No TCP -> Unicast 26511 
*10 

Yes rupdsvc.exe 

rupdssvc.ex
e 

2650
6 
*10 

Yes TCP <- Unicast *1 No rupdsvc.exe 

rupdssvc.ex
e 

2650
7 
*10 

Yes TCP <- Unicast *1 No rupdsvc.exe 

Searchin
g the 
Manage
ment 
Server 

pxesvc.exe 67 No UDP 
(DHCP
) 

<- Broadca
st 
*4 

68 *11 No Windows: 
GetBootServerIP.exe 
Linux: 
GetBootServerIP 

pxesvc.exe 67 No UDP 
(DHCP
) 

-> Broadca
st 
*4 

68 *11 No Windows: 
GetBootServerIP.exe 
Linux: 
GetBootServerIP 

pxesvc.exe 4011 No UDP <- Unicast *1 No Windows: 
GetBootServerIP.exe 
Linux: 
GetBootServerIP 

pxesvc.exe 4011 No UDP -> Unicast *1 No Windows: 
GetBootServerIP.exe 
Linux: 
GetBootServerIP 

pxemtftp.exe  69 No UDP 
(TFTP) 

<- Unicast  *1 No  

pxemtftp.exe  69 No UDP 
(TFTP) 

-> Unicast  *1 No  
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File 
distributi
on, 
File 
deletion, 
Obtainin
g the 
informati
on in 
File/Fold
er List 
screen 

apiserv.exe *1 No TCP -> Unicast 26520 Yes For Windows:  
rupdsvc.exe 
For Linux:  
depagtd 

*1 
The port is automatically assigned. 

*2 
A machine on the same segments as the Management Server is addressed 255.255.255.255. 
If the segments are different than those of the Management Server, the address specification is direct 
broadcast. 
Example) The segment 192.168.0.0(MASK=255.255.255.0) is addressed 192.168.0.255. 

*3 
With ICMP (Internet Control Message Protocol), communication specifying the port number is not performed, 
but is routed using the value in the ICMP Type field value. 

*4 
A packet relayed by DHCP relay may be addressed as Unicast. 
 

*5 
Only if the DHCP and the Management Server are installed on different machines. 

*6 
Depends on the LAN board ROM of the machine. 

*7 
The protocols and port numbers listed in Restore are also required. 

*8 
The protocol and the port number in the table of Network Boot are also needed. (You can restore by multicast 
only when you use DHCP server.) 

*9 
If operations are performed using DHCP, the protocols and port numbers listed in Network Boot items are 
also required. 
If operations are performed without using DHCP, the protocols and port numbers listed in CD Boot are also 
required. 
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*10 

The default values of the ports to be used were changed from DPM Ver6.1. When you upgraded from the 
version earlier than DPM Ver6.1, the port numbers used before upgrading are taken over. Therefore, the port 
numbers are different from them (Values in the above table) of when you install DPM Server newly. However, 
the port for Web service (56050) is not taken over and new port (26500) is used. When you use the port which 
was used before upgrading, modify it manually. The following is the default port when you install DPM Server 
newly and when you upgrade DPM Server. 

When you install DPM Server newly When you upgrade DPM Server from the 
version earlier than DPM Ver6.1 

26500 26500 
26501 56020 
26502 56022 
26503 56030 
26504 56011 
26505 56060 
26506 56024 
26507 56028 
26508 56023 
26509 56010 
26510 56000 
26511 56025 
26529 56001 
26530 56021 

*11 
When both you operate DPM with DHCP server and you operate DPM without DHCP server, the part of the 
communication sequence of DHCP is used and UDP:68 is used.  

 
  When OS of managed machine is either of the following, ports and programs are 

opened as the following, depending on the status of the network which is used when 
DPM Client is installed. 
・ In the case of Windows Server 2008/Windows Vista 

Ports and programs are opened for either of public profile, private profile, or domain 
profile of Windows Firewall. 

・ In the case of Windows Server 2008 R2/Windows 7 or later 
- About DeploymentManager (DepAgent.exe) and DeploymentManager 

(rupdsvc.exe), ports and programs are opened for active public profile, private 
profile, or domain profile of Windows Firewall. 

- About File and Printer Sharing (Echo Request – ICMPv4-In), ports and programs 
are opened for either of public profile, private profile, or domain profile of 
Windows Firewall. 

 
Example) 
When the managed machine joins domain and the Domain Profile was changed, the 
port and the product which are used by DPM will be blocked, and the machine cannot 
communicate anymore. 
Open the ports or programs used by DPM in Domain Profile in advance on the 
managed machine that joins domain or the master machine of OS installation by disk 
duplication. 
You can open the managed machine's ports or programs in Domain Profile, following 
the procedure below. 
・ Setup by domain policy: 
Specify in the domain policy of domain controller on Windows Server 2008/Windows 
Vista or later. 

- Setup locally on the managed machine: 
(1) On the managed machine, from Inbound Rules of Windows Firewall with 

Advanced Security, right-click the following items and select Properties. 
・ DeploymentManager(DepAgent.exe) 
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・ DeploymentManager(rupdsvc.exe) 
・ File and Printer Sharing (Echo Request – ICMPv4-In)(*) 
* In the case of Windows Vista/Windows7 

Network - Echo Request(ICMPv4-In) 
(2) In Advanced tab of Properties dialog, select Domain checkbox in Profiles. 

 In case of Windows Server 2003(SP1/SP2)/Windows Server 2003 R2, all connection 
request are blocked by secirity update(Post-Setup Security Updates:PSSU) until latest 
update program is applied. 
Update the managed machine to latest status by Windows Update and so on, or 
release PSSU manually. To release PSSU manually, log on by administrator and close 
the security update window. 

 When you set the firewall service on the managed machine to automatic start, all ports 
are closed from when the machine is started to when the firewall service is started 
regardless of that the firewall function is enabled or disabled. At this timing, if you 
operate the following, the processing will fail. 
・ If you execute a scenario or shut down, an error occurs because the Management 

Server cannot communicate with the managed machine. 
In this case, after confirming that the managed machine is powered on on the Web 
Console, execute a scenario or shut down. 

・ When the version and revision of DPM Client is not matched with that of DPM 
Server, automatic upgrade of DPM Client will be done. However, the automatic 
upgrade fails because the Management Server cannot communicate with the 
managed machine at this timing. 
In this case, upgrade by a scenario, seeing Section 3.3.2, "Manually Upgrading 
DPM Client" in Installation Guide. 

 
•Communication between the Database Server and the Management Server 

Item Database Server  Protoco
l 

Conne
ction 
Directi
on 

z Management Server 
Execu
table 
File 
Name 

Port  
No. 

Availa
bility 
of 
Modif
ying 
Port 
No. 

Port  
No. 

Avail
abilit
y of 
Modi
fying 
Port 
No. 

Executab
le File 
Name 

Database  26512 
*2 

Yes TCP <- Unicast *1 No apiserv.ex
e 
bkressvc.
exe 
depssvc.e
xe 
ftsvc.exe 
pxesvc.ex
e 
rupdssvc.
exe 
schwatch.
exe 

*1 
The port is assigned automatically. 

*2 
When you change the port number, do it before installing DPM Server newly. After that, you cannot 
change it. 
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•Communication between DHCP server and managed machines 

Item DHCP Server  Protocol Conne
ction 
Directi
on 

Address 
Specifica
tion 

Managed Machine 
Executa
ble File 
Name 

Port  
No. 

Availa
bility 
of 
Modif
ying 
Port 
No. 

Port  
No. 

Availabili
ty of 
Modifyin
g Port 
No. 

Exec
utabl
e 
File 
Nam
e 

Obtaining 
the IP 
address 

 67 No UDP 
(DHCP) 

<- Broadcast 
*1 

68 No  

 67 No UDP 
(DHCP) 

-> Broadcast 
*1 

68 No  

*1 
A packet relayed by DHCP relay may be addressed as Unicast. 

 
・ Communication between NFS Server and managed machines 

Item NFS Server  Protocol Conne
ction 
Directi
on 

Address 
Specifica
tion 

Managed Machine 
Executa
ble File 
Name 

Port 
No. 

Availa
bility 
of 
Modif
ying 
Port 
No. 

Port 
No. 

Availabili
ty of 
Modifyin
g Port 
No. 

Exe
cuta
ble 
File 
Nam
e 

OS Clear 
Installation 

- *1 111 No TCP <- Unicast *2 No *1 
- *1 111 No UDP <- Unicast *2 No *1 
- *1 1048 

*3 
No TCP <- Unicast *2 No *1 

- *1 1048 
*3 

No UDP <- Unicast *2 No *1 

- *1 2049 No TCP <- Unicast *2 No *1 
- *1 2049 No UDP <- Unicast *2 No *1 

*1 
The file name is a Linux OS related module. (Not included in DPM products.) 

*2 
The port is automatically assigned. 

*3 
This port number may be dynamically changed. If communication fails, use the "rpcinfo -p" command to 
check the port number used by mountd (NFS mount daemon) service, and then open the port. If the problem 
is not solved by this method, turn off the Windows firewall. 
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・ Communication between the Web Console and the Management Server 

Item Machine used for Web 
Console 

Protocol Conne
ction 
Directi
on 

Address 
Specifica
tion 

Management Server *2 

Executa
ble File 
Name 

Port 
No. 

Availa
bility 
of 
Modify
ing 
Port 
No. 

Port 
No. 

Availabi
lity of 
Modifyi
ng Port 
No. 

Exe
cuta
ble 
File 
Nam
e 

Web 
Console 

 *1 No TCP 
(HTTP) 

-> Unicast 80 *3 Yes Web 
service 
(IIS) 

* 1 
The port is automatically assigned. 

* 2 
Because the Management Server uses the port (TCP:26500) for the internal processing (the communication 
between DPM Server and Web Service (IIS)), do not use this port by other applications. 

* 3 
You can change the port to be used by the following procedure. 

Example) For IIS 7.0 
1) Select Administrative Tools -> Internet Information Services (IIS) Manager from Start menu. 
2) Internet Information Services (IIS) Manager screen appears. Right-click computer name -> Sites 

-> Web Site name on the tree view, and select Edit Bindings... and change the port number. 
 
・ Communication between Image Builder (Remote Console) and the Management Server 

Item Machine used for Image 
Builder (Remote Console) 

Protocol Con
necti
on 
Dire
ction 

Address 
Specifica
tion 

Manageme
nt Server 

Executa
ble File 
Name 

Port 
No. 

Availabi
lity of 
Modifyi
ng Port 
No. 

Port 
No. 

Availabi
lity of 
Modifyi
ng Port 
No. 

Execu
table 
File 
Name 

Image 
Builder 
(Remote 
Console) 

DIBuilde
.exe 

*1 No TCP -> Unicast 26508 
*2 

Yes ftsvc.e
xe 

* 1 
The port is automatically assigned. 

* 2 
When you upgrade DPM Server from the version earlier than DPM Ver6.1, the port before upgrading 
(56023) is taken over. 
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・ Communication between DPM Command Line and the Management Server 

Item Machine used for DPM 
Command Line 

Protoco
l 

Conne
ction 
Directi
on 

Addres
s 
Specific
ation 

Management Server *2 

Executa
ble File 
Name 

Port 
No. 

Availabi
lity of 
Modifyi
ng Port 
No. 

Port No. Availabi
lity of 
Modifyi
ng Port 
No. 

Exe
cuta
ble 
File 
Nam
e 

DPM 
Command 
Line 

dpmcmd
.exe 

*1 No TCP 
(HTTP) 

-> Unicast 80 *3 Yes Web 
servic
e (IIS) 

* 1 
The port is automatically assigned. 

* 2 
Because the Management Server uses the port (TCP:26500) for the internal processing (the communication 
between DPM Server and Web Service(IIS)), do not use this port by other applications. 

* 3 
You can change the port to be used by the following procedure. 

Example) For IIS 7.0 
1) Select Administrative Tools -> Internet Information Services (IIS) Manager from Start menu. 
2) Internet Information Services (IIS) Manager screen appears. Right-click computer name -> Sites 

-> Web Site name on the tree view, and select Edit Bindings... and change the port number. 
 

 Depending on the type of OS, the DPM service may not be able to start if there is a port 
conflict between the DPM service and other service or application causing by the 
Ephemeral port. For methods of checking and handling problems with ephemeral ports, 
see "Regarding ports used by DPM" of Section 2.2.1, "Network Environment" in First Step 
Guide. 

 
 For router and switch configuration, see the manual of the network device or contact the 

vendor. 
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Appendix E Log Files Output by DPM 
 
 DPM Server 

The following are logs which are output on the machine on which DPM Server is installed. 
 

 In the machine on which DPM Server is installed, Image Builder and DPM Command Line 
are also installed. See also the description of Image Builder (Remote Console) and DPM 
Command Line below. 

 
Folder <DPM Server installation folder>\Log 

(Default: C:\Program Files\NEC\DeploymentManager\Log) 
File apiserv.csv 

apitrace.log 
bkressvc.csv 
DepInit.csv 
depssvc.csv 
DIBPkgMake.csv 
ftsvc.csv 
pmdb.log 
pminfo.log 
pxemtftp.csv 
pxesvc.csv 
rupdssvc.csv 
schwatch.csv 
rupdssvc_managed machine MachineName_ managed machine 
MACAddress.log 

Output Content DPM trace log, monitor log, error information, database access log 
Recording Method The maximum size of apitrace.log is 1MByte. The maximum size of 

pmdb.log and pminfo.log is 16KByte. The maximum size of the other files 
is 10MByte. 
If the size of apitrace.log exceeds the maximum file size, the file is 
overwritten in order from the top location in the file. 
The pmdb.log and pminfo.log and rupdssvc_manmaged machine 
MachineName_managed machine MACAddress.log are managed by 2 
generations. (If the size exceeds the maximum file size, the file is renamed 
to *.log.bak, and the original *.log.bak is deleted.) 
The *.csv files are managed by 5 generations. 
(If the size of *.csv exceeds the maximum file size, the file is renamed to 
*.csv.1, and each original *.csv.n file is renamed to *.csv.n+1, and *.csv.4 is 
deleted.) 
Also, each file can be deleted manually. (Delete *.csv and apitrace.log 
manually after stopping the DPM services.) 

 
Folder <DPM Server installation folder>\Datafile\LogFile\SnrReport  

(Default: 
C:\Program Files\NEC\DeploymentManager\Datafile\LogFile\SnrReport) 

File Scenario.rpt 
Output Content Scenario Execution Results 
Recording Method There is no restriction for the file size. 

Furthermore, you can delete it from the Web Console. (For delete 
procedure details, see Section 4.5.2, "Delete Log.") 
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Folder <DPM Server installation folder>\Datafile\LogFile\AuReport  

(Default: 
C:\Program Files\NEC\DeploymentManager\Datafile\LogFile\AuReport) 

File Index.rpt 
managed machine MACaddress.rpt 

Output Content Execution log for automatic update (application automatic delivery) on a 
managed machine 

Recording Method Each managed machine is individually managed by MAC address. 
There is no restriction for the file size. 
The maximum record numbers of the logs can be set from the Web 
Console. 
 
According to the setting of maximum number of logs, if the log number 
exceeds it, the logs will be deleted from index.rpt file from the oldest in 
order, or 10% of the logs will be deleted from the oldest. 
 
For maximum number of log settings, see Section 4.7.2, "Maximum 
Number of Logs Settings."  
 
Furthermore, when the oldest log records from Index.rpt are deleted, the 
related information is deleted from managed machine MACaddress.rpt. 
Also, you can delete the log file from the Web Console. (For delete 
procedure details, see Section 4.7.4, "Delete Log.") 

 
Folder <DPM Server installation folder>\Datafile\JSLog 

(Default: 
C:\Program Files\NEC\DeploymentManager\Datafile\JSLog) 

File CmdUserJSLog_YYYYMMDD.csv 
CmdSelfJSLog_YYYYMMDD.csv 
MngUserJSLog_YYYYMMDD.csv 
MngSelfJSLog_YYYYMMDD.csv 
 
* YYYYMMDD is a date. 

Output Content Monitor log (the user operations/DPM Server internal operations) 
Recording Method Each file is saved to a file dated to the current day. 

There is no restriction for the file size. 
The files dated to the current day cannot be deleted while DPM Services 
are running. Only those files whose dates have already passed can be 
deleted even if those services are running. Furthermore, a file is 
automatically deleted when 30 days have elapsed from the file creation 
date. 
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Folder <DPM Server installation folder>\WebServer\Logs  

(Default:  
C:\Program Files\NEC\DeploymentManager\WebServer\Logs) 

File Browser.log 
Error.log 
JSOX-Event.csv 
LibAPI.log 
Polling.log 
Trace.log 
WebConsole.log 

Output Content Web Console error notifications, traces, and monitor logs 
Recording Method The maximum size of Polling.log is 1MByte. The maximum size of the 

other files is 10MByte. 
 
Polling.log is increased in one file, and the JSOX-Event.csv file is 
managed by 2 generations. (If the size exceeds the maximum file size, 
the file name is renamed to JSOX-Event.csv.1, and the original 
JSOX-Event.csv.1 is deleted.) 
 
The other files are managed by 6 generations. (If the size of *.log 
exceeds the maximum file size, the file name is renamed to *.log.1, and 
each original *.log.n file is rename to *.log.(n+1), and *.log.5 is deleted.)  
Each file can also be deleted manually. 

 
Folder <Folder for Image>\upload\dpmupload 

(Default: C:\Deploy\upload\dpmupload) 
File managed machine MACaddress_B.zip 

managed machine MACaddress_B.Error.zip 
managed machine MACaddress_R.zip 
managed machine MACaddress_R.Error.zip 
managed machine MACaddress_P.zip 
managed machine MACaddress_P.Error.zip 
managed machine MACaddress.zip 
managed machine MACaddress_Error.zip 

Output Content managed machine-side results from execution of backup/restore/disk 
format check 

Recording Method Each managed machine is individually managed by MAC address. 
The maximum size of each file is approx. 310KByte + (the number of 
target disks * approx. 50KByte). 
In the case of the managed machine in UEFI mode, approx. 460KByte + 
(the number of target disks * approx. 50KByte). 
The file is overwritten each time a scenario is executed.  
You can delete each file manually. 

 
Folder %SystemRoot% 

(Default: C:\WINDOWS)  
File Inst_Dpm_Db.log 

Inst_Dpm_Dbadmin.log 
Inst_Dpm_Ports.log 
Inst_DPM_Mng.log 

Output Content DPM installation log 
Recording Method There is no limit for the file size. 

Inst_Dpm_Db.log is overwritten each time DPM Server is installed, and 
the size does not increase after installing. Other files increase 
monotonically. Each file can be deleted manually. 
When you configure the Database Server, Inst_Dpm_Db.log and 
Inst_Dpm_Dbadmin.log are not created. 
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 Database Server 

The following are logs which are output on the machine on which the database is installed. 
 
Folder <SQL Server installation folder>\MSSQL11.Instance name 

\MSSQL\Log 
(Default: 
C:\Program Files\Microsoft SQL Server\MSSQL11. Instance name 
\MSSQL\Log) 

File ERRORLOG 
log_n.trc (n is a number) 

Output Content SQL Server log 
Recording Method There are no file size restrictions on any of the files. 

 
ERRORLOG is managed by 7 generations. (If SQL Server(Instance 
name) restarts, the file name is changed to ERRORLOG.1, and each 
original ERRORLOG.n file is changed to become ERRORLOG.(n+1), 
and ERRORLOG.6 is deleted.) 
 
log_n.trc is managed by 5 generations. (If SQL Server(Instance name) 
service is restarted at a state in which log_1.trc to log_5.trc exist, 
log_1.trc is deleted, and new log_6.trc is created.) 
 
ERRORLOG cannot be deleted. 
The log_n.trc cannot be deleted while SQL Server(Instance name) 
service is running. Past logs can be deleted even if the service is 
running. 
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 DPM Client (Windows) 

The following are logs which are output on the managed machine on which DPM Client (Windows) is installed. 
 

Folder <DPM Client installation folder> 
(Default: C:\Program Files\NEC\DeploymentManager_Client) 

File DepAgent.log 
rupdsvc.log 
DPMTray.log 
GetBootServerIP.log 
WindowsChgIP.log 

Output Content DPM Client service log 
Logs of Automatic Update Status Display Tool 
Logs of searching the Management Server by DPM Client 

Recording Method The maximum file size of DPMTray.log is 1MByte. The maximum file 
size of other files is 2MByte. 
If the size of DPMTray.log exceeds the maximum size of the file, all logs 
are cleared and the log is recorded newly. 
DepAgent.log, rupdsvc.log, GetBootServerIP.log, and  
WindowsChgIP.log are managed by 2 generations. (If the size exceeds 
the maximum file size, the file name is changed to *.log.bak, and the 
original *.log.bak is deleted.) 
Each file can also be deleted manually. 

 
Folder %SystemRoot%\DeploymentManager\JSLog 

(Default: C:\WINDOWS\DeploymentManager\JSLog)  
File CliSelfJSLog_YYYYMMDD.csv 

* YYYYMMDD is a date. 
Output Content Monitor log (DPM Client internal operations) 
Recording Method There is no restriction for the file size. 

Saved to a file dated to the current day. 
Files dated to the current day cannot be deleted while DPM Services 
are running. Only those files whose dates have already passed can be 
deleted even if those services are running. The file is automatically 
deleted when 30 days have elapsed from the file creation date. 

 
Folder %SystemRoot% 

(Default: C:\WINDOWS) 
File Inst_DPM_Win_Cli.log 
Output Content DPM install log 
Recording Method There is no limit of the file size on each file. Each time DPM Client is 

installed, the file size is increased monotonically. The file can be 
deleted manually. 
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 DPM Client (Linux) 

The following are logs which are output on the managed machine on which DPM Client (Linux) is installed. 
 

Folder /opt/dpmclient/agent/log 
File depinst.log 

depagtd.log 
GetBootServerIP.log 
LinuxChgIP.log 

Output Content Install log of DPM Client 
Service log of DPM Client 
Logs of searching the Management Server by DPM Client 

Recording Method There is no limit for the file size in depinst.log, and the file is overwritten 
each time DPM Client is installed. 
The depagtd.log, GetBootServerIP.log, and LinuxChgIP.log are 
managed by 2 generations. (If the size exceeds the maximum file 
size(2MByte), the file name is changed to *.log.bak. Original *.log.bak is 
deleted.) 
The file can be deleted manually. 

 
 Image Builder (Remote Console) 

The following are logs which are output on the machine on which Image Builder (Remote Console) is installed. 
 

Folder <Image Builder (Remote Console) installation folder>\Datafile\JSLog  
(Default: C:\Program Files\NEC\DeploymentManager\Datafile\JSLog) 

File ImgUserJSLog_YYYYMMDD.csv 
ImgSelfJSLog_YYYYMMDD.csv 

* YYYYMMDD is a date. 
Output Content Monitor log (operations performed by the user/Image Builder internal 

operations) 
Recording Method There is no limit for the file size, and each file is saved to a file dated to 

the current day. 
Files dated to the current day cannot be deleted while DPM Services are 
running. Thus, only those files whose dates have already passed can be 
manually deleted even if those services are running. The file is 
automatically deleted when 30 days have elapsed from the file creation 
date. 

 
 DPM Command Line 

The following are logs which are output on the machine on which DPM Command Line is installed. 
 

Folder <DPM Command Line installation folder>\Log  
(Default: C:\Program Files\NEC\DeploymentManager\Log) 

File DPM_Trace1.csv 
Output Content Monitor log (operations performed by the user/DPM Command Line 

internal operations) 
Recording Method The maximum file size of DPM_Trace1.csv is 10MByte. 

It is managed by 5 generations. (If the size of DPM_Trace1.csv exceeds 
the maximum file size, the file name is changed to DPM_Trace2.csv, and 
each original DPM_Tracen.csv file is changed to become 
DPM_Trace[n+1].csv, and DPM_Trace5.csv is deleted.) 
Each file can also be deleted manually. Files cannot be deleted while 
DPM Command Line is running. 
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Appendix F Procedure to Check the Version 
of Each Component 

 
 DPM Server 

Check the bottom (footer) of the Web Console. 
About starting the Web Console and logging into DPM, see from Section 5.1.1, "Starting the Web Console" to 
Section 5.1.2, "Logging into DPM" in Installation Guide. 

Example) DeploymentManager 6.3-XXXXX 
 

* XXXXX is the number. 
 

 DPM Client (Windows) 
1) From the Start menu, click Control Panel -> Programs and Features. 
2) Select Views menu-> Choose Details. 
3) On the Choose Details screen, select the Version check box and click OK. 
4) Check the Version displayed on DeploymentManager. 

Example) 6.30.000 
 
 DPM Client (Linux) 

Execute the command below, and check the version displayed. 
cd /opt/dpmclient/agent/bin 
depagtd -v 

 
Example) DeploymentManager Ver6.3 
 
 Image Builder (Remote Console) 

1) From the Start menu, click Control Panel -> Programs and Features. 
2) Select Views menu-> Choose Details. 
3) On the Choose Details screen, select the Version check box and click OK. 
4) Check the Version displayed on DeploymentManager (Image Builder). 

Example) 6.30.000 
 
 DPM Command Line 

1) From the Start menu, click Control Panel -> Programs and Features. 
2) Select Views menu-> Choose Details. 
3) On the Choose Details screen, select the Version check box and click OK. 
4) Check the Version displayed on DeploymentManager (DPM Command Line). 

Example) 6.30.000 
 
 PackageDescriber 

1) From the Start menu, click Control Panel -> Programs and Features. 
2) Select Views menu-> Choose Details. 
3) On the Choose Details screen, select the Version check box and click OK. 
4) Check the Version displayed on DPM PackageDescriber. 

Example) 6.30.000 
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Appendix G Glossary 
 
 Alphabetical order 
 

A 
 
 
 

Automatic Download Function which automatically downloads a new package from the Package Web 
Server to the Management Server at timing configured in advance. 

automatic update The managed machine checks the Management Server at timing configured in 
advance, if there has packages which has not been applied. It will send distribution 
request and automatically apply those packages. 

automatic update 
notice 

Notification that the Management Server issues to the managed machine so that 
automatic update can be executed in real time when a package of highest urgency is 
registered to the Management Server. 

B  
 
 

Backup/Restore Function to backup or restore data contained on a disk by either disk unit or partition 
unit. 

D  
 
 

Deploy-OS A Linux OS (kernel) customized for DPM that runs on the managed machine. 
Deploy-OS is sent to the managed machine from the Management Server, and is 
deployed on the memory of the managed machine during backup/restore/disk 
configuration check. 
Furthermore, if operating DPM without using a DHCP server, Deploy-OS is included 
in the bootable CD. 

DHCP server DHCP (Dynamic Host Configuration Protocol) is a protocol that dynamically modifies 
the IP address. 
DHCP sever refers to the machine or network device which has the functionality to 
provide configuration information by DHCP. 
In DPM, the DHCP server is used when a managed machine performs a PXE boot, 
or to assign an IP address during OS installation by disk duplication. 

Disk configuration 
check  

Function to check disk configuration before backup/restore is executed. You can 
check the disk number specified at the time of backup/restore. 

DPM Client DPM component. It runs on a managed machine and transfers data to DPM Server. 
Also controls the managed machines (shutdown and so on) and sends information 
such as package applied/not applied. 

DPM Command Line DPM component. It performs processing such as status check of the managed 
machine and scenario execution from the command line. 

DPM Server DPM component. It performs processing to the managed machine through Web 
Console operations or DPM Command Line. 

E  
 
 

Effective sector backup Backup of the only effective sectors of a hard disk. 

ESX, ESXi Virtualization software offered by VMware, Inc. 

Express5800 Series Business-oriented workstation server offered by NEC. 
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Full sector backup Backup all sectors of hard disk. 

F  
 
 

File Operation Function to copy or overwrite the file on the Management Server to the arbitrary 
place on the managed machine. Also, you can see the detailed information of files 
and folders on the managed machine and delete a file. 

G  
 
 

Guest OS The OS operating on the virtual machine. 

H  
 
 

Host OS Indicates the OS which is the infrastructure on which virtualization software runs. 

Hyper-V Microsoft virtualization software offered by Microsoft. 

I  
 
 

IIS Abbreviation for Internet Information Services, software for internet services offered 
by Microsoft. 

Image Builder Create packages, and disk duplication data files used by OS installation by disk 
duplication, and then registers them to the Management Server. 

Image Builder (Remote 
Console) 

Image Builder used on machine except the Management Server. 

Installation media Indicates the media bundled in DPM product. 

L 
 
 
 

LAN board Board used to connect to a LAN (Local Area Network). Also called NIC (Network 
Interface Card) or LAN adaptor. 

Local restoring Function to store a backup image file, which is created by DPM, in DVD(CD) media 
and restore the image only on the managed machine by using the media. 

M  
 
 
 

MAC Address Abbreviation for Media Access Control address, which is a fixed ID number for each 
LAN board. 
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Managed Machine Machine which managed by DPM. May be noted as Computer, Client, or Client 
Computer. 

Management Server The physical server that DPM Server is installed. 

Master Image Disk image of the machine which is the master of OS installation by disk duplication 
source. 

Master Machine The machine which is the master of OS installation by disk duplication source. 

O  
 
 

OS clear Installation Function that installs Red Hat Enterprise Linux while setting detailed configurations 
for the managed machine. 

OS installation by disk 
duplication 

Machine cloning function using Sysprep tools (master image creation tools) and DPM 
backup/restore functionality. 

P  
 
 

Package  The combination of patch, application or package application file. 
Created by either Image Builder or PackageDescriber. 

Package Information 
File 

File that basic information, execution information, applicable OS information, 
dependent information and identification information of a patch or an application are 
stored. 
Created by either Image Builder or PackageDescriber. 

Package Registration Upload a package created by PackageDescriber to the Package Web Server. 
Furthermore, the package needs to be re-uploaded if has been modified by 
PackageDescriber to the Package Web Server. 

Package Web Server  The web server which stores the packages. The Package Web Server can share 
packages for two or more Management Servers. Access must be allowed by HTTP 
protocol. 

PackageDescriber DPM component. A tool that creates packages and registers them to the Package 
Web Server. 

Patch Windows OS service packs and hotfixes released by Microsoft. 

PXE boot (network 
boot) 

Abbreviation for Preboot eXecution Environment boot. 
A boot method that using PXE (network booting standard) by the LAN board to start a 
program through the network. 
It is used by DPM to detect a managed machine, or to execute backup/restore/disk 
configuration check or package distribution. 

R  
 
 

Remote update Installing service packs, hotfixes, Linux patch files, and applications, and applications 

S  
 
 

Scenario  A configuration used to execute processing such as Distribution of floppy disk image 
for BIOS/firmware, OS clear installation, Installing service packs, hotfixes, Linux patch 
files, and applications, and backup/restore/disk configuration check. 
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SigmaSystemCenter The management software of IT platforms including virtual environment. 
DPM is bundled into SSC software suit. 

SQL Server Relational model database server provided by Microsoft. The data of DPM is stored in 
SQL Server. 

Sysprep Windows OS deployment tool provided by Microsoft. 

V  
 
 

Virtual Machine Indicates the machines virtually run on the virtual machine server. 

VirtualPCCenter Software product that manages a virtual PC-type thin client. 

VLAN Technology which builds a logical network, and then divides the network into two or more 
broadcast domains, unlike physically network configuration. 

W  
 
 

Web Console Checks the status of a managed machine and executes processing to a managed 
machine. 

WOL(Wake On LAN) Function which allows a machine connected to LAN to be turned on the power from 
another machine via network. 

X  
 
 

XenServer Virtualization software provided by Citrix. 

 

Appendix H Revision History 
 
 Second Edition(Rev.001)(2014.11): Revised to add the description about enhanced functions in DPM 

Ver6.31. 
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